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After Vegas software is installed and you start it for the first time, the registration wizard appears. This wizard offers easy 
steps that allow you to register the software online with Sony Media Software. Alternatively, you may register online at 
http://www.sony.com/mediasoftware at any time.

Registering your product will provide you with access to a variety of technical support options, notification of product 
updates, and special promotions exclusive to registered Vegas users. 

Registration assistance

If you do not have access to the Internet, registration assistance is available during normal weekday business hours. 
Please contact our Customer Service department by dialing one of the following numbers:

Customer service/sales

For a detailed list of customer service options, we encourage you to visit  
http://mediasoftware.sonypictures.com/support/custserv.asp. Use the following numbers for telephone support during 
normal weekday business hours:

Technical support

For a detailed list of technical support options, we encourage you to visit  
http://mediasoftware.sonypictures.com/support/default.asp. To listen to your support options by telephone, please call 
608-256-5555.

About your rights in Vegas software

Vegas software is licensed to you under the terms of the End User License Agreement. The End User License Agreement is 
first presented to you when you install the software. Please review the End User License Agreement carefully as its terms 
affect your rights with respect to the software. For your reference, a copy of the End User License Agreement for Vegas 
software is located at 
http://www.sony.com/mediasoftware.

Telephone/Fax Country
1-800-577-6642 (toll-free) US, Canada, and Virgin Islands

+608-204-7703 for all other countries

1-608-250-1745 (Fax) All countries

Telephone/Fax Country
1-800-577-6642 (toll-free) US, Canada, and Virgin Islands

+608-204-7703 for all other countries

1-608-250-1745 (Fax) All countries

http://www.sony.com/mediasoftware
http://mediasoftware.sonypictures.com/support/custserv.asp
http://mediasoftware.sonypictures.com/support/default.asp
http://www.sony.com/mediasoftware


About your privacy

Sony Media Software respects your privacy and is committed to protecting personal information. Your use of the 
software is governed by the Software Privacy Policy. A copy of this policy is incorporated into the registration process and 
you are asked to agree to its terms prior to accepting the terms of the End User License Agreement. Please review its 
contents carefully as its terms and conditions affect your rights with respect to the information that is collected by the 
software. For your reference, a copy of the Software Privacy Policy is located at http://mediasoftware.sonypictures.com/
corporate/privacy.asp. 

Proper use of software

Vegas software is not intended and should not be used for illegal or infringing purposes, such as the illegal copying or 
sharing of copyrighted materials. Using Vegas software for such purposes is, among other things, against United States 
and international copyright laws and contrary to the terms and conditions of the End User License Agreement. Such 
activity may be punishable by law and may also subject you to the breach remedies set forth in the End User License 
Agreement.

Legal notices

Vegas, Vegas+DVD, DVD Architect, Vegas Movie Studio, Vegas Movie Studio+DVD, DVD Architect Studio, ACID, Music Studio, ACIDized, 
Super Duper Music Looper, Jam Trax, Sony Sound Series, Chopper, Groove Mapping, Groove Cloning, Media Manager, CD Architect, 
Sound Forge, Audio Studio, Cinescore, Acoustic Mirror, Noise Reduction, Wave 64, Wave Hammer, and XFX are trademarks or registered 
trademarks of Madison Media Software, Inc. or its affiliates in the United States and other countries. 

PlayStation and PSP are registered trademarks of Sony Corporation Entertainment Inc. 

HDV and HDV logo are trademarks of Sony Corporation and Victor Company of Japan, Limited (JVC). 

All other trademarks or registered trademarks are the property of their respective owners in the United States and other countries.

Thomson Fraunhofer MP3

MPEG Layer-3 audio coding technology licensed from Fraunhofer IIS and Thomson.

Supply of this product does not convey a license nor imply any right to distribute content created with this product in revenue 
generating broadcast systems (terrestrial, satellite, cable and/or other distribution channels), streaming applications (via internet, 
intranets and/or other networks), other content distribution systems (pay-audio or audio on demand applications and the like) or on 
physical media (compact discs, digital versatile discs, semiconductor chips, hard drives, memory cards and the like).

An independent license for such use is required. For details, please visit: http://mp3licensing.com.

Microsoft DirectX programming interface

Portions utilize Microsoft® DirectX® technologies. Copyright © 1999 – 2006 Microsoft Corporation. All rights reserved. 

Microsoft Windows Media 9

Portions utilize Microsoft Windows Media® technologies. Copyright © 1999 – 2006 Microsoft Corporation. All rights reserved. 

Real, RealMedia, RealAudio, and RealVideo applications

2006 RealNetworks, Inc. Patents Pending. All rights reserved. Real®, Real Media®, RealAudio®, RealVideo®, and the Real logo are 
trademarks or registered trademarks of RealNetworks, Inc. in the United States and other countries. 

MPEGLA and MPEG 2

USE OF THIS PRODUCT IN ANY MANNER THAT COMPLIES WITH THE MPEG-2 STANDARD IS EXPRESSLY PROHIBITED WITHOUT A LICENSE 
UNDER APPLICABLE PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM MPEG-LA, LLC, 250 STEELE 
STREET, SUITE 300, DENVER, COLORADO 80206.

Manufactured under license from MPEG-LA. 

Dolby, Dolby Digital AC-3, and AAC encoding

This product contains one or more programs protected under international and U.S. copyright laws as unpublished works. They are 
confidential and proprietary to Dolby Laboratories. Their reproduction or disclosure, in whole or in part, or the production of derivative 
works therefrom without the express permission of Dolby Laboratories is prohibited. Copyright 1992 – 2006 Dolby Laboratories. All 
rights reserved. 

Dolby®, the double-D symbol, AC-3®, and Dolby Digital® are registered trademarks of Dolby Laboratories. AAC™ is a trademark of Dolby 
Laboratories.

PNG file format

Copyright © 2006. World Wide Web Consortium (Massachusetts Institute of Technology, European Research Consortium for Informatics 
and Mathematics, Keio University). All rights reserved. This work is distributed under the W3C Software License in the hope that it will be 
useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTIBILITY or FITNESS FOR A PARTICULAR 
PURPOSE. http://www.w3.org/Consortium/Legal/2002/copyright-software-20021231.

http://mediasoftware.sonypictures.com/corporate/privacy.asp
http://mediasoftware.sonypictures.com/corporate/privacy.asp
http://mp3licensing.com
http://www.w3.org/Consortium/Legal/2002/copyright-software-20021231


Apple QuickTime

Apple® QuickTime® application is a trademark of Apple, Inc. in the United States and other countries. 

Apple Macintosh Audio Interchange File Format (AIFF) file format. 

Apple® Macintosh® Audio Interchange™ File Format (AIFF) is a trademark of Apple, Inc. in the United States and other countries. 

Sony AVC/AAC

THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL AND NON-COMMERCIAL USE OF A 
CONSUMER TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS 
ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL 
INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C.  
SEE HTTP://MPEGLA.COM.

Targa file format

The Targa™ file format is a trademark of Pinnacle Systems, Inc.

Tagged Image File Format (TIFF)

Adobe Tagged Image™ File Format is a registered trademark of Adobe Systems Incorporated in the United States and other countries. All 
rights reserved. 

Main Concept encoder

Main Concept® plug-in is a trademark of registered trademark of Main Concept, Inc. in the United States or other countries. All rights 
reserved.

Macromedia Flash

Macromedia and Flash are trademarks or registered trademarks of Macromedia, Inc. in the United States and/or other countries.

Gracenote

CD and music-related data from Gracenote, Inc., copyright © 2000-2006 Gracenote. Gracenote CDDB® Client Software, copyright 2000-
2006 Gracenote. This product and service may practice one or more of the following U.S. Patents: #5,987,525; #6,061,680; #6,154,773, 
#6,161,132, #6,230,192, #6,230,207, #6,240,459, #6,330,593, and other patents issued or pending. Services supplied and/or device 
manufactured under license for following Open Globe, Inc. United States Patent 6,304,523. 

Gracenote and CDDB are registered trademarks of Gracenote. The Gracenote logo and logotype and the “Powered by Gracenote” logo 
are trademarks of Gracenote.

 

The information contained in this manual is subject to change without notice and does not represent a guarantee or 
commitment on behalf of Madison Media Software, Inc. in any way. All updates or additional information relating to the 
contents of this manual will be posted on the Sony Media Software web site, located at  
http://www.sony.com/mediasoftware. The software is provided to you under the terms of the End User License 
Agreement and Software Privacy Policy, and must be used and/or copied in accordance therewith. Copying or 
distributing the software except as expressly described in the End User License Agreement is strictly prohibited. No part 
of this manual may be reproduced or transmitted in any form or for any purpose without the express written consent of 
Madison Media Software, Inc.

Copyright 2006. Madison Media Software, Inc.

Program Copyright 2006. Madison Media Software, Inc. All rights reserved.

Madison Media Software, Inc.
A subsidiary of Sony Corporation of America

1617 Sherman Avenue 
Madison, WI 53704  
USA

http://www.sony.com/mediasoftware
HTTP://MPEGLA.COM
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Chapter 1
 Introduction

Welcome

Vegas® software from Sony Media Software is an innovative and advanced multitrack media-editing system. Vegas 
software was designed to create an efficient audio/video production environment without sacrificing the quality and 
processing power that you expect from Sony Media Software. Whether it’s the standard and familiar Microsoft® 
Windows® navigation commands or the clean and uncluttered interface, you’ll find Vegas software to be a tool that will 
be mastered in minutes. Beneath the unique and customizable interface, you’ll find a product that is both powerful and 
flexible. 

System requirements

In order to use Vegas software, your computer must satisfy the following minimum specifications:

• Microsoft® Windows® 2000 SP4 or XP (Windows XP SP2 required for HDV and XDCAM)
• 800 MHz processor (2.8 GHz recommended for HDV)
• 200 MB hard-disk space for program installation
• 600 MB hard-disk space for optional Sony Sound Series Loops & Samples™ reference library installation
• 256 MB RAM (512 MB RAM recommended for HDV)
• OHCI compatible i.LINK® connector*/IEEE-1394DV card (for DV and HDV capture and print-to-tape) 
• Microsoft Windows-compatible sound card
• DVD-ROM drive (for installation from a DVD only) 
• Supported CD-Recordable drive (for CD burning only) 
• Microsoft DirectX® 9.0c or later (included on application disc)
• Microsoft .NET Framework 2.0 (included on application disc)
• Microsoft Internet Explorer 5.1 or later (included on application disc)

*i.LINK is a registered trademark of Sony Electronics, used only to designate that a product contains an IEEE 1394 
connector. All products with an IEEE 1394 connector may not communicate with each other. 

Technical support

The Web site at http://mediasoftware.sonypictures.com/support/default.asp has technical support, reference 
information, program updates, tips and tricks, user forums, and a knowledge base.

Installing Vegas software

1. Place the Vegas application disc in the drive. The setup screen displays (if AutoPlay is enabled for your CD-ROM or 
DVD-ROM drive).

2. Click Install, and then follow the on-screen prompts to install the appropriate version of Vegas for your computer.

Note: If you have disabled the AutoPlay feature, click the Start button and choose Run. Type D:\setup.exe, where D is 
the drive letter of your CD-ROM or DVD-ROM drive, and follow the on-screen prompts to complete the installation.

Note: Windows Installer is used for all versions of Windows. Windows Installer is installed and then you are asked to 
restart your system.
INTRODUCTION | 17
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Getting help

You can access two varieties of help within Vegas:

• Online help
• Context-sensitive help

Online help

To access online help, choose Contents and Index from the Help menu or press F1.

The online help window has four tabs that you can use to find the information that you need.

Context-sensitive help

To use context-sensitive help in a dialog box, click the question mark button  in the upper-right corner of the dialog 
box and then click an item in the dialog box.

Note: To view online help, Internet Explorer 5.1 or later must be installed on your system. Internet Explorer 5.1 is included 
on the Vegas software application disc for your convenience.

Tab Description
Contents Provides a list of available help topics. Click a closed book  to open the pages, and then click on a 

topic page .
Index Provides a complete listing of the help topics available. Scroll through the list of available topics or 

type a word in the Type in the keyword to find box to quickly locate topics related to that word. 
Select the topic and click the Display button.

Search Allows you to enter a keyword and display all of the topics in the online help that contain the 
keyword you have entered. Type a keyword in the Type in the word(s) to search for box and click 
the List Topics button. Select the topic from the list and click the Display button.

Favorites Allows you to keep topics that you revisit often in a separate folder. To add a topic to your favorites, 

click the Add button on the Favorites tab.

Tabs

Information
pane

Toolbar



Help on the Web

Additional help and information is available on the Sony Media Software Web site. From the Help menu, choose Sony on 
the Web to view a listing of Web pages pertaining to Vegas software and Sony Media Software. The software starts your 
system’s Web browser and attempts to connect to the appropriate page on the Sony Media Software site.

Overview

Vegas software is designed to be an easy-to-use program with many tools that provide power and flexibility when 
creating and working with multimedia files. Many operations, menu items, and shortcut keys are consistent with other 
popular Microsoft Windows software applications. 

The following sections provide a graphical tour of the Vegas workspace.

Main window

This is the window that appears when the software is opened. The work area is subdivided into three primary areas: the 
track list, the track view (or timeline), and the window docking area.You can resize the track list, track view, and window 
docking area by dragging the dividers between them. 

Tip: If you prefer to work with the timeline at the bottom of the window and the docking area at the top of the window, 
select the Dock windows at top of main window check box on the Display tab of the Preferences dialog.

Menu bar

Track view

Transport bar

Status bar

Scrub control

Window

Track list

Time display

Toolbar

Ruler
Marker bar

docking
area

(timeline)
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Toolbar

The toolbar allows you to quickly access the most commonly used functions and features. From the Options menu, 
choose Customize Toolbar to specify which buttons are displayed.

Time display

The Time Display window reflects the cursor’s position on the timeline, MTC input, MTC output, or MIDI clock output 
time. You can customize time display settings, including what time the window displays and which colors are used in the 
display. For more information, see Using the Time Display window on page 304.

You can move the Time Display window from its docked position above the track list to float on the workspace or dock in 
the window docking area. 

Ruler

The ruler is the timeline for your project. You may specify how the ruler measures time: seconds, measures and beats, 
frames, etc. For more information, see Changing the ruler format on page 303.

Marker bar

The marker bar is the area where you can place, name, and position markers and regions along the project’s timeline. 
These informational tags can serve as cues or reminders highlighting important events in your project. For more 
information, see Adding project markers and regions on page 104.

Create new project Enable automatic crossfades

Open existing project Enable automatic ripple editing

Save project Lock envelopes to events

Open project properties Ignore event grouping

Cut selected events or time range Normal edit tool

Copy selected events or time range Envelope edit tool

Paste items from clipboard into 
project

Selection edit tool

Undo Zoom edit tool

Redo What’s This? help

Enable snapping

Docked position Floating window Docked in window docking area



Command bar

The command bar displays when you add a command to your project. Commands add metadata to media files to create 
effects such as closed captioning. For more information, see Adding project markers and regions on page 104.

CD layout bar

The CD layout bar displays tracks and indices in an audio CD layout project for disc-at-once (DAO) CD burning. For more 
information, see Burning CDs on page 329.

Track list

This area identifies the track order in your project and contains controls used to determine track compositing and mixing. 
For more information, see Using the track list on page 59.

Timeline

All arranging and editing is done in the timeline or track view. This area contains all of a project’s events. For more 
information, see Using the track view on page 58.

Track number

Track minimize

Video tracks

Audio track

Parent/child
compositing
control

and maximize

Selected track
INTRODUCTION | 21



22 | CHAPTER 1
Transport bar controls

The transport bar contains the playback and cursor positioning buttons frequently used while working on and 
previewing your project.

Status bar

The status bar is located at the bottom of the main program window and displays 
information about roughly how much space is left on your computer to record audio 
(Record Time). During the rendering processes, the left side of the status bar also contains 
information about the progress of the render.

The Video Preview window also has its own status bar that displays project specific information. For more information, see 
Understanding the Video Preview window on page 265.

Scrub control

The scrub control is used to play your project forward or backward 
for editing purposes. You may adjust playback speed by setting 
the speed control marker located beneath the scrub control. For 
more information, see Scrubbing on page 63.

Window docking area and floating window docks

By default, the window docking area is located in the lower half of the Vegas workspace. This area allows you to keep 
frequently used windows available but out of the way while you are working with a project. Windows can be docked next 
to each other, subdividing the docking area, or they can be docked in a stack in the window docking area or in a separate 
floating docking window. When stacked, each window has a tab at the bottom with its name on it. Click the window’s tab 
to bring it to the top.

• To dock a window, drag it to the docking area.
• Drag the handle on the left side of a docked window to remove a window from the docking area and float it.
• To prevent a window from docking when you drag it, hold the Ctrl key.
• To expand a docked window so it fills the docking area, click the Maximize button ( ). Click again to restore the 

window to its previous size.
• To remove a window from the docking area or a floating dock, click the Close button ( ).

Record into track Pause project playback

Loop playback Stop playback

Play from beginning of project Move cursor to start of project

Play project from cursor position Move cursor to end of project

Set playback speed

Drag either forward or
backward for playback

Drag the handle away from the
docking area to float the window.

Close window

Expand window



Explorer window - Alt+1

The Explorer window is similar to the Microsoft Windows Explorer. Use the Explorer window to select media files to drag 
to the project timeline or add to the Project Media window. You can also use the Explorer to perform common file 
management tasks such as creating folders, renaming files and folders, and deleting files and folders. Use the Start 

Preview ( ) and Auto Preview ( ) buttons to preview files before adding them to the project.

Display tips:

To display the window docking area in the top half of the Vegas workspace, select the Dock windows at top of main 
window check box on the Display tab of the Preferences window.

To display the tabs at the top of the window docking area rather than the bottom, select the Put tabs at top of docked 
windows check box on the Display tab of the Preferences window.

To hide the window docking area, select the Automatically hide docking area check box on the Display tab of the 
Preferences window.

For more information, see Display tab on page 323.

Move up the folder list to the next 
highest folder

Stop preview

Refresh the current view Enable automatic preview

Create a new folder Use Gracenote MusicID service to 
locate matching CD information

Delete selected file(s) Edit and submit CD information to 
Gracenote

Add selected file to My Favorites list 
in address bar

Get media from the Web for use in 
project

Start preview Change the display view

Select drive 

Preview selected
media files before
placing them
in the project.

or folder

Select media to place 
in the project by dragging
or double-clicking.

Add media to the Project Media
window by right-clicking a file and
choosing Add to Project Media
list from the shortcut menu.
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Trimmer window - Alt+2

The Trimmer window is a good place to edit any media file. When a media file is placed in the Trimmer window, you can 
place portions of the file on separate tracks by dragging and dropping. For more information, see Using the Trimmer 
window on page 119. 

Mixer window - Alt+3

The Mixer window gives you access to your project’s audio properties, bus assignments, output levels, and plug-in 
chains. For more information, see Using the Mixer window on page 167.

Video Preview window - Alt+4

This window displays a project’s video during project editing and playback. For more information, see Previewing and 
Analyzing Video on page 265.

Video appears during
project playback or as
the cursor is moved 
during editing.

Right-click to 
change Video
Preview settings



Project Media window - Alt+5

The Project Media window helps you organize the media files you’re using in a project. The information about these files 
is displayed in a highly flexible database that can be instantly sorted. You can also use the Project Media window to apply 
effects and plug-ins to media files and set the specific properties of these files. For more information, see Using the Project 
Media window on page 44. 

Edit Details window - Alt+6

This window serves as a highly detailed and customizable database of all of the events in a project. The database can be 
organized and sorted according to a large number of attributes. For more information, see Using the Edit Details window on 
page 124.

Transitions window - Alt+7

The Transitions window contains all of the transitions available. The thumbnails display animated examples of each 
transition. You can drag transitions from this window to replace the crossfade between two video events or to replace 
the fade-in or fade-out region of a video event. For more information, see Understanding basic transitions on page 245. 
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Video FX window - Alt+8

The Video FX window contains the video effects available. The thumbnails display animated examples of each plug-in 
preset. You can drag plug-ins from this window to an event, track, or to the Video Preview window (video output effects). 
For more information, see Using video effects on page 223. 

Media Generators window - Alt+9

The Media Generators window contains the different media generators provided. Media generators make it easy to 
create events containing text, credit rolls, test patterns, color gradients, and solid color backgrounds. You can drag a 
media generator to the timeline to create a new generated media event. For more information, see Using generated media 
on page 228. 

Plug-In Manager window - Ctrl+Alt+1

This window organizes all of the plug-ins available, including video and audio effects, media generators, and transitions. 
The plug-ins, which are organized in a folder structure, can be dragged into the project. For more information, see Using 
audio effects on page 175 or Using video effects on page 223. 



Video Scopes window - Ctrl+Alt+2

This window allows you to monitor your broadcast video for image problems.

Use the scopes to analyze the your video and adjust accordingly with the Brightness and Contrast, Broadcast Colors, 
Color Corrector, Color Corrector (Secondary), and Levels plug-ins before rendering.

For more information, see Monitoring video with scopes on page 270.

Surround Panner window - Ctrl+Alt+3

This window allows you to control panning in a 5.1 surround project. You can also display the Surround Panner window 
by double-clicking the surround panner on a track or mixer control. For more information, see Working with 5.1 Surround 
on page 191.
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Media Manager window - Ctrl+Alt+4

This window displays the Media Manager™, which you can use to search for, manage, and tag your media files. For more 
information, see Using the Media Manager on page 67.

XDCAM Explorer window - Ctrl+Alt+F5

This window displays the XDCAM Explorer window, which you can use to locate, import, and export XDCAM clips. For 
more information, see Working with XDCAM video on page 127.

Saving and recalling window layouts - Ctrl+Alt+D or Alt+D

A window layout stores the sizes and positions of all windows and floating window docks in the Vegas workspace. You 
can store up to ten window layouts so you can quickly recall customized layouts for specific editing tasks. For more 
information, see Saving and recalling window layouts on page 309.

Note: The XDCAM Explorer is not available unless the Enable XDCAM Explorer check box on the General tab of the 
Preferences dialog is selected. If you're not using the XDCAM Explorer, you may want to turn it off to conserve processing 
power or memory. 

When the check box is selected, the XDCAM Explorer window will start when you start Vegas software.



Keyboard command reference 

Project file commands

Window view commands

Red eye reduction commands

Description Keys
Create new project Ctrl+N

Create new project and bypass Project 
Properties dialog

Ctrl+Shift+N

Open existing project or media file Ctrl+O

Save project Ctrl+S

Open project’s properties Alt+Enter

Close current project Ctrl+F4
Exit Vegas software Alt+F4

Description Keys Description Keys
Focus to track view Alt+0 Plug-ins (show/hide window if 

not docked)

Ctrl+Alt+1

Explorer (show/hide window if 
not docked)

Alt+1 Video Scopes (show/hide 
window if not docked

Ctrl+Alt+2

Trimmer (show/hide window if 
not docked)

Alt+2 Surround Panner (show/hide 
window if not docked)

Ctrl+Alt+3

Mixer (show/hide window if not 
docked)

Alt+3 Media Manager (show/hide 
window if not docked)

Ctrl+Alt+4

Video Preview (show/hide 
window if not docked)

Alt+4 XDCAM Explorer (show/hide 
window if not docked)

Ctrl+Alt+5

Project Media (show/hide 
window if not docked)

Alt+5 Next window F6 or Ctrl+Tab

Edit Details (show/hide window 
if not docked)

Alt+6 Previous window Shift+F6 or Ctrl+Shift+Tab

Transitions (show/hide window 
if not docked)

Alt+7 Toggle focus between track 
list and timeline (and bus 
track list and timeline if bus 
tracks are visible)

Tab

Video FX (show/hide window if 
not docked)

Alt+8 Show/hide audio bus tracks B

Media Generators (show/hide 
window if not docked)

Alt+9 Show/hide video bus track Ctrl+Shift+B

Description Keys Description Keys
Scroll Left/Right Right/Left Arrow

Press Shift to scroll quickly

Jump to horizontal center of 
image

\

Numeric Keypad *

Scroll Up/Down Up/Down Arrow

Press Shift to scroll quickly

Jump to vertical center of image \

Numeric Keypad *

Jump to top/bottom of image Page Up/Down

Shift+Home/End

Jump to horizontal and vertical 
center of image

C

Jump to left/right edge of image Home/End

Shift+Page Up/Down
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Playback, recording, and preview commands

Edit commands

Description Keys Description Keys
Start/stop playback Spacebar Scrub playback J/K/L (pg. 64)
Play from start Shift+Spacebar or  

Shift+F12
Build dynamic RAM preview Shift+B (pg. 268)

Stop playback Esc Preview in player Ctrl+Shift+M
Looped playback mode Q or 

Ctrl+Shift+L
Prerender video Shift+M

Play/pause Enter or 
Ctrl+F12

Generate MIDI timecode F7

Record Ctrl+R Generate MIDI clock Shift+F7
Arm track for record Ctrl+Alt+R Trigger from MIDI timecode Ctrl+F7
Arm for record and set 
recording path

Ctrl+Alt+ Shift+R Preview cursor position

Specify the length of time that will play using the 
Cursor preview duration field on the Editing tab of 
the Preferences dialog.

Numeric keypad 0

Play back from any window Ctrl+Spacebar or F12 Toggle external monitor preview Alt+Shift+4

Description Keys Description Keys
Undo Ctrl+Z or  

Alt+Backspace
Delete selection Delete

Redo Ctrl+Shift+Z or 
Ctrl+Y

Split event(s) S

Cut selection Ctrl+X or  
Shift+Delete

Trim/crop selected events Ctrl+T

Copy selection Ctrl+C or  
Ctrl+Insert

Normal Edit Tool Ctrl+D

Paste Ctrl+V or 
Shift+Insert

Switch to next editing tool D

Paste repeat Ctrl+B Switch to previous editing 
tool

Shift+D

Paste insert Ctrl+Shift+V Open in audio editor Ctrl+E



Cursor placement commands

Time selection commands

Description Keys Description Keys
Go to beginning of selection  
or view (if no selection)

Home Move left to marker(s) Ctrl+Left Arrow

Go to end of selection or view 
(if no selection)

End Move right to marker(s) Ctrl+Right Arrow

Go to beginning of project Ctrl+Home or W Move left to event edit points 
including fade edges

Ctrl+Alt+Left Arrow

Go to end of project Ctrl+End Move right to event edit 
points including fade edges

Ctrl+Alt+Right Arrow

Move left by grid marks Page Up Nudge cursor one pixel on 
timeline (when Quantize to 
Frames is turned off )

Left or Right Arrow

Move right by grid marks Page Down Jump to next audio CD track 
region or index

Period

Go to Ctrl+G Jump to previous audio CD 
track region or index

Comma

Jump to Marker # or select 
corresponding region

0-9 keys (not 
numeric keypad)

Jump to next audio CD track 
region

Ctrl+Period

Move one frame Alt+Left or Right 
Arrow

Jump to previous audio CD 
track region

Ctrl+Comma

Center in View \ Set in and out points I (in) and O (out)
Jog left/right (when not in 
edge-trimming mode or during 
playback)

F3/F9 Create time selection while 
dragging on an event

Ctrl+Shift+drag with 
mouse

Note: Many of the preceding cursor placement commands, when combined with the Shift key, are also selection 
commands.

Description Keys
Snap select to event edge Ctrl+Shift+Alt+Left or Right Arrow
Select loop region Shift+Q
Recover previous 5 selection areas Backspace
Select left by grid marks Shift+Page Up
Select right by grid marks Shift+Page Down
Mark in/out locations I (in) and O (out)
Create time selection while dragging on an event Ctrl+Shift+drag with mouse
Expand selection one frame Shift+Alt+Left or Right Arrow
Select to next audio CD track marker Shift+. (period)
Select to previous audio CD track marker Shift+, (comma)
Enter location for end of selection Ctrl+Shift+G
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View commands

Event commands

Description Keys Description Keys
Increase track height Ctrl+Shift+Up Arrow Show/hide window docking area F11 or Alt+`
Decrease track height Ctrl+Shift+Down Arrow Show/hide track list Shift+F11 or Shift+Alt+`
Minimize all tracks ` Show/hide window docking area 

and track list
Ctrl+F11

Set track height smaller Shift+` Recall window layout Alt+D, then press 0-9
Set track heights to default size Ctrl+` Save window layout Ctrl+Alt+D, then press 0-9
Zoom in time (incremental) Up Arrow Show/hide envelopes Ctrl+Shift+E
Zoom in time until each video 
thumbnail represents one frame

Alt+Up Arrow View event media markers Ctrl+Shift+K

Zoom out time (incremental) Down Arrow View active take information Ctrl+Shift+I
Zoom in on audio waveforms Shift+Up Arrow View waveforms and frames Ctrl+Shift+W
Zoom out on audio waveforms Shift+Down Arrow View video event buttons Ctrl+Shift+C
Zoom in Ctrl+Up Arrow View event fade lengths Ctrl+Shift+T
Zoom out Ctrl+Down Arrow View video event edge edit 

frames
Ctrl+Shift+O

Description Keys Description Keys
Move or trim selected event(s) left/right one 
pixel

Numeric keypad 4/6 Enter edge-trimming mode and select event 
start; move to previous event edge

In this mode, 1, 3, 4, and 6 on the numeric 
keypad trim the selected event edge. Hold 
Ctrl while pressing 1, 3, 4, or 6 to time 
compress/stretch, or hold Alt while 
pressing 1, 3, 4, or 6 to slip trim, or hold 
Ctrl+Alt while pressing 1, 3, 4, or 6 to slide 
a transition or crossfade.

Numeric keypad 7 or [

Move or trim selected events one frame left/
right

Numeric keypad 1/3 Enter edge-trimming mode and select event 
end; move to next event edge

In this mode, 1, 3, 4, and 6 on the numeric 
keypad trim the selected event edge

Numeric keypad 9 or ]

Move selected event(s) left/right on grid Ctrl+numeric keypad 
4/6

Trim left/right (when in edge-trimming mode F3/F9

Move selected event(s) left/right by the 
project frame period

Alt+Right Arrow 
numeric keypad 4/6

Exit edge-trimming mode Numeric keypad 5

Move selected event(s) left/right by the first 
selected event’s length

Ctrl+Alt+Right Arrow 
numeric keypad 4/6

Select next take T

Move selected event(s) up/down one track Numeric keypad 8/2 Select previous take Shift+T



Event editing commands

Event selection commands

Description Keys Description Keys
Slip: move media within 
event without moving the 
event

Alt+drag inside the 
event

Raise pitch one octave Shift+=

Slip Trim: move the media 
with the edge as it is 
trimmed

Alt+drag edge of 
event

Lower pitch one semitone - (not numeric 
keypad)

Slide: trim both ends of 
event simultaneously

Ctrl+Alt+drag middle 
of event

Lower pitch one cent Ctrl+-

Slide Crossfade: move 
crossfade

Ctrl+Alt+drag over a 
crossfade

Lower pitch one octave Shift+-

Trim Adjacent: trim selected 
event and adjacent event 
simultaneously

Ctrl+Alt+drag edge of 
event

Reset pitch Ctrl+Shift+= or

Ctrl+Shift+- 

Stretch (compress) the 
media in the event while 
trimming

Ctrl+drag edge of 
event

Select next take T

Open in audio editor Ctrl+E Select previous take Shift+T
Raise pitch one semitone = (not numeric 

keypad)
Convert cut to transition Numeric Keypad /

Numeric Keypad * 
Numeric Keypad -

Raise pitch one cent Ctrl+= Convert transition to cut Ctrl+Numeric Keypad 
/

Description Keys
Range selection Shift+click range of objects
Multiple selection Ctrl+click individual objects
Select all Ctrl+A
Unselect all Ctrl+Shift+A
Select all events in group Shift+G
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Track commands

Description Keys Description Keys
New audio track Ctrl+Q Group selected events G
New video track Ctrl+Shift+Q Remove event(s) from group U
Enable/disable snapping F8 Ignore event grouping Ctrl+Shift+U
Quantize to frames Alt+F8 Clear group (without deleting events) Ctrl+U
Snap to markers Shift+F8 Select all events in group Shift+G
Snap to grid Ctrl+F8 Insert/show/hide track volume envelope V

Auto ripple mode Ctrl+L Remove track volume envelope Shift+V

Auto crossfade mode Ctrl+Shift+X Insert/show/hide track panning envelope P

Normal edit tool Ctrl+D Remove track panning envelope Shift+P

Next tool D Cycle through effect automation 
envelopes

E or Shift+E

Previous tool Shift+D Show/hide envelopes Ctrl+Shift+E

Render to new track Ctrl+M Adjust envelope point up/down by one 
pixel

Select envelope 
point and hold the 
mouse button; press 
8 or 2 on the 
numeric keypad

Change the track that has focus Alt+Shift+Up/Down 
Arrow

Adjust envelope point left /right by one 
pixel

Select envelope 
point and hold the 
mouse button; press 
4 or 6 on the 
numeric keypad

Mute selected tracks Z Make fine envelope point or segment 
adjustments without changing envelope 
points’ timeline positions

Ctrl+drag envelope 
point or segment

Mute selected tracks and remove other 
tracks from mute group

Shift+Z Make normal envelope point or segment 
adjustments without changing envelope 
points’ timeline positions

Ctrl+Alt+drag 
envelope point or 
segment

Solo selected tracks X Adjust envelope point’s timeline position 
without changing its value

Alt+drag

Solo selected track and remove other 
tracks from solo group

Shift+X Insert region R

Change audio track volume or video track 
compositing level (when focus is on track 
list)

Ctrl+Right/Left 
Arrow

Insert marker M

Change audio track panning or video 
track fade-to-color setting (when focus is 
on track list)

Note: Click the Automation Settings 

button  and choose Show Automation 
Controls to adjust the track fade-to-color 
setting.

Ctrl+Shift+Left/
Right Arrow

Insert command marker C

Override snapping Shift+drag Insert audio CD track region N
Bypass snapping Shift+drag Insert audio CD track index Shift+N
Post-edit ripple affected tracks F Insert transition /, *, - (numeric 

keypad)
Post-edit ripple affected tracks, bus 
tracks, markers, and regions

Ctrl+F Insert cut transition Ctrl+*, - (numeric 
keypad)

Post-edit ripple all tracks, markers, and 
regions

Ctrl+Shift+F Convert crossfade or transition to cut Ctrl+/ (numeric 
keypad)



Trimmer commands

Track Motion window shortcuts

Surround panner commands

For finer, more precise movements on the shortcuts in this section, add the Ctrl key.

Tip: Many of the shortcuts that apply to the timeline (e.g., cursor placement, selection commands, etc.) also work in 
the Trimmer.

Description Keys Description Keys
Add Media From Cursor A Sort Trimmer history H
Add Media to Cursor Shift+A Clear Trimmer history Ctrl+Shift+H
Transfer time selection from timeline to 
Trimmer after cursor

T Remove current media from Trimmer 
history

Ctrl+H

Transfer time selection from timeline to 
Trimmer before cursor

Shift+T Save markers/regions S

Toggle selected stream: audio/video/both Tab Toggle automatic marker/region saving Shift+S
Toggle audio/video stream height Ctrl+Shift+Up/

Down Arrow
Open in audio editor Ctrl+E

Description Keys
Change 3D layout 1-6 (not numeric keypad)
Lock aspect ratio A
Scale about center C
Edit in object space O
Prevent movement X, Y, and Z
Prevent scaling Shift+X, Shift+Y, and Shift+Z
Enable snapping F8
Enable rotation Shift+F8

Description Keys
Constrain motion to a line through the center of the 
surround panner

Shift+drag the pan point (only when Move Freely  is selected)

Constrain motion to a constant radius from the center Alt+drag the pan point (only when Move Freely  is selected)  
Alt+mouse wheel

Constrain motion to the maximum circle that will fit in 
the Surround Panner

Alt+Shift+drag the pan point (only when Move Freely  is selected) 
Alt+Shift+mouse wheel

Move the pan point forward/back (when the pan point 
is selected)

Up/down arrow  
Page Up/Page Down  
Mouse wheel

Move the pan point left/right (when the pan point is 
selected)

Left/Right Arrow  
Shift+Page Up/Page Down  
Shift + mouse wheel forward/back

Move the pan point to a corner, edge, or center of the 
Surround Panner (when the pan point is selected)

Numeric Keypad

Move the pan point to a corner on the largest circle 
that will fit in the Surround Panner (when the pan 
point is selected)

Ctrl+Numeric Keypad 1,3,7,9
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Miscellaneous commands

Multimedia keyboard shortcuts

Mouse wheel shortcuts

Description Keys Description Keys
Online help F1 Shortcut menu Shift+F10
What’s This? help Shift+F1 Rebuild audio peaks F5
Change relative keyframe 
spacing

Alt+drag 
keyframes

Move both region markers or audio CD 
track region markers

Alt+drag region 
marker

Make fine fader/slider 
adjustments

Ctrl+drag 
fader/slider

Description Keys
Play/Pause Play/Pause
Play from start Shift+Play/Pause
Stop Stop
Mute track Mute
Mute track and remove other tracks from mute group Shift+Mute
Solo track Ctrl+Mute
Solo track and remove other tracks from solo group Ctrl+Shift+Mute
Change audio track volume or video track compositing level (when focus is on 
track list)

Ctrl+Volume Up/
Down

Change audio track panning or video track fade-to-color setting (when focus is 
on track list)

Shift+Volume Up/
Down

Change track focus Next/Prev Track

Description Keys
Zoom in/out on timeline Wheel
Vertical scroll Ctrl+wheel
Horizontal scroll Shift+wheel
Move the cursor in small increments Ctrl+Shift+wheel
Move cursor one frame at a time Ctrl+Shift+Alt+wheel
Auto-scroll Press mouse wheel and move mouse left or right
Move fader/slider Hover over fader and use wheel
Move fader/slider with fine control Ctrl+hover over fader and use wheel



Cursor indications

The cursor changes depending on which functions are available.

Using a control surface

A control surface is a hardware device that uses knobs, faders, and buttons to control user interface elements that are 
normally controlled with a mouse. Using a control surface lends a tactile feel to your editing sessions. 

Unlike keyboard shortcuts—which determine the shortcut’s behavior based on the portion of the Vegas window that has 
focus—a control surface’s mapped functions work no matter what part of the application has focus. 

You can use one Mackie® Control Universal or up to five generic control surfaces with Vegas software. For more 
information about setting up a control surface, please see External Control & Automation tab on page 326.

Cursor Indicates Modifier Description
Standard none This is the standard arrow cursor that means events can be 

dragged.

Trim none Position the cursor over the edge of an event and drag to trim the 
event shorter or longer.

Slip Trim Alt Position the cursor over the edge of an event, press Alt, and drag 
to trim. The media within the event moves with the edge. This is 
useful to preserve the beginning or end of an event while 
trimming.

Stretch Ctrl Position the cursor over the edge of an event, press Ctrl, and drag 
the edge to stretch or compress it. This makes the media in the 
event play slower or faster.

Slip Alt Press Alt and drag on the middle of a clip to move the media 
within the event without moving the event itself.

Trim 
Adjacent

Ctrl+Alt Position the cursor over the boundary between two adjacent 
events, press Ctrl+Alt, and drag. Both events are edge trimmed 
simultaneously.

Slide Ctrl+Alt Position the cursor over the middle of an event, press Ctrl+Alt, and 
drag to simultaneously trim both ends.

Slide 
Crossfade

Ctrl+Alt Position cursor over a crossfade, press Ctrl+Alt, and drag on a 
crossfade to move it.
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Audio signal flow



Video signal flow

Track signal flow

Composited track signal flow
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Chapter 2
 Getting Started

Vegas® software is a new way of creating multimedia productions. Whether you are an experienced multimedia author or 
a budding novice, the powerful features and capabilities of Vegas software are organized to increase your creativity and 
productivity. The following chapter summarizes the software’s basic functions and operations.

Creating projects

The process of creating a multimedia production can be a complicated undertaking, involving hundreds of shots, takes, 
voiceovers, music beds, audio tracks, and special effects. Organization is a critical issue in this process. In the software, 
organization is handled by a small project file (VEG) that saves information about source file locations, edits, cuts, 
insertion points, transitions, and special effects. This project file is not a multimedia file, but is instead used to create 
(render) the final file when editing is finished.

Because Vegas software edits a project file and not the original source files, you can edit without worrying about 
corrupting your source files. This not only gives you a strong sense of security, but it also gives you the freedom to 
experiment.

Starting a new project

1. From the File menu, choose New.

2. Enter your project settings on the various tabs. For more 
information, see Working with project properties on page 
306.

• The Video tab allows you to select the video format 
and other video parameters. 

• The Audio tab allows you to set up the basic audio 
settings.

• The Ruler tab allows you to choose the way the ruler 
is delineated (beats, seconds, etc.).

• The Summary tab allows you to enter any relevant 
information and reminders about your project.

• The Audio CD tab allows you to enter information for 
burning audio CDs.

3. Click OK.

4. From the File menu, choose Save. Enter a name, browse for a location, and click Save to save your project (VEG file).

You can change project settings at any time while working on a project. From the File menu, choose Properties to 
change any of these settings.

Note: The first time you run the software, a new project will automatically be started for you.

Tip: The easiest way to set the often-complex properties on 
the Video tab is to select a template that matches your media 
(e.g., NTSC DV (720x480, 29.970 fps)).
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Setting video properties based on a media file

You can automatically set your project video properties to match an existing video file.

1. From the File menu, choose Properties.

2. On the Video tab of the Project Properties dialog, click the Match Media Settings button ( ).

3. Browse for a media file that has the settings you wish you use for the project.

4. Click Open.

The frame size, frame rate, pixel aspect ratio, and field order of this file are automatically detected and the project 
properties are set to match.

5. Click OK to save the new project properties.

Saving a project

When you save your work, it is saved in a project file. Project files are not rendered media files.

1. From the File menu, choose Save.

The first time you save a project, the Save As dialog appears. In subsequent saves, the dialog is bypassed, your 
existing file name is retained, and your project is updated to include any implemented changes.

2. Select the drive and folder where you want to store the project.

3. Type the project name in the File Name box.

4. Click Save.

Renaming a project (using Save As)

After you have been working with your project, you can use the Save As command in the File menu to save a copy of a 
project with a new name. This is useful for backing up different versions of a project. For more information, see Renaming 
or creating a copy of a project (using Save As...) on page 281.

Tip: To save this information for future use, enter a name in the Template box and click the Save Template button ( ). 
If your projects typically use these settings, select the Start all new projects with these settings check box.

Tip: Select the Copy and trim media with project check box to save the project file and copies of the media files to 
a common location. For more information, see Renaming or creating a copy of a project (using Save As...) on page 
281.



Getting media files

You can add media from a variety of sources to your project. You can add audio and video files, record audio into a track, 
capture video from a video camera, or extract music from your own CD. You can also create media such as text overlays, 
backgrounds, and credit rolls from within the software. For more information, see Using generated media on page 228.

Vegas software supports a wide range of media file types. There are multiple ways to locate and add files to your Vegas 
project, as discussed in the following sections. 

Previewing a media file

You may preview files before placing them in your project. The Explorer window has a mini-transport bar with Play, Stop, 

and Auto Preview buttons ( ). When you preview a file, its stream is sent to the Mixer window’s preview bus (for 
audio files) or to the Video Preview window (for video files).

1. Select a file in the Explorer window.

2. Click the Play button ( ) to listen to the file.

3. Click the Stop button ( ) or select a different file to stop previewing the file.

Notes: 

• To have pulldown fields automatically removed when opening 24 fps progressive-scan DV video files, select the Allow 
pulldown removal when opening 24p DV check box on the General tab of the Preferences dialog. To open your 24p DV 
video files as 29.97 fps interlaced video (60i), clear this check box.

• When you add an ACID loop to the timeline, it is automatically stretched to match the project tempo as specified on the 
Ruler tab of the Project Properties dialog. If you want to ignore tempo information, clear the Import audio at project 
tempo check box on the Audio tab of the Preferences dialog. For more information on project properties, see Working 
with project properties on page 306. For more information on preferences, see Setting preferences on page 311.

• When you add a multichannel audio file (.wav/.wav64, .avi, .mxf, ATRAC, and BWF) to your project, the audio is added 
across tracks. For example, if you import a four-channel WAV file, the audio will be added to four adjacent tracks. For 
control over which channels are used by each event, right-click a multichannel audio event, choose Channels from the 
shortcut menu, and choose a command from the submenu. For more information, see Adjusting audio channels on page 
160.

• When you add a multistream audio file to your project, you can choose which stream you want to use by right-clicking the 
event, choosing Stream from the shortcut menu, and then choosing a stream from the submenu.

• 5.1-channel audio from DVD camcorders will be downmixed to stereo when importing into a stereo project. When 
importing into a 5.1 surround project, audio will be added to separate tracks for the center, front, rear, and LFE channels.

Tip: You can use the same mini-transport bar buttons in the Project Media window to preview files in the Project 
Media list.

Tip: To automatically preview selected files, click the Auto Preview button ( ) on the Explorer window’s transport 
bar.
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Using the Project Media window 

Media files, both video and audio, tend to be the 
largest files on your hard drive. It is therefore not 
always easy to move them around and impractical to 
store multiple copies of these files. You can add media 
files to the Project Media window to organize them 
before any editing begins. Once you begin working 
on a project, all files you add to the timeline are 
automatically included in the Project Media list. From 
the View menu, choose Project Media to open this 
window if it is not already visible. 

Using Project Media views

You can control the information that is displayed in the Project Media window by clicking the Views button ( ) and 

selecting a view. The purpose of each view is explained below.

Adding media to the Project Media list

You can add media to the Project Media list without adding it to the timeline by importing the file. For more information, 
see Importing media on page 49.

Adding media to the Project Media list from the Explorer window

1. Navigate to and select a file to add to the Project Media list. You can use Ctrl or Shift to select multiple media files. 

2. Right-click the file and choose Add to Project Media list from the shortcut menu. The selected file is added to the 
Project Media window.

Replacing media in the Project Media window

You may replace a file in the Project Media window with a different file. When changing the media file that an event 
contains, every occurrence of the event on the timeline is updated with the new media file contents.

1. Right-click a file in the Project Media window.

2. Choose Replace from the shortcut menu.

3. In the Replace Media File dialog, browse for and select the file that you want to replace the current file.

4. Click Open. The selected file replaces the old file in the Project Media list, and any events in the timeline containing 
the old file are updated to contain the new media file.

View Description
List Displays a simple listing of the file name of each file in the Project Media window.
Detailed Displays all the properties for each file. The information is presented in a table format. You can 

customize the information displayed:

Reorder columns (fields) by dragging the column label to a new position.

Hide a column by dragging the column label off of the Project Media window. To display a 
hidden column, right-click the Project Media window, choose View from the shortcut menu, 
and choose the column name from the submenu.

Sort the files in the Project Media list according to a category by clicking the column label for 
that category.

Use the Comments field to add your own annotations to a file’s entry in the Project Media list. 
Double-click the field to enter text. This information is saved with the project and is not saved 
with the media file itself.

Thumbnail Displays the first frame of a video file.



Capturing video

You can use the Sony Video Capture application installed with Vegas software to capture video clips from your DV or HDV 
video camera or via your SDI card and add them to the Project Media window. You can also specify a different third-party 
capture application for video capture.

1. From the File menu, choose Capture Video or click the Capture Video button ( ) in the Project Media window. 
The Capture Video dialog displays.

2. Choose the option you want to use for capturing video:

• Select the DV radio button if you want to capture DV or Video for Windows clips using the video capture 
application specified on the Video tab of the Preferences dialog.

• Select the HDV or SDI radio button if you want to capture SDI/HDV clips using the internal Vegas video capture 
application.

3. Click OK. The specified video capture application starts.

4. Capture your video. For information on capturing video with the Sony Video Capture application, please see the 
Vegas online help. To access help, choose Contents and Index from the Help menu.

Once you have captured your video, Video Capture adds the file(s) to the Project Media window. If any captured clips 
go offline, you can recapture the clips using your video capture application. Right-click an offline file in the Project 
Media window and choose Recapture from the shortcut menu.

Getting images

You can bring images directly into the software from your scanner, digital camera, or other TWAIN device. The images are 
added to the Project Media list as JPEG image files.

1. Make sure your device (scanner or digital camera) is on and connected to your computer.

2. In the Project Media window, click the Get Photo button ( ). The software is started for the device.

3. Use the device software to get an image and send it to Vegas 
software. Once the image has been sent, the Scanned Files dialog 
appears.

• Click Rename to give the new image a more meaningful 
name.

• Click Delete to cancel the process of adding the image.

4. Click Done. The new JPEG file is added to the Project Media 
window.

Notes: 

If you are using a DVD-based video camera, you can use the Import DVD Camcorder Disc dialog to import your video into 
your Vegas project. For more information, see Importing video from a DVD camcorder on page 52.

If you are using an XDCAM camera, you can use the XDCAM Explorer window to import XDCAM clips from a camera or 
deck. For more information, see Working with XDCAM video on page 127.

To specify the video capture application you want to use with Vegas, check the Use external video capture application 
check box on the Video tab of the Preferences window and browse for the program’s executable (.EXE) file.

Tip: If you always capture from the same device, select the Always use the selected method check box, and you won’t 
be prompted to choose a capture method again. You can change the method later using the Video tab of the Preferences 
dialog.
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Extracting audio from a CD

You can extract tracks from a CD and add them to the Project Media window as WAV files.

1. Insert the audio CD.

2. In the Project Media window, click the Extract Audio 
from CD button ( ). The Extract Audio from CD 
dialog appears. 

3. From the Action drop-down list, choose the method 
you want to use for extracting the CD audio:

• Read by track - Use this option to choose the 
tracks you want to extract from the CD.

• Read entire disc - Use this option to 
automatically extract all tracks on the disc. The 
entire CD is extracted into one new file in the 
Project Media window.

• Read by range - Use this option to extract audio 
from a specified range of time.

4. If you chose either the Read by track or Read by 
range option, specify the track(s) or range to extract:

• For Read by track, click the track(s) you want to 
extract in the Tracks to read list. Use the Ctrl or Shift keys to select more than one track. Each track is extracted 
into a separate file in the Project Media window.

• For Read by range, enter a time in the Range start field and either the Range end or Range length fields. The 
range of audio is extracted into one new file in the Project Media window.

5. From the Drive drop-down list, choose the drive containing the audio CD from which you want to extract.

6. Click the MusicID button if you want to obtain CD information using Gracenote® MusicID. 

If CD information is not available, you can click the CD Info button to display a dialog box where you can edit the CD 
information and submit it for inclusion in the Gracenote Media Database. 

7. From the Speed drop-down list, choose the speed at which you want to extract the audio. If you experience any 
problems extracting audio, you can try decreasing the selected speed, or you can click Configure to adjust the 
Audio extract optimization setting.

8. Click OK. The Save As dialog appears.

9. Select a name and location for the new WAV file.

10. Click Save to begin extracting the audio.

The track is extracted and a progress meter is displayed to indicate the percent complete. Once extraction is complete, 
the new WAV file appears in the Project Media window.

The option of automatically naming extracted tracks is provided for you. To enable this option, choose Preferences from 
the Options menu, and on the CD Settings tab, select the Autoname extracted tracks check box. For more information, 
see CD Settings tab on page 324.

Important: Vegas software is not intended for, and should not be used for, illegal or infringing purposes, such as the 
illegal copying or sharing of copyrighted materials. Using Vegas software for such purposes is, among other things, 
against United States and international copyright laws and contrary to the terms and conditions of the End User License 
Agreement. Such activity may be punishable by law and may also subject you to the breach remedies set forth in the End 
User License Agreement.

Note: If you want to extract multiple tracks to a single file, choose Read by track from the Action drop-down list to 
select your tracks, and then choose Read by range from the Action drop-down list. The appropriate time range for 
the tracks you selected will automatically be inserted and the time range will be extracted to a single file.

Note: To eject the CD at any time prior to beginning the extraction process, click the Eject button.



Adding a still-image sequence

If you’ve exported a video clip as a still-image sequence using another application (a 3D-rendering application, for 
example), the sequence can be added to the Project Media window and treated as a single media file. Each image in the 
sequence will be displayed for one frame in the event.

1. Click the Import Media button ( ) in the Project Media 
window. The Import Media dialog appears.

2. Choose the folder where the sequence you want to open 
is stored.

3. Select the first image in the sequence (or the image you 
want to start the event).

4. Select the Open still-image sequence check box.

5. In the Range field, enter the number of the last image you 
want to open. For example, if you'd selected 
AnimationOne_00001.tga in step 3, you could enter 120 in 
this box to create a new image sequence using 
AnimationOne_00001.tga to AnimationOne_00120.tga.

6. Click Open. The still-image sequence is added to the 
Project Media window.

Sorting media with bins

The detailed view of the Project Media window helps you sort your media files using their attributes, but for more control, 
you can create bins. Bins are folders within projects that you can use to organize your media files.

Media bins are virtual folders that are saved with your project. They do not affect the way media is saved on your 
computer.

Creating bins

Right-click the parent bin where you want to create a new bin and choose Create New Bin from the shortcut menu.

Adding media to a bin

1. Browse your existing bins to find the media file you want to move. The All Media Folder contains all media files in 
your project.

2. Drag a file from the right-hand pane to a bin.

Searching media bins

1. Right-click in the Project Media window and choose Search Media Bins from the shortcut menu. The Search Media 
Bins dialog is displayed.

2. Use the drop-down lists in the Search Media Bins dialog to set your search conditions and click the Search button. 
The selected bin and all sub-bins will be searched.

3. Click the Search Results icon to view the matching files.

Automatically adding recorded files to a media bin

Select a media bin if you want to automatically add your recorded audio to a media bin.

Hint: Right-click the Search Results icon and choose Save as Bin from the shortcut menu to save the results of your 
search as a new media bin.
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Deleting media from a bin

1. Select a media file.

2. Press Delete on your keyboard.

3. If the All Media Folder is selected, the file will be removed from your project.

4. If a media bin is selected, the file is removed from the bin, but remains part of your project. The file is still available in 
the All Media Folder.

Configuring 24p pulldown removal

Right-click a DV AVI file in the Project Media window and choose File Format Properties from the shortcut menu to edit 
file settings from the file format plug-in associated with the media file type.

For 24p NTSC DV AVI files with 2-3 pulldown, you can use this dialog to configure removal of pulldown fields.

In most cases, you will not need to edit pulldown removal settings. However, if the settings were not properly set in the 
DV header when your video was captured, you can fine-tune pulldown removal without recapturing your video.

1. Right-click an AVI file in the Project Media window and choose File Format Properties from the shortcut menu. The 
AVI/DV Media Properties dialog is displayed.

This command is not available for non-24p NTSC video or for 24p NTSC video using 2-3-3-2 pulldown.

2. Select the Enable 2-3 pulldown removal check box.

3. Choose a setting from the Starting frame timecode offset drop-down list to indicate what timecode numbers 
represent which frame in the video sequence. 

For example, if you have an NTSC DV file with 2-3 pulldown created on a Sony JH3 HDCAM deck, the default settings 
for timecode offset use 0 for the Starting frame timecode offset. 

If you have changed the timecode offsets on the deck (or if you have material with pulldown from another source) 
you will have to experiment with the settings to determine the correct offset. 

4. Check for interlacing:

a. In the Project Properties dialog, choose a NTSC DV 24p template from the Template drop-down list.

b. Choose the Best (Full) setting in the Video Preview window to show full frames.

c. Step though the clip and look for interlace lines in moving objects or backgrounds.

d. If you see interlace lines, repeat from step 3 and choose a different offset value.

e. When no interlace lines appear, the offset is set correctly.

Note: You can clear this check box if you want to override pulldown removal for individual files when the Enable 
pulldown removal when opening 24p DV check box is selected on the General tab of the Preferences dialog.



Importing media

Importing media allows you to add media to the Project Media list for use in your project without adding it to the 
timeline. Vegas supports the importing of a wide variety of file formats, including AAF and broadcast wave, which are 
discussed separately below.

1. From the File menu, choose Import, and then choose Media from the submenu.

The Import dialog displays.

2. Navigate to and select a media file to add to the Project Media list. You can use Ctrl or Shift to select multiple files.

3. Click Open. The media file is added to the Project Media list.

Importing and exporting AAF files 

You can use AAF (Advanced Authoring Format) files to exchange projects between applications. For example, if your 
postproduction facility uses a tool other than Vegas software, you could provide your project as an AAF file.

Creating an AAF file

If you intend to export your project as an AAF file, please note the following usage guidelines and plan your project 
accordingly: 

• Audio and video cuts are preserved.
• Track-based audio gain and panning are preserved when saving or importing AAF files.

Select the AAF Export - Use clip-based audio envelope check box on the General tab of the Preferences dialog if you 
want to combine track and event gain envelopes and save them as clip-based gain envelopes in the AAF file. When the 
check box is cleared, track envelopes are saved as track envelopes, and event envelopes are saved as clip envelopes.

When exchanging AAF with another application, refer to its documentation to determine whether audio gain and 
panning changes are supported.

• Audio and video effects are ignored.
• All video transitions are exported as AAF Video Dissolve transitions.
• All audio crossfades are exported as AAF Mono Audio Dissolve transitions.
• Time-stretched video is exported using the AAF “Video Speed Control” effect.
• Time-stretched audio is not supported: audio events that are time stretched will play at their original speed, and time is 

added to the track to represent the stretched duration; audio events that are time compressed will play at the original 
speed, but the event is trimmed to match the compressed event length.

• Any track that has mono and stereo audio will be ignored; the AAF format does not allow mono and stereo audio on a 
single track.

• Still images will be exported as 1,080,000 frames (the AAF specification does not allow media with a length and frame 
rate of 0).

• Track order in your exported AAF will not match your Vegas project: in the Vegas track model, the first track represents 
the foreground; in the AAF specification, the first track represents the background.

• Audio is exported using frame units when the AAF Export - Use frame unit for audio check box is selected on the 
General tab of the Preferences dialog. Clear the check box if you want to use sample units for exported audio (use this 
setting only if your project contains audio only or if you know the application that will import your AAF supports frame 
units for video and sample units for audio).

Tip: You can also click the Import Media button ( ) in the Project Media window.

Tips: 

To limit the files displayed in the dialog, choose a file type from the Files of Type drop-down list or enter *. and an 
extension in the File name box. For example, enter *.wav to display all wave files in the current folder, or enter 
*guitar*.wav to display all wave files that have the word guitar in the file name.

If you select an image from a still-image sequence, you can select the Open still-image sequence check box to import all 
images in the sequence as a single entry in the Project Media window. In the Range box, enter the number of the last 
image you want to open. For example, if you'd selected AnimationOne_00001.tga in step 2, you could enter 120 in this box 
to create a new Project Media entry using AnimationOne_00001.tga to AnimationOne_00120.tga.
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1. From the File menu, choose Save As. The Save As dialog is displayed.

2. Select the drive and folder where you want to store the project.

3. Type a name in the File Name box.

4. From the Save as type drop-down list, choose Edit Protocol Compliant AAF File (*.aaf) or Avid Legacy AAF File 
(*.aaf).

5. Select the Embed WAVE/AIFC Media check box if you want to embed audio that uses the wave or AIFC codec with 
your AAF file. 

This check box is available only if Edit Protocol Compliant AAF File is selected from the Save as Type drop-down list.

6. Type a name for the file and browse for a destination.

7. Click Save.

Importing an AAF file into the current project

If you intend to import an AAF file into your current Vegas project, please note the following usage guidelines and plan 
your project accordingly: 

• Audio and video cuts are preserved.
• Track-based audio gain and panning are preserved when saving or importing AAF files.

When you import an AAF file, the track- and clip-based gain envelopes are combined and imported as track envelopes.

When exchanging AAF with another application, refer to its documentation to determine whether audio gain and 
panning changes are supported.

• All video transitions are imported as crossfades.
• Audio and video effects are ignored.

• The AAF Video Speed Control effect is preserved and mapped to the Playback rate setting in the imported event’s 
properties. For more information, see Editing in the Event Properties dialog on page 116.

• If you import an AAF file that has embedded wave or AIFC audio, the files will be extracted to the same folder as the 
AAF file when you import the project.

1. From the File menu, choose Import, and then choose AAF from the submenu. The Import dialog is displayed.

2. Choose the folder where the project you want to open is stored:

Choose a drive and folder from the Look in drop-down list.

—or—

Choose a folder from the Recent drop-down list to quickly select a folder from which you have previously opened 
files.

3. Select a file in the browse window or type a name in the File name box.

4. Click Open. The AAF file is imported into the current project.

Importing an AAF file into a new Vegas project

If you intend to import an AAF file into a Vegas project, please note the following usage guidelines and plan your project 
accordingly: 

• Audio and video cuts are preserved.
• Track-based audio gain and panning are preserved when saving or importing AAF files. 

When you import an AAF file, the track- and clip-based gain envelopes are combined and imported as track envelopes.

When exchanging AAF with another application, refer to its documentation to determine whether audio gain and 
panning changes are supported.

• All video transitions are imported as crossfades.
• Audio and video effects are ignored. 
• The AAF Video Speed Control effect is preserved and mapped to the Playback rate setting in the imported event's 

properties.
• If you import an AAF file that has embedded wave or AIFC audio, the files will be extracted to the same folder as the 

AAF file when you import the project.

Note: Only individual audio files that use the wave or AIFC codec will be embedded. Audio streams from video files of 
audio that does not use the wave or AIFC codec will not be embedded.



1. From the File menu, choose Open. The Open dialog is displayed.

2. Choose the folder where the project you want to open is stored:

• Choose a drive and folder from the Look in drop-down list.
—or—

• Choose a folder from the Recent drop-down list to quickly select a folder from which you have previously 
opened files.

3. Select a file in the browse window or type a name in the File name box.

4. Click Open. If you have not saved the current project, you will be prompted to save your changes.

Importing broadcast wave files

You can use Broadcast Wave Format (BWF) files to exchange audio between audio editors or broadcasting platforms.

Broadcast Wave Format files are similar to standard .wav files, but they contain additional metadata including 
timestamps that tell the software where to add audio on the Vegas timeline.

1. From the File menu, choose Import, and then choose Broadcast Wave from the submenu. The Import Broadcast 
Wave dialog is displayed.

2. Choose the folder where the project you want to open is stored:

• Choose a drive and folder from the Look in drop-down list.
—or—

• Choose a folder from the Recent drop-down list to quickly select a folder from which you have previously 
opened files.

3. Select the files you want to open in the browse window.

Information about the selected files is displayed at the bottom of the Import Broadcast Wave dialog.

4. From the Arrange drop-down list, choose a setting to indicate how you want to arrange audio events on the 
timeline:

5. If you chose Add across tracks in step 4, choose a setting from the Order tracks drop-down list to indicate how you 
want to arrange the tracks in the track list:

Tip: You can also add Broadcast Wave Format files to your project by dragging them from the Explorer window to the 
timeline. However, if you drag a BWF file to the timeline, events are created where you drop the file. Using the Import 
Broadcast Wave dialog ensures that events are arranged according to the timestamps in the file.

Setting Description
Add across tracks A separate track is created for each BWF file you import.
Add across time All selected BWF files are added to a single track.

Note: Audio from multichannel BWF files is always added across tracks, regardless of the Arrange setting. For 
example, if you import a four-channel BWF file, the audio will be added to four adjacent tracks. For control over which 
channels are used by each event, right-click a multichannel audio event, choose Channels from the shortcut menu, 
and choose a command from the submenu. For more information, see Adjusting audio channels on page 160.

Setting Description
By timestamp Sorts tracks chronologically using the timestamp in each file. 

You can display a file’s timestamp at the bottom of the Import Broadcast Wave 
dialog by selecting a file.

Alphabetically by 
filename

Sorts tracks alphabetically using the names of the files you import.
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6. Choose a setting from the Positioning drop-down list to indicate where imported audio will be added to the 
timeline.

7. Click Open. The selected files are imported and added to the timeline of the current project.

Importing video from a DVD camcorder

You can use Vegas software to import video from a finalized Sony® DVD Handycam® camcorder disc.

1. Place the DVD you want to import in your computer’s DVD drive or connect your camcorder to your computer via 
USB.

2. From the File menu, choose Import, and then choose DVD Camcorder Disc from the submenu. The Import DVD 
Camcorder Disc dialog is displayed.

3. From the Source drop-down list, choose the disc that contains the video you want to import.

4. The Destination box displays the folder where the video will be imported. Click the Browse button if you want to 
choose a different folder.

5. Click the OK button to start importing video.

After importing is complete, the video from the disc is added to the Project Media window. Each chapter is imported as a 
separate file. You can then add the imported video to your project just like any other media file.

Importing video from a Hard Disk Recording Unit

From the File menu, choose Import, and then choose Hard Disk Recording Unit from the submenu to import video from 
a hard disk based recording unit such as the HVR-DR60.

1. Connect your hard disk recording unit to your computer via iLINK®.

2. From the File menu, choose Import, and then choose Hard Disk Recording Unit from the submenu. The Import 
from Hard Disk Recording Unit dialog is displayed.

3. From the Source drop-down list, choose the hard disk unit that contains the video you want to import.

4. The Destination box displays the folder where the video will be imported. Click the Browse button if you want to 
choose a different folder.

Setting Description
Use ruler time Adds each imported file to the Vegas timeline at the exact position indicated by its 

timestamp. For example, if you import a BWF file with a timestamp of 00:00:30;00, 
the media would be added to the timeline at the thirty-second mark on the ruler.

Relative to cursor Adds each imported file to the Vegas timeline and offsets the timestamp value by 
the cursor position. For example, if you position the cursor at 00:00:10;00 before 
importing a BWF file with a timestamp of 00:00:30;00, the media would be added to 
the timeline at the forty-second mark on the ruler.

Important:

Before importing video, you’ll need to finalize the disc. For information about finalizing a disc, please refer to your 
camcorder’s documentation.

5.1-channel audio will be downmixed to stereo when importing into a stereo project. When importing into a 5.1 surround 
project, audio will be added to separate tracks for the center, front, rear, and LFE channels.

Important: The Sony Handycam USB driver that is included with DVD-based camcorders can prevent Vegas from 
recognizing a USB-connected camera. If you use the Add/Remove Programs Control Panel to uninstall the “Sony DVD 
Handycam USB driver” component, Vegas will be able to connect to the camera and import video.



5. Click the OK button to start importing video.

If you’re importing to a FAT32 drive, files from the hard disk unit are copied directly to the destination folder.

If you’re importing to an NTFS drive, files from the hard disk unit are copied as follows:

• If your hard disk unit is configured to record .dv (raw DV) files, the files are copied to the destination folder.
• If your hard disk unit is configured to record .avi files, the files from each folder will be assembled into a single 

type-2 AVI file. The new file is named to match the source folder on the hard disk unit. For example, video from 
the 101DVF folder would be imported as DVS101.avi.

• If you’re importing HDV clips, the files from each folder will be assembled into a single HDV file. The new file is 
named to match the source folder on the hard disk unit. For example, video from the 101HDVF folder would be 
imported as HDV101.m2t.

After importing is complete, the video is added to the Project Media window.

You can then add the imported video to your project just like any other media file.

Generating music with Cinescore

If you purchased the Sony Cinescore™ plug-in from Sony Media Software, you can automatically generate a soundtrack 
for use in your project.

When you generate music, the Cinescore plug-in will use the sample rate and bit depth from the Audio tab in the Project 
Properties window.

Adding generated music to your project

1. Select the audio track where you want to add a generated-music event.

2. Position the cursor or create a time selection to indicate where you want to add your composition.

• To create a composition that fills a portion of your project, click and drag in a blank area of the timeline to create 
a time selection.

• To create a composition that matches the length of a video event on the timeline, double-click the video event 
to select it.

• To create a composition of a specific length, click to position the cursor where you want the music to begin. By 
default, the composition will fill the space from the cursor to the end of the project, but you can choose the 
length of the composition in step 4.

3. From the Insert menu, choose Generated Music. 

4. Use the controls in the Cinescore plug-in to choose the settings for your generated music. For detailed information 
about using the Cinescore plug-in, please see the Cinescore online help (to access online help installed with 
Cinescore, click the  button in the upper-right corner of the Cinescore window).

5. Click OK to close the Cinescore plug-in and add the generated music to the selected track in your Vegas project.

Note: Vegas uses the index (.idx) file on your hard disk recorder to ensure that files that have already been imported 
aren’t unnecessarily reimported.

Note: For more information on purchasing Cinescore, please see the Cinescore page on our Web site at  
http://www.sony.com/cinescore. For detailed information about using the Cinescore plug-in, please see the Cinescore 
online help (which is installed only with the Cinescore plug-in).
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Editing generated music

1. Select a generated-music event on the timeline.

2. From the Edit menu, choose Generated Music, and then choose a command from the submenu to recreate or edit a 
composition: 

• If you want to recreate an existing composition, choose Recreate from the submenu (or click the Recreate 
Generated Music button  on an event). The music is regenerated, and the event in the timeline is updated to 
match the new composition length.

• If you want to edit an existing composition, choose Edit from the submenu. The music is regenerated, but the 
events that refer to the composition are unaffected. Editing a composition is useful if you’ve split or trimmed 
generated music events on the timeline and want to modify the underlying composition without losing your 
timeline edits.

3. Use the controls in the Cinescore plug-in to edit the settings for your generated music. For detailed information 
about using the Cinescore plug-in, please see the Cinescore online help (to access online help installed with 
Cinescore, click the  button in the upper-right corner of the Cinescore window).

4. Click OK to close the Cinescore plug-in and update the generated music in your Vegas project. The new composition 
is added as a take in the event and set as the active take.

Adding media to the timeline

Media files may be added to your project from the Explorer or Project Media windows by double-clicking them or by 
dragging them. Either method places the media file in an event in its entirety in the timeline. 

Dragging a media file to the timeline

You can create a new track by dragging a media file to a blank area on the timeline and dropping it in place. Tracks can 
contain multiple events, so you can place different events next to each other on a track.

1. Locate a media file in the Explorer or Project Media window.

2. Drag the media file to the timeline. 

An event for the media file appears where you released the mouse.

Note: Video and audio events cannot be placed on the same track.



Dragging multiple media files to the timeline

1. Select multiple media files in the Explorer or Project Media window. Select a range of adjacent media files by 
pressing Shift and clicking the first and last files in the range or select files that are not adjacent by pressing Ctrl and 
clicking individual files.

2. Right-click and drag the files to the track view (timeline).

3. When you release the mouse, a shortcut menu appears. Select a placement option from the menu.

• Add Across Time

• Add Across Tracks

• Add As Takes

For more information, see Working with takes on page 117.

• Video Only and Audio Only allow you to isolate either the video or audio, and add that stream from a 
multimedia file either across tracks, across time, or as takes.

Double-clicking a media file

This method places the event at the cursor’s position in the selected track. If the selected track is a video track, and you 
double-click an audio event (or vice versa), a new track is created for the event. Once an event is placed, you can move it 
from one track to another or change its position on the timeline.

Inserting a video file with associated audio

Media files with video frequently include associated audio. When you insert a media file into the timeline, the associated 
audio is automatically inserted into a separate audio track below the video track. The two associated events are grouped 
together and behave as a single unit when moved or otherwise edited. You can ungroup the events to move them 
independently. For more information, see Clearing a group on page 165.

Tip: A left-click drag-and-drop automatically inserts files across time. However, you can cycle through placement modes 
by right-clicking (without releasing the left mouse button) while performing the drag-and-drop operation.

You will see one event on the track.
The other events are listed at takes “beneath” the 
the topmost event.

Two events that contain the video (top)
and audio (bottom) streams from a single 
multimedia video file; each event is 
inserted on a separate track.
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Automatically crossfading inserted events

When inserting multiple events across time, the events (both video and audio) may be set to automatically crossfade. 
Two options must be enabled in order to create crossfades automatically when adding multiple events. First, verify that a 
check mark appears next to Automatic Crossfades in the Options menu. Second, from the Options menu, choose 
Preferences, and on the Editing tab, select Automatically overlap multiple selected media when added. For more 
information, see Using automatic crossfades on page 101.

Project references in rendered media files

When your project uses media that was rendered with an embedded project path reference, you can easily open the 
source project in the associated application if you need to edit the media later. Recent versions of ACID, Sound Forge, and 
Vegas software allow you to save the project path reference when you render files.

For example, imagine that you have an audio file on the Vegas timeline that was rendered from an ACID project. In 
previewing your Vegas project, you discover that you’d accidentally rendered your ACID project with a critical track 
muted. You could simply right-click the event on the Vegas timeline and choose Edit Source Project from the shortcut 
menu to reopen your ACID project, unmute the track, and then rerender it.

The project information in the rendered file is a reference to a project file only. If you modify the project file after 
rendering, the project data will no longer match the rendered file. To edit a project using a path reference, the project file 
and all media must be available on your computer.

Editing a referenced project

1. Perform one of the following actions:

• Right-click a media file in the Explorer window.
—or—

• Right-click a media file in the Project Media window.
—or—

• Right-click an event on the timeline.

2. From the shortcut menu, choose Edit Source Project. An ACID, Vegas, or Sound Forge window will open with the 
source project.

To edit a source project using a computer other than the computer where the project was created, the editing 
computer must meet the following requirements:

• The software that was used to create the project must be installed and the project file extension (.acd, .acd-zip, 
.veg, or .frg) must be registered on the editing computer. 

• The editing computer must have the same version (or later) of the software that was used to create the project.
• The project file must exist on the editing computer using the same file path as on the computer where the 

project was created.
• The project’s source media must exist on the editing computer. If the media files do not use the same file path as 

on the computer where the project was created, you will be prompted to choose a new folder or replacement 
files.

3. Edit the project as necessary.

4. Render the edited project using the same name as the original media file and close the editing application. 

If you’re editing an existing track, your project will automatically be updated to use the latest rendered media file.

Tip: For more information on saving project path references in rendered files, see Rendering a project on page 282.



Working with events

Events are the most basic objects in a project. An event is something that happens in time, has a specific duration, and 
can be video or audio. 

Understanding files and events

The objects you work with are referred to as media files and events. 

• Files are objects that are stored on your hard disk. In Vegas software, you will work with media files, such as music and 
video files. These files are neither operated on nor changed. You can access files from the Vegas Explorer window.

• Events are periods of time on the timeline that act as windows into media files, either whole or in part. When you drag 
a media file onto the timeline, you automatically create an event that contains that file’s contents. An event can 
contain video, audio, still images, or generated media. The event window may contain only a small portion of a much 
larger media file. A single media file can be used repeatedly to create any number of different events, since each event 
can be trimmed independently.

Audio events are created from audio files on your computer (e.g., WAV, MP3) or can be a part of a video file (e.g., 
AVI). You can change many characteristics of an audio event, such as speed, volume, and equalization. Audio events 
can be mixed with other audio events.

Video events are created from video files captured to your computer (typically AVI, MOV, QT) or images (BMP, JPEG, 
PNG, or TGA). You can change many characteristics of a video event, such as speed, color, and size. Video events can 
overlay other video events and are visual elements that appear on top of a background video, image, or color. 

The original media file.

An event trimmed from the original media file.

The event as it appears in the Vegas timeline.
GETTING STARTED | 57



58 | CHAPTER 2
Moving events along the timeline

You can move events along the timeline individually or as a group. Events may overlap each other or be placed on top of 
each other. You can crossfade overlapping events automatically or with envelopes.

Moving an event

You can move an event along the timeline within a track or move it to a different track.

1. Drag the event along the timeline. 

If you move the event along the original track’s timeline, the event’s appearance (color) remains the same.

However, you may move the event to a different track. When you do, the event appears as a simple outline and you 
will see its original track and position on the timeline. Once you release the mouse, the event assumes the new 
timeline position and track color.

2. Release the mouse to place the event.

Moving multiple events

You can move multiple events along the timeline within a track or move them to a different track. Selected events do not 

need to be within the same track. Use the Ctrl key, the Shift key, or the Selection Edit Tool ( ) to select multiple events 
and drag them. To select all events on the track after a given event, right-click the event and choose Select Events to End. 
For more information, see Selecting multiple events on page 86.

Moving events by small increments

To move an event more precisely, click the event and press 4 or 6 on the numeric keypad to nudge it by small increments. 
The amount of movement caused by each nudge is determined by how far the timeline is zoomed in or out. You can also 
click the event and press 1 or 3 on the numeric keypad to nudge the event by frames.

Moving grouped events

Groups allow you to move multiple events within their tracks as a single unit. While you can create your own groups as 
needed, groups are automatically created for you when video files with associated audio (e.g., AVI) are added to a project. 
When you add these video files, the audio portion of the video file is inserted into the timeline as a separate audio event. 
The video and audio events are grouped and can be moved as a single unit within their respective tracks. 

To move grouped events, drag any event in the group to a new position. For more information, see Grouping events on 
page 164. 

Working with tracks

A project consists of multiple audio and video tracks. The track view is the timeline in which all events appear. The track 
list provides information about the track and contains controls that affect all events in the track.

Using the track view

Numerous options are provided for viewing and navigating in track view.

Original track position

New track and position



Scrolling and zooming

There are several ways to scroll and zoom in the track view. 

• Click the scroll bar arrows or drag the scroll bars to move up and down the tracks or to move forward and back along 
the timeline. 

• Click the Zoom buttons ( ) to reveal more or less of the timeline.
• Drag the edge of the scroll box, found on the scroll bar, to zoom.
• Press the up arrow  and down arrow  keys to zoom in and out along 

the timeline.
• Click the Zoom Edit Tool ( ) button or, from the Edit menu, choose 

Editing Tool and then choose Zoom. In this mode, drag on the timeline to 
draw a rectangle that defines the zoom region.

Mouse wheel control is also supported. The default behavior of the wheel is to zoom horizontally.

• Shift+wheel scrolls horizontally (through time).
• Ctrl+wheel scrolls vertically.
• Ctrl+Shift+wheel moves the cursor in small increments.
• Ctrl+Shift+Alt+wheel moves the cursor in one-frame increments.
• Clicking the mouse wheel turns auto-panning on and off.

Zooming directly controls the accuracy of your editing. Each video event has thumbnail representations of the frames 
within the event. Depending on how far you have zoomed in on a video event, a thumbnail can represent the entire 
event or a single frame in the event.

Changing track height

You can change the height of individual tracks by dragging their borders in the track list. In the example below, the main 
video track is fairly large to show the details of the scene while the two tracks above it, which are overlays, have been 
resized to a shorter height. For more information, see Changing track height on page 134.

Using the track list

This section describes the different controls in the track header of each track. Some controls are specific to either video or 
audio tracks.

Tip: You can also access the Zoom Edit Tool from the lower-right corner of the track view ( ).

Tip: You can choose to display frame numbers, time, or timecode on video event thumbnails. For more information, see 
Displaying frame numbers on page 303.

Scroll box
Zoom
tools
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Video track header

Audio track header

Button or 
Control

Name Description

Make 
compositing 
child

Creates a parent/child compositing relationship with the track above. Used when 
creating masks. For more information, see Understanding the parent/child track 
relationship on page 229.

Track number 
and color

Track numbers and colors help organize a multitrack project. For more information, 
see Managing tracks on page 133.

Minimize track 
height 

Minimizes track height. For more information, see Changing track height on page 134.

Maximize 
track height

Maximizes track height. For more information, see Changing track height on page 134.

Expand track 
keyframes

Displays track keyframes on the timeline. For more information, see Working with 
keyframes in track view on page 253.

Bypass motion 
blur

Bypasses motion blur envelope for a track. For more information, see Using video bus 
tracks on page 141.

Track motion Track motion is used to move a video track across a background. Picture-in-picture 
effects and scrolling title sequences are two simple cases where this tool is important. 
For more information, see Adding track motion on page 258.

Track FX Adds track effects plug-ins. For more information, see Using video effects on page 223.

Mute Temporarily suspends playback of the track so that you can focus on other tracks. For 
more information, see Muting a track on page 139.

Solo Isolates a track for playback by muting the other tracks. For more information, see 
Soloing a track on page 140.

Track name 
(scribble strip)

Allows you name a track. To name a track, double-click the scribble strip and type the 
track’s name. For more information, see Naming or renaming a track on page 133.

Composite 
level slider

Determines the opacity/transparency of the video track. Drag the slider to control the 
transparency or blending of the track. Left is 100% transparent and right is 100% 
opaque. You can also double-click the label to enter a specific numeric percentage.

Compositing 
mode

Determines how the transparency in a video track is generated. For more information, 
see Selecting compositing modes on page 230.

Button or Control Name Description
Track number 
and color

Track numbers and colors help organize a multitrack project. For more information, 
see Managing tracks on page 133.

Minimize track 
height

Minimizes track height. For more information, see Changing track height on page 
134.

Maximize track 
height 

Maximizes track height. For more information, see Changing track height on page 
134.

Track name 
(scribble strip)

Allows you name a track. To name a track, double-click the scribble strip and type 
the track’s name. For more information, see Naming or renaming a track on page 
133.



Nesting projects

With Vegas software, you can simplify and organize complex projects by adding multiple projects to the timeline of a 
single Vegas project. Using project nesting, you can:

• Create a single element that can be used in multiple locations or projects. If you update the project, it is updated 
everywhere.

• Create a complex composited element that can be used as a single media event in multiple locations or projects.
• Create a transition across multiple events by placing the events in a nested project and applying the transition to the 

nested events project.
• Create a musical composition with its own tempo and bus structure that can be used in another project.
• Create an individual project for each scene in a video and place those projects in a master project. You can apply color 

correction to each project individually, and then apply color correction to the master project as well.
• Use master projects to deliver a single project in multiple formats without time- and disk-consuming intermediate 

renders: for example, you could add your 24p, 16:9 HD (high-definition) project to a master project to reformat the 
project as widescreen SD (standard definition) for DVD, letterboxed SD for VHS, 4:3 pan-and-scan SD, or 25p.

Adding a project to the Vegas timeline

Use one of the following methods to nest an existing project in your current timeline:

• From the Explorer window, drag a Vegas project file (.veg) to the timeline. The project is added to the timeline where 
you drop it.

• From the File menu, choose Import and then choose Media to browse to the .veg file you want to nest.

Arm for record Prepares a track for recording. You may record directly into audio tracks. A track is 
ready when you see the recording meter appear on it. For more information, see 
Arming the track for recording on page 185.

Bus assignment Assigns an audio track to a specific output bus. This option is available for projects 
being mixed for multiple stereo busses. For more information, see Assigning audio 
tracks to busses on page 172.

Invert Track 
Phase

Inverts the audio track at its baseline, in effect reversing its polarity. For more 
information, see Phase inverting a track (audio only) on page 139.

Track FX Adds track effects plug-ins. For more information, see Using audio effects on page 
175.

Mute Temporarily mutes playback of the track so that you can focus on other tracks. For 
more information, see Muting a track on page 139.

Solo Isolates a track for playback by muting the other tracks. For more information, see 
Soloing a track on page 140.

Volume fader Controls the audio track volume relative to the other tracks. Drag the fader left or 
right to adjust the volume. For more information, see Using the volume fader (audio 
only) on page 135.

Multipurpose 
slider

Controls several features, including track panning, bus send levels, and assignable 
effects send levels. Select what the slider controls by clicking the label. Each item’s 
slider position is independent from the others. For more information, see Using the 
multipurpose slider (audio only) on page 136.

Note: In order to use network rendering with nested projects, the nested project must contain only media from folders 
that do not require remapping. Before nesting your Vegas project, update the project so that all media in the project is 
added from a network folder or a local, shared folder that is mapped to the same drive letter on all renderers and the 
render host.

Tip: You can also drag files from the Windows® Explorer and drop them on the Vegas timeline.

Button or Control Name Description
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Using any of the methods above, the Vegas project file is also added to the Project Media window. Once a nested project 
is in the timeline, you can then edit the its events just as you would any other event in your project.

Playing back and previewing

You can play back your project in two ways: directly from the timeline from within the software or by mixing the entire 
project to a preview file.

Playing your project

The transport bar allows you to play back your entire project or portions of your project based on a time selection or the 
current cursor position.

If your project includes video, make sure the Video Preview window is displayed for playback: from the View menu, 
choose Video Preview or press Alt+6.

Playing an entire project

1. Click the Play From Start button ( ) to begin playback at the beginning of the project.

2. Click the Stop button ( ) to stop playback.

Most of the time, you will only want to preview a small portion of the project to perfect a section. You can do this by 
creating a time selection.

Playing a time selection

1. Place the mouse pointer above the ruler on the marker bar. The mouse pointer 
changes to include a left/right arrow cursor ( ).

2. Drag to select the time region. To increase or decrease the time selection, drag its 
start and end points. The time selection is highlighted and the loop bar appears 
above the ruler on the timeline.

3. Click the Play button ( ) to begin playback. Only the non-muted tracks and events 
within the time selection play back.

4. Click the Loop Playback button ( ) to continually play back the events within the 
time selection. Click the button again to toggle this feature off.

5. Click the Stop button ( ) to stop playback.

By looping the playback, you can repeatedly watch the same section of the project over and over as you make changes to 
filters and effects in real time. You can define selection areas automatically, depending on what you would like to 
preview. For more information, see Selecting a time range on page 87 and Time selection commands on page 31.

Notes:

• The output from the nested project’s master bus is used to create the audio event. If you nest a 5.1 surround project, the 
audio event will be a stereo downmix of the surround master bus.

• Audio events from nested projects cannot be edited in a sound editor.
• The audio from a nested project will require that a proxy file be built. To avoid building proxy files, delete audio from nested 

projects and use the master project to create your audio.
• Markers and regions in the nested project are displayed in the timeline as media markers in the event.
• Prerendered video from a project will be used when that project is nested in another project’s timeline.
• You can edit a nested project by right-clicking the event in the timeline and choosing Edit Source Project from the 

shortcut menu. A new Vegas window will open to allow you to edit the project.

Loop bar



Playback reference

The following table describes all the transport bar buttons and their keyboard equivalents. You may use these playback 
functions at any time while working in your project.

Scrubbing

Scrubbing is a type of timeline playback that gives you precise control over the speed and direction of playback. Both 
linear and logarithmic scale scrubbing are allowed. For more information, see General tab on page 312. 

The use of multimedia controllers is supported for scrubbing. For more information on using the software with 
multimedia controllers, please see the online help. To access help, choose Contents and Index from the Help menu.

Four methods of scrubbing are provided.

Scrubbing with the playhead

The playhead ( ) above the timeline can be dragged back and forth to shuttle 
forward or backward from the cursor position to locate an edit point.

Note: The use of many multimedia keyboards is also supported for controlling playback.

Button Keyboard Function
Ctrl+R Begin recording into record-enabled tracks

Q Turn on/off loop playback during time selection playback

Shift+Space Begin playback from the start of the project

Space Begin playback from cursor position

Enter Pause playback, cursor stops and holds at pause position

Space or Esc Stop playback, cursor stops and returns to prior cursor position

Ctrl+Home Place cursor at the beginning of project

Ctrl+End Place cursor at the end of the project

Tip: You can use the spacebar to stop or pause playback, depending on your preference. From the Options menu, choose 
Preferences, and on the General tab, select Make spacebar and F12 Play/Pause instead of Play/Stop to change the 
setting.

Tip: Choose a setting from the JKL / shuttle speed drop-down list on the Editing tab of the Preferences dialog to control 
the scrub speed and range when using the keyboard or multimedia controllers.

Tip: Set in and out points while dragging the playhead by pressing the I and O 
keys.

The playhead is also available in the Trimmer window.

Drag playhead to scrub
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Scrubbing with the scrub control slider

The scrub control slider can be dragged back and forth. The farther from the 
center that the slider is dragged, the faster the playback, both forward and in 
reverse. Below the slider is a small yellow marker that can be used to set the 
normal rate playback speed. This is the speed at which the project plays when 
you click the Play button on the transport bar.

Scrubbing on the timeline

The second way that a project can be scrubbed is by positioning the mouse pointer 
over the timeline cursor at a location that is not over any events and pressing Ctrl. 
The cursor changes to a speaker icon. Now, when you left-click, the cursor icon 
changes again to a pan/scrub icon. Drag the mouse left or right to scrub the 
timeline.

Scrubbing with the keyboard

Three letters (JKL) are used as a keyboard scrub control.

Press J for reverse and L for forward playback. Press K to pause playback. 

There are several ways to adjust playback speed:

• Adjust the JKL / shuttle speed selection on the Editing tab of the Preferences 
dialog.

• Hold K while pressing J or L to emulate a shuttle knob mode. Press K+J to turn the knob to the left or K+L to turn the 
knob to the right. Press K again or Space to return to normal mode.

Previewing to media player

A project can be previewed in a media player by mixing and rendering the project according to the project’s properties 
and playing back using the media player associated with the file type you select.

1. From the Tools menu, choose Preview in Player. The Preview dialog appears.

2. Select the file type from the drop-down list.

3. Click OK to begin the mixing and rendering process. A progress dialog appears indicating the percent complete of 
the new file.

When mixing is completed, the associated media player opens and begins playback.

Tip: You can also choose to enable timeline scrubbing when the mouse is positioned over events. From the Options 
menu, choose Preferences, and select Allow Ctrl+drag cursor style scrub over events on the General tab.

Note: Choose a setting from the JKL / shuttle speed drop-down list on the 
Editing tab of the Preferences dialog to control the scrub speed and range.

Note: You may cancel the preview by clicking the Cancel button on the status bar.

Scrub control slider

Press Ctrl over
timeline cursor

Left-click and 
drag to scrub

J K L
Reverse Pause Forward

Keyboard scrub letters



Prerendering video previews

Playing a project using the transport controls can instantly show how a project is progressing, but it does not actually 
render your project in its final form. The preview you see in the Video Preview window may be different from your final 
project in a number of ways: frame size, frame rate, and quality. In most cases, the Video Preview is all you need for 
checking the timing of events in your project. Eventually, however, you may need to output a full-quality preview of a 
section of your project. To do this, from the Tools menu, choose Selectively Prerender Video. For more information, see 
Prerendering video on page 267.

Rendering a project 

Rendering refers to the process of creating a new media file from a Vegas project. The project file is not affected 
(overwritten, deleted, or altered) during the rendering process. You may return to the original project to make edits or 
adjustments and render it again. 

More detailed instructions for rendering to a specific format appear later in this manual. For more information, see Saving, 
Rendering, and Printing Projects on page 281.

Creating a movie

To create a movie, you render the project into an appropriate media file output. The final output format depends on the 
destination of the new media file. Some examples are AVI, MOV, and WMV.

1. From the File menu, choose Render As.

2. In the Render As dialog box, choose the appropriate option from the Save as type drop-down list.

3. Click Custom to select custom compression settings. The default compression options are set automatically 
according to your project’s properties. For more information, see Customizing the rendering process on page 288.

4. Enter a name and browse for a destination for your file.

5. Click OK.

Publishing a project

From the File menu, choose Publish and then follow the on-screen instructions to choose a publishing provider and save 
your the current project to the Web so you can share it with others.
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Chapter 3
 Using the Media Manager

This chapter covers the management and tagging of your media files in Vegas software using the Media Manager™ 
feature.

Creating a new media library

You can create multiple media libraries as necessary to organize your media. Each media library is maintained by the 
Media Manager software as a separate database that stores information about the media contained within it. You might 
want to use separate libraries, for example, to distinguish media from different computers or to create separate libraries 
for multiple users of a single computer.

1. If the Media Manager window isn’t already visible, choose Media Manager from the View menu.

2. In the Media Manager window, click the Media Library Actions button ( ) and choose New Media Library from 
the menu. The New Media Library dialog is displayed.

3. In the Name box, type the name you want to use to identify the library.

4. The Folder box displays the path to the folder where the library will be created. Click Browse to choose a different 
location.

5. Click the Create button to create the new library.

Opening a media library

The Media Manager window displays the contents of the current media library. You can open a different library at any 
time.

1. In the Media Manager window, click the Media Library Actions button ( ) and choose Open Media Library from 
the menu. The Open Media Library dialog is displayed.

2. Choose the folder where the library you want to open is stored:

• Choose a drive and folder from the Look in drop-down list.
—or—

• Use the bar on the left side of the window to browse to a folder.

3. Select a library from the list.

4. Click the Open button to open the selected library. The name of the current library is displayed in the upper-right 
corner of the Search Results pane:

Tip: For very large media collections, using multiple media libraries can improve performance.

Important: When you open a media library, the Media Manager tool creates a transaction log file. This file is created in 
the same folder as the .medialib file and uses the same base name as the .medialib file. For example, the transaction log 
file for default.medialib would be default_log.ldf. 
Do not delete these log files. Doing so will prevent you from opening the associated library. When the Media Manager tool 
closes, it automatically removes the log file. If the application terminates inappropriately, close all running Vegas 
windows, restart the Vegas software, and close the application to clear the log file.
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Adding media files to a library

Before you can search or organize your media files, you’ll need to add them to a media library.

If you have the Sony Sound Series Loops & Samples™ reference library loaded when you search your computer for media, 
media from existing Sony Loops and Samples or Loops for ACID™ collections will inherit tags and custom properties from 
the reference library. Use the Reference Library drop-down list in the Media Manager Options dialog to determine which 

library is opened when you click the Switch to Reference Library button ( ). For more information on Media Manager 
options, see Setting Media Manager options on page 82.

1. Click the Add Files to Media Library button ( ). The Add Files to Media Library dialog is displayed.

2. Choose the folders that will be searched for media:

a. If it isn’t displayed automatically, click the Add Folder button ( ) to display the Browse for Folder dialog.

b. Select the folder you want to search.

c. Click OK.

3. Repeat step 2 for each folder you want to search.

4. Select the Include subfolders check box if you want to search folders within the selected folders.

5. Select the Audio, Video, Images, or MIDI check boxes to indicate the types of media you want to add. Clear a check 
box to exclude that type of media file.

Files that contain audio and video streams will be added if either or both of the Audio or Video check boxes are 
selected.

6. Specify whether you want to search for new files or all files:

• Select the New files only radio button if you want to search only for new media files. Files that already exist in 
the media library will be skipped.

—or—

• Select the All files radio button if you want to search for all media files in the specified folder. New media files 
will be added, and files that already exist in the media library will be searched to determine whether their 
properties have changed.

7. Select the Add tags and custom properties from files check box if you want to add tags and custom columns saved 
in the media files to your library. For more information about tagging media, please see Tagging media files on page 69. 
For information about adding custom columns to the Search Results pane, see Adding custom columns on page 80.

8. Select the Use file and folder names to apply tags automatically check box if you want to automatically tag files 
based on the file path. 

For example, when this check box is selected, a loop saved in the d:\loops\drums\hi-hats\ folder would have the 
tags Drums and Hi-Hats applied when it is added to the library. Some synonyms (and variant spellings) will be 
resolved using a tag thesaurus. If you need to modify the thesaurus, you can edit the TagThesaurus.xml file, which is 
created in your My Documents\Sony Media Libraries folder the first time the application starts.

Notes: The Sony Sound Series Loops & Samples reference library is not installed by default, but you can install it from the 
Vegas CD or download it from the Sony Media Software Web site (http://mediasoftware.sonypictures.com/reference). 

If the Save media-usage relationships in active media library check box is selected on the General tab of the Vegas 
Preferences dialog, you can add individual files to a library by previewing the files in the Vegas Explorer window.

Tips: If you want to change an item in the folder list, select it and click the Browse button ( ) in the Folders column. 
If you want to remove a folder from the list, select it and click the Remove Folder button ( ).

Note: Changing the selection of the Add tags and custom properties from files and Use file and folder names to 
apply tags automatically check boxes also changes the settings in the Media Manager Options dialog.

http://mediasoftware.sonypictures.com/reference


9. Click the Search button to start adding files to the library.

10. Click the Close button when you’re finished.

A tag is automatically added to the Tag tree when you search. The tag name will include the date and time of the 
search, and all files that were added or updated in the library are marked with this tag. 

Removing media files from a library

You can remove a reference to a media file from a library without affecting the media file itself.

1. Select files in the Search Results pane to choose the files you want to delete:

• To select a single file, click the file.
—or—

• To select multiple consecutive files, click the first file, hold the Shift key, and then click the last item.
—or—

• To select multiple files that are not consecutive, hold the Ctrl key and click each file.

2. Right-click a selected file and choose Remove from Library from the shortcut menu (or press the Delete key on your 
keyboard). A confirmation dialog is displayed.

3. Click OK to remove the selected files from the library.

Tagging media files

Tagging helps you classify your media files. For example, if you wanted to keep track of loops played by a specific 
instrument, you could create a tag with the name of the instrument and apply it to the appropriate loops. Similarly, you 
could create tags for genres, moods, seasons, client names, locations, scenes, performer names, and so on.

When you create a new library, a default tag tree is displayed in the Tags pane. You can create your own tags to 
customize the tags for your needs. Tags are the fastest way to search a media library, and they require very little disk 
space.

Tags are saved in your media library. If a media file exists in multiple libraries, tagging the media file in one library has no 
effect on the other libraries unless you save the tags to the files and use the Add Files to Media Library dialog to update 
tags and custom properties for all files.

Creating a tag

Adding tags creates new tags in the current library only.

1. Click the New Tag button ( ) to add a new tag to the tree.

If a tag is selected, the new tag will be added below the selected tag. If no tag is selected, the new tag will be added 
to the bottom of the tag tree.

2. Type a name for the tag.

3. Press Enter.

4. If you want to change the icon used to display the tag, right-click it and choose Edit from the shortcut menu to 
display the Tag Editor dialog.

5. If you want to change the tag’s location, drag it to a new location in the tag tree.

Tip: If you want to see which tags are associated with a file as you’re adding or removing tags, drag the Tags column in 
the Search Results pane to the left so you can see the Name and Tags columns at the same time.
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Applying a tag to a media file

You tag media by dragging a tag from the tag tree to a media file in the Search Results pane (or by dragging a media file 

to a tag) when the Apply Tag Mode button ( ) is selected.

1. Select media files to tag in the Search Results pane:

• To select a single file, click the file.
—or—

• To select multiple consecutive files, click the first file, hold the Shift key, and then click the last item.
—or—

• To select multiple files that are not consecutive, hold the Ctrl key and click each file.

2. Click the Apply Tag Mode button ( ) in the Search pane.

3. Drag a tag from the tag tree to the selected file(s).

When you add a subtag to a media file, the tag’s hierarchical position in the tag tree is 
applied implicitly. 

In this example, adding the “Snare” tag to a media file would mean that a search for 
“Audio,” “Drum One-Shots,” or “Snare” would find your tagged media. If the user 
rearranged the tag tree so that the “Snare” tag did not appear below the “Audio” and 
“Drum One-Shots” tags, searching for “Audio” or “Drum One-Shots” would not find your 
tagged media.

If you add all three tags to your media file, a search for “Audio,” “Drum One-Shots,” or 
“Snare” would find your tagged media even if the tag tree had been rearranged, though 
this behavior is not always desirable.

Removing a tag from a media file

You remove tags from media by dragging a tag from the tag list to a media file in the 

Search Results pane (or by dragging a media file to a tag) when the Remove Tag Mode button ( ) is selected.

Notes: 

If you want to see which tags are associated with a file as you’re adding or removing tags, use the Properties pane in the 
Search Results pane (or drag the Tags column in the Search Results pane to the left so you can see the Name and Tags 
columns at the same time). For more information, see Using the Properties pane on page 81.

Tags are saved in your media library. If a media file exists in multiple libraries, tagging the media file in one library has no 
effect on the other libraries unless you save the tags to the files and use the Add Files to Media Library dialog to update tags 
and custom properties for all files.

Tip: You can also right-click a selection in the Search Results pane and choose Apply Tag from the shortcut menu to add 
a tag to all selected media. The Tag Chooser dialog will be displayed. Select the tag you want to add, and then click the OK 
button.

Tip: If you want to see which tags are associated with a file as you're adding or removing tags, use the Properties pane in 
the Search Results pane (or drag the Tags column in the Search Results pane to the left so you can see the Name and Tags 
columns at the same time).



1. Select media files in the Search Results pane:

• To select a single file, click the file.
—or—

• To select multiple consecutive files, click the first file, hold the Shift key, and then click the last item.
—or—

• To select multiple files that are not consecutive, hold the Ctrl key and click each file.

2. Click the Remove Tag Mode button ( ) in the Search pane.

3. Drag a tag from the tag tree to the selected file(s). The tag is removed from the file(s).

Deleting a tag from a library

Deleting the selected tag(s) affects the current library only.

1. In the Search pane, select the tag(s) to be removed:

• To select a single tag, click the tag.
—or—

• To select multiple consecutive tags, click the first tag, hold the Shift key, and then click the last tag.
—or—

• To select multiple tags that are not consecutive, hold the Ctrl key and click each tag.

2. Click the Delete Selected Tag button ( ) to delete the tag from the current library. A confirmation dialog is 
displayed.

3. Click OK to remove the selected tags from the library.

The tag is removed from the library and from all media files in the library. However, if the tag had been saved to the 
media file, it will be added to the library again the next time the file is added to the library if the Add tags and 
custom properties from files check box is selected in the Add Files to Media Library dialog.

Merging subtags

Merging tags combines a selected tag with its subtags and removes the subtags from your library permanently.

To merge a tag with its subtags, right-click the tag and choose Merge Subtags into Selected Tag from the shortcut 
menu.

All subtags are combined with the main tag, and the subtags are removed from the library. All media formerly associated 
with the subtags is associated with the main tag.

Arranging tags in the tag tree

Tags are displayed in a tree view in the Media Manager window. You can organize tags hierarchically: click the Expand 

button ( ) in the Search pane to expand a list, or click the Collapse button ( ) in the Search pane to hide an expanded 
list.

You can drag, copy, and paste tags within the list to arrange them and create parent and child tags. 

You can also display tags in a palette view by clicking the Change Tags View button ( ).

Editing tag names or images

1. Double-click a tag (or right-click a tag and choose Edit from the shortcut menu) to display the Tag Editor dialog.

2. In the Tag name box, type the name you want to display for the tag.

3. Select a thumbnail image to choose the icon that will be displayed for the tag in the Search pane and in the Search 
Results pane when the tag is added to a media file.

4. Click the OK button to apply your changes and close the Tag Editor dialog.
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Viewing or creating palettes

The palette view provides another way of working with tags that can be useful for more focused searching. You can use a 
palette to concentrate on a portion of the current tag tree.

In the palette view, tags are displayed as a grid of buttons instead of the standard hierarchical tag tree.

1. Click the Change Tags View button ( ) to toggle the display of the tag tree and palette view. 

2. Click the down arrow  next to the button to choose a saved palette or create a new palette.

Creating a palette

1. Click the down arrow  next to the Change Tags View button ( ) and choose New Palette from the menu. The 
New Palette dialog is displayed.

2. In the Name box, type the name you want to use to identify the palette.

3. In the Rows box, specify the number of rows of buttons you want to display in the palette.

4. In the Columns box, specify the number of columns of buttons you want to display in the palette.

5. Click OK to create the palette. The palette is displayed as a grid with empty buttons.

Assigning palette buttons

1. Perform either of the following actions to display the Tag Chooser dialog:

• Click an empty palette button.
—or—

• Click an existing button and choose Choose Tag from the shortcut menu.

2. Select the tag you want to assign to the button.

3. Click the OK button. 

Clearing a button 

Right-click a palette button and choose Clear from the shortcut menu.

Deleting a saved palette

1. Right-click a palette button and choose Delete Current Palette from the shortcut menu.

2. Click the OK button when prompted to delete the palette from your library.



Saving tags and properties to media files

Saving tags and properties to files makes all your tagging work portable: if tags are saved to files, those tags will be 
preserved in the files and can be added to the library by selecting the Add tags and custom properties from files check 
box in the Add Files to Media Library dialog. 

Saving tags to files affects only the current media library and libraries that you create after saving the tags. If you have 
multiple libraries, you can add embedded tags and custom columns to existing libraries by opening the desired library 
and rescanning your media folders with the Add tags and custom properties from files check box selected in the Add 
Files to Media Library dialog. Embedded file properties are also updated when you preview or add media to a project.

Follow these steps to save tag information in your media file(s):

1. Perform a search to find the files you want to tag.

2. In the Search Results pane, select media files for which you want to save tags and properties:

• To select a single file, click the file.
—or—

• To select multiple consecutive files, click the first file, hold the Shift key, and then click the last item.
—or—

• To select multiple files that are not consecutive, hold the Ctrl key and click each file.

3. Click the Save Tags and Properties to File(s) button ( ) in the top right corner of the Search Results pane. 
Information about tags associated with the file or information that you edited in the Search Results pane is saved to 
the selected files.

Tagging for loop developers

If you develop collections of loops and samples, you want to make sure you tag your media so users can find your loops 
easily and so your tagging is consistent with other existing collections.

1. Make a copy of the media library named Sony Tag Tree for Library Development.medialib. This file is saved in 
your My Documents\Sony Media Libraries folder by default.

2. Open the copy of the library.

3. Add the loop collection you want to tag to the library.

4. Apply the appropriate tags from the tag tree to your media files.

• Use existing tags whenever possible to ensure your collection is consistent with other collections in the Sony 
Sound Series Loops & Samples family.

• When adding new tags, try to add them within the existing tag tree. For example, if you wanted to create a tag 
for a bowed upright bass, consider adding it below the existing Basses tag:

• When adding tags, consider how the user will search for media. In the previous example, adding the tag Bowed 
to a media file means that the user will find that file whether searching for Basses or Bowed. If a user’s tag tree is 
rearranged so that Bowed is not a subtag of Basses, a search for the Basses tag will not find the file.

• If you add both tags, a search for Basses or Bowed will find the file regardless of whether Bowed is a subtag of 
Basses. This could result in inaccurate search results.

• Each tag contains a globally unique identifier (GUID) that preserves information about the tag and its location 
within the tag tree. For example, if you saved the Bowed tag to a media file, the file Bowed tag would be added 
to a user’s media library when the file is added. If the Basses tag did not exist in the user’s library, it would also 
be created.

• Because tags have unique identifiers, tag information and location is preserved. In the previous example, the 
Bowed tag would be added to the correct location in the user’s media library even if the user had translated all 
the tag names to a different language or otherwise renamed the Basses tag. In this case, the new tag would be 
added, but higher-level tags that were renamed by the user would be unaffected.
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5. Save the tags to your media files:

a. Delete the Scan [date / time] tags from the tag tree.

b. If you’ve searched the collection, click Clear to remove all search criteria and ensure all media files are displayed 
in the Search Results pane.

c. Select all files in the Search Results pane.

d. Click the Save Tags and Properties to Files button ( ).

6. Distribute your media files. You may optionally include the .medialib file.

Backing up your media libraries

Media Manager software automatically saves your library as you make changes, so you don’t need to tell the application 
explicitly to save your library as you’re working.

However, you can create a backup of the current library as a restore point or as a template to create new libraries.

1. Click the Media Library Actions button ( ) and choose Back Up Media Library from the menu. The Back Up 
Media Library dialog is displayed.

2. Choose a drive and folder from the Save in drop-down list, or use the browse window to locate the folder where you 
want to save your backup.

3. In the File name box, type the name you want to use to identify the library.

4. Click the Save button. 

To restore the backup at a later time, open the backup file.

Opening a Reference Library

A reference library contains information about media from an outside source or vendor.

If you have the Sony Loops and Samples reference library loaded when you search your computer for media, media from 
existing Sony Loops and Samples or Loops for ACID collections will inherit tags and custom properties from the reference 
library.

You can also use a reference library to search media files that you aren’t part of your collection. For example, if you’re 
unable to find the perfect loop for a Vegas project in your own collection, you could use the Sony Sound Series Loops & 
Samples reference library to search the entire Sony Sound Series Loops & Samples catalog and purchase a new loop 
library. 

You can use the Media Reference Library drop-down list in the Media Manager Options dialog to determine which library 

is opened when you click the Switch to Reference Library button ( ).

1. Click the Switch to Reference Library button ( ). The reference library specified in the Media Manager Options 
dialog is opened. Media in a reference library is displayed in gray text to indicate that the files are not available on 
your computer.

2. Find the media you’re looking for with a standard or advanced search.

Tip: You can also right-click a selected file and choose Save Tags and Properties to Files from the shortcut menu.

Note: When you back up your library, the Media Manager automatically performs database management that can 
reclaim free space and improve performance.

Tip: To view the Media Manager Options dialog, click the Media Library Actions button ( ) and choose Options from 
the menu.



3. Tag media from the reference library as needed. For more information on tagging, see Tagging media files on page 69.

4. When you select a file in a reference library, the Product Information pane displays information about the selected 
file and a link you can use to purchase the media. 

Using the Sony Sound Series Loops & Samples reference library

If you have the Sony Sound Series Loops & Samples reference library loaded when you search your computer for media, 
media from existing Sony Loops and Samples or Loops for ACID collections will inherit tags and custom properties from 
the reference library. 

The Sony Sound Series Loops & Samples reference library is not installed by default, but you can install it from the Vegas 
CD or download it from the Sony Media Software Web site  
(http://mediasoftware.sonypictures.com/reference). After installing the library, go to the Media Manager Options dialog 

(click the Media Library Actions button  and choose Options from the menu) and choose the reference library from 
the Reference library drop-down list.

Searching for media files

You can use the Media Manager tool to search the current media library for media files using keywords or tags.

Searching using a keyword

1. Select the Quick text search check box in the Search pane and type a keyword (or keywords) in the edit box.

2. Press Enter.

The Media Manager tool searches your media files and displays the results in the Search Results pane on the right 
side of the window. Any file that contains your keywords in the file name or attributes is displayed (tags are not 
searched as keywords).

Tips: 

You can use the Search results limit box in the Media Manager Options dialog to determine the maximum number of 
media files you’d like to have returned in the results of your searches. Increasing the Search results limit setting increases 
the amount of time required to search a library and can significantly decrease performance if set excessively high.

When performing complex searches, consider creating temporary tags to classify the results. If you apply a tag to the files 
found by a complex search, you can return to those files easily by searching on the tag. The Media Manager tool can search 
for tags more quickly than it can perform keyword or advanced searches.

Tip: You can separate search terms using quotation marks and other operators. If quotes or wildcard characters are not 
applied, an * is automatically added before and after each search term.
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Your search terms are displayed in the yellow bar below the Search Results toolbar.

3. You can refine the search results using any of the following methods:

• Select tag check boxes.
• Use the Advanced search controls. For more information, see Using advanced search options on page 77.
• Choose Match Any from the Match Any/Match All drop-down list to display all media that matches any of your 

keyword, tag, or advanced search criteria. Using this option in the search displayed in step 2, the Search Results 
pane would display all files that contain the keyword “EBow” OR the “Guitar” tag.

• Choose Match All from the Match Any/Match All drop-down list to display only media that matches all of your 
keyword, tag, and advanced search criteria. Using this option in the search displayed in step 2, the Search 
Results pane would display all files that contain the keyword “EBow” AND the “Guitar” tag.

• Click the View items not matching search criteria button ( ) to display only items that do not match your 
keyword, tag, and advanced search criteria.

Searching using tags

In the Search pane, select the check box for each tag you want to find. The Media 
Library searches your media files and displays the results in the Search Results pane 
on the right side of the window.

Choose Match Any from the Match Any/Match All drop-down list if you want to 
display all media that contains any keyword, tag, or advanced search criteria. In the 
example to the right, the Search Results pane would display all files that contain the 
tag “High Tom” OR the tag “Floor Tom.”

Choose Match All from the Match Any/Match All drop-down list if you want to 
display only media that includes all keyword, tag, and advanced search criteria. In the 
preceding example, the Search Results pane would display only files with tags “High 
Tom” AND “Floor Tom.”

Click the View items not matching search criteria button ( ) to display only items that do not match your keyword, 
tag, and advanced search criteria.

Sorting search results

Click a column heading to sort the results in ascending or descending order based on that column.

Note: If you have check boxes selected for parent and child tags, those tags will be 
treated as an OR relationship regardless of whether Match Any or Match All is 
selected.

 Keyword

Search results

Search terms



Viewing previous searches

Click the Previous Search button ( ) in the top left corner of the Search Results pane to navigate through your recent 
searches and update the contents of the Search Results pane. 

After viewing previous searches, click the Next Search button ( ) in the top left corner of the Search Results pane to 
navigate back to your current search.

Using advanced search options

If your media library contains many files and you’re searching for a very specific media file, the Advanced section of the 
Search pane can help you zero in on exactly the file you want. 

If you want to perform an advanced search to refine the results of a previous search, start by creating a quick search or 
tag-based search and then perform the following steps.

1. Add your search criteria:

a. Click the Add New Search Criteria button ( ) in the Search pane. The Search Criteria Chooser is displayed.

b. Double-click an item in the Search Criteria Chooser or drag it to the Advanced section of the Search pane.

2. Set parameters for each of your search criteria. If the item displays an edit box, type the parameter you want to 
search for. If the item is displayed as a hyperlink, click the value to display a control you can use to set the value.

3. Choose whether you want to display files that match any or all of your search criteria:

• Choose Match Any from the Match Any/Match All drop-down list if you want to display all media that matches 
any of your keyword, tag, or advanced search criteria.

—or—

• Choose Match All from the Match Any/Match All drop-down list if you want to display only media that matches 
all of your search criteria.

4. Select the check boxes for the advanced search criteria you want to include in your search, or clear a check box to 
exclude that item.

Tips: 

You can use the Search Results Limit box in the Media Manager Options dialog to determine the maximum number of 
media files you’d like to have returned in the results of your searches. Increasing the Search Results Limit setting increases 
the amount of time required to search a library and can significantly decrease performance if set excessively high.

When performing complex searches, consider creating temporary tags to classify the results. If you apply a tag to the files 
found by a complex search, you can return to those files easily by searching on the tag. The Media Manager tool can search 
for tags more quickly than it can perform keyword or advanced searches.

Tips: If an item in the Search Results pane displays a  button, you can click it to find related media. For example, 
clicking the button in the following example adds an item to the Advanced section to help you find other media with a 
beat count of 16. 
You can also drag a column heading from the Search Results pane to the Advanced section of the Search pane.
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Previewing media

You can use the transport controls in the Media Manager window to preview media files.

1. Select files in the Search Results pane to choose the files you want to preview:

• To select a single file, click the file.
—or—

• To select multiple consecutive files, click the first file, hold the Shift key, and then click the last item.
—or—

• To select multiple files that are not consecutive, hold the Ctrl key and click each file.

2. Start playback:

• If the Auto Preview button ( ) is selected, playback will begin automatically. 
• If the Auto Preview button is not selected, click the Start Preview button ( ) to begin playback.

If you have multiple files selected, they will be played back sequentially. Each file’s icon will change to a play icon 
( ) during playback.

3. Click the Stop Preview button ( ) to stop the preview, or turn off the preview feature by deselecting the Auto 
Preview button.

If the file is offline, you’ll be prompted to locate the file or choose a replacement.

Media relationships

When you’re searching or browsing the contents of your media library, you may be overwhelmed by the amount of 
media you’ve amassed. How can you possibly remember how and where you’ve used your media? No problem. The 
Media Manager tool takes care of the details.

Media relationships are maintained only when the Save media-usage relationships in active media library check box is 
selected on the General tab of the Vegas Preferences dialog.

1. Right-click a media file in the Search Results pane.

2. Choose Find Related Items from the shortcut menu, and then choose a command from the submenu:

Media files matching the selected command are displayed in the Search Results pane.

3. Click the Previous Search button ( ) to return to the previous contents of the Search Results pane. 

Tip: To preview a media file in its associated media player, right-click the file and choose Open with <Application 
Name> from the shortcut menu.

Command Description
Used with Displays all media files that use the selected media.
Previewed with Displays all media that has been previewed in a project containing the selected media.
Rendered to Displays all media files that were created from the selected media file using the Render As command.
Rendered from Displays the original media files that were used to create the selected media file if the file was created 

using the Render As command.
Chopped to Displays all media files that were created from the selected file using the Chop to New Track 

command in ACID software.
Chopped from Displays the original media file that was used to create the selected media file if the file was created 

using the Chop to New Track command in ACID software.
Rendered track to Displays all media files that were created from the selected file using the Render to New Track 

command.
Rendered track from Displays the original media files that were used to create the selected media file if the file was created 

using the Render to New Track command.



Adding media to your project

After you’ve added media to your library, tagged it, and searched for specific files or related media, you’ve probably 
found just the right piece of media for your current project.

You can add media to your project from the Search Results pane by performing any of the following actions:

• Dragging a file from the Search Results pane to the project timeline. The file is added wherever you drop it.

• Double-clicking a media file in the Search Results pane (if the Double-click in Search Results pane adds media to 
project check box is selected in the Media Manager Options dialog). The file is added to the track list. 

• Right-clicking a media file in the Search Results pane and choose Add to Project from the shortcut menu. The file is 
added to the track list.

If the file is offline, you’ll be prompted to locate the file or choose a replacement. For more information, see Resolving 
offline media files below.

Resolving offline media files

An offline media file is a file that is no longer available to the Media Manager. Media may be classified as offline if you 
eject removable storage after adding a file to your library or change a file’s name or location. 

1. Add media to your project or preview media files. If any of the files are not accessible, the Resolve Offline Media 
dialog is displayed with a listing of offline files and their status:

2. Select the files you want to resolve:

• To select a single file, click the file.
—or—

• To select multiple consecutive files, click the first file, hold the Shift key, and then click the last item.
—or—

• To select multiple files that are not consecutive, hold the Ctrl key and click each file.

3. Specify how you want to resolve the selected files:

• Click the Smart Search button to search quickly and allow the Media Manager tool to suggest the replacement 
file.

• Click the Browse button to choose a specific replacement file.
• Click the Leave Offline button to leave the file offline. The file will not be added to your project.
• Click the Remove button to remove the file from the media library. The file will not be added to your project. 

The original media file is not deleted.

4. Repeat step 3 for each file in the list.

5. Click the OK button to preview the files or add the files to your project and update the media library with the 
replacement files.

Tip: You can also drag files from the Search Results pane to the Windows desktop, a folder, or to another application that 
is an OLE (object linking and embedding) drop target.

Icon Status Description

Offline  The file listed in the Offline File column cannot be found. The status will be Offline if you did 
not search or browse for a replacement file.

Probable 
Match

The file listed in the Offline File column will be replaced by the file listed in the Replacement 
File column. A status of Probable Match indicates that the Media Manager tool found a 
likely replacement file when you clicked Smart Search.

Found The file listed in the Offline File column will be replaced by the file listed in the Replacement 
File column. A status of Found indicates that you chose the file you want to use after 
clicking the Browse button.
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Customizing the Media Manager window

Much of what you see in the Media Manager window can be customized to suit your preferences.

Automatically hiding the Search pane

Click the push pin button ( ) in the title bar of the Search pane if you want to save space in the Media Manager window 
by automatically hiding the search pane:

• The push pin is displayed as a  when the Search pane is anchored in the Media Manager window.
• The push pin is displayed as a  when the Search pane is set to hide automatically.

When the Search pane is set to hide automatically, you can hover over the Search tab on the left edge of the Media 
Manager window to show the pane. When you move your mouse away from the Search pane, it hides automatically.

Docking and undocking the Search pane

You can undock the Search pane from its location in the Media Manager window to float it over the Vegas window, or 
you can change the docking position of the pane within the Media Manager window. To undock and move the Search 
pane, drag its title bar to the desired location.

Resizing columns

You can resize the columns in the Search Results pane by dragging the splitter between columns to the desired size. To 
resize a column automatically, double-click a splitter.

Moving columns

To move a column in the Search Results pane to a different location, drag the column header to the desired location. A 
red indicator shows where the column will be dropped.

Showing or hiding columns

1. Right-click the column headings and choose Column Chooser from the shortcut menu.

2. Drag the columns you want to see from the Column Chooser dialog to the Search Results pane.

3. To hide a column, right-click a column heading and choose Remove this Column from the shortcut menu.

Adding custom columns

You can add custom columns to the Search Results pane to store additional information about media files. When you add 
custom columns, they are added to the current library only.

For example, if you wanted to keep track of which removable hard drive contained a media file, you could create a 
custom Drive Number column to assign any numeric rating to a media file. You could then use the Advanced section of 
the Search pane to search using the Drive Number value.

When adding media to a library, you can choose to add this information by selecting the Add tags and custom columns 
from files check box in the Add Files to Media Library dialog.

1. Right-click the column headings and choose Custom Columns from the shortcut menu. The Custom Columns dialog 
displays.

2. Click the Add New Column button ( ) to add a custom column. A new entry is added to the list.



3. In the Name box, type the name you’d like to display as a column heading.

4. Select the Type box and choose Text or Integer from the drop-down list to indicate whether you’ll store text or 
numeric data in the column.

5. If you want to remove a custom column, select an entry in the list and click the Delete Selected Columns button 
( ). The column and all data stored in the column is removed from the library.

6. Click the OK button. The column is added to the media library, and the Search Results pane is scrolled to the right to 
display your new column.

Editing a column’s contents

Some columns in the Search Results pane can be edited. When an entry in the Search Results pane is selected, click a box 
to make it editable. You can then type new information in the box.

Changing a column’s contents affects only the entry in the current media library. Click the Save Tags and Properties to 

Files button ( ) to save the properties with the media file.

Showing thumbnails

If you’re working with videos or still-images, the thumbnail view helps you see the files that match your search criteria.

To switch to thumbnail view, click the down arrow ( ) next to the Change Search Results View button ( ) and choose 
Thumbnail.

You can drag the slider at the bottom of the Search Results pane to adjust the size of the thumbnails.

When you select a file, the thumbnail is magnified. You can change the zooming behavior on the Thumbnail tab of the 
Media Manager Options dialog.

You can choose which frame you want to use as a thumbnail for video files:

1. Right-click a thumbnail in the Search Results pane and choose Choose Thumbnail from the shortcut menu. The 
Thumbnail Chooser dialog is displayed.

2. Drag the slider in the Thumbnail Chooser dialog to set the frame you want to use.

3. Click the OK button.

Using the Properties pane

The Properties pane displays extended information about the selected file in the Search Results pane. You can view and 
edit file attributes and view a listing of all tags that have been applied to the file.

Right-click a file in the Search Results pane and choose Show Properties Pane from the shortcut menu to toggle the 
display of the window.

Automatically hiding the Properties pane

Click the push pin button ( ) in the title bar of the Properties pane if you want to save space in the Media Manager 
window by automatically hiding the pane:

The push pin is displayed as a  when the Properties pane is anchored in the Media Manager window.

The push pin is displayed as a  when the Properties pane is set to hide automatically.

When the Properties pane is set to hide automatically, you can hover over the Properties tab on the right edge of the 
Media Manager window to show the pane. When you move your mouse away from the pane, it hides automatically.

Note: Properties that are editable are displayed in black.
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Moving the Properties pane

Drag the title bar of the Properties pane if you want to move it from its current position. You can float the pane over the 
Media Manager window, or drag to one of the edges of the window to dock it in a different position.

Setting Media Manager options

Use the Media Manager Options dialog to set options for working with the Media Manager tool.

To display the Media Manager Options dialog, click the Media Library Actions button ( ) and choose Options from 

the menu.

General tab

Media Library tab

Preference Description
Reference library Choose the library you want to load when you click the Switch to Reference Library button in the upper 

right corner of the Search Results pane. For more information about using reference libraries, see 
Opening a Reference Library on page 74.

Search results limit Type the maximum number of media files you’d like to have returned in the results of your searches.

Note: Increasing the Search results limit setting increases the amount of time required to search a 
library and can significantly decrease performance if set excessively high.

Double-click in Search 
Results pane adds media to 
project

Select this check box if you want to add files to the current project by double-clicking a file in the Search 
Results pane.

Shut down database service 
on exit

Select this check box if you want to stop the database service when you close Vegas software.

Note: Stopping the service can conserve system resources when you aren’t using any applications that 
use the Media Manager tool. However, the application will take longer to start when the check box is 
selected.

Add tags and custom 
properties from files

Select this check box if you want to add tags and custom columns saved in the media files to your library. 
For more information about tagging media, see Tagging media files on page 69. For information 
about adding custom columns to the Search Results pane, see Adding custom columns on page 80.

Use file and folder names to 
apply tags automatically

Select this check box if you want to automatically tag files based on the file path. 

For example, when this check box is selected, a loop saved in the d:\loops\drums\hi-hats\ folder would 
have the tags Drums and Hi-Hats applied when it is added to the library. Some synonyms (and variant 
spellings) will be resolved automatically. If you need to modify the pattern-matching, you can edit the 
AutoTagPatterns.xml file, which is created in your My Documents\Sony Media Libraries folder the first 
time the application starts.

Preference Description
Delete Click this button to remove information about media relationships from your database.

Media relationships are maintained only when the Save media-usage relationships in active media 
library check box is selected on the General tab of the Vegas Preferences dialog.

Update Click this button to scan the media files in your library and compare them to the files on disk to look for 
updated media properties.

If the values stored in the media library and the files on disk do not match, the Media Manager will 
prompt you to choose the values you want to keep. 

Select the Ignore file dates when checking for changes check box if you want to scan all files. When 
the check box is cleared, only files that have been modified since the last update will be scanned.

You can also use the Update button to check your media library for offline files.



 

ll 
 

Thumbnails tab

Thumbnail (*.sftb) files are used to represent image and video files in the Media Manager. Use the Thumbnails tab to edit 
settings for saving and using thumbnails

About tab

Use the About tab to view information on the version of the Media Manager that is currently installed. This information 
can be useful when troubleshooting issues with the Media Manager.

Using the Media Manager with multiple computers

If you have multiple computers in your production environment, you can easily share media libraries.

The following guidelines will help you make the most of your media libraries in a multicomputer setup:

• Save your media in shared folders where all necessary users have access.
• Use common drive letters or UNC (universal naming convention) paths for the folders where your media files and 

libraries are stored on all computers.
For example, your media files could be in a shared folder called \\studio_a\media (“studio a” is the computer name, 
and “media” is the name of the shared folder), or you could map the shared folder “media” to drive letter M for all 
computers.

• After tagging your media or otherwise changing properties, save the metadata to the media files by clicking the Save 
Tags and Properties to Files button ( ). Saving this information in the files makes the information more portable 
across computers.

Preference Description
Thumbnail Caching Choose a setting from the drop-down list to indicate how you want to store thumbnails for image and 

video files.

Store thumbnails in common folder: choose this setting if you want to store all thumbnails in a single 
folder. When you store thumbnails in a common location, you can view media thumbnails even if the 
media is not available (if you store media on a removable drive or network folder, for example).

Store thumbnails with media files: choose this setting if you want to store thumbnails each media file's
thumbnails in the same folder as the media. When you store thumbnails with media files, adding media 
files from a removable drive or network folder can be much faster because the Media Manager does not 
need to generate thumbnail files for each media file.

Store thumbnails in common folder and with media files: choose this setting if you want to duplicate 
thumbnail files in a common folder and with the media. When you add media files, the Media Manager wi
not need to generate thumbnails for media files that already have thumbnails in the media folder; existing
thumbnail files are copied to the common folder.

Do not store thumbnails: choose this setting if your disk space is limited and you do not want to store 
thumbnails. Thumbnails will be generated as needed.

Common Thumbnail Folder Displays the path to the common thumbnail folder. Click Browse to choose a different folder.
Limit Common Folder Size Select this check box and type a value in the box if you want to limit the amount of storage used for 

thumbnail files.

Click the Empty button to clear all thumbnails from the common location.
Enable Thumbnail Zoom Select this check box if you want to zoom thumbnails when you select them in the Search Results pane.
Delay before zooming 
thumbnails

Type a value in the box to set the delay before a thumbnail image is zoomed when you select it.

Smooth thumbnail zooming Select this check box if you want to animate thumbnail zooming.
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Chapter 4
 Basic Editing Techniques

Vegas® projects are multitrack compilations of events that occur over time. The events in your project are references 
(pointers) to source media files. Vegas software is a nondestructive editor, so editing events in your project does not alter 
the source media files in any way. 

Getting around

When editing and playing back the project, the cursor identifies where you are along the project’s timeline. 

Moving the cursor

Use the following keyboard commands to move the cursor in the timeline.

Changing focus

Focus is used to describe which objects have the attention of a program. For example, when you click a file in the Project 
Media window, that window has focus. To instantly switch the program’s focus to the track view (timeline), press Alt+0 or, 
from the View menu, choose Focus to Track View.

In Vegas software, it matters which track has focus when you perform a task. For example, when you double-click a media 
file in the Explorer, it is inserted into the track that has focus. You can click a track on its track number to make it the focus 
track. A blinking white line under the track number and shading in the track list indicates a track has focus.

Making selections

You have the flexibility to select one or more events, a time range, or events and a time range. All selection options can 
apply to a single track or to multiple tracks.

To select an event, click it.

Description Keys Description Keys
Go to beginning of project Ctrl+Home or 

W
Move left/right to marker(s) Ctrl+Left/Right Arrow

Go to end of project Ctrl+End or E Move to marker # 0-9 keys (not numeric keypad)

Go to beginning of selection  
or view (if no selection)

Home Move left/right to event edit points including 
fade edges (see figure below)

Ctrl+Alt+Left/Right Arrow

Go to end of selection or view (if 
no selection)

End Nudge cursor on timeline Left or Right Arrow

Move right by grid marks Page Down Move left/right one frame Alt+Left/Right Arrow
Move left by grid marks Page Up Move left/right one frame Ctrl+Alt+Shift+Mouse 

wheel
Go to Ctrl+G Center in view \

Event edit point cursor jumps
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Selecting multiple events

You can select multiple events in your project using several methods.

Selecting nonadjacent events

1. Hold the Ctrl key.

2. Select the events by clicking them. 

To deselect an event, simply click it again to 
toggle the event selection on or off. 

Selecting a range of events

1. Hold the Shift key.

2. Click the first event that you want to select. 

3. Click the last event that you want to select.

All events between the first and last selected events are highlighted and selected.

Selecting a block of events

1. Click the Selection Edit Tool button ( ).

2. Position the cursor in a corner of the area that you want to select.

3. Click and hold the left mouse button.

4. Drag the cursor to the opposite corner of the area you want to select. A 
rectangle is drawn on the workspace. All events within this rectangle are 
selected.

Hold the left mouse button and right-click to toggle through the three 
types of selection boxes: free, vertical, or horizontal.

Selecting all events to the end of the track

1. Right-click an event. A shortcut menu appears.

2. From the shortcut menu, choose Select Events to End. All events on the track after the selected event are selected.

Notes: Once you have selected multiple events, you can group them together. For more information, see Grouping 
events on page 164.

You can select multiple video events, multiple audio events, or a combination of both video and audio events. However, 
you can only use commands and operations that apply to both types of events for selections composed of both audio and 
video events.

Tip: Click the right mouse button while holding the left mouse button switch from rectangular selection, time selection, 
and track selection.

Tip: You may include or exclude events from a selection area by pressing Ctrl and clicking an event. To deselect all events, 
click anywhere in the workspace outside of the selected events.

Tip: To move large blocks of events, you can use Select Events to End with events selected on different tracks. Press Ctrl 
and click to select events on different tracks, and then right-click to access the shortcut menu.

Selected events

Selected events



Selecting all events that refer to a specific media file

Right-click a file in the Project Media window and choose Select Timeline Events from the shortcut menu. All events that 
use the selected media file in the active take are selected.

Hold Ctrl or Shift while choosing Select Timeline Events from the shortcut menu to add the events to the current 
selection.

Selecting a time range

Time selections are indicated by a shaded box and a bar that appears 
on the top of the timeline. You can use the time selection bar for 
playing back a smaller portion of your project or to apply cross-track 
edits.

Dragging to select a time range

1. Position the mouse pointer above the ruler (on the marker bar). The mouse pointer changes to a left/right arrow 
cursor ( ).

2. Drag to select a region. All events, or portions of events within the region are 
highlighted.

3. Drag the yellow handles on either end of the time selection to increase or decrease your 
time range selection.

Selecting a time range during playback

1. Click the Play ( ) or the Play From Start ( ) button to begin playback.

2. Press I where you want the time selection to begin.

3. Press O where you want the time selection to end.

4. Click the Stop button ( ) to stop playback.

Using shortcuts for time selections

These shortcuts can speed up the process of making precise time selections.

Note: Unless an event is locked, a selected time range affects all 
events, or portions of events, that occur within the range.

Tip: You can move the entire selection range by dragging the time selection bar.

Description Shortcut
Set time selection duration equal to an event’s 
duration

Double-click the event

Extend selection to the end of the currently 
selected event edge

Ctrl+Shift+Alt+Right Arrow

Extend selection to the beginning of the currently 
selected event edge

Ctrl+Shift+Alt+Left Arrow

Drag a time selection on an event without 
selecting/deselecting the event

Ctrl+Shift+drag on the event

Tip: Press Backspace to recall the last five time selection areas.

Only the events within 
the time selection are
affected by edits or 
played back.

Time selection
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Looping playback

If you want to play back the time range, click Play ( ) to play only the events within the time range. Click the Loop 

Playback button ( ) or press Q to toggle loop playback on and off. Vegas software continually plays back the portion of 
the timeline within the time selection when loop playback is toggled on.

Selecting events and a time range

Selecting a time range does not automatically select 
events. Excluding locked events, all items within the 
time range play back and are affected by Edit menu 
commands. However, you may select specific events 
to edit, and then select a time range. 

1. Select the events you wish to edit. For more 
information, see Selecting multiple events on 
page 86.

2. Place the mouse pointer above the ruler (on 
the marker bar). The mouse pointer changes to 
a left/right arrow cursor ( ). 

3. Drag to select the region. Notice that events 
that were not initially selected in step 1 remain 
unselected (not highlighted).

Selecting tracks

Click a track header to select it. Hold Ctrl or Shift to select multiple tracks.

Selecting groups of composited tracks

Click the vertical bar below a parent track to select a group of composited tracks. For example, clicking the area marked A 
in the following track list to select tracks 2 through 6. Clicking the area marked B selects tracks 5 and 6.

UnselectedSelected event

Selected event

SelectedUnselected

Unselected

Time selection

event

event

event

event

A

B



Editing events

Copying events

You can copy events, or portions of events, to the clipboard and paste them into your project. You may copy a single 
event or multiple events. Copying preserves the original event information, edits, and other modifications.

1. Select the events to be copied. For more information, see Selecting multiple events on page 86.

2. Select a time range, if applicable.

3. Click the Copy button ( ). 

Copying selected events

When copied, selected events are reproduced and placed on the clipboard. Time information is also placed on the 
clipboard.

Copying a time selection

Events within the time selection and across all tracks are reproduced and placed on the clipboard. Time information is 
also placed on the clipboard.

Tip: When the Cut, copy, and delete grouped events check box on the Editing tab of the Preferences dialog is 
selected, cutting, copying, or deleting an event will affect all events in the same group. If you need to delete a single 
event, you can choose Ignore Event Grouping from the Options menu to temporarily ignore grouping.

Events before copy Clipboard contents Events after copy
The original events are not 
affected and do not change.

Events before copy Clipboard contents Events after copy
The original events are not 
affected and do not change.
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Copying a time selection and events

Events and portions of selected events within the time selection are reproduced and placed on the clipboard. Time 
information is also placed on the clipboard.

Cutting events

Cutting events removes them from their respective tracks, but places the cut information (events and time) on the 
clipboard. Once on the clipboard, you may paste the information into your project.

1. Select events or a time range. For more information, see Making selections on page 85.

2. Click the Cut button ( ). 

Cutting selected events

When cut, selected events are removed from the timeline and placed on the clipboard. Time information is also placed on 
the clipboard. 

Events before copy Clipboard contents Events after copy
The original events are not 
affected and do not change.

Tips: 

When the Cut, copy, and delete grouped events check box on the Editing tab of the Preferences dialog is selected, 
cutting, copying, or deleting an event will affect all events in the same group. If you need to delete a single event, you can 
choose Ignore Event Grouping from the Options menu to temporarily ignore grouping.

You can apply a ripple edit after cutting. For more information, see Applying post-edit ripples on page 99.

Events before cut Clipboard contents Events after cut Events after cut in post-
edit ripple mode



Cutting a time selection

Events within the time selection are reproduced and placed on the clipboard. Time information is also placed on the 
clipboard. When cutting a time selection, auto ripple mode affects the position of material on all tracks or affected tracks 
after the cut.

Cutting a time selection and events

Events and portions of selected events within the time selection are reproduced and placed on the clipboard. Time 
information is also placed on the clipboard. When cutting a combination of time selection and event selection, post-edit 
ripple mode affects the position of material on all tracks or the tracks of selected events after the cut.

Pasting events

Once information is copied to the clipboard, you may choose a variety of ways to paste the clipboard items. Items are 

always pasted from the cursor’s position along the timeline.

When post-edit ripple mode is enabled, material is pushed down the track to make room for pasted material. The exact 
behavior of the ripple depends on what is being pasted, and the type of ripple edit you chose to perform. If one or more 
events are pasted, only those tracks where pasted material appears are ripple edited.

1. Move the cursor to the desired location on the timeline.

2. Click either the track number or within the track where you want to paste the event. This track is the focus track; 
there can be only one focus track at a time.

Events before cut Clipboard contents Events after cut Events after cut in post-
edit ripple mode

Events before cut Clipboard contents Events after cut Events after cut in post-
edit ripple mode

Tip: When the Cut, copy, and delete grouped events check box on the Editing tab of the Preferences dialog is 
selected, cutting, copying, or deleting an event will affect all events in the same group. If you need to delete a single 
event, you can choose Ignore Event Grouping from the Options menu to temporarily ignore grouping.

Tip: You can apply a ripple edit after pasting. For more information, see Applying post-edit ripples on page 99.

Note: If you are pasting multiple events from different tracks, new tracks are automatically created as needed.
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3. Click the Paste button ( ).

Clipboard events are pasted at the cursor position on the track. Existing track events can be overlapped with newly 
pasted information.

Using paste repeat

Use paste repeat to specify how many times clipboard events are pasted at the cursor position on the selected track and 
to specify the space between pasted events. 

1. Copy a selection to the clipboard.

2. From the Edit menu, choose Paste Repeat. The Paste Repeat 
dialog appears.

3. Specify the number of times to paste the clipboard contents and 
the space between successive copies. 

4. Click OK.

Using paste insert

When using paste insert, clipboard events are placed at the cursor position on the selected track and existing events on 
all tracks are moved further down the timeline by the total length of pasted information. This action differs from post-edit 
ripple mode because pasting in post-edit ripple mode affects only the tracks in which material is pasted, while paste 
insert affects all tracks in the project. 

1. Copy a selection to the clipboard.

2. From the Edit menu, choose Paste Insert

Punching-in and crossfading events 

You can insert events into the middle of (on top of ) existing events without altering the timing of the project. When the 
inserted event ends, the original event continues playing as if it had never stopped.

You can choose the duration of crossfades for punched-in audio events.

1. From the Options menu, choose Preferences. The Preferences dialog appears.

2. Click the Editing tab.

3. Select Quick fade length of audio events. Specify a duration for each transition.

Clipboard contents Events before paste insert Events after paste insert

Events on all tracks (not just tracks with
pasted material) are pushed down the timeline.



Events that have previously been inserted or punched-in are not affected by this change. The concept of punching in and 
out only applies when you are inserting an event that is shorter than the event that it is being inserted into. In the 
following illustration, every frame is numbered so that you can see how the original event continues after the inserted 
event ends, as if it continued to play underneath the original.

Duplicating events

Duplicating is a combination of copying and pasting in one action. The process is like moving the event to a new position 
while leaving a copy behind. 

1. Press Ctrl.

2. Drag the event you want to duplicate to the place where you want the new event to be positioned.

Inserting empty events and time

You can insert events into the timeline that do not have any contents and are not references to any media files. Empty 
events are useful as placeholders in the timeline that can be filled with media or recorded into at a later time. In either 
case, the new media is added to the empty event as a take. For more information, see Working with takes on page 117. To 
add an empty event to a track, from the Insert menu, choose Empty Event.

You can also make space in a project by inserting a length of time across all tracks. To insert a period of time into the 
timeline, from the Insert menu, choose Time. 

Trimming events

This section describes simple ways to trim events. For more information, see Using the Trimmer window on page 119.

Trimming an event

During the trimming process for a video event, both the last thumbnail image on the event and the Video Preview 
window show the last frame in the event, allowing you to edit events very accurately.

1.Move the cursor over the edge of the event. The cursor changes 
when properly positioned ( ).

2.Drag the edge of the event to trim it.

Since a multimedia file often has both a video and an audio 
component, both events are trimmed (or extended) as a group unless 
you ungroup them or temporarily suspend grouping by clicking the 

Ignore Event Grouping button ( ). For more information, see 
Grouping events on page 164. 

Tip: You can apply a ripple edit after trimming an event. For more information, see Applying post-edit ripples on page 99.

Punched-in event

Trimming
grouped events
at the same time
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Trimming an event beyond its end

You can trim an event beyond its end, extending it as a result. Once extended, the event loops as a default. A notch 
indicates where the looped event repeats. 

Alternately, you can turn looping off and make the last frame of an event’s media repeat for the duration of the event (a 
freeze frame). A notch appears at the point in the event where the video ends and the freeze frame begins. For more 
information, see Loop on page 157.

Trimming adjacent events

You can trim adjacent events simultaneously. Press Ctrl+Alt while dragging the common edge between two adjacent 

events. The trim adjacent cursor appears ( ).

Trimming a time selection

Trimming events removes all media outside the time selection. The removed information is not placed on the clipboard. 
Trimming is different from cutting in that the events within the time selection are preserved.

1. Select a time range. For more information, see Selecting a time range on page 87.

2. Press Ctrl+T or, from the Edit menu, choose Trim.

The material outside the time selection (across all tracks) is removed from the project. However, the time information 
(space) between events is not removed.

Trimming a time and event selection

1. Select the events to be trimmed.

2. Select a time range. For more information, see Selecting events and a time range on page 88.

3. Press Ctrl+T or, from the Edit menu, choose Trim.

Only the portion of selected events outside the time selection is trimmed. Unselected events remain. The time 
information (space) between events is not removed. 

Events before trim Clipboard contents Events after trim

Trimmed information is not 
placed on the clipboard.

Events before trim Clipboard contents Events after trim

Trimmed information is not 
placed on the clipboard.

Press Ctrl+Alt over the 
boundary between two events... ...and drag left... ...or right to trim both events at once.



Edge trimming events using the keyboard

With this method, you can quickly jump through your project and adjust cuts until they’re perfectly synchronized. If you 
have an external multimedia controller, it’s even easier.

1. If you want downstream events to ripple as you trim, click the Auto Ripple button ( ) to turn on Auto Ripple 
mode.

2. Select the event you want to trim.

3. Press 7 or 9 on the numeric keypad to move the cursor to the event edge you want to trim. 7 selects the beginning of 
an event or moves to the previous event edge. 9 selects the end of the event or moves to the next event edge. A red 
bracket is displayed to indicate which event edge will be trimmed.

4. Use the 1, 3 and 4, 6 keys on the numeric keypad to trim the current event edge:

• Press 1 to trim one video frame left, or press 3 to trim one video frame right (or hold Ctrl+Shift+Alt while rolling 
the mouse wheel).

• Press 4 to trim one pixel left, or press 6 to trim one pixel right (or hold Ctrl+ Shift while rolling the mouse wheel). 
Depending on the current zoom level, the trim duration will vary.

5. Repeat steps 3 and 4 as necessary.

Splitting events

You are allowed to create multiple, independently functioning events from a single event by splitting it. Splitting creates 
a new ending point for the original event and creates a starting point for the newly created event. 

Splitting an event does not alter the original media. The original 
media file’s information is there, but is omitted for playback based 
on where the event’s starting or ending point occurs on the 
timeline. 

When split, the two new events are flush against one another. The 
two events can be moved independently.

Splitting an event

1. Select the event(s) to be split. For more information, see Making 
selections on page 85.

2. Place the cursor at the timeline position where the split will 
occur.

3. From the Edit menu, choose Split, or press S.

Note: You can also perform this step using the [ or ] keys.

Note: Pressing 5 on the numeric keypad exits edge-trimming mode. If you are not in edge-trimming mode, 1, 3, 4, 
and 6 on the numeric keypad to nudge events on the timeline by frame (1 and 3) or by pixel (4 and 6).

One event

Split position

Two events after split

The two new events 
can be moved 
independently.
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Splitting all events at the cursor

All events are split at the cursor’s position (unless an event is locked). The split occurs across all tracks (if no events are 
selected).

Splitting selected events

Only the selected events are split at the cursor’s position.

Splitting a time selection

Unless locked, all events within the time selection are split at the starting and ending points of the time range, meaning 
that two splits are made. The split occurs across all tracks.

Events before splitting Events after splitting

Events before splitting Events after splitting

Events before splitting Events after splitting



Splitting a time selection across selected events

Only selected events within the time selection are split at the starting and ending points of the time range. 

Slipping and sliding events

To help you picture what happens when you slip and slide events, think of an event as a window to a media file. The 
window can display the entire media file or a small section. When the window displays only a portion of the media file, 
you can move either the window or the underlying media to adjust the media that is played by an event:

• When you slip an event, your event maintains its place on the timeline, but the media file moves in the direction you 
drag.

• When you slide an event, the media file maintains its place on the timeline, but the event moves in the direction you 
drag.

Shifting the contents of (slipping) an event

Press Alt while dragging an event. The slip cursor appears ( ).

As you drag the event, the contents of the event shift, but the event does not move. You can use this technique when you 
want to maintain an event’s length and position, but have the event play a different section of the source media file.

Slip-trimming an event

Press Alt while dragging the right or left edge of an event. The slip-trim cursor appears ( ).

As you drag the event edge, the media moves with the event edge.

Sliding an event

Press Ctrl+Alt while dragging an event. The slide cursor appears ( ).

As you drag, the relative position of the media remains fixed on the track, and the event position changes. You can use 
this technique when you want to maintain an event’s length, but have the event play a different section of the source 
media file at a different point in your project. For more information, see Applying post-edit ripples on page 99.

Events before splitting Events after splitting

Tip: You can also slip or slide grouped events (at the same time) or slide a crossfade between two events. For more 
information, see Grouping events on page 164 or Sliding a crossfade on page 102.

Tip: You can apply a ripple edit after slip-trimming or sliding an event.
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Detecting and repairing audio and video synchronization problems

When audio and video events are not aligned, Vegas software will highlight the events in the timeline so you can see 
synchronization problems at a glance. 

The software determines whether events are synchronized by comparing grouped and overlapping events:

• An event in a group is compared to other events in the same group (of the opposite media type) that were created 
from the same media, and the events with the most overlap are used to calculate synchronization. If no events overlap, 
the closest events are used to calculate synchronization.

• An event that is not in a group is compared to events (of the opposite media type) that were created from the same 
media, and the events with the most overlap are used to calculate synchronization. If no events overlap, no 
synchronization offset is displayed.

To restore synchronization, right-click the audio or video event you want to synchronize, choose Synchronize from the 

shortcut menu, and then choose a command from the submenu:

Note: The amount of offset is displayed when the Active Take Information option is selected on the View menu. Very 
small offsets that are below the resolution of the timeline may be displayed as 0.00. Set the project time format to samples 
to see the offset amount.

Command Description
By Moving  Moves the event you clicked so it is synchronized to its corresponding audio or video event.

By Slipping Slips the contents of the event you clicked so the audio and video are synchronized. The events do not 
move, but the contents of the event you right-click are shifted forward or backward to restore 
synchronization.

The original 

The event on the timeline

media file.

Slipping the event two 

Slip-trimming the event 

Sliding the event two 

frames to the right.

two frames to the right.

frames to the right.

with original frames.



Deleting events

Deleting an event removes it from its track. Multiple events can be deleted and time selections can be used to modify the 
process. Ripple editing also applies to delete actions. Deleting operates exactly like a cutting operation, but the removed 
information is not placed on the clipboard. For more information, see Cutting events on page 90.

1. Select the events to be deleted.

2. Press Delete.

Applying post-edit ripples

You can apply a post-edit ripple that affects either the edited track(s), the track(s) and certain project elements, or 
everything in the timeline. The power lies in the fact that you can apply this post-edit ripple to a wide variety of editing 
tasks, such as trimming, crossfading, cutting, pasting, and deleting events. You can also choose to apply your ripple edits 
manually or automatically.

You can ripple the contents of the timeline following an edit after performing these tasks:

• trimming (pg. 93), slip-trimming (pg. 97), and sliding (pg. 97) events
• time compressing/stretching events (pg. 116)
• cutting events (pg. 90)
• pasting events (pg. 91)
• deleting events (pg. 99)

Ripple editing also affects how material is added from the Trimmer window. For more information, see Using the Trimmer 
window on page 119.

A quick and easy method is also provided for shuffling a sequence of events on a track. Decide that the third event in a 
series should really be the second instead? You can drag the event to a new position and instruct the software to shuffle 
the events into their new order.

The original four events

Trimming the second event

After applying a post-edit ripple, the third and fourth events close the gap
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Applying a post-edit ripple manually

1. Perform one of edits discussed above. Above the timeline, an arrow indicates where 
the post-edit ripple will occur and the direction the affected events will move.

2. From the Edit menu, choose Post-Edit Ripple, and choose a command from the 
submenu:

• Affected Tracks ripples only the track(s) where you performed the edit.
• Affected Tracks, Bus Tracks, Markers, and Regions ripples the track(s) where you performed the edit and 

ripples any keyframes or envelopes on those tracks. This command also ripples any markers, regions, CD layout 
markers, and command markers in the project.

• All Tracks, Markers, and Regions ripples all tracks and all keyframes and envelopes on those tracks. This 
command also ripples any markers, regions, CD layout markers, and command markers in the project.

The timeline is rippled after the edit according to the option you choose.

Applying a post-edit ripple automatically

1. Click the arrow button next to the Auto Ripple button ( ) and choose a ripple type:

• Affected Tracks ripples only the track(s) where you performed the edit.
• Affected Tracks, Bus Tracks, Markers, and Regions ripples the track(s) where you performed the edit and 

ripples any keyframes or envelopes on those tracks. This command also ripples any markers, regions, CD layout 
markers, and command markers in the project.

• All Tracks, Markers, and Regions ripples all tracks and all keyframes and envelopes on those tracks. This 
command also ripples any markers, regions, CD layout markers, and command markers in the project.

2. Perform one of edits discussed above. Above the timeline, an arrow indicates where 
the post-edit ripple will occur, the direction the affected events will move, and the 
distance the events will move.

3. The timeline is rippled after the edit according to the ripple type you choose.

Shuffling events

A quick way to change the order of a sequence of events in a track is provided. Right-click and drag an event to a new 
location in the track and choose Shuffle Events from the shortcut menu that appears. The events are shuffled into the 
new order.

Tip: You can press F after an edit to ripple the affected tracks, or you can press Ctrl+F to ripple markers, keyframes, and 
envelopes too. To ripple everything after an edit, press Ctrl+Shift+F.

The original four events

Right-click and drag event three between events one and two

The four events after the shuffle



Crossfading events

You are allowed to crossfade between two events on the same 
track. For audio events, crossfading fades out one audio event’s 
volume while another event’s volume fades in. For video events, 
crossfading creates a transition between two events, one fading 
out while the other fades in. Lines appear indicating how and when 
the event’s volume or transparency is being affected.

Using automatic crossfades

The automatic crossfade feature turns the overlapping portions of two events into a smooth crossfade. This feature is 

turned on as a default. Click the Automatic Crossfades button ( ) or press Ctrl+Shift+X to turn automatic crossfades on 
and off.

An option is provided for creating automatic crossfades when you add multiple media files to a track. For more 
information, see Automatically crossfading inserted events on page 56.

Manually setting a crossfade

An automatic crossfade is not inserted if a shorter event is placed on top of and within the same time frame of a longer 
event. In this case, the longer event begins playing, then the shorter event plays, and then the longer event resumes 
playing at the timeline position. You can manually create a crossfade to fade in and out of the shorter event.

1. Place the mouse pointer on one of the shorter event’s handles. The envelope cursor appears ( ).

2. Drag the handle to the desired position.

This is a fast and effective method of inserting a voiceover on top of a background music track (although the music fades 
out completely) or to replace a bad section of audio. For more information, see Punching-in and crossfading events on page 
92.

Fade in
volume line

Fade out
volume line

Events before crossfade Events after crossfade

Drag one event to
overlap the other

Events without crossfade Events with manual crossfade
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Changing crossfade curves

You can change the crossfade curves that are used to fade in and out between two events. 

1. Right-click anywhere in the crossfade region to display a shortcut menu.

2. From the shortcut menu, choose Fade Type, and choose the desired fade type from the submenu.

Sliding a crossfade

You can slide a crossfade between two events without affecting the total length of the two overlapping events. This 
process is similar to sliding and slipping events. For more information, see Slipping and sliding events on page 97.

Press Ctrl+Alt while dragging the overlapping area between two events. The slide crossfade cursor appears ( ).

As you drag, the relative position of the media remains fixed on the track, and the crossfade position changes, effectively 
trimming the edge of the event in the direction you drag. You can use this technique when you want to maintain the 
length of two combined events but want the transition to occur earlier or later.

Using undo and redo

You are given unlimited undo and redo functionality while working on your project, even to the extent of being able to 
undo changes made before the last time a project was saved (but not closed). While you are working with a project, an 
undo history of the changes that you have performed is created. Each time you undo something, that change is placed in 
the redo history. 

When you close the project or exit the software, both the undo and redo histories are cleared. 

Using undo

Pressing Ctrl+Z or clicking the Undo button ( ) reverses the last edit performed. Repeatedly using the keyboard 
command or toolbar button continues undoing edits in reverse order, from most recent to oldest. In addition, you may 
undo the last edit by choosing it from the Edit menu.

Tip: If you use the same crossfade curve frequently, you can set it as a default for all new audio or video crossfades. For 
more information, see Editing tab on page 322.

Right-click a crossfade to 
choose a different crossfade curve.

Two events with a
crossfade.

Sliding the crossfade
to the left...

...and to the right.



Undoing a series of edits

You can undo a series of edits by using the drop-down list on the Undo button. 

1. Click the arrow to the right of the Undo button ( ).

2. From the drop-down list, choose the edit that you want to undo. Items above it (subsequent edits) are selected 
automatically. Your project is restored to the state prior to those edits.

When you undo an edit or a series of edits, they are added to the redo history. This feature allows you to restore your 
project to a previous state.

Using redo

Pressing Ctrl+Shift+Z or clicking the Redo button ( ) redoes the last undo performed. Repeatedly using the keyboard 
command or toolbar button continues redoing undos in reverse order, from most recent to oldest. In addition, you may 
redo the last edit by choosing it from the Edit menu.

Redoing a series of edits

You can view the redo history by clicking the arrow on the right side of the Redo button ( ). The top item in the list 
that appears is the most recent undo edit. If you redo a specific edit that appears farther down the list, all subsequent 
edits above it are redone as well. 

When you redo an edit or a series of edits, they are added to the undo history again. The redo history is cleared when a 
new edit is performed.

Clearing the edit history

You can clear both undo and redo histories without closing your project or exiting the software. Once the histories have 
been cleared, a new edit history is created as you continue working on the project. While clearing the edit history is not 
usually necessary, it can free up disk space. To clear the edit history, choose Clear Edit History from the Edit menu.

Tip: From the Edit menu, choose Undo All to undo all edits in the history. All edits are undone and added to the redo 
history.

Use the mouse
to select
a series of edits.
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Adding project markers and regions

Several types of project markers are provided that identify parts of your project, serve as cues, and provide additional 
functionality:

• Markers are points that you mark along the project’s timeline. They are typically used to mark locations in the project 
for later reference or to mark timing cues.

• Regions are ranges of time that you mark along the timeline. Regions identify ranges of time for your reference and 
can function as permanent time selections.

• Command markers are markers that enable metadata in streaming media files. These markers can be used to display 
headlines or closed captions, link to Web sites, or perform any other function you define. For more information, see 
Adding closed captioning to Windows Media Video (WMV) files on page 211. In addition, these markers can be used to 
embed Scott Studios data information, which is used extensively in broadcasting.

• CD layout markers are markers that indicate tracks and indices for an audio CD layout. These marks are used to create 
tracks and index points when burning an audio CD. For more information, see Understanding tracks and indices on page 
329.

Working with markers

Markers are useful for identifying and navigating to specific locations in longer projects. As you place markers in your 
project, they are automatically numbered (up to 99) in the order that they are placed. Markers appear as orange tags 
above the ruler. You may name them and reposition them along the project’s timeline.

If you choose to save markers in your rendered MPEG-2 file, DVD Architect™ will read those markers as chapter markers. 
Ensure the Render I-frames at markers check box is selected before rendering (in the Render As dialog, choose 
MainConcept MPEG-2 from the Template drop-down list, and then click the Custom button. In the Custom Template 
dialog, select the Video tab and select the Render I-frames at markers check box).

Inserting a marker at the cursor

1. Position the cursor where you want to place the marker.

2. From the Insert menu, choose Marker, or press M.

3. Type a name for the marker and press Enter. If you do not want to name the marker, simply press Enter.

Inserting a marker during playback

During playback, press M. The marker appears on the marker bar. You may name the marker after it has been set.

Tip: You can use ripple editing to automatically move markers and regions as you edit in the timeline. For more 
information, see Applying post-edit ripples on page 99.

Markers

Marker

Right-click the marker bar

bar



Naming (or renaming) a marker

1. Place the mouse pointer on the marker you want to name or rename. The pointer changes to a hand icon ( ).

2. Right-click to display a shortcut menu.

3. From the shortcut menu, choose Rename. A text box opens next to the marker.

4. Type the marker name.

5. Press Enter to set the marker’s name.

You can also double-click an existing name or double-click the space just to the right of a 
marker to rename it.

Moving markers

You can reposition a marker by dragging it on the marker bar.

Navigating to markers

You can jump the cursor to any marker on the timeline by clicking the marker. You can also jump to a marker by pressing 
the number keys along the top of the keyboard (not the numeric keypad).

Deleting markers

1. Place the mouse pointer on the marker that you want to delete. The pointer changes to a hand ( ).

2. Right-click to display a shortcut menu.

3. From the shortcut menu, choose Delete. The marker is removed from your project. 

The tags are not renumbered as you remove them. For example, if you have five markers in your project and delete 
markers 3 and 4, the remaining markers will be listed as 1, 2 and 5. However, as you add markers again, Vegas software 
begins numbering the missing sequence first, in this case 3 and 4, then 6, 7, 8, etc.

Deleting all markers and regions

1. Right-click the marker bar.

2. From the shortcut menu, choose Markers/Regions, and choose Delete All from the submenu.

Working with regions

Regions identify ranges of time and provide a way to subdivide your project. A region is defined as the area between two 
region markers that share the same number. Regions can function as semi-permanent time selections. You can view 

region information in the Explorer by clicking the arrow next to the View button ( ) and selecting Region View.

Inserting regions

1. Make a time selection. For more information, see Selecting a time range on page 87.

2. From the Insert menu, choose Region, or press R.

3. Type a name for the region and press Enter. If you do not want to name the region, simply press Enter.

Region markers display at the beginning and end points of a time selection. 

Tip: Jump the cursor to the next or previous marker by pressing Ctrl+ right arrow  or Ctrl+left arrow .
BASIC EDITING TECHNIQUES | 105



106 | CHAPTER 4
Moving regions

Drag a region marker to reposition it. To move both region markers (start and end markers) at once, hold Alt while 
dragging a region marker.

Naming regions

1. Place the mouse pointer on the left region marker you want to name or rename. The pointer changes to a hand icon 
( ).

2. Right-click to display a shortcut menu.

3. From the shortcut menu, choose Rename. A text box appears next to the region marker.

4. Type the region’s name.

5.  Press Enter or click anywhere in the track view to set the name.

Selecting regions

You may select the events, across all tracks, within the region for editing or playing back. 

1. Right-click one of the region markers to display a shortcut menu.

2. From the shortcut menu, choose Select Region.

Navigating to regions

You can move the cursor to the start or end of a region by clicking either region marker. You may press Ctrl+ right arrow 
 or Ctrl+left arrow  to move the cursor to the next or previous region markers.

Right-click a region marker to display a shortcut menu that allows you to navigate to the beginning (Go to Start) or the 
end (Go to End) of a region.

Tip: You can also select a region by pressing a number on your keyboard (not the numeric keypad) or by double-clicking a 
region marker.

Region start Region end Right-click the marker bar

Marker
bar

Selected region



Deleting regions

1. Place the mouse pointer on the region marker’s starting or ending point. The pointer changes to a hand icon ( ).

2. Right-click to display a shortcut menu.

3. From the shortcut menu, choose Delete. The region is removed from your project. 

The tags are not renumbered as you remove them. For example, if you have five regions in your project and delete region 
3 and 4, the remaining regions are listed at 1, 2 and 5. However, as you add regions again, Vegas software begins 
numbering the missing sequence first, in this case 3 and 4, and then 6, 7, 8, etc.

Deleting all regions and markers

1. Right-click the marker bar.

2. From the shortcut menu, choose Markers/Regions, and choose Delete All from the submenu.

Working with command markers

Command markers add interactivity to a multimedia presentation streamed over the Internet by inserting metadata into 
streaming media files. As your video plays, any number of other actions can be programmed to occur. These commands 
are a part of the Microsoft® Windows Media® and RealMedia® streaming formats. Most frequently, these actions add text 
or open a related Web site where the viewer can find more information about the topic at hand. The specific commands 
available vary depending on the final format of your project.

You can use command markers to add closed captions to your project. For more information, see Adding closed captioning 
to Windows Media Video (WMV) files on page 211.

Command markers can also indicate when an instruction (function) will occur in a WAV file being used in a radio 
broadcast environment (Scott Studios data). The following two sections define the markers for both streaming media and 
Scott Studios files.

Defining streaming media commands

In a streaming media file, command markers can be used to display headlines, show captions, link to Web sites, or any 
other function you define. Several command types are included that you may add to a streaming media file. Some 
command types are exclusive to either the Windows Media or the RealMedia player.

Note: Windows Media Player 9 will ignore metadata commands unless the Run script commands when present check 
box is selected on the Security tab of the player's Preferences dialog. Be sure to instruct your audience to select this check 
box before playing your file.

Note: While streaming media files can be played on any hard drive or CD-ROM, they require a special streaming media 
server (provided by your Internet service provider) to stream properly across the Internet.

Command Player type Description
URL Windows Media 

and RealMedia
Indicates when an instruction is sent to the user’s internet browser to change the 
content being displayed. With this command, you enter the URL that displays at a 
specific time during the rendered project’s playback.

Text Windows Media Displays text in the captioning area of the Windows Media Player located below the 
video display area. You enter the text that will display during playback.

Note: To view captions during playback in Windows Media Player 9, choose 
Captions and Subtitles from the Windows Media Player Play menu, and then 
choose On if Available from the submenu.

WMClosedCaption Windows Media Displays the entered text in the captioning window that is defined by an HTML 
layout file.

WMTextBodyText Window Media Displays the entered text in the text window that is defined by an HTML layout file.
WMTextHeadline Windows Media Displays the entered text in the headline window that is defined by an HTML layout 

file.
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Defining Scott Studios data commands

For WAV files using Scott Studios data, command markers can be used to define information about the WAV file.

Inserting command markers

Command markers appear as blue tags on the command bar, which is above the marker bar.

1. Position the cursor where you want to place the command marker.

2. From the Insert menu, choose Command, or press C.

Title RealMedia Displays the entered text on the RealPlayer’s title bar.

Note: When rendering Windows Media files, title information is based on the 
settings on the Summary tab of the Project Properties dialog or the Index/Summary 
tab of the Custom Template dialog. The summary information from the Project 
Properties dialog will be used if information has been specified in both places.

To view this information during playback, choose Now Playing Options from the 
Windows Media Player View menu and select the items you want to display.

Author RealMedia Displays the entered text (Author’s name) when a user selects About This 
Presentation from the RealPlayer’s shortcut menu.

Note: When rendering Windows Media files, author information is based on the 
settings on the Summary tab of the Project Properties dialog or the Index/Summary 
tab of the Custom Template dialog. The summary information from the Project 
Properties dialog will be used if information has been specified in both places.

To view this information during playback, choose Now Playing Options from the 
Windows Media Player View menu and select the items you want to display.

Copyright RealMedia Displays the entered copyright information when a user selects About This 
Presentation from the RealPlayer’s shortcut menu.

Note: When rendering Windows Media files, copyright information is based on the 
settings on the Summary tab of the Project Properties dialog or the Index/Summary 
tab of the Custom Template dialog. The summary information from the Project 
Properties dialog will be used if information has been specified in both places.

To view this information during playback, choose Now Playing Options from the 
Windows Media Player View menu and select the items you want to display.

Command Description
SCOTT EOM Calculates when the next queued clip starts playing in a Scott Studios system. For more information, 

please refer to your Scott Studios documentation.
SCOTT Cue In Set the beginning of a file in a Scott Studios System without performing destructive editing. For 

more information, please refer to your Scott Studios documentation.

Command Player type Description

Marker bar

Command bar

Right-click to place a command marker
on the command bar



3. Complete the Command Properties dialog:

• If desired, choose a custom template from the 
Template drop-down list. For more information, see 
Saving command properties as a custom template on 
page 109.

• Choose the type of command from the Command 
drop-down list.

• In the Parameter box, enter parameters to define 
the behavior of the command.

• Enter your own notes or comments in the 
Comments box.

• Specify the timing of the command in the Position 
box. Otherwise, command markers are automatically set to the current cursor position.

4. Click OK. The new command marker appears on the command bar.

Editing command properties

Double-click any command marker to open the Command Properties dialog and edit its contents. You can also right-click 
a command marker and choose Edit from the shortcut menu.

Saving command properties as a custom template

If you plan to use a command more than once, you can save command properties as a template. You can then reuse the 
command properties by choosing the template from the Template drop-down list.

1. Create a command and complete the Command Properties dialog.

2. Enter a name for the template in the Template box.

3. Click the Save Template button ( ).

Deleting command markers

1. Place the mouse pointer on the command marker. The pointer changes to a hand icon ( ).

2. Right-click to display a shortcut menu.

3. From the shortcut menu, choose Delete. The command marker is removed from your project.

Working with CD layout markers

Markers on the CD layout bar indicate the locations of tracks and indices in an audio CD layout project. These markers are 
discussed in a later chapter. For more information, see Understanding tracks and indices on page 329.

Note: Your metadata command templates are saved in the cmdtemp.xml file in the C:\Documents and Settings\<user 
name>\Application Data\Sony\Vegas\7.0\ folder. You can edit this file directly to modify your templates.
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Working with the marker tool

You can use the marker tool to navigate the marker bars and edit multiple selected markers.

1. Click the Marker Tool button  in the top-right corner of the timeline.

2. Select the markers you want to edit:

• Press the Left Arrow/Right Arrow keys to move to the previous/next marker in the active bar (marker/region bar, 
CD layout bar, or command bar).

• Press Shift+Left Arrow/Right Arrow keys to extend the selection to the previous/next marker.
• Press Shift while clicking two marker tags to select all markers between the two tags.
• Press Ctrl while clicking marker tags to select or deselect individual markers. 

3. Edit your markers:

• Dragging any selected marker will move all selected markers in the active bar as a group.
• Pressing Delete will remove all selected markers in the active bar.

The marker tool is inactive when you change focus to another portion of the Vegas window.

Using an external audio editing program

Vegas software is a nondestructive editing environment, which means that the original source files remain unchanged by 
any editing done in the software. Destructive (constructive) edits that modify the actual source media file may be done in 
a separate application such as Sound Forge® software from Sony Media Software. By setting up a separate audio editor, 
you can quickly access the program from Vegas software via the Tools menu or by pressing Ctrl+E.

Setting up an audio editing program

If you already have Sound Forge software loaded on your computer when you installed Vegas software, the installation 
should have detected it and made it your default audio editing program. However, if you do not have Sound Forge 
software or want to specify a different audio editor, you may do so in the Preferences dialog.

1. From the Options menu, choose Preferences. The Preferences dialog appears.

2. In the Preferences dialog, click the Audio tab.

3. Click the Browse button to the right of the Preferred audio editor box. The Preferred Audio Editor dialog appears.

4. From this dialog, navigate to the application to use for editing audio files.

5. Select the application’s executable icon (.exe) and click Open to set the application as your default audio editor.

The application’s path displays in the Preferred audio editor box.

Opening an audio editor from Vegas software

All events in your project are references to media files on a storage device. When you edit an audio event in an audio 
editor, you can choose to open the original media file or a copy of the file. 

Opening a file in an audio editor

You can directly edit the media file to which an audio event is referenced. Any changes you make and save in the audio 
editor are permanent and are reflected in the event in your project. 

1. Select the event to be edited.

2. From the Tools menu, choose Audio, and choose Open in Audio Editor from the submenu.

Your selected audio editing application opens the event’s referenced media file. Make the necessary changes and save 
the file in the audio editor. If you keep the media file’s name and location the same, its event is updated immediately in 
your project. However, if you change the media file’s name or location (by using Save As), you must import the edited 
(new) file into Vegas software.



Opening a copy of a file in an audio editor

You can also create a copy of an audio file and open it in an audio editor. Opening a copy of a file has the advantage of 
preserving the original file unchanged. The modified copy is inserted into the event as a take and is automatically added 
to the Project Media window. 

1. Select the event to be edited.

2. From the Tools menu, choose Audio, and choose Open Copy in Audio Editor from the submenu.

When you are finished editing, save the file. “Take X” is added to the end of the filename to distinguish it from the original 
and adds it to the project as a take. If you save it to a new file (by using Save As), you must manually add it as a take into 
the project. For more information, see Working with takes on page 117.
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Chapter 5
 Advanced Editing Techniques

This chapter builds on the techniques that were introduced in the last chapter. Ripple editing, pitch shifting, and takes 
are just three of the more advanced editing topics that are covered in this chapter. 

Snapping events

Vegas® software is preset to snap events into place as you drag them. 

Events can snap to another event’s edges, to the cursor position, a marker or 
region, the grid, or to a time selection. As you move an event along the timeline, 
its edge automatically aligns to designated snap points.

As you drag items along the timeline, an indicator is displayed to show snap 
points. When you snap to an event, the snap indicator is displayed in the 
appropriate track. If you snap to the cursor, a marker/region, time selection, or the 
grid, the snap indicator is displayed across the height of the timeline.

Turning snapping on and off

You can quickly turn snapping on and off by clicking the Enable Snapping button ( ). You can also selectively turn 

snapping options on and off in the Options menu. When snapping is enabled, events will snap to the following points:

• Other events’ edges
• The cursor
• Time selection edges

You can also choose to snap events to grid lines or to markers.

Snapping to the grid

When snapping is enabled, you can also choose to have elements in the timeline snap to the vertical grid lines in the 
timeline.

From the Options menu, choose Snap to Grid (or press Ctrl+F8) to toggle snapping to grid lines.

Tips: 

• Hold the Shift key to temporarily override snapping.
• You can edit snap indicator colors on the Display tab of the Preferences dialog. For more information, see Display tab on 

page 323.

Tip: To change the spacing of the grid, choose Grid Spacing from the Options menu and choose a setting from the 
submenu.

Snap
indicator
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Snapping to markers

When snapping is enabled, you can also choose to have elements in the timeline snap to markers in the timeline.

From the Options menu, choose Snap to Markers (or press Shift+F8) to toggle snapping for all marker types:

• Markers
• Regions
• CD track regions
• CD index markers
• Command markers

If the Event Media Markers command is selected on the View menu, you can also use media markers as snap points 
when you click in an event or edge-trim an event.For more information, see Editing events on page 89.

Snapping to events on other tracks

When snapping is enabled, you can also choose to have elements in the timeline snap to the ends of events on other 
tracks. 

From the Options menu, choose Snap to All Events (or press Ctrl+Shift+F8) to toggle snapping to event edges across 
tracks.

Quantizing to frames

The Quantize To Frames command in the Options menu takes snapping one step further. With this feature enabled, 
edits are forced to occur on project frame boundaries. This setting is independent of grid and marker snapping. 
Quantizing affects how you can move events, place markers and regions, make selections, and position the cursor.

Using the event snap offset 

Each event in your project has a snap offset flag that can be moved along the length of the event. The flag is the white 
triangle that is located in the lower-left corner of each event. This flag allows you to designate where snapping occurs. 
This is useful if you need to align the snap with a beat in the event instead of the edge.

1. Place the mouse pointer on the snap offset triangle. The pointer changes to a hand icon ( ).

2. Drag the snap offset flag to the new position in the event. As the flag moves, a time display appears. This time 
display indicates where the snap offset flag occurs in time in the event. 

3. Release the mouse to set the snap offset flag.

Note: If a media file’s frame rate does not match your project frame rate, you will not be able to snap to media 
markers (or other snap points that do not occur on a frame boundary) when Quantize to Frames is selected on the 
Options menu.

Notes: 

• If you drag to a snap point that does not occur on a frame boundary when Quantize to Frames is enabled, the snap 
indicator is displayed as a dashed line.

• Edits that do not occur on frame boundaries can produce an undesirable visual result. For example, if you split two events 
and move them together to create a cut, splits that are not at frame boundaries can produce a short dissolve in your 
rendered video.

Snap offset flag



Pitch shifting audio events

A pitch shift is a way to raise or lower the pitch of an audio event. The semitone range is -24 to 24. Twelve semitones 
equal one octave, so you may increase or decrease the pitch of an event within a two-octave range. Within each semitone 
is a finer pitch adjustment called cents. There are one hundred cents in one semitone.

Editing from the timeline

1. Select an event.

2. Use the = and - keys on your keyboard (not the numeric keypad) to adjust pitch:

If the Active Take Information option is selected on the View menu, the event’s pitch shift is displayed in the bottom-left 
corner of the event. If the media has a known root note, the new root is displayed in parentheses: 

Key Result
= Raise pitch one semitone.
Ctrl+= Raise pitch one cent.
Shift+= Raise pitch one octave.
Ctr+Shift+= Reset pitch.
- Lower pitch one semitone.
Ctrl+ - Lower pitch one cent.
Shift+ - Lower pitch one octave.
Ctr+Shift+ - Reset pitch.

Original event

Event with pitch shift 
of 12 or one octave speeds up

Event with pitch shift
of -12 or one octave slows down

Change length and pitch
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Editing in the Event Properties dialog

1. Right-click the event and choose Properties from the shortcut menu.

2. On the Audio Event tab, choose a setting from the Method drop-down list to specify how you want to pitch-shift the 
event, or choose None if you want to preserve the event pitch.

3. If you selected Classic from the Method drop-down list, indicate the new event length and amount of pitch shifting 
you want to apply:

a. Type the desired event length in the New length box.

b. Type the desired pitch shift (in semitones) in the Pitch change box.  
 
If you want to change the event length without changing pitch, type 0 in the box. 
 
If you want the pitch to be determined by the amount of time stretching, select the Lock to stretch box. For 
example, doubling an event’s length will raise its pitch by one octave.

c. Choose a setting from the Stretch Attributes drop-down list to specify how you want to divide and crossfade 
the file to prevent artifacts. Depending on your source material, you may need to experiment with different 
crossfade types.

4. If you selected ACID from the Method drop-down list, indicate the new event tempo and the amount of pitch 
shifting you want to apply:

a. Type the desired event length in the New tempo box.

b. Type the desired pitch shift (in semitones) in the Pitch change box. 

If you want to change the event length without changing pitch, type 0 in the box.

If you want the pitch to be determined by the new event tempo, select the Lock to stretch box. For example, 
doubling an event’s tempo will raise its pitch by one octave.

5. Click OK.

Time compressing/stretching events

Time stretching and compressing events is the process of using the same amount of source media to fill a shorter or 
longer event. While this can be done to both video and audio events, the two cases are fundamentally different. 

Press Ctrl and drag the edge of the event toward the center of the event to compress (shorten) it or drag the edge out 
away from the center to stretch (lengthen) it.

You can see the results of the time compression or stretching by viewing the properties of the event. Right-click the event 
and choose Properties from the shortcut menu. Time compressing/stretching an audio event affects the Time stretch/
pitch shift settings, while Time compressing/stretching a video event affects the Playback rate setting.

Tip: You can time compress/stretch several events at once by grouping them first. You can also apply a ripple edit after 
time compressing or stretching events. For more information, see Grouping events on page 164 or Applying post-edit 
ripples on page 99.



Time compressing/stretching video

Time stretching video allows you to fill a given duration with a set amount of actual video, sometimes called fit-to-fill. For 
example, if you have a five-second video event and you want this event to fill an eight-second slot, press Ctrl and drag the 
edge of the event to eight seconds. The resulting video is in slow motion, but the contents (footage) remain the same. If 
you had used a velocity envelope to slow the video to the same rate, the event would also be in slow motion, but its 
duration would remain unchanged at five seconds. Stretched video has a zigzag line between thumbnails. Video can also 
be compressed (sped up and shortened in length) by using this method.

When stretching video events or slowing video down, a set number of frames are extended across a period of time. For 
example, if you take source footage at 30 frames in a second and slow it so that only 15 source frames run during that 
same second, an additional 15 frames must be created to maintain the project’s 30 fps frame rate. Simply duplicating 
frames is the easiest way to do this. A more sophisticated method is to resample the frames of an event, allowing Vegas 
software to interpolate and redraw these intervening frames. For more information, see Resample (video only) on page 159 
and Resampling video on page 214.

Working with takes

A take is a version of a scene or audio recording, as in “Scene 10, Take 7”, which means the seventh time that scene 
number ten has been shot. A number of takes can be included in the same location (event) of the project. You can then 
rapidly switch between these separate takes to see which one fits into the project the best. Although this is what takes 
are designed for, you can actually use any media files you want as a take, even completely different sounds or scenes. 
Since an event is just a container of a specific length and at a specific location, the actual content (media file) is easily 
changed.

Adding takes

You can add multiple media files to the timeline at the same time to a single event as takes. You can also add regions 
within media files as takes. For more information, see Adding regions as takes on page 122.

Adding media files to the timeline as takes

1. Locate the media files that you want to insert as takes in the Explorer and select them. Select a range by pressing 
Shift and clicking the first and last file in the range, or select nonadjacent files by pressing Ctrl and clicking the 
various clips individually.

2. Right-click and drag one of the selected clips in the group to the timeline.

3. From the shortcut menu, choose Add as Takes.

Tip: To add either just the audio or just the video portions of files as takes, choose Video Only: Add Video as Takes or 
Audio Only: Add Audio as Takes from the shortcut menu.
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Adding takes to existing events

You can add media files to existing events as takes.

1. Right-click a media file in the Explorer and drag it to an existing event. 

2. From the shortcut menu, choose Add as Takes.

Selecting takes

When you add an event with multiple takes, a single event is inserted into a track. The length of the event is set according 
to the last clip that was selected. This last clip is set as the active take.

1. Right-click an event with multiple takes. 

2. From the shortcut menu, choose Take, and choose Next Take or Previous Take from the submenu. Alternately, 
choose the name of the take from the list at the bottom of the submenu.

Previewing and selecting takes

You can preview the takes for a given event.

1. Select an event containing multiple takes.

2. Right-click to display a shortcut menu or, from the Edit menu, choose Take to display a submenu.

3. Choose Choose Active... from the submenu. The Take Chooser dialog 
appears.

4. Select the take that you want to preview and use the Play ( ) and 
Stop ( ) buttons within the dialog. 

5. To use a take, select it and click OK. The selected take is now the active 
take.

Deleting takes

You can delete individual takes from an event at any time.

1. Right-click an event with multiple takes. 

2. From the shortcut menu, choose Take, and choose Delete Active from the submenu to immediately remove the 
active take. Alternately, choose Delete to open a dialog with a list of all of the takes contained in this event.

Working with take names

Displaying take names on events

Take names may be displayed on the events in the timeline. From the View 
menu, choose the Active Take Information option.

Changing take names

Changing the name of a take does not affect the source media file in any 
way. Typically, you may want to change an event’s name after recording multiple takes into a track or event. For more 
information, see Working with multiple recorded takes on page 189.

1. Select the take to be renamed. For more information, see Selecting takes on page 118.

2. Right-click the event to display a shortcut menu.

3. From the shortcut menu, choose Properties. The Properties dialog opens.

Tip: Click an event and press T to select the next take or Shift+T to select the previous take.

Without take name With take name



4. Type the new name in the Active take name box.

5. Click OK to set the new take name.

Using the Trimmer window

The Trimmer allows you to work with and edit one media file at a time. The entire file is opened into the Trimmer, in 
contrast to events on the timeline that may only contain a portion of the actual source file. 

The main function of the Trimmer window is to allow you to trim a media file and place portions of it on a track. You can 
also add regions and markers to a file, preview the media file, or open it in an external audio editing program.

You can open any number of files in the Trimmer at the same time, selecting the one you currently want to work on from 
the Trimmer history drop-down list.

From the View menu, choose Trimmer or press Alt+2 to display the Trimmer window, if it is not already visible. You can 
dock the Trimmer window in the window docking area or float it over the work area. For more information, see Window 
docking area and floating window docks on page 22.

Opening a file in the Trimmer

1. Right-click an event. A shortcut menu appears.

2. Choose Open in Trimmer.

You can also drag files to the Trimmer from the Explorer or the Project Media windows. 

Tips: If you open a multichannel audio file in the Trimmer, you can choose which channels you want to display in the 
Trimmer window: right-click the waveform display, choose Channels from the shortcut menu, and then choose a 
command from the submenu.

If you open a multistream audio file in the Trimmer, you can choose which stream you want to display in the Trimmer 
window: right-click the waveform display, choose Stream from the shortcut menu, and then choose a stream from the 
submenu.

Tip: If you want to open the original media file that was used to create a subclip in the Trimmer, right-click a subclip 
in the Project Media window and choose Open Parent Media in Trimmer from the shortcut menu.

Trimmer 

PlaybackLoop Add mediaCursor

Marker

Open in Audio Editor

Clear Trimmer

Save Markers/Regions

Remove Current Media From

Sort Trimmer

Loop region or
Selection area

Add media

Historyhistory

navigationcontrols from cursor up to cursor

Trimmer HistoryHistory

Create Subclip

Select Parent Media

Zoom controls

Media file

Playhead
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Double-clicking a file to open it in the Trimmer

You can set the software to open a file in the Trimmer when you double-click the file in the Project Media or Explorer 
windows.

1. From the Options menu, choose Preferences.

2. Click the General tab.

3. Choose Double click on media file loads into Trimmer instead of tracks.

Moving frame-by-frame in the Trimmer window

As you navigate through a video file in the Trimmer, the exact frame that the cursor is over in time is displayed as in a 
thumbnail image under the cursor. When using the left and right arrow keys, this allows you to edit with frame accuracy. 
Make sure Animate video frames in Trimmer is selected on the General tab of the Preferences dialog to use this feature. 

Making selections in the Trimmer

After you have opened a media file in the Trimmer, you may select a segment of it and place it in your project. Make a 
time selection to select a segment in the Trimmer in the same way you do in the project timeline. For more information, 
see Selecting a time range on page 87. 

You can make a selection during playback by using the keyboard. Press I or [ to mark the start of the selection, and press 
O or ] to mark the end. 

If you know the exact timecode of the point where you want to begin and end a time selection, you can enter it into the 
boxes at the lower right corner of the Trimmer window. 

Adding selections to the timeline

You can use the Trimmer window to do traditional three-point and two-point editing. These editing techniques allow you 
to add smaller sections of files to the timeline.

Post-edit ripple mode affects how a selection is added to the timeline from the Trimmer. When the Auto Ripple button 

( ) is selected, adding a selection from the Trimmer selection affects the position of later events on the track. When not 
in post-edit ripple mode, adding a selection from the Trimmer has no effect on the position of other events. For more 
information, see Editing events on page 89.

Tip: Press Backspace to recall the last five time selection areas in the Trimmer.

Double-click to enter a value.

Selection Selection Selection
LengthEndStart



Adding selections at the cursor 

1. Open a media file in the Trimmer.

2. Make a time selection in the Trimmer. 

3. Select the track in the timeline where the selection will be added.

4. Position the cursor in the timeline at either the start or end point where you want to add the selection.

5. Add the selection to the timeline in one of the following ways:

• Click the Add Media from Cursor button ( ) or press A to insert the event after the cursor. 
• Click the Add Media up to Cursor button ( ) or press Shift+A to insert the event before the cursor.

Alternately, you can drag the selection from the Trimmer to the 
timeline

Filling a time selection on the timeline 

You can select a range of time on the project timeline and then fill it 
with the same length selection from the Trimmer.

1. Create a time selection in the timeline where you want to add the event. This sets the duration and position of the 
event that you will create.

2. Open the media file you want to use to fill the time selection in the Trimmer window.

3. Right-click the file in the Trimmer window and choose Sync Track View Selection Time from Cursor or Sync Track 
View Selection Time up to Cursor from the shortcut menu. A time selection is created in the file in the Trimmer 
window to match the time selection in the timeline. 

4. Adjust the location of the time selection in the Trimmer as needed by dragging the time selection (the area between 
the yellow triangles) on the Trimmer marker bar.

5. Drag the event from the Trimmer to the timeline and allow it to snap into place within the time selection.

Adding selections from a media file with audio and video

You can open a file in the Trimmer that has both audio and video streams (e.g., AVI). When you add a selection from this 
type of file to the timeline, both streams are added:

• If you select a video track before adding the selection, the video is added to the selected track and the associated audio 
is added to the track below it. 

• If you select an audio track before adding the selection, the audio is added to the selected track and the associated 
video is added to the track above it. 

New tracks are created for the added media if necessary.

Adding and saving regions and markers to a media file

The Trimmer allows you to add markers and regions to a media file in the same way that you add them to your project. 
Media file markers and regions are different from project markers and regions. The difference between the two is that 
project markers and regions affect a project, while media file markers and regions are embedded in, and saved with, a 
media file. For more information, see Adding project markers and regions on page 104.

Note: Post-edit rippling (if enabled) applies to clips inserted from 
the Trimmer. For more information, see Editing events on page 89.

Drag from the
Trimmer...

...to a project
track
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The markers and regions you add in the Trimmer are only temporary. You must save them by clicking the Save button 

( ) in the Trimmer window if you want to use them again after you close the project. After the markers and regions are 
added and saved to the media file, they are available when you open the media file in an audio editor program or in the 
Trimmer.

Automatically saving Trimmer markers and regions with media files 

1. From the Options menu, choose Preferences.

2. On the General tab, select Automatically save trimmer markers and 
regions with media file. 

Adding regions as takes

Once regions are saved with a media file, either in the Trimmer window or in another application, you can add the 
regions as takes to the timeline from the Explorer window. In the Explorer window, click the arrow next to the View 
button and select Region View from the drop-down list. A single media file may contain a number of separate regions. 
You can select these regions individually or as groups and insert them as takes into the timeline. This is especially useful 
when loop-recording numerous takes to a single file. For more information, see Working with takes on page 117.

Viewing media markers and regions in events

From the View menu, choose Event Media Markers to toggle the display markers (including XDCAM essence marks) and 
regions that are saved in a media file. These markers are displayed in the timeline in events that refer to the media file.

Media markers and regions cannot be edited within the event. However, when you edit the markers in markers and 
regions in the Trimmer window or in an external audio editor, the event will reflect your changes.

Note: You cannot save markers to read-only media files. Change a file’s properties to make the file writable before saving 
markers.

Tips: 

From the View menu, choose Event Media Markers, and then choose Show Marker Labels from the submenu to toggle 
the display of marker labels in events.

When media markers are displayed, you can use them as snap points for positioning the cursor and for edge-trimming if 
Snap to Markers is selected on the Options menu. If a media file's frame rate does not match your project frame rate, 
frame quantization will occur after the snap if Quantize to Frames is selected on the Options menu. 

Marker Region

Media markers in Trimmer Media markers in event



Opening a file in an external audio editor from the Trimmer

The Trimmer allows you to open your selected audio editing application (e.g., Sound Forge) to perform permanent edits 
to the media file. After you make the necessary changes and save the file in the audio editor, the event is automatically 
updated. Make sure that the media file’s name and location remain the same. For more information, see Using an external 
audio editing program on page 110.

To open the audio editor from the Trimmer, click the Open in Audio Editor button ( ).

Creating a subclip

1. Create a selection in the Trimmer window.

2. Click the Create Subclip button . The Create Subclip dialog is displayed.

3. In the Name box, type the name you want to use to identify the subclip in the Project Media window. For more 
information, see Using the Project Media window on page 44. By default, the file name is used with a subclip number 
appended.

4. Select the Reverse check box if you want the subclip to be played backward when you add it to your project.

5. Click OK to create the subclip. You can then create events from subclip via the Project Media window.

Selecting a subclip in its parent media

1. Right-click a subclip in the Project Media window and choose Open in Trimmer from the shortcut menu.

2. Click the Select Parent Media button  in the Trimmer window. The subclip's original media file is opened in the 
Trimmer, and the portion of the media that represents the subclip is selected. 

Removing red eye from still images

1. Right-click a still image on the timeline (or in the Project Media window) and choose Red Eye Reduction from the 
shortcut menu.

2. Click the center of the red eye and drag to create a selection around the red portion of the eye.

3. Click the  or  buttons to change the magnification of the image, or roll the mouse wheel forward or backward to 
zoom around the cursor position.

4. Drag to position the selection box over the portion of the eye you want to correct.

5. Drag the borders of the selection box to adjust its size. Vegas automatically adjusts the portion of the image in the 
selection box to remove red eye.

Tip: You can also right-click an event in the timeline and choose Create Subclip from the shortcut menu.

Tip: If you want to open the original media file that was used to create the subclip in the Trimmer, right-click an event 
on the timeline (or a subclip in the Project Media window) and choose Open Parent Media in Trimmer from the shortcut 
menu.

Tip: For keyboard shortcuts to help you navigate in the Red Eye Reduction dialog, please see Red eye reduction 
commands on page 29.

Tip: Right-click a selection box and choose Delete from the shortcut menu to remove it.
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6. Readjust the selection box as needed, and repeat this procedure for each red eye in the image.

Using the Edit Details window

The Edit Details window displays a database for all of the media in your project. It shows information about how the files 
are being used and allows you to modify many of those properties. You may sort, add or change information, rearrange 
columns, and edit items in the project.

This window provides an alternate method for working with events, audio CD track list items, command markers, 
markers, and regions after they are placed in your project. 

You can dock the Edit Details window in the window docking area or float it on the workspace. For more information, see 
Window docking area and floating window docks on page 22.

Viewing the Edit Details window

To view the Edit Details window, choose Edit Details from the View menu or press Alt+4. The Show drop-down list allows 
you to view categorized project information. You can edit most entries by double-clicking them or by right-clicking them 
to display a shortcut menu.

Audio CD track list

The Audio CD track list category displays information about the track and index markers placed on the CD layout bar. 
This information is used to burn audio CDs. For more information, see Understanding tracks and indices on page 329.

Commands

The Commands category displays information about commands that are placed along the project’s timeline. This 
category displays four columns: the command’s position along the timeline, the command type, its parameters, and any 
comments that were entered when the command marker was placed in your project. Right-click a command entry to 
display a shortcut menu. For more information, see Working with command markers on page 107.

Events

The Events category displays information about all of the events in your project. You may sort any of the information by 
clicking a column’s header. The number of columns in the Events category requires that you use the scroll bar to view 
them all.

Note: If an image is used multiple times in your project, removing the red eyes once will affect all instances of the image.

Use the scroll bar to view other 

Right-click an
entry to display
a shortcut menu,
or double-click
an entry to edit it.

columns in the window.



The following table explains each column in the Events category and describes its function.

Markers

The Markers category displays information about markers on the project’s timeline. This category displays two columns: 
the marker’s position on the timeline and the marker’s name. For more information, see Working with markers on page 104.

Regions

The Regions category displays information about regions on the project’s timeline. This category displays four columns: 
the region’s start position, end position, length, and name. For more information, see Working with regions on page 105.

Selected Events

The Selected Events category is visually identical to the Events category except that the Edit Details window only 
displays information about events that are selected in your project.

Column Description Edit function
Track Displays the track number where 

the event is located.
Move the event to a different location by entering a different track 
number (pg. 58).

Start Displays when on the timeline the 
event starts playback.

Enter a different value to cause the event to begin playback sooner 
or later in the project (pg. 58).

End Displays when on the timeline the 
event ends playback.

Enter a different value to cause the event to end playback sooner or 
later in the project (pg. 58).

Length Displays the total length of the 
event.

Enter a different value to increase or decrease the event’s playback 
time.

Number of Takes Displays the amount of recorded 
takes contained in the event.

Cannot be edited (display only).

Active Take 
Name

Displays the event’s current take 
name.

Enter a different name for the current take (pg. 118).

Take Start Displays the offset into the source 
media file when the placed event 
begins playback.

Enter a different value to cause the take to playback sooner or later 
from the source media file.

Timecode In Displays the media file timecode 
at the start of the event.

Display only (cannot be edited).

Timecode Out Displays the media file timecode 
at the end of the event.

Display only (cannot be edited).

File Path Displays the path of the event’s 
media file.

Enter a new media file reference path for the event to use.

Tape Name Displays the name of the source 
media tape name.

Change the tape name here or in the properties dialog for the 
media file (pg. 221).

Select Displays whether the event is 
selected in the project.

Toggle the event’s selection by clicking the check box. A check mark 
in the box indicates that the event is selected (pg. 85).

Mute Displays whether the event is 
muted.

Toggle the event’s mute switch by clicking the check box. A check 
mark in the box indicates that the event is muted (pg. 157).

Loop Displays whether the event is 
looped for playback.

Toggle the event’s loop switch by clicking the check box. A check 
mark in the box indicates that the event is looped for playback 
(pg. 157).

Lock Displays whether the event is 
locked.

Toggle the event’s lock switch by clicking the check box. A check 
mark in the box indicates that the event is locked (pg. 157).

Normalize Displays whether the event is 
normalized.

Toggle the event’s normalize switch by clicking the check box. A 
check mark in the box indicates that the event is normalized 
(pg. 158).

Snap Offset Displays when in the event the 
snap offset is positioned.

Enter a different value to change the snap offset position in the 
event (pg. 114).
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Customizing the Edit Details window

You may arrange and delete columns from each category and save the changes to a personal template. One template is 
available from which you may create your own display options.

1. From the Show drop-down list, choose the category that you want to customize.

2. Drag a column’s header to the new position. The cursor changes to a column icon ( ) as you move the column. If 
you want to remove the column from the display, drag the icon off the Edit Details window. Release the mouse to 
drop the column in its new position.

3. The Template drop-down name changes to “Untitled.” Enter a new name in the Template drop-down.

4. Click the Save button ( ) on the Edit Details window to save the custom display.

Tip: You can delete a custom display by selecting it from the template drop-down list and clicking the Delete button 
( ).



Chapter 6
 Working with XDCAM video

You can use MXF files just like any other supported media type. The following sections provide a workflow for efficient 
editing.

Setting up an XDCAM device

Use the following procedure if you need to set up an XDCAM deck or camera for importing clips, replacing proxy files 
with full-resolution clips, or exporting video to an XDCAM device.

1. Click the Device button in the Export Video to XDCAM Disc or XDCAM Disc Transfer dialog. The XDCAM Device 
Settings dialog is displayed.

2. Choose the XDCAM device where you want to import/export clips.

• Select the File Access Mode (i.LINK) radio button if your XDCAM camera or deck is connected directly to your 
computer via an IEEE-1394 cable. In this mode, your camera or deck is accessible much like an external drive.
Click the Browse button and choose the drive letter of the camera or deck.

• Select the FTP (Ethernet) radio button if your camera or deck is connected to your network.
Type the camera or deck's IP address in the IP Address box.

In the Username box, type admin.

In the Password box, type the device/model number of your camera or deck. For example, if you're exporting 
clips to a PDW-1500 deck, type PDW-1500.

3. Click OK.

Note: The XDCAM deck is not available for external monitor or print to tape via iLink® while in file-access mode. Click 
the Safely Remove Hardware icon in the Windows system tray and choose your XDCAM device from the menu to 
disconnect the device. You can then switch to AV/C mode and reconnect to enable external monitor and print to tape 
functionality.

Note: Choose the drive letter of the camera or deck only; do not navigate into the folders on the disc.

Tip: The XDCAM deck is not available for external monitor or print to tape via iLink® while in file-access mode. Using FTP 
transfers allows you to export to a remote device and or use the device's i.LINK connection in AV/C mode for external 
monitor previewing.

Note: For information about using your camera or deck, please refer to its documentation.
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Using the XDCAM Explorer window

From the View menu, choose XDCAM Explorer (or press Ctrl+Alt+F5) to display the XDCAM Explorer window, which you 
can use to locate, import, and export XDCAM clips.

Item Name Description
Disc List Displays a list of all XDCAM discs from which you’ve imported clips. Select a disc name to display its 

clips in the right side of the window.

The imported disc is not associated with the current project. Imported discs are available in the 
XDCAM Explorer window until you delete them from your computer.

Right-click a disc and choose Rename from the shortcut menu to change a disc's name. 

For example, if you’ve written “Joe’s Tire Spot” on your XDCAM disc, you can type that name so you 
don't have to try to identify the disc in the XDCAM Explorer window using its 32-digit identifier.

Contents Pane Displays the clips from the selected disc.

Full-resolution clips are labeled Full, and proxy files are labeled Proxy.

If you’ve transferred proxy files only, you can right-click a proxy file and choose Import Full 
Resolution Files from the shortcut menu to transfer the full-resolution version of the proxy clip to 
your computer. Files are imported to the same folder where you transferred the proxy files.

If you’ve transferred metadata only without transferring clips, no thumbnail is displayed. Right-
click a metadata entry and choose Import Full Resolution Files or Import Proxy Files from the 
shortcut menu.

If the disc contains edit lists that you created on your deck or camera, they are displayed at the 

bottom of the contents pane. Click the down arrow next to the Views button ( ) and choose 

Edit Lists from the menu to show or hide edit lists.
Import XDCAM Disc Click to import clips from an XDCAM disc. You can choose to import proxy-resolution clips, full-

resolution clips, or both. For more information, see Importing XDCAM discs on page 129.

Delete Selected 
XDCAM Disc from 
Capture Folder

Select a disc in the left pane and click this button to delete the disc’s clips from your computer.

Play Clip Click to play the selected clip.

Stop Click to stop playback.

Auto Preview Automatically preview media files when you click them in the Explorer window.



Importing XDCAM discs

You can use the XDCAM Explorer window to import full- or proxy-resolution clips from XDCAM discs to your computer for 
editing.

1. From the View menu, choose XDCAM Explorer to display the XDCAM Explorer window if it isn't already visible.

2. Click the Import XDCAM Disc button ( ) in the XDCAM Explorer window. The Import XDCAM Disc dialog is 
displayed.

Views Click the down arrow and choose a command from the menu to change the way clips are 
displayed in the XDCAM Explorer.
All Essence Marks Displays a separate thumbnail for each essence marker in a clip.
Shot Marks 1 & 2 Displays a separate thumbnail for each shot marker in a clip.
Clips Displays a single thumbnail for each clip.
Custom Displays the Custom Essence Mark Filter dialog. Select the check box for each 

essence mark you want to display as thumbnails, and then click OK to close 
the dialog.
Record Start Created when recording begins and stops.
Record End
Shot Mark 1 Created manually during recording.
Shot Mark 2
Flash Created when a sudden change in brightness occurs.
Filter Change Created when the filter is changed on the camera.
Gain Change Created when the gain value is changed on the camera.
Shutter Speed 
Change

Created when the shutter speed is changed on the camera.

White Balance 
Change

Created when the white balance is changed on the camera.

Over Audio 
Limiter

Created when the audio level exceeds 0 dB.

Edit Lists If you’ve created an edit list on your camera or deck, you can display those edit 
lists in the XDCAM Explorer. Edit lists are displayed in the lower half of the 
XDCAM Explorer.

Right-click an edit list and choose Add to Current Project Using Proxy Files or 
Add to Current Project Using Full Resolution Files from the shortcut menu to 
add the edit list to the timeline at the cursor position.

Conform XDCAM 
Media in Current 
Project

Click to replace proxy-resolution files with full-resolution files before rendering your project or 
exporting your video to an XDCAM disc.

If the full-resolution clips are not available on your computer, the Conform XDCAM Media in 
Current Project dialog is displayed. Insert the specified disc and click Continue to import the full-
resolution clips to your computer.

If you need to choose a different XDCAM device or import method, click the Device button. For 
more information, see Setting up an XDCAM device on page 127.

 Clips are imported if necessary, and the events on the timeline are updated to use the full-
resolution files.

Export Video to 
XDCAM Disc

Click to transfer video to an XDCAM disc in a camera or deck.

You can choose to render the current project to MXF or export an already-rendered MXF file. For 
more information, see Exporting video to XDCAM discs on page 131.

Tips: If you delete XDCAM clips from your computer, those clips will appear offline in your projects. You can reimport the 
clips by right-clicking the clips in the Project Media window and choosing Recapture from the shortcut menu.

The XDCAM deck is not available for external monitor or print to tape via iLink® while in file-access mode. Click the Safely 

Remove Hardware icon ( ) in the Windows system tray and choose your XDCAM device from the menu to disconnect 
the device. You can then switch to AV/C mode and reconnect to enable external monitor and print to tape functionality.

Item Name Description
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3. The XDCAM Device box displays the current XDCAM camera or deck. 

If you need to choose a different XDCAM device or import method, click the Device button. For more information, see 
Setting up an XDCAM device on page 127.

4. In the Clip Resolutions box, select check boxes to indicate which clips you want to import:

• Clear both check boxes if you want to import clip information (metadata) only without importing clips. 
You can import clips later by right-clicking a clip in the XDCAM Explorer and choosing Import Full Resolution 
Files or Import Proxy Files from the shortcut menu.

• Select the All full resolution files check box to import full-resolution clips.
• Select the All proxy resolution files check box to import low-resolution clips for quick timeline editing and 

preview.
If you’re working on a system with limited disk space or processing power, you can edit the smaller proxy files 
on the timeline and replace the proxies with full-resolution files before rendering.

5. The Capture Folder box displays the path to the folder where clips will be imported. Click the Browse button to 
choose a folder.

6. Type a name in the Optional Disc Name box if you want to assign a friendly name to the disc. 

For example, if you’ve written “Joe’s Tire Spot” on your XDCAM disc, you can type that name so you don’t have to try 
to identify the disc in the XDCAM Explorer window using its 32-digit identifier.

7. Click the OK button to start importing clips. The disc label is added to the left pane in the XDCAM Explorer window, 
and the clips are displayed in the right pane.

8. You’re ready to start editing your XDCAM clips on the timeline.

Editing XDCAM clips on the timeline

You can use MXF files just like any other supported media type on the timeline. Depending on your workflow, you may 
want to use proxy or full-resolution files on the timeline.

1. Import the clips from your XDCAM camera or deck to your local hard drive. For more information, see Importing 
XDCAM discs on page 129.

2. Select an imported XDCAM disc on the left side of the XDCAM Explorer window. The imported clips are displayed in 
the right pane. 

If the disc contains edit lists that you created on your deck or camera, they are displayed at the bottom of the 

contents pane. Click the down arrow next to the Views button ( ) and choose Edit Lists from the menu to show 
or hide edit lists.

Note: For information about using your camera or deck, please refer to its documentation.

Notes: Select the Import MXF as multichannel check box on the General tab of the Preferences dialog if you want 
to import MXF files from XDCAM cameras and decks with multichannel audio. When the check box is cleared, audio 
from MXF files will be imported as stereo, but you can access the other channels by right-clicking the event and 
choosing Channels from the shortcut menu.

The imported disc is not associated with the current project. Imported discs are available in the XDCAM Explorer 
window until you delete them from your computer.

Imported clips are not added to the Project Media window. Drag a clip to the timeline to add it to your project or right-
click a clip and choose Add to Project Media List from the shortcut menu.

Tip: Proxy files are much smaller than the full-resolution versions. If you're working on a system with limited disk space or 
processing power, you can edit the smaller proxy files on the timeline and replace the proxies with full-resolution files 
before rendering.

Proxy editing is ideal for storyboarding or rough-cut editing.



3. Drag clips from the XDCAM Explorer window to the timeline if you want to create events, or drag them to the Project 
Media window to add to your project without creating events.

Right-click an edit list and choose Add to Current Project Using Proxy Files or Add to Current Project Using Full 
Resolution Files from the shortcut menu to add the edit list to the timeline at the cursor position.

4. Edit your project as needed.

5. If you’re working with proxy-resolution clips, replace them with full-resolution clips before rendering your project or 
exporting it to an XDCAM disc:

a. Click the Conform XDCAM Media in Current Project button ( ) in the XDCAM Explorer window.

b. If the full-resolution clips are not available on your computer, the Conform XDCAM Media in Current Project 
dialog is displayed. 

c. Insert the specified disc.

If the events on the timeline have been trimmed, you can select the Trim clips to used regions when possible 
check box to import only the portions of the media files required for the events. This option is not available when 
connecting to an XDCAM deck or camera via file access mode (i.Link).

If you need to choose a different XDCAM device or transfer method, click the Device button. For more 
information, see Setting up an XDCAM device on page 127.

d. Click Continue to import the full-resolution clips.

e. Repeat steps 5c and 5d as needed.

Clips are imported to your computer if necessary, and the events on the timeline are updated to use the full-
resolution files.

6. You can now render your project or export it to an XDCAM deck or camera.

Exporting video to XDCAM discs

From the Tools menu, choose Export Video to XDCAM Disc (or click the  button in the XDCAM Explorer window) to 
save your project to a disc in an XDCAM camera or deck.

Exporting video from the timeline

Use this procedure to export the current project to an XDCAM disc.

1. If you want to export only a portion of your project, create a time selection that includes the section of your project.

2. From the Tools menu, choose Export Video to XDCAM Disc (or click the  button in the XDCAM Explorer window). 
The Export Video to XDCAM Disc dialog is displayed.

3. The XDCAM Device box displays the current XDCAM camera or deck. 

If you need to choose a different XDCAM device or transfer method, click the Device button. For more information, 
see Setting up an XDCAM device on page 127.

Note: Essence marks from the MXF files are displayed as named media markers (media markers are visible in the timeline 
events and in the Trimmer window). Choose View > Event Media Markers > Show Markers to toggle their display.

Important: If you are exporting a rendered file to an XDCAM disc, the file must precisely conform to the target disc 
format, or the export will fail.

Note: For information about using your camera or deck, please refer to its documentation.
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4. Choose render settings:

a. Select the Render format radio button. 

b. In the File path box, type the path to the file you want to render, or click the Browse button to browse to the 
folder you want to use and then type a file name. 

This path is used to render an MXF file to your hard drive before transferring to your XDCAM device. You can 
delete the file after the transfer is complete.

c. Select the Enable multichannel mapping check box if you want to map render multiple channels of audio. 

You can click the Channels button if you want to map the busses in your project to channels in the rendered file. 
If you don't specify a channel mapping, Vegas will not render a multichannel file.

• In the Channel Mapping dialog, select the check box for each bus you want to include in the rendered file. Each 
stereo bus will be saved to two channels in the rendered file. If you want to save a bus to a single channel, 
select the (Mono downmix) check box for that bus.

• If you want to change order of the busses in the channel mapping, select the bus and click the Move Up or 
Move Down button.

• Click OK to close the Channel Mapping dialog and return to the Export Video to XDCAM Disc dialog.   

d. From the Template drop-down list, choose the setting that matches your destination disc.

Information about the selected rendering template is displayed in the Description box.

If you choose Default Template, the number of channels will match the number of channels specified in the 
Channel Mapping dialog.

e. Select the Render loop region only check box if you want to export only the portion of your project that you 
selected in step 1.

f. Select the Delete file after print check box if you want to delete the rendered file from your hard drive after 
exporting it to disc. If the export fails, the rendered file remains on disk so you can adjust your XDCAM device 
settings and export again without having to render again.

5. Click OK. Your project is rendered and transferred to your camera or deck.

Exporting a rendered file

Use this procedure when you have a rendered MXF file that you want to save to an XDCAM disc.

1. From the Tools menu, choose Export Video to XDCAM Disc (or click the  button in the XDCAM Explorer 
window). The Export Video to XDCAM Disc dialog is displayed.

2. The XDCAM Device box displays the current XDCAM camera or deck. 

If you need to choose a different XDCAM device or transfer method, click the Device button. For more information, 
see Setting up an XDCAM device on page 127.

3. Choose the file you want to export:

a. Select the Use an existing file radio button. 

b. In the File path box, type the path to the file you want to print, or click the Browse button to choose the file you 
want to print. 

4. Click OK. The selected file is transferred to your camera or deck.

Important: If you are exporting a rendered file to an XDCAM disc, the file must precisely conform to the target disc 
format, or the export will fail.

Note: For information about using your camera or deck, please refer to its documentation.



Chapter 7
 Working with Tracks

Tracks contain the media events on the timeline of a project. There are two types of tracks in a Vegas® project: video and 
audio. Each type of track has its own features and controls. While tracks can be organized and mixed in any order, track 
hierarchy can be important in determining the final output for video. Because tracks are containers for events, effects that 
are applied to a track apply to every event in that track.

Managing tracks

Once you have added a track to your project, you may perform basic editing tasks on it such as duplicating, deleting, and 
renaming.

Inserting an empty track

Tracks are created for you when you drag events to empty spaces in the timeline. You can also add empty (eventless) 
tracks to a project. You can record into these tracks or use them as placeholders for specific media that you will add later. 
For example, you may want to create an empty track and then record a voiceover directly into a project.

1. Right-click in the track view or the track list to display a shortcut menu.

2. Choose Insert Audio Track or Insert Video Track.

You may also add an empty track from the Insert menu by choosing Audio Track or Video Track. An empty track is 
added at the bottom of the track list.

Duplicating a track

You can duplicate a track in your project including all of the events contained on it. When you duplicate a track, the 
duplicate is placed directly below the original track. You can duplicate one track or select multiple tracks to duplicate.

1. Click the track that you want to duplicate. To select multiple tracks, click each one while pressing Shift to select 
adjacent tracks or Ctrl to select nonadjacent tracks.

2. Right-click and choose Duplicate Track from the shortcut menu.

Deleting a track

You can delete a track from your project and all of the events contained on it. You can delete one track or select multiple 
tracks to delete.

1. Select the track that you want to delete. To select multiple tracks, click each one while pressing Shift to select a range 
of adjacent tracks or Ctrl to select discontinuous tracks.

2. From the Edit menu, choose Delete.

Naming or renaming a track

Every track in your project has a scribble strip where you can type a name for the track. The track name may be up to 255 
characters long. If the scribble strip is not visible, you may need to increase the height or width of the track by dragging 
the track’s edge to reveal it. For more information, see Changing track height on page 134. 

1. Double-click the scribble strip. Any existing name is highlighted on the strip. 

2. Type the new track name.

3. Press Enter to save the track’s name.

Tip: You can also delete a track by selecting it and pressing Delete.

Double-click and type track name
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Organizing tracks

Vegas software is flexible in how tracks can be organized. You can arrange and resize tracks to fit your particular needs.

Reordering tracks

When you create tracks, they are arranged in the order that they were added. It is a simple process to reorder tracks to fit 
your needs. You may reorder one or more tracks at a time.

1. In the track list, place the mouse pointer on the track that you want to move.

2. Drag the track to the new position in the track list.

Changing track color

When you add a track, it is automatically assigned a color. This color is easily changed. This feature is useful if you want to 
use color to organize similar tracks. 

1. In the track list, right-click a track to display a shortcut menu.

2. From the shortcut menu, choose Track Display Color, and choose a color from the submenu.

Changing track height

You can control track height by dragging the bottom edge of a track in the track list. You can also change track height by 
clicking the buttons on the track list. 

You can also use several different keyboard shortcuts to change all track heights at once:

• Press Ctrl+Shift+down arrow or Ctrl+Shift+up arrow  to change the height of all tracks in your project at once.
• Press ` to minimize all tracks. Press the key again to restore the tracks to their previous height.
• Press Ctrl+` to make all tracks the default height.

Note: Track hierarchy can be critical in video compositing. For more information, see Compositing on page 229.

Tip: When moving a track, you may want to place the mouse pointer on the track number when dragging. This helps 
avoid accidental modifications to other track list controls.

Tip: To change the available colors, use the Display Tab in the Preferences dialog.

Action Button Resulting Track height
Minimize/Restore 
Track Height

 

Restored Track Height

Maximize/Restore 
Track Height



Resizing a track

You can resize a track by dragging its bottom or right border. Place the mouse pointer at the bottom of the track. The 

cursor turns into an up/down arrow ( ). Drag up or down and release the mouse to set the desired track size. You can 
resize the width of the track list in a similar way.

Using the track list

Each track in your project has its own controls, faders, and sliders that are contained in the track list on the left side of the 
track. You can work with these controls to affect the events on the track.

The controls in the track list can function as trim controls or automation controls for track volume, panning, assignable 
effects send, and bus send levels. Adjusting the trim control affects the level of the entire track.

When a track does not use envelopes (or when the track automation mode is set to Off ), the trim level is added to the 
track fader. For example, setting the track volume fader to +3 dB and the trim control to -3 dB produces a gain of 0 dB.

When a track uses envelopes, the trim level is added to the envelope so your envelope is preserved, but with a boost or 
cut applied. For example, setting the trim control to -3 dB has the same effect as decreasing every envelope point by 3 dB.

To adjust trim levels, click the Automation Settings button  and verify Show Automation Controls is not selected. 
When Show Automation Controls is selected, the volume fader and multipurpose slider adjust automation settings.

Using the volume fader (audio only)

The fader in the track header can function as a trim control that adjusts the overall volume of the track, or it can adjust 
track volume automation settings. For more information, see Volume or pan automation (audio only) on page 144.

The trim level is added to the volume automation settings so your envelope is preserved, but with a boost or cut applied. 
For example, setting the trim control to -3 dB has the same effect as decreasing every envelope point by 3 dB.

1. Click the Automation Settings button  and verify Show Automation Controls is not selected.

2. Drag the Vol fader to control how loud a track is in the mix. If multiple tracks are selected, all selected tracks are 
adjusted. 

As you drag the fader, the volume level displays to the left of the fader. Double-click the fader to set it to 0.0 dB, or 
double-click the current volume value to enter a specific number.

Note: The Automation Settings button is not available in Vegas Movie Studio and Vegas Movie Studio Platinum 
software. In these versions of the software, the Volume and Pan controls in the track header always function as trim 
controls for track volume or panning envelopes.

Note: The Automation Settings button is not available in Vegas Movie Studio and Vegas Movie Studio Platinum 
software. In these versions of the software, the Volume control in the track header always functions as a trim control for 
track volume envelopes.

Drag to change track height... ...or to change track list width.
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Volume envelopes allow you to automate track volume changes. For more information, see Volume or pan automation 
(audio only) on page 144.

Using the multipurpose slider (audio only)

This slider controls several features, including panning, bus send 
levels, and assignable effects send levels. The options for the 
multipurpose slider depend on what your project contains (e.g., 
busses, assignable effects, etc.). You can select what the slider 
controls by clicking the slider label. Each item’s slider position is 
independent from the others.

Adjusting stereo panning

The multipurpose slider in the track header can function as a trim control that adjusts the overall panning of the track, or 
it can adjust track panning automation settings. For more information, see Adjusting volume or pan automation settings on 
page 144.

The trim level is added to the pan automation settings so your envelope is preserved, but with a boost or cut applied. For 
example, setting the trim control to -9% left has the same effect as moving every envelope point 9% to the left.

1. Click the Automation Settings button  and verify Show Automation Controls is not selected.

2. Drag the Pan slider to control the position of a track in the stereo field. If multiple tracks are selected, all selected 
tracks are adjusted. 

Tip: Press Ctrl while dragging or use the mouse wheel for finer control of the fader. You can also move the fader by using 
the right or left arrow keys.

Tips: If you do not see this slider on a track, increase the track height. For more information, see Resizing a track on page 
135.

You can move the slider by pressing Shift+the right or left arrow keys.

Note: The Automation Settings button is not available in Vegas Movie Studio and Vegas Movie Studio Platinum 
software. In these versions of the software, the Pan control in the track header always functions as a trim control for track 
panning envelopes.

Double-click the fader
to set to 0.0 dB.

Drag to change volume. Double-click the current level to
enter a value.

Click the slider

a control
label to select



You can further control the panning by right-clicking the multipurpose slider and selecting an option from the shortcut 
menu:

• The Add Channels panning model is most useful for panning stereo 
source material. This model makes the stereo image appear to move 
as a unit between the speakers. As the fader is moved from the 
center to a side, more and more of the signal from the opposite side 
is folded into the side you are panning towards, until at the extreme, 
both channels are fed at full intensity into a single channel. This 
panning model uses a linear panning curve.

• The Balance panning model is most useful for adjusting the relative 
signal levels of the right and left channels in stereo source material. 
In this model, moving from the center to a side, the opposite side 
starts at a base dB level (either 0 dB, -3 dB, or -6 dB) and decays to no 
signal level. The signal in the side you are panning towards starts at the base dB level (either 0 dB, -3 dB, or -6 dB) and 
increases to 0 dB. This panning model uses a linear panning curve.

• The Constant Power panning model is most useful for panning mono source material. As you move the fader from side 
to side, this model creates the illusion of the source moving around the listener from one side to the other in a semi-
circle. This model uses a constant-power panning curve.

You can add a pan envelope to automate panning changes. For more information, see Composite level automation (video 
only) on page 147.

Assigning audio tracks to assignable effects chains

Assignable effects chains are made up of one or more plug-ins that are used to add audio effects to a track’s signal. You 
can adjust the level of a track that is sent to an assignable effects chain using the multipurpose slider in the track list. The 
multipurpose slider can function as a trim control that adjusts the overall assignable effects send level for the track, or it 
can adjust assignable effects automation settings. For more information, see Adjusting assignable effects automation levels 
on page 145. 

1. Click the Automation Settings button  and verify Show Automation 
Controls is not selected. 

2. Click the label on the multipurpose slider to display a drop-down list.

3. Choose the assignable effects chain that the track will use.

4. Drag the slider to adjust the level of the track sent to the assignable effects 
chain.

Assigning audio tracks to busses

If your project contains multiple busses, you can assign a track to a specific bus.

1. Click the Bus button ( ) in the track list to display a drop-down list of available busses. This button appears only if 
the project contains multiple busses. For more information, see Adding busses to a project on page 169.

2. From the drop-down list, choose the bus for the track’s output.

Note: Assignable effect sends are post-volume by default. To change to pre-volume, right-click the multipurpose 
slider and choose Pre Volume from the shortcut menu.

Select a bus 
for playback
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Adjusting bus send levels

When a track is routed to a bus, you can control the level of tracks sent to the bus using the multipurpose slider. The 
multipurpose slider in the track header can function as a trim control that adjusts the overall send level of the track, or it 
can adjust bus send automation settings. For more information, see Adjusting bus automation levels on page 146.

1. Click the Automation Settings button  and verify Show Automation Controls is not selected. 

2. Click the label on the multipurpose slider and choose an assignable effects 
chain from the menu. 

3. Drag the FX fader to control the level of the track sent to each of the assignable FX 
chains that you have created. Dragging the fader to the left cuts the volume; 
dragging to the right boosts the volume. 

You can hold Ctrl while dragging a fader to adjust the setting in finer increments, or 
double-click the fader to return it to 0 dB.

If multiple tracks are selected, the trim level of all selected tracks is adjusted.

For more information, see Adjusting a bus send level on page 172 or Assigning audio tracks to assignable effects chains on page 
174.

Adjusting the composite level (video only)

The Level slider in the track header determines the opacity of the video track. The slider can function as a trim control 
that adjusts the overall opacity of the track, or it can adjust track composite level automation settings. For more 
information, see Adjusting the composite level automation settings on page 148.

The trim level is added to the composite level automation settings so your envelope is preserved, but with a boost or cut 
applied. For example, setting the trim control to -3% has the same effect as decreasing every envelope point by 3%.

1. Click the Automation Settings button  and verify Show Automation Controls is not selected. 

2. Drag the slider to control the transparency or blending of each track. Left is 
100% transparent and right is 100% opaque. You can also double-click the 
percent to enter a specific value.

Selecting the compositing mode

Click the Parent Overlay Mode or Compositing Mode button and choose a mode 
from the menu to determine how the transparency in a video track is generated. 
Since lower tracks show through higher tracks, it is the compositing mode of the 
higher track that determines how much of the lower track shows though. The 
compositing mode of the lowest video track adjusts its transparency against the 
background.

For more information, see Compositing on page 229.

Bypassing motion blur envelopes (video only)

If you applied a motion blur envelope to your video bus track, this envelope affects all tracks. You can select specific 

tracks to bypass this envelope by clicking a track’s Bypass Motion Blur button ( ). For more information on motion blur 
envelopes, see Adding a motion blur envelope on page 148.

Note: Bus sends are pre-volume by default. To change to post-volume, right-click the multipurpose slider and 
choose Post Volume from the shortcut menu.

Parent Overlay Mode

Compositing Mode



Using track motion (video only)

Use the Track Motion button ( ) to move a video track over another track (i.e., picture-in-picture). For more information 
on adding track motion, see Adding track motion on page 258.

Phase inverting a track (audio only)

The Invert Track Phase button ( ) inverts the audio track at its baseline, in effect reversing its polarity. Inverting a track, 
while creating little audible difference, is occasionally useful for matching transitions when mixing audio on separate 
tracks or fine-tuning a crossfade. 

You can also phase invert an audio event. If an event on a track is inverted and you invert the track, the event is doubly-
inverted (restored to its original state). For more information, see Invert phase (audio only) on page 158.

Muting a track

The Mute button ( ) in the track list temporarily suspends playback of the track so that you can focus on another track. 
When a track is muted, it appears grayed out on the track view. You can mute more than one track at a time. The Mute 
button can mute a track or change its mute automation state. For more information, see Mute automation (audio and 
video) on page 143.

To mute a track, click the Automation Settings button  and verify Show Automation Controls is not selected. Next, 
click the Mute button. 

To mute several tracks, select the tracks and click the Mute button on any of the selected tracks. Click the Mute button 
again to restore the track(s).

When you have multiple levels of parent and child tracks, clicking the Mute button on a 
parent track mutes the parent track and its compositing children.

In the sample track list, muting track 1 will mute tracks 1 through 6. Muting track 4 will 
mute tracks 4 through 6.

Muting all audio or video tracks

You may mute either all audio or all video tracks in a project. From the Options menu, 
choose Mute All Audio or Mute All Video.

Tip: Press Ctrl and click the Mute button to mute only the selected track (and restore any other muted tracks). If the 
selected track is already muted, press Ctrl and click the Mute button to restore all tracks.
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Soloing a track

The Solo button ( ) in the track list isolates a track’s events for playback. This allows you to focus on a track’s contents 
without the distraction of other tracks. You can solo more than one track at a time.

To solo a track, click the Solo button on that track. To solo several tracks, select the tracks 
and click the Solo button on any of the selected tracks. Click the Solo button again to 
restore the track(s) for playback.

When you have multiple levels of parent and child tracks, clicking the Solo button on a 
parent track solos the parent track and its compositing children. Other nonsoloed tracks 
at the same compositing level are bypassed.

In the sample track list, soloing track 1 will solo tracks 1 through 6.

Soloing track 4 will solo tracks 4 through 6. Tracks 2 and 3 are bypassed, and tracks 1 and 
7 play normally.

Setting default track properties

You can use the settings of a selected track to determine the 
default settings for all new tracks in your project. Properties that 
can be set appear in the Set Default Track Properties dialog.

1. Set up a track in your project with the properties to use as 
default settings for new tracks.

2. Right-click the track number and choose Set Default Track 
Properties. The Set Default Track Properties dialog 
appears. 

3. Select the check boxes that you want to set as defaults.

4. Click OK.

Any new tracks created in the project will have these defaults. 
To return to the original settings for new tracks, select the Restore original defaults check box in the Set Default Track 
Properties dialog.

Track automation envelopes

Track automation envelopes allow you to control volume, audio panning, opacity, and fade to color effects of a particular 
track over time. For more information, see Working with track envelopes on page 149.

Using audio bus tracks

From the View menu, choose Audio Bus Tracks to toggle the display of audio bus tracks at the bottom of the track view. 
An audio bus track exists for each bus or assignable effects chain in your project and serves as a timeline representation 
of each bus or assignable effects chain.

You can use bus tracks to automate volume, panning, and effect parameters using envelopes. For more information, see 
Bus automation (audio only) on page 145.

Adding envelopes to an audio bus track

Adding volume, panning, and effect automation envelopes to a bus track is just like adding an envelope to a standard 
track. For more information, see Composite level automation (video only) on page 147.

Tip: Press Ctrl and click the Solo button to solo only the selected track (and restore any 
other soloed tracks). If the selected track is already soloed, press Ctrl and click the Solo 
button to restore all tracks.



Adding effects to audio bus tracks

Click the Bus FX button ( ) in the bus track header to add or edit bus effects. If there are no effects on the bus, clicking 
this button displays the Plug-In Chooser. If an audio bus already has effects assigned, clicking this button displays the 
Audio Plug-In window.

Clicking this button has the same effect as clicking the button on a bus control in the Mixer window or the Video Preview 
window.

If the bus effects chain includes plug-ins with automatable parameters, the Bus FX button is displayed as a .

Muting or soloing an audio bus track

Click the Mute ( ) or Solo ( ) button in the bus track header to mute or solo a bus.

Clicking these buttons on a bus track has the same effect as clicking the buttons on a bus control in the Mixer window.

Resizing audio bus tracks

You can drag the horizontal splitter between the track list and bus tracks to increase or decrease the space allocated to 
bus tracks. Perform any of the following actions to resize individual bus tracks:

• Drag a bus track's bottom border to set its height.
• Click Minimize ( ) to minimize a track vertically.
• Click Maximize ( ) to zoom in vertically so a bus track fills the lower portion of the timeline.
• After minimizing or maximizing a bus track, click either button again to return a bus track to its previous height.
• Press Ctrl+Shift+up arrow /down arrow  when the bus track area has focus to resize all bus tracks at once.

Using video bus tracks

From the View menu, choose Video Bus Track to toggle the display of the video bus track at the bottom of the track 
view. A single bus track exists as a timeline representation of the main video output.

You can use bus tracks to animate video output effects using keyframes, add motion blur envelopes, or video 
supersampling envelopes.

Adding keyframes to the video bus track

Adding keyframes to the video bus track is just like working with any other video track. Use video bus track keyframes to 
animate video output effects. For information on adding keyframes, see Using keyframe animation on page 250.

Adding envelopes to the video bus track

You can add fade-to-color, motion blur amount, and video supersampling envelopes to the video bus track to affect your 
video output. For more information, see Working with track envelopes on page 149.

Adding effects to video bus tracks

Click the Video Output FX button ( ) in the bus track header to add or edit video output effects. If there are no video 
output effects, clicking this button displays the Plug-In Chooser. If you've already set up video output effects, clicking the 
button displays the Video Output FX window.

Muting the video output

Click the Mute button ( ) in the bus track header to mute all video output. 
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Bypassing video effects and envelopes

Click the Bypass FX and Envelopes button ( ) in the bus track header to bypass all video output effects and bus track 
envelopes.

Resizing video bus tracks

You can drag the horizontal splitter between the track list and bus tracks to increase or decrease the space allocated to 
bus tracks. Perform any of the following actions to resize individual bus tracks:

• Drag a bus track's bottom border to set its height.
• Click Minimize ( ) to minimize a track vertically.
• Click Maximize ( ) to zoom in vertically so a bus track fills the lower portion of the timeline.
• After minimizing or maximizing a bus track, click either the Minimize or Maximize button again to restore a bus track 

to its previous height.
• Press Ctrl+Shift+up arrow /down arrow  when the bus track area has focus to resize all bus tracks at once.

Rendering to a new track

Rendering or mixing multiple tracks to a single track can be a good method of decreasing the complexity of a project and 
speeding up future renders. The original tracks and their events are unaffected when you render (mix) to a single track.

Typically, you would use this feature when you are finished refining a few tracks and want to combine them. When you 
render multiple tracks, any envelope or track effects that you have applied are rendered into the new track. The original 
source files remain unaffected and the new track(s) are saved to a new file.

When working with DV files, select a DV template to avoid any loss of quality. For more information, see Working in DV 
format on page 215.

1. Click the Solo button ( ) for the tracks that you want to mix down. If no tracks are soloed, the rendered track will 
match the Master Bus output. Create a time selection if you want to mix down a portion of your project.

Video tracks will be rendered into a single video track, and audio tracks will be rendered into a single stereo audio 
track.

2. From the Tools menu, choose Render to New Track or press Ctrl+M. The Render to New Track dialog appears.

3. Complete the dialog as follows:

• From the Save in drop-down list, select the drive or folder to save the new media file.
• Type a file name in the File name box.
• From the Save as type drop-down list, choose the file format (e.g., .wav for audio or .avi for video).
• From the Template drop-down list, choose a format from the template list. Alternately, click Custom to set 

custom rendering settings. For more information, see Customizing the rendering process on page 288.
• Select Render loop region only if you only want to render the time selection area.
• Select Stretch video to fill output frame size (do not letterbox) to adjust the aspect ratio so the output frame is 

filled on all edges. When the check box is cleared, the current aspect ratio is maintained and black borders are 
added to fill the extra frame area (letterboxing).

4. Click Save to render to a new track.

As the tracks are being rendered (mixed down), a small dialog appears displaying the progress of the render. A status 
bar also appears in the lower-left portion.

After the new track is rendered, it appears at the top of the track view. If you render the entire project, you may 
delete (or mute) the other tracks from the project, since they are all contained on the new track.

Note: Every video render that uses compression results in a loss of quality from the original source material. To minimize 
loss of quality, minimize the number of video renders that use compression.

Tip: You can cancel the rendering process by clicking the Cancel button on the status bar.



Chapter 8
 Using Automation

Automation allows you to control audio and video levels, panning, and effect parameter automation over time. You can 
create fades, apply stereo panning, and vary effect parameters throughout your project. Automation is represented on 
the Vegas® timeline as an envelope or set of keyframes. You can create automation by adding envelopes or keyframes to 
your tracks (including bus tracks), or you can record automation parameters by adjusting controls in the Vegas interface 
(or on a control surface) during playback.

Showing or hiding automation controls

The controls in the track list can function as trim controls or automation controls for track volume, panning, assignable 
effects send, and bus send levels. Adjusting the trim control affects the level of the entire track.

To display trim controls in the track header, click the Automation Settings button  and select Show Automation 
Controls.

Track automation

Track automation will always affect all events on the track. This means that any event envelopes will be calculated after 
the track automation. For more information, see Using audio event envelopes (ASR) on page 161.

Mute automation (audio and video)

Mute automation changes a track’s mute state throughout your project. Mute automation is either on or off with no fade 
between. If you want to use fades, apply volume automation.

When you apply mute automation to a track, it’s possible to have a track that is muted and soloed simultaneously. The 
mute state overrides the solo state:

• If a track’s Solo button is selected, the track is included in the solo group, but it will be muted whenever the mute 
automation is set to mute the track.

• If the track’s Mute button is selected, the track is muted regardless of the mute automation settings.

Adding or removing mute automation

1. Select a track.

2. From the Insert menu, choose Audio Envelopes or Video Envelopes, or right-click in the track list and choose 
Insert/Remove Envelope from the shortcut menu. 

3. From the submenu, choose Mute. A check mark is displayed next to the command, and an envelope is added to the 
timeline. 

4. You can adjust the automation by editing the envelope in the timeline or by using the Mute button  in the track 
header when Show Automation Controls is selected. 

Tip: Choose a fade type from the Audio default drop-down list on the Editing tab of the Preferences dialog to set the 
default fade type that will be used when you add volume and panning envelopes. This setting is used only when you create 
new envelopes—when you add a point to an existing envelope, the new point always uses the same fade type as the 
preceding envelope point. Also, this setting is not used for event envelopes.
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Adjusting mute automation settings 

1. Click the Automation Settings button  and select Show Automation Controls. The Mute button is displayed as 
.

2. Click the Mute button to change the track's mute automation state.

The button behaves differently depending on the track automation recording mode:

• When the track automation mode is set to Off, the button mutes the entire track.
• When the track has a mute envelope and the track automation mode is set to Read, the button changes state to 

reflect the envelope setting during playback but cannot be adjusted.
• When the track has a mute envelope and the track automation mode is set to Touch or Latch, the button edits 

the envelope setting at the cursor position.

If you click the Mute button  during playback, the behavior varies depending on the selected automation 
recording mode. For more information, see Automating 5.1 surround projects on page 153.

Volume or pan automation (audio only)

You can change a track’s volume or position in the stereo field throughout a project using automation envelopes. 

Adding or removing volume or pan automation

1. Select an audio track.

2. From the Insert menu, choose Audio Envelopes, or right-click in the track list and choose Insert/Remove Envelope 
from the shortcut menu.

3. From the submenu, choose Volume or Pan. A check mark is displayed for the automation types that are used on the 
selected track.

4. If you want to change the track’s volume or pan setting throughout the track, edit the envelope in the timeline.

Adjusting volume or pan automation settings

1. If you want to change volume or pan settings by recording automation, click the Automation Settings button  
and select Show Automation Controls. The fader/slider handle is displayed as a  in automation mode.

2. Drag the Vol fader to control how loud a track is in the mix or drag the Pan slider to control the position of the track 
in the stereo field.

The fader and the slider behave differently depending on the track automation recording mode:

• When the track automation mode is set to Off, the fader adjusts the volume of the entire track and the slider 
pans the entire track. In this mode, the automation control acts as a second trim control.

• When the track has a volume envelope and the track automation mode is set to Read, the fader/slider will follow 
the envelope during playback but cannot be adjusted.

• When the track automation mode is set to Touch or Latch, the fader/slider edits the envelope setting at the 
cursor position. If the track does not have a volume/pan envelope, an envelope will be added when you adjust 
the fader/slider.

If multiple tracks are selected, all selected tracks are adjusted. 

If you adjust the fader/slider during playback, the behavior varies depending on the selected automation recording 
mode. For more information, see Automating 5.1 surround projects on page 153.

Assignable effects automation (audio only)

You can use assignable effects automation to vary the level of a track sent to an assignable effects chain. 

Note: Panning envelopes will use the current panning mode for the Pan slider in the track list. For more information, see 
Adjusting stereo panning on page 136.



Adding or removing assignable effects automation

Before you can add an assignable effects envelope, you'll need to add an assignable effects chain to your project. For 
more information, see Creating an assignable effects plug-in chain on page 176.

1. Select an audio track.

2. From the Insert menu, choose Audio Envelopes, or right-click in the track list and choose Insert/Remove Envelope 
from the shortcut menu.

3. From the submenu, choose the effects chain where you want to send the selected track. A check mark is displayed 
for each assignable effects chain that is automated for the selected track. 

Adjusting assignable effects automation levels

1. Click the Automation Settings button  and select Show Automation Controls. The fader handle is displayed as a 
 in automation mode.

2. Click the label on the multipurpose slider and choose an assignable effects chain from the menu. 

3. Drag the FX fader to control the level of the track sent to each of the assignable FX chains that you have created. 

The fader behaves differently depending on the track automation recording mode:

• When the track has an assignable effects envelope and the track automation mode is set to Off, the fader 
adjusts the send level of the entire track. In this mode, the automation control acts as a second trim control.

• When the track has an assignable effects envelope and the track automation mode is set to Read, the fader will 
follow the envelope during playback but cannot be adjusted.

• When the track has an assignable effects envelope and the track automation mode is set to Touch or Latch, the 
fader edits the envelope setting at the cursor position. If the track does not have an envelope, one will be 
created when you adjust the fader.

If multiple tracks are selected, all selected tracks are adjusted. 

If you adjust the fader during playback, the behavior varies depending on the selected automation recording mode. For 
more information, see Automating 5.1 surround projects on page 153.

Bus automation (audio only)

You can use bus automation envelopes to vary the level of a track sent to a bus.

Adding or removing a bus automation envelope

Before you can add a bus envelope, you'll need to specify the number of busses for your project.

1. Select an audio track.

2. From the Insert menu, choose Audio Envelopes, or right-click in the track list and choose Insert/Remove Envelope 
from the shortcut menu.

3. From the submenu, choose the bus where you want to send the selected track. A check mark is displayed for each 
bus send level that is automated for the selected track.
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Adjusting bus automation levels

1. Click the Automation Settings button  and select Show Automation Controls. The fader handle is displayed as a 
 in automation mode.

2. Click the label on the multipurpose slider and choose a bus from the menu.

3. Drag the fader to control the level of the track sent to each of the assignable FX chains that you have created. 
Dragging the fader to the left cuts the volume; dragging to the right boosts the volume. 

The fader behaves differently depending on the track automation recording mode:

• When the track automation mode is set to Off, the fader adjusts the send level of the entire track. In this mode, 
the automation control acts as a second trim control.

• When the track has a bus envelope and the track automation mode is set to Read, the fader will follow the 
envelope during playback but cannot be adjusted.

• When the track has a bus envelope and the track automation mode is set to Touch or Latch, the fader edits the 
envelope setting at the cursor position. If the track does not have an envelope, one will be created when you 
adjust the fader.

If multiple tracks are selected, all selected tracks are adjusted. 

If you adjust the fader during playback, the behavior varies depending on the selected automation recording mode. For 
more information, see Automating 5.1 surround projects on page 153.

Adding or removing track effect automation

If a plug-in supports automation, you can dynamically adjust effect parameters over time.

Adding or removing effect automation envelopes

If a plug-in supports automation, you can use envelopes to adjust effect parameters over time. The appearance of the 

plug-in in the Plug-In Chooser window indicates whether the plug-in supports automation. Plug-ins with this icon ( ) 

support automation, while plug-ins with this icon ( ) do not. In addition, you can quickly locate plug-ins that support 
automation in the Automatable subfolder.

1. Click the Track FX button ( ) on a track to open the Audio Plug-In window.

If no track effects exist, clicking the Track FX button displays the Plug-In Chooser. Use the Plug-In Chooser to create 
an effect chain including an automatable plug-in.

2. Click the Configure FX Automation button ( ) to display the FX Automation Chooser.

3. Click a plug-in at the top of the FX Automation Chooser. A list of the effect’s automatable parameters appears.

4. Select the check box for each parameter that you want to control with an envelope. You can use the Select All and 
Select None buttons to quickly change your selections to all or none of the parameters.

Note: If you're working with a 5.1 surround project, you can select the Enable check boxes to determine which 
channels will be affected by the plug-in. An automation envelope is added to the timeline for each selected channel so 
you can enable or bypass the plug-in during the project. If you want to use distinct plug-in settings for each channel 
(separate EQ settings for the front and surround speakers, for example), you can add multiple instances of the plug-in 
to the track effects chain and select the Enable check boxes for the channels you want each instance of the plug-in to 
affect.



5. Click OK to close the FX Automation Chooser. 

Envelopes are displayed on the track for parameters that you selected in the FX Automation Chooser. To control 
which effect parameter envelopes are displayed on the track, click the arrow adjacent to the Track FX button ( ) 
and choose an envelope from the menu.

Adjusting effect automation settings

You can adjust automated effect parameters by editing the envelopes in the timeline or by recording automation with 
the controls in the Audio Plug-In Window.

If you’ve enabled the Bypass parameter for a plug-in, you can click the Bypass button in the plug-in's banner to toggle 
the Bypass envelope at the cursor position.

Composite level automation (video only)

You can use the composite level automation envelopes to adjust the opacity of a track over time.

Adding or removing composite level automation 

1. Select a video track.

2. From the Insert menu, choose Video Envelopes, or right-click in the track list and choose Insert/Remove Envelope 
from the shortcut menu.

3. Choose Track Composite Level from the submenu or shortcut menu.

4. You can adjust the envelope by editing the envelope in the timeline or by adjusting the slider in the track header 
when Show Automation Controls is selected.

Tip: Press E to toggle through the display of all effect parameter automation envelopes.

Note: When you automate an effect’s frequency parameter, such as the frequency parameters in the track EQ effect, you 
may notice that the frequency changes are more apparent when moving through the lower frequencies. This is because 
frequency scales in track EQ and other plug-ins use a logarithmic scale, but effect automation uses linear interpolation. To 
make the automated frequency changes sound more natural, change the fade curve types to change the interpolation 
rates between envelope points. For high-to-low frequency sweeps, use a fast fade curve; for low-to-high frequency sweeps, 
use a slow curve. For more information, see Changing envelope fade curves on page 151.
USING AUTOMATION | 147



148 | CHAPTER 8
Adjusting the composite level automation settings

1. Click the Automation Settings button  and select Show Automation Controls. The slider handle is displayed as a 
 in automation mode.

2. Drag the slider to control the transparency or blending of each track. Left is 
100% transparent and right is 100% opaque. You can also double-click the 
percent to enter a specific value.

• When the track automation mode is set to Off, the slider adjusts the send 
level of the entire track. In this mode, the automation control acts as a second trim control.

• When the track has a composite level envelope and the track automation mode is set to Read, the slider will 
follow the envelope during playback but cannot be adjusted.

• When the track has a composite level envelope and the track automation mode is set to Touch or Latch, the 
slider edits the envelope setting at the cursor position. If the track does not have an envelope, one will be 
created when you adjust the slider.

If multiple tracks are selected, all selected tracks are adjusted. If you adjust the slider during playback, the behavior 
varies depending on the selected automation recording mode. For more information, see Automating 5.1 surround 
projects on page 153.

Adding a motion blur envelope

Motion blur can help you make computer-generated animation look more realistic. For example, if you use track motion 
or event pan/crop to move a clip across the frame, each frame is displayed clearly when no motion blur is applied. 
Turning on motion blur adds a motion-dependent blur to each frame to create the appearance of smooth motion in the 
same way a fast-moving subject is blurred when you take a photograph with a slow shutter speed.

1. Right-click the video bus track, choose Insert/Remove Envelope from the shortcut menu, and then choose Motion 
Blur Amount from the submenu.

2. Add and adjust envelope points as necessary to set the time interval that will be used for blurring. Increasing the 
value emphasizes the blur effect. For example, setting the envelope to 0 means no blurring will occur; setting the 
envelope to 1 second means that each frame will be blurred for one-half second before and after the frame.

3. The motion blur envelope affects all tracks. To bypass motion blur for a track, select the Bypass Motion Blur button 
( ) in the track header.

4. To change blur type, choose a setting from the Motion blur type drop-down list on the Video tab in the Project 
Properties dialog. This setting determines the shape of the blur and the opacity of the frames.

Adding a video supersampling envelope

Video supersampling can improve the appearance of computer-generated animation by calculating intermediate frames 
between the project’s frame rate, allowing you to create smoother motion blurring or motion from sources such as track 
motion, event pan/crop, transitions, or keyframable effects.

1. Right-click the video bus track, choose Insert/Remove Envelope from the shortcut menu, and then choose Motion 
Blur Subsampling from the submenu.

Note: Motion blur significantly increases your rendering time. Adjust the envelope to apply motion blur only where 
necessary.

Note: The effect of video supersampling is less apparent with video that contains fast motion, and supersampling 
cannot improve the appearance of existing video.



2. Add and adjust envelope points as necessary to indicate how many frames will be calculated between frames (using 
the project’s frame rate) to create the blur.

Working with track envelopes

Envelopes represent volume, audio panning, opacity, and fade to color automation settings in the timeline.

Adding envelope points

Once you add an envelope to a track, you may add points to it. These points are used to edit the envelope line in order to 
automate the control.

1. Place the mouse pointer on the envelope’s 
line. The pointer changes to a hand icon ( ).

2. Right-click and choose Add Point from the 
shortcut menu or double-click to add an 
envelope point. A square point appears on the 
envelope line.

Note: Video supersampling significantly increases your rendering time. For example, when you set the video 
supersampling envelope to 2, Vegas software renders twice as many frames as it would without supersampling. Adjust the 
envelope to apply supersampling only where necessary.

Track Type Envelope type Description Color

Audio Volume Controls track volume. Blue

Audio Bus send volume Controls track level sent to bus. Lilac

Audio Assignable effects send 
volume

Controls track level sent to assignable effects control. Green

Audio Pan Controls the position of a track in the stereo field (pan). Red

Video Composite level Controls track opacity/transparency. Blue

Video Fade to color Controls fading of a track to color. Designate a top and 
bottom color by right-clicking the track, choosing Fade 
Colors from the shortcut menu, and choosing Top or 
Bottom from the submenu.

Red

Video bus Motion blur Adds a motion-dependent blur to each frame to 
smooth computer-generated animation.

Lilac

Video bus Video supersampling Calculates intermediate frames between the project 
frame rate to create smooth motion blurring.

Rust

Tip: You can use ripple editing to automatically 
move envelope points as you edit in the timeline. 
For more information, see Applying post-edit 
ripples on page 99.
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Drawing envelope points

To create an envelope quickly, you can draw freehand envelope curves in the timeline.

1. With the Normal Edit  or Envelope  tool active, hover over an envelope.

2. Hold Shift, and then click and drag over the envelope. As you drag, a trail of envelope points is created.

3. Release the mouse button when you’re finished drawing.

If the Smooth and thin automation data after recording or drawing check box is selected on the External Control 
& Automation tab of the Preferences dialog, the number envelope points will be reduced when you release the 
mouse.

Thinning envelope points

Thinning envelope points decreases the number of points on an envelope while retaining the envelope’s overall settings. 
Right-click an envelope and choose Thin All Points from the shortcut menu to thin the entire envelope.

To apply thinning to a section of the envelope, create a time selection, right-click the envelope, and then choose Thin 
Selected Points from the shortcut menu.

Deleting envelope points

You can delete a point by right-clicking it and choosing Delete from the shortcut menu. If you want to delete all envelope 
points, right-click a point and choose Reset All from the shortcut menu.

Moving envelope points

Once you have added envelope points, you can raise and lower them to different levels along the timeline, or you can 
adjust the envelope’s location along the timeline by dragging it right or left. You can move one point at a time, even 
during playback and check the results in real time. If snapping is enabled, the envelope point snaps to time divisions as 
you drag. Hold Shift while dragging to override snapping.

1. Place the mouse pointer on an envelope point. The pointer changes to a hand icon ( ).

2. Drag the point to the desired position. As you move an envelope point, a ToolTip displays both the point’s location 
on the timeline and its decibel level/percent pan.

Note: Thinning is intended to reduce the number of envelope points created through automation recording and will 
have little or no effect if you create envelopes by adding and editing points manually.

Tip: You can move multiple envelope points at once using the Envelope Edit tool. For more information, see Using the 
Envelope Edit tool on page 152.

Unthinned envelope

Thinned envelope



3. Click the Play ( ) or Play From Start ( ) button to play the project and check the timing of the envelope.

Changing envelope fade curves

You can set the type of fade curve used after each envelope point: linear, fast, slow, smooth, or sharp. You can select 
either a point or a portion of the envelope to set the fade curve. If you select a portion of the envelope, the fade curve is 
applied to that envelope segment. If you select a point, the fade curve is applied to the segment of the envelope after the 
selected point. 

1. Right-click a point or a portion of the envelope to display a shortcut menu.

2. From the shortcut menu, choose the curve type.

Hiding track envelopes

After you have set your envelopes on the tracks, you can hide them from the track view. Hiding track envelopes does not 
affect playback. The points that you set still automate the controls, even though the envelopes are not visible.

1. From the View menu, choose either Audio Envelopes or Video Envelopes. A submenu appears. Envelopes that are 
currently displayed are selected in the submenu.

2. From the submenu, choose an envelope name. All envelopes in your project of that type no longer appear in the 
track view.

If you’ve added effect automation envelopes to a track, the track can get cluttered. Click the down arrow next to the 
Track FX button  and choose an envelope from the drop-down list to select which envelope you want to 
display.

Removing track envelopes

When an envelope is removed, the events on the track no longer have automated control and the envelope line no 
longer displays.

1. Select the track(s) from which you want to remove envelopes.

2. From the Insert menu, choose either Audio Envelopes or Video Envelopes. A submenu appears. Envelopes that are 
currently displayed are selected.

3. From the submenu, click an envelope name. The envelope of that type is removed from the selected track.

Alternatively, right-click an empty area of a track, choose Insert/Remove Envelope from the shortcut menu, and choose 
an envelope type from the submenu to remove that envelope.

Tip: You can also set the value of the point by right-clicking an envelope point and choosing a setting from the shortcut 
menu. 

Tip: If you use the same fade curve frequently, you can set it as a default all new audio or video envelopes. For more 
information, see Editing tab on page 322.

Tip: From the View menu, choose Show Envelopes (or press Ctrl+Shift+E) to toggle the display of all envelopes in the 
timeline.

Note: When you remove a track envelope from a track and then add it again, all points are reset.
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Using the Envelope Edit tool

You can also edit envelope points using the Envelope Edit tool. To use this tool, click the Envelope Edit Tool button ( ). 
The advantage of switching to this tool to edit envelopes is that events cannot be moved when this tool is selected, 
thereby protecting them from changes. This effectively locks all of the events and effects in a project while you modify 
envelopes.

Selecting and adjusting envelope points

1. Select the Envelope Edit Tool button ( ).

2. Click within a track to select it.

3. Drag along the timeline to select envelope points.

4. Drag the selected envelope points to a new position.

To deselect envelope points, click anywhere in the event that is not part of the 
envelope.

Cutting, copying, and pasting envelope points

1. Select the Envelope Edit Tool button ( ).

2. Click within a track to select it.

3. Drag along the timeline to select envelope points.

4. From the Edit menu, choose Cut or Copy.

5. Click to position the cursor where you want to paste envelope points. Click within a different track if you want to 
paste envelope points to another track.

6. From the Edit menu, choose Paste. The envelope points are pasted in the new position.

Copying an envelope to another track

1. Select the Envelope Edit Tool button ( ). The Envelope Edit tool is active.

2. Click within a track to select it.

3. From the Edit menu, choose Select All.

4. From the Edit menu, choose Copy.

5. Click within a track to select it.

6. Click Go to Start ( ) if you want the envelope to appear exactly 
as it was in the original track, or click to position the cursor where you want the envelope to start.

7. From the Edit menu, choose Paste. The envelope is pasted on the track.

Drag to select envelope points.

The original 

...and the newly 
pasted copy.

envelope...



Locking envelopes to events

Track envelopes extend for the length of a track and are independent of the events on the track. This means that the 
envelope remains in place when you move the events in the track. However, track envelopes can be set to move with the 
underlying events, thus preserving the timing of envelope points in relation to events. 

To lock all of the envelopes in a project to the events in which they occur, click the Lock Envelopes to Events button ( ) 
or, from the Options menu, choose Lock Envelopes to Events. You can turn this feature off by clicking the button again.

Automating 5.1 surround projects

In a 5.1 surround project, you can automate the center channel’s volume and surround panning using keyframes. For 
more information, see Working with 5.1 Surround on page 191.

Automation recording modes

Automation recording allows you to edit envelope and keyframe settings by using the controls in the Vegas interface. 
When combined with a control surface, you can create fades and adjust control parameters with a level of control that 
only a tangible control can provide.

Automation recording is available for the following settings:

• Audio track envelopes (using the controls in the track header).
• Audio track effect parameters for automatable effects (using the controls in Audio Plug-In window).
• Surround panning keyframes.
• Video track envelopes (using the controls in the track header).
• Video track effect parameters (using the controls in Video Track FX window).
• Parent track overlay mode plug-in settings (using the controls in Parent Track Overlay window).
• Track-level mask generator plug-in settings (using the controls in Video Mask FX window).

Note: If you want to thin envelope points after recording automation, you can select the Smooth and thin automation 
data after recording check box on the External Control & Automation tab of the Preferences dialog or right-click the 
envelope and choose Thin Points from the shortcut menu.

The original event

Moving the event with
Lock Envelopes to Events
turned on

Moving the event with
Lock Envelopes to Events
turned off
USING AUTOMATION | 153



154 | CHAPTER 8
Recording automation settings

1. Add an envelope or automatable/keyframeable effect to a track. 

For automatable audio track effects, you must add and effect automation envelope for each parameter you want to 
automate.

2. Click the Automation Settings button  in the track header and select Show Automation Controls.

3. Click the Automation Settings button and choose Automation Write (Touch) or Automation Write (Latch) from 
the menu.

4. Click to position the cursor in the timeline, and click the Play button  to start playback.

5. Adjust the control that corresponds to the envelope point or keyframe you want to adjust.

During playback, adjusting a control will create envelope points or keyframes at the cursor position. As long as you're 
adjusting the control, new envelope points/keyframes will be created for each change of the play cursor's position. 

6. Click Stop  to end playback and stop recording automation.

Editing sections of your recorded settings in Touch mode

In Touch recording mode, envelope points or keyframes are created only while a control is being adjusted. When you 
stop adjusting the control, automation recording stops and the existing envelope points/keyframes are unaffected.

Use Touch mode for touching up sections of your recorded automation settings. 

1. Click the Automation Settings button  in the track header and select Show Automation Controls.

2. Click the Automation Settings button  and choose Automation Write (Touch) from the menu. The icon in the 
track header is displayed as a .

3. Click to position the cursor in the timeline, and click the Play button  to start playback.

4. When you're ready to start editing, adjust the control that corresponds to the envelope point or keyframe you want 
to adjust. Envelope points/keyframes are updated at the cursor position, and when you stop adjusting the control, 
the original settings are preserved.

5. Click Stop  to end playback and stop recording automation.

Overwriting recorded settings in Latch mode

In Latch mode, envelope points or keyframes are created when you change a control setting, and recording continues 
until you stop playback. When you stop adjusting the control, the control's current setting overwrites the existing 
envelope points/keyframes.

Use Latch mode to overwrite automation settings with new values. 

1. Click the Automation Settings button  in the track header and select Show Automation Controls.

2. Click the Automation Settings button  and choose Automation Write (Latch) from the menu. The icon in the 
track header is displayed as a .

3. Click to position the cursor in the timeline, and click the Play button  to start playback.

Automation Recording 
Mode

Track Icon Description

Automation Write (Touch) Envelope points or keyframes are created only while a control is being 
adjusted. When you stop adjusting the control, automation recording stops 
and the existing envelope points/keyframes are unaffected.

Automation Write (Latch) Envelope points or keyframes are created when you change a control setting, 
and recording continues until you stop playback. When you stop adjusting the 
control, the control's current setting overwrites the existing envelope points/
keyframes.



4. When you’re ready to start editing, adjust the control that corresponds to the envelope point or keyframe you want 
to adjust. 

Envelope points/keyframes are updated at the cursor position until you stop playback.

5. Click Stop  to end playback and stop recording automation.

Editing individual envelope points or keyframes

Editing individual envelope points or keyframes gives you fine control over your recorded settings.

1. Click the Automation Settings button  on the track you want to edit and select Show Automation Controls.

2. Click the Automation Settings button  and choose Automation Write (Touch) or Automation Write (Latch) from 
the menu. 

3. Select the parameter you want to edit:

• For a track envelope, select the envelope tool  and click the envelope point you want to edit. You can right-
click a point and choose Properties from the shortcut menu to display an effect's property page.

• For a keyframe, click the Expand/Collapse Track Keyframes button  to expand track keyframe rows, and then 
double-click a keyframe to open its property page. For more information, see Using video effects on page 223.

4. Adjust the control that corresponds to the envelope point or keyframe you want to adjust. The selected envelope 
point/keyframe is edited, and all others are unaffected. 

For track envelopes, you can also edit the envelope directly in the timeline.

Setting the automation recording mode for a track

1. Click the Automation Settings button  in the track header and select Show Automation Controls.

2. Click the Automation Settings button  and choose a command from the menu to choose the automation mode.

Mode Track Icon Description

Off Automated parameters are ignored during playback.

When you switch to Off mode, the control setting from the cursor position is 
used as a static setting, and the envelope/keyframe is dimmed to indicate that 
it is unavailable.

Read The envelope/keyframe value is applied during playback, and the control 
reflects the envelope/keyframe settings at the cursor position. 

Adjustments to the control are not recorded.

Automation Write (Touch) The envelope/keyframe value is applied during playback, and the control 
follows the envelope/keyframe settings during playback and when you 
position the cursor.

Envelope points or keyframes are created only while a control is being 
adjusted. When you stop adjusting the control, automation recording stops 
and the existing envelope points/keyframes are unaffected.

Automation Write (Latch) The envelope/keyframe value is applied during playback, and the control 
follows the envelope/keyframe settings during playback and when you 
position the cursor.

Envelope points or keyframes are created when you change a control setting, 
and recording continues until you stop playback. When you stop adjusting the 
control, the control's last setting overwrites the existing envelope points/
keyframes.
USING AUTOMATION | 155



156 | CHAPTER 8



Chapter 9
 Working with Events

Events are windows into media files in a project and are the most basic unit of editing in Vegas® software. Media files that 
are inserted into the timeline are automatically contained within an event. Trimming and editing an event does not affect 
the source media file in any way.

Setting event switches

Event switches are important functions that are used to determine the basic behavior of events. You can set switches for 
a single event or multiple events at the same time. 

1. Right-click an event.

2. From the shortcut menu, choose Switches, and choose the desired switch from the submenu. 

Active switches have a check mark next to them. Choose an active switch on the menu to turn it off.

Mute

Use the Mute switch to mute an event. This prevents the event from playing back. 

Lock

The Lock switch locks an event to prevent it from being moved or edited.

Loop

You can loop an event so that you can extend it along the timeline by dragging the right edge of the event. Notches 
appear in the top of the event to mark where the media in the event ends and then repeats.

Tip: You can also set switches in the Edit menu, in the Edit Details window, or by right-clicking an event and choosing 
Properties.

Selected event 
before loop

Selected event after
loop is applied

Looping notches

Drag the right 
edge to extend
the event
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For video events, turning off the Loop switch makes the last frame repeat for the duration of the event beyond its original 
length, creating a freeze frame effect (as in the middle example below). The Loop switch is enabled for the event in the 
last example below.

Invert phase (audio only)

This switch inverts the audio event at its baseline, in effect reversing its polarity. Inverting an event, while creating no 
audible difference, is occasionally useful for matching transitions when mixing audio on separate tracks or fine-tuning a 
crossfade. 

You can also phase invert a track. If a track is inverted and you invert an event on the track, the event is doubly-inverted 
(restored to its original state). For more information, see Phase inverting a track (audio only) on page 139.

Normalize (audio only)

You may normalize an event to maximize its volume, based on the waveform’s highest peak, without clipping the event 
during playback. 

Recalculating the normalization

When you normalize an event, the event is 
analyzed and the volume is raised based on the 
waveform’s highest peak and then adjusts the 
rest of the event accordingly. If you have 
adjusted the edge of an event to exclude the 
(formerly) highest waveform peak, you may 
want to recalculate the event’s normalization.

1. Right-click the event to display a shortcut 
menu.

2. From the shortcut menu, choose Properties. The Properties dialog opens.

The original three frame clip.

Looping is off. The elongated event repeats (freezes) the final frame.

Looping is on. The entire event repeats.

Selected event 
before normalize

Selected event after
normalize is applied

Highest peak used
for normalization

Highest peak used
for recalculating the
normalization

Event edited after
normalization 

before editing



3. Click Re-calculate to normalize the event again.

Maintain aspect ratio (video only)

Video and image files of various sizes and formats can be included in a single project. The project itself may have a 
different frame size aspect ratio from the source media files. This is not a problem, but you must specify how these 
differences are handled. If the length-to-width ratio of the source media and the project’s frame size are the same (e.g., 
source media at 320x240 and project frame size of 640x480), no aspect ratio distortion occurs. If the ratios are not the 
same, the source material may become distorted (stretched or compressed). By maintaining the aspect ratio of the 
original, the video is kept from becoming distorted by letterboxing or pillarboxing around the edges. This is the default 
setting.

Reduce interlace flicker (video only)

This switch can be useful in cases where the source material didn’t originate as video and contains extremely high spatial 
or temporal frequencies. When you watch the rendered (interlaced) output on video of this sort of media, you may see 
flickering or crawling edges if this switch is not applied.

Resample (video only)

Resampling allows Vegas software to interpolate frames in an event when the frame rate of a media file is significantly 
different from the project’s frame rate. Resampling may solve some interlacing problems and other jittery output 
problems. For more information, see Resampling video on page 214.

Three options are provided for event-level resampling:

• Smart resample: Only resamples the event when the event frame rate does not match the project output frame rate. 
This can occur either because the event has a velocity envelope or because the frame rate of the original media is 
different than the project frame rate. Smart resample is the standard setting.

• Force resample: Always resamples the event, regardless of its frame rate or the project’s frame rate.
• Disable resample: Does not resample the event.

Accessing event properties

The properties of an event are automatically determined based on the properties of the source media file. In addition to 
the event switches (mute, loop, etc.) described in the previous section, event properties include playback and 
undersample rates for video and pitch shifting for audio.

1. Right-click an event to display a shortcut menu.

2. From the shortcut menu, choose Properties. The Properties dialog appears.

The first tab in the dialog, either Audio Event or Video Event, contains the properties that are exclusively related to your 
Vegas project. The second tab, the Media tab, contains many properties that are an inherent part of the media file itself. 

In addition to the event switches discussed in this chapter, event properties on the Audio Event/Video Event tab include 
the following:

• For video events, the Playback rate box sets the rate of playback. For example, a playback rate of 1 plays at normal 
speed, while a playback rate of 0.5 plays at half speed. For more information, see Time compressing/stretching events on 
page 116.

• For video events, the Undersample rate box allows you to simulate a lower frame rate. For example, an undersample 
rate of 0.5 plays the event at half its original frame rate. Each frame plays twice as long as in the original media file, 
creating a strobe effect.

• For audio events, the Time stretch/pitch shift section of the dialog allows you to change the pitch, duration, or both 
pitch and duration of an audio event. For more information, see Pitch shifting audio events on page 115.

Tip: You can set the maximum decibel level used to calculate the event during normalization. For more information, see 
Audio tab on page 318.
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Adjusting audio channels

Vegas software allows you to perform audio channel conversion nondestructively. You can mix channels, convert to 
mono, swap channels in a stereo file, or choose the channel that you want to use in a multichannel file.

1. Select an event and choose Channels from the Edit menu (or right-click an event and choose Channels from the 
shortcut menu). A submenu is displayed.

2. Choose a command from the submenu to specify how to treat the channels in your file.

You can also pan from one channel to the other using either the multipurpose slider or a pan envelope. For more 
information, see Adjusting stereo panning on page 136.

Setting audio streams

When you add a multistream audio file to your project, you can choose which stream you want to use in the event.

1. Select an audio event and choose Stream from the Edit menu (or right-click an event and choose Stream from the 
shortcut menu). A submenu is displayed.

2. Choose a command from the submenu to choose the stream you want to use.

Copying and pasting event attributes

You’ve set up one event exactly the way you want it, and now you want to apply the same attributes to another event. A 
quick way to copy the attributes of one event and paste them onto another is provided.

You can copy and paste multiple event attributes, including:

• Properties (pg. 159), including audio pitch shift (pg. 115) and video playback rate (pg. 116)
• Switches (pg. 157)
• Video event plug-ins (pg. 223)
• Cropping (pg. 205)

1. Click the event with the attributes you wish to copy and click the Copy button ( ).

2. To paste the event attributes to multiple events, select the events. For more information, see Selecting multiple events 
on page 86.

3. Right-click an event and choose Paste Event Attributes from the shortcut menu. The attributes are pasted onto the 
selected event(s).

Item Description
For events that use multichannel audio
Channel x Treats the event as a mono file using the audio from the channel you choose.
Channels x/y Treats the event as a stereo file using the audio from the channels you choose.
For events that use stereo audio
Both Treats the event as a normal stereo file.
Left Only Creates a mono event using only the left channel of your media file.
Right Only Creates a mono event using only the right channel of your media file.
Combine Creates a mono event by mixing the channels of your media file. After mixing the channels, the 

amplitude is divided by two to prevent clipping.
Swap Exchanges the right and left channels in a stereo file.



Using audio event envelopes (ASR)

You may apply envelopes to individual events. Envelopes, also known as ASRs (attack, sustain, and release), give you the 
ability to control an audio event’s fade-in, fade-out, and overall volume level.

When you add an event to your project, handles are added that are used to set the envelope. As you use these handles on 
audio events, a volume envelope appears indicating how the event is being affected. 

Setting an audio event’s volume

When you place the mouse pointer at the top of the event, the pointer changes to a hand cursor ( ) that you can use to 
lower the event’s overall volume.

1. Place the mouse pointer at the top of the event.

2. When you see the envelope cursor ( ), drag the volume envelope to 
the desired level. As you drag, the event’s decibel level is displayed.

Setting an event’s fade in and out

The event handles allow you to change an audio event’s fade in and out volume. You can also change the type of curve 
that the event uses to control the volume’s fade in or out.

1. Place the mouse pointer on a handle (upper corners of the event). The pointer changes to the envelope cursor ( ).

2. Click the corner of the event and drag to create a fade.

To remove a fade, drag the end of the fade curve back to the edge of the event.

Changing an event’s fade curve

You can set the shape of the fade curve (fast, linear, slow, sharp, or smooth) that an event uses to raise or lower the 
volume over time. To access the different fade curves, right-click anywhere in the event’s fade-in or fade-out region and 
choose Fade Type from the shortcut menu.

Notes: Event envelopes only affect an event. Track envelopes affect the entire track. For more information, see 
Composite level automation (video only) on page 147.

If you want to display fade lengths in selected events, select the Event Fade Lengths option on the View menu.

Note: When you have multiple events selected, the gain of all selected events is adjusted simultaneously.

Audio eventEnvelope
handles envelope

Volume line

Decibel level
WORKING WITH EVENTS | 161



162 | CHAPTER 9
Using video event envelopes

Video envelopes allow you to control an event’s opacity or velocity over time. Envelopes appear as lines on an event. 
With a velocity envelope, you have the added control of being able to create and edit envelope points.

Using opacity envelopes

Opacity envelopes set the overall opacity and 
allow you to fade video events in and out. This 
affects the transparency of the event in relation 
to background events on lower tracks. These 
background events can be other video events or 
background colors. For more information, see 
Using generated media on page 228.

Setting a video event’s opacity

When you place the mouse pointer at the top of 
the event, the pointer changes to a hand cursor 

( ) that you can use to lower the event’s overall 
opacity.

1. Place the mouse pointer at the top of the event.

2. When you see the envelope cursor ( ), drag the opacity envelope to the desired level. As you drag, the event’s 
opacity level is displayed.

Tip: If you use the same fade curve frequently, you can set it as a default for all new audio event envelopes. For more 
information, see Editing tab on page 322.

Note: Event envelopes only affect an event. Track envelopes affect the entire track. For more information, see Composite 
level automation (video only) on page 147.

Note: When you have multiple events selected, the opacity of all selected events is adjusted simultaneously.

Fast

Linear

Slow

Smooth

Sharp

Right-click to select
the fade curve type



Setting an event’s fade in and out

The event handles allow you to change a video event’s fade in and out. You can also change the type of curve that the 
event uses to control the fade in or out.

1. Place the mouse pointer on a handle (upper corners of the event). The 
pointer changes to the envelope cursor ( ).

2. As you drag the cursor, the opacity envelope appears. Both the time in the 
event and the opacity level are displayed as you drag.

Changing an event’s fade curve

You can set the shape of the fade curve (fast, linear, slow, sharp, or smooth) that an event uses to increase or decrease the 
opacity over time. To access the different fade curves, right-click anywhere in the event’s fade-in or -out region and 
choose Fade Type from the shortcut menu.

Using velocity envelopes

You can use velocity envelopes to change the speed of a video event over time. To view a velocity envelope, right-click 
the event, choose Insert/Remove Envelope, and then choose Velocity from the submenu.

1. Right-click an event, choose Insert/Remove Envelope, and then choose Velocity from the submenu. The velocity 
envelope appears on the event as a blue line. 

2. To increase the speed, drag the envelope up. To slow the video down, drag the envelope down.

Adding velocity envelope points

When combined with points, envelopes can be used to animate velocity changes.

1. Double-click the envelope where you want to add a 
point.

2. Drag the point to adjust it. The time and velocity level of 
the point are displayed as you drag.

3. Right-click the envelope between two points to choose 
a fade type (linear, fast, slow, smooth, or sharp) to set 
the shape of the curve.

Making a video play at twice its normal speed makes the duration of the video half as long. Likewise, slowing a video 
down makes it longer (with 0% being an infinite freeze frame). For example, if you decrease the speed of a ten-second 
video event by 50%, only five seconds of video play (played over the course of the ten-second event), meaning that only 
half as much actual footage from the original event plays. On the other hand, if the speed is increased 200%, the ten 
seconds of content play in only five seconds. The remaining five seconds of the event are filled either with a freeze of the 
last frame or with ten additional seconds of video content from the longer file.

You may want to resample the frame rate of an event that has been significantly slowed. To resample an event, right-click 
the event and choose Properties. Then, on the Video Event tab, select the Resample check box. For more information, see 
Resampling video on page 214.

Tip: If you use the same fade curve frequently, you can set it as a default for all new video event envelopes. For more 
information, see Editing tab on page 322.

Tip: To delete a point, right-click the point and choose Delete.

Envelope points
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Using the Envelope Edit Tool

While you can edit envelopes using the Normal Edit tool ( ), you can limit your editing to envelopes only by clicking 

the Envelope Edit Tool button ( ). You cannot move, trim, or otherwise modify events with this tool, which allows you 
to edit envelope points without making any other unwanted changes. For more information, see Using the Envelope Edit 
tool on page 152.

Removing a velocity envelope

To remove a velocity envelope and all of its settings, right-click the event, choose Insert/Remove Velocity Envelope, and 
then choose Velocity from the submenu. 

Grouping events

You are allowed to group events together within tracks or across separate 
tracks.

Once you create a group, you can move all the events in the group within their 
tracks as a unit and apply event-specific edits at the same time. You can still edit 
properties of individual events within a group without affecting the other 
events in a group.

Creating a new group

Grouping is useful when you want to preserve timing of events and move events together along the timeline. 

1. Select the events you want to group. For more information, see Selecting multiple events on page 86.

2. From the Edit menu, choose Group, and choose Create New from the submenu.

Adding an event to an existing group

1. Right-click an event in the existing group, choose Group from the shortcut menu, and choose Select All from the 
submenu to select all of the members of the group.

2. Press Ctrl and click the event to be added to the group.

3. Right-click the event, choose Group from the shortcut menu, and choose Create New from the submenu.

Note: When the Cut, copy, and delete grouped events check box on the Editing tab of the Preferences dialog is 
selected, cutting, copying, or deleting an event will affect all events in the same group.

Note: Events can only be in one group at a time. Adding an event to an existing group essentially clears the old group 
and creates a new one that includes all of the selected events.

Dragging one event in a group
moves all events in the group.



Removing events from a group

You can remove individual events from a group without affecting the other members of the group. An event you remove 

from the group is not deleted from the project and remains on the timeline.

1. Right-click the event you want to remove from the group.

2. From the shortcut menu, choose Group, and choose Remove From from the submenu. The event is removed from 
the group. The rest of the grouped events remain intact.

Clearing a group

You may ungroup all events by clearing the entire group. Clearing a group does not remove events from your project.

1. Right-click one of the members of the group.

2. From the shortcut menu, choose Group, and choose Clear from the submenu.

Selecting all members of a group

While grouped events move together within their tracks, selecting one member of a group does not automatically select 
every member of that group. 

1. Right-click one of the members of the group. 

2. From the shortcut menu, choose Group, and choose Select All from the submenu. 

With all events in a group selected, you can move the group to other tracks, or cut and paste the group to a new 
location.

Suspending grouping temporarily

You can temporarily suspend the grouping behavior of all groups (including video media files with included audio 

streams) by clicking the Ignore Event Grouping ( ) button.

Cutting, copying, or deleting grouped events

1. Select the events you want to cut or delete.

2. From the Edit menu, choose Group, and choose Cut All, Copy All, or Delete All from the submenu. The selected 
events and any events that are grouped with the selected events are deleted or copied/cut to the clipboard.

Note: When the Cut, copy, and delete grouped events check box on the Editing tab of the Preferences dialog is 
selected, cutting, copying, or deleting an event will affect all events in the same group.

Note: When the Cut, copy, and delete grouped events check box on the Editing tab of the Preferences dialog is 
selected, cutting, copying, or deleting an event will affect all events in the same group.
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Chapter 10
 Using the Mixer

The Mixer window is where you control the project’s busses and assignable effects chains.

Using the Mixer window

The Mixer is a dockable window where you can control audio busses and assignable effects chains within your project 
and adjust the outgoing signal’s volume and routing.

Viewing the Mixer window

The Mixer window appears in the window docking area by default when you first start Vegas software. However, you can 
drag the Mixer within the workspace at any time to float it. For more information, see Window docking area and floating 
window docks on page 22.

To hide/view the Mixer window, choose Mixer from the View menu or press Alt+3.

Preview

Float handle

(display optional) Busses Assignable effects
USING THE MIXER | 167



168 | CHAPTER 10
Using the Mixer toolbar

The Mixer’s toolbar allows you to access project properties, add busses, and add assignable effects chains to the Mixer.

Using the Mixer Preview fader

The Preview fader allows you to adjust the volume and monitor output levels of media files when you preview them from 
the Explorer or Project Media windows, or play them back from the Trimmer window. The Preview fader also controls the 
metronome volume. For more information, see Using the metronome on page 186.

Viewing/hiding the Preview fader

The Preview fader is hidden as a default to make 
more room for other busses and assignable 
effects chains. To view or hide the Preview fader, 
simply right-click anywhere within the Mixer 
and choose Show Preview fader from the 
shortcut menu.

Adjusting the Preview fader

You can adjust the Preview fader while you are 
previewing a media file from the Explorer 
window. Drag the fader up or down, or press Ctrl while dragging to move in smaller increments. Double-click the fader to 
reset it.

You can select a preferred meter resolution at which the Preview fader displays the media file’s volume level. For more 
information, see Changing bus meter resolution on page 171. You can also adjust the Preview fader to correct clipping in the 
same way you adjust a bus. For more information, see Adjusting a bus for clipping on page 171.

Using busses

A bus is a master control for the audio-signal mix of one or more tracks. You can assign tracks to play back on a specific 
bus. For more information, see Assigning audio tracks to busses on page 172. 

However, to assign a track to a bus, you must have more than one bus in your project. Each project has a Master bus as a 
default, but you may add up to 25 additional busses to the Mixer window. A bus is the last stage in the signal’s flow 
through Vegas software. For more information, see Audio signal flow on page 38. 

Button Description

The Project Audio Properties button accesses the project properties dialog 
(pg. 306).

The Downmix Output button downmixes your audio from 5.1 surround to stereo or 
from stereo to mono so you can ensure your mix will sound the way you intended it, 
even when your audience’s hardware has fewer channels than the original mix. The 
button represents the current playback mode:

 5.1 surround output

 Stereo output

 Mono output

The Dim Output button attenuates the volume of all busses that are routed to 
hardware outputs by 20 dB. Click again to restore original volume.

The Insert Assignable FX button adds an assignable effects chain to your project. 
You can route tracks to the assignable effects chain (pg. 174).

The Insert Bus button adds a bus to your project. You can route tracks or 
assignable effects chains to the bus (pg. 172).



You can configure each bus to use a specific hardware output. For more information, see Audio tab on page 318.

Adding busses to a project

You can add up to 25 busses at any time during the development of your project. 

Adding a bus

Click the Insert Bus button ( ) on the Mixer window. 

Automation 
settings

The controls in the bus control list can function as 
trim controls or automation controls for bus 
volume, panning, and muting. Click the button 
and verify Show Automation Controls is not 
selected if you want the bus control to function as 
a trim control. Adjusting a trim control affects the 
entire track. Click the button and choose Show 
Automation Controls to adjust automation 
settings. For more information, see Using 
Automation on page 143.

Mute Prevents playback of the bus (pg. 172). When 
Show Automation Controls is selected, the button 

is displayed as a ,and you can use the button 

to edit mute automation on the bus’s bus track.
Solo Plays only the output of that bus (pg. 172).
Fader Adjusts the bus’s volume on two stereo channels 

(pg. 171). When Show Automation Controls is 

selected, the thumb is displayed as a , and you 

can use the fader to edit volume automation on 
the bus’s bus track. Tip: Right-click the thumb and 
choose Pre FX or Post FX from the shortcut menu 
to specify whether the bus level is applied before 
or after the bus effects chain.

Name Name of the bus. Double-click the name to edit it 
(pg. 172).

Pan Drag to ajust the overall panning of the track.

When Show Automation Controls is selected, the 
thumb is displayed as a , and you can use the 
slider to edit pan automation on the bus’s bus 
track.

Playback device Allows you to select the device that the bus uses 
for playback.

Bus FX Displays the Bus FX window and allows you to 
adjust the audio effects plug-ins.

Meter Displays the playback level of the bus (pg. 171).

Mute

Solo
Bus FX

Fader

Meter

Name

Playback 

Bus control in Mixer Window

device

Automation 
settings

Pan slider

Bus control Bus control showing

automation controls
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Adding multiple busses

1. Click the Audio Properties button ( ) on the Mixer window. The Project Properties dialog appears with the Audio 
tab displaying.

2. In the Number of stereo busses box, enter the desired number of busses (up to 25) to appear in the Mixer window. 

3. Click OK to add the specified number of busses and close the Project Properties dialog.

The new busses appear in the Mixer window.

Deleting busses from a project

You can remove busses from your project at any time. When you remove a bus from a project, any tracks assigned to it 
are reassigned to the Master bus.

Deleting a bus

Right-click the bus to be deleted in the Mixer window and choose Delete from the shortcut menu.

Deleting multiple busses

1. Click the Audio Properties button ( ) on the Mixer window. The Project Properties dialog appears with the Audio 
tab displaying.

2. In the Number of stereo busses box, enter the desired number of busses to appear in the Mixer window.

3. Click OK. All tracks assigned to a deleted bus are reassigned to the Master bus in the Mixer window.

Routing a bus to another bus

If you have multiple busses, you can use bus-to-bus routing to create subgroups. 

1. Add busses to your project. For more information, see Adding busses to a project on page 169.

2. In the Mixer window, click the Playback Device Selector button on the bus you want to route and choose a bus from 
the menu.

• The button is displayed as a  when a bus is routed to the master bus.
• The bus letter is displayed ( , , and so on) when a bus is routed to another bus.
• The button is displayed as a  when a bus is routed to a hardware output.

Routing busses to hardware

You can assign busses to use specific hardware for output. When you installed the software, it automatically detected the 
hardware available for output on your computer. For more information, see Audio tab on page 318.

1. From the Options menu, choose Preferences and click the Audio device tab. 

2. From the Audio device type drop-down list, choose Windows Classic Wave Driver or an ASIO™ driver.

3. Click OK to close the Preferences dialog.

4. In the Mixer window, click the Playback Device Selector button on the bus you want to route.

Note: If you select Microsoft Sound Mapper in the Audio device type drop-down list on the Audio tab, you will not be 
able to assign the bus to a different device.

Enter the number
of busses



5. Choose a hardware device from the menu.

• The button is displayed as a  when a bus is routed to the master bus.
• The bus letter is displayed ( , , and so on) when a bus is routed to another bus.
• The button is displayed as a  when a bus is routed to a hardware output.

Working with busses

Busses in the Mixer window are fully independent and may be adjusted separately. You can adjust the bus volume, 
change the bus meter resolution, and adjust the bus fader to eliminate clipping.

Adjusting bus volume

You can adjust a bus’s volume during project playback by dragging the fader. The fader on a stereo bus is split so that you 
can adjust the levels of the two stereo channels independently.

The fader can function as a trim control that adjusts the overall level of the bus, or it can adjust volume automation 

settings on the bus track. Click the Automation Settings button  and verify Show Automation Controls is not 
selected if you want the fader to function as a trim control.

The faders are locked (ganged) so that the left and right channels of stereo files move together. Click the Lock/Unlock 

Fader Channels button ( ) to unlock or lock the faders. You can also press Shift while dragging a fader to temporarily 
override a fader’s locked or unlocked state.

If you want to adjust volume automation settings on the bus’s bus track, click the Automation Settings button  and 
select Show Automation Controls. For more information, see Adjusting volume or pan automation settings on page 144. The 

fader handle is displayed as  in Automation mode.

You can adjust the volume of several busses simultaneously by selecting the busses and adjusting any of their faders. If 
you select an assignable effect along with the busses, the output fader of the assignable effect moves along with the bus 
volume faders.

Changing bus meter resolution

You can select a meter resolution at which a bus displays the signal levels that are being mixed. When you change the 
meter resolution on this control, the other meters (assignable effects and preview) automatically change to match.

To change bus meter resolution, right-click a meter and choose a meter resolution from the shortcut menu.

Adjusting a bus for clipping

If the volume level is set too high, it may cause clipping. The clipping displays in red at the top of the meter with the 
clipping value displayed in decibels (dB). Adjust the fader and click the red clipping value to reset the meter. Continue to 
adjust the fader and reset the meter until you eliminate the clipping.

You can set the meter to remember and display the highest and lowest levels by right-clicking and selecting Hold Peaks 
and Hold Valleys. 

Note: You can map multiple busses to a single sound card.

Tip: Double-click a fader to reset it to 0.0 dB. If you have set each channel independently, double-click either the left or 
right fader to have the other fader match the other’s volume setting.
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Muting a bus

Muting allows you to temporarily suspend playback of the bus. When a bus is muted, the word Muted appears at the 
bottom of the meter. You can mute more than one bus at a time.

The Mute button can mute the bus, or it can adjust mute automation on the bus’s bus track. To mute the bus, click the 

Automation Settings button  and verify Show Automation Controls is not selected. Click the Mute button ( ) to 
mute the bus, and click it again to restore playback.

To adjust mute automation, click the Automation Settings button  and select Show Automation Controls. The Mute 

button is displayed as  in Automation mode. Click to turn mute automation on, or click it again to turn mute 
automation off. For more information, see Adding or removing mute automation on page 143.

Soloing a bus

Soloing isolates a bus’s playback so that you can focus on a specific output. You can solo more than one bus at a time. To 

solo the bus, click the Solo button ( ). Click the button again to turn off soloing.

Naming or renaming a bus

Every bus in the Mixer window has an editable name.

1. Double-click the bus name.

2. Type a new name.

3. Press Enter to save the name.

Panning a bus

Like volume, the pan slider in the track header can function as a trim control that adjusts the overall panning of the track, 
or it can adjust track panning automation settings. For more information, see Adding or removing volume or pan 
automation on page 144.

Assigning audio tracks to busses

If your project contains multiple busses, you can assign a track to a specific bus. For more information, see Assigning audio 
tracks to busses on page 137.

Adjusting a bus send level

You can adjust the level of a track sent to a bus by using the multipurpose slider in the track list. For more information, see 
Assigning audio tracks to busses on page 137.



Using assignable effects chains

Assignable effects allow you to send various levels of multiple tracks to a single audio effect chain. Like busses, these 
controls reside in the Mixer window and support plug-in chains. In addition, you can route assignable effects outputs to 
project busses. 

Click the Insert Assignable FX button ( ) in the Mixer window to add an assignable effects chain to your project. For 
more information, see Adding Audio Effects on page 175.

 

Number/Name Number and name of assignable effects. Double-click the name to edit it.
Automation settings The controls in the assignable effects control list can function as trim controls or automation controls for 

output level, panning, and muting. Click the button and verify Show Automation Controls is not selected 
if you want the bus control to function as a trim control. Adjusting a trim control affects the entire track. 
Click the button and choose Show Automation Controls to adjust automation settings. For more 
information, see Using Automation on page 143.

Mute Prevents the assignable effects chain from processing the track’s signal. When Show Automation 

Controls is selected, the button is displayed as , and you can use the button to edit mute automation 

on the chain’s bus track.
Solo Plays only the output of that assignable effects chain.
Assignable FX Displays the Assignable FX window and allows you to adjust the plug-in settings.
Bus Pan Drag to adjust the overall panning of the assignable effects chain. When Show Automation Controls is 

selected, the thumb is displayed as , and you can use the slider to edit pan automation on the chain’s 
bus track.

Bus assignment Allows to you assign the assignable effects chain to a bus.
Input Fader Adjusts the input volume.
Output Fader Adjusts the output volume. When Show Automation Controls is selected, the thumb is displayed as , 

and you can use the fader to edit volume automation on the chain’s bus track.
Meter Displays the incoming and outgoing signal level to the assignable effects chain.
Lock/Unlock Fader 
Channels

Locks the faders so the left and right channels of stereo files always move together. Click again to unlock 
the faders.

Tip: To use the output fader to control the wet/dry mix of the assignable effects chain, set each plug-in to 100% wet. Use 
the output (effects return) fader to balance the dry track signal with the wet plug-in signal.

Mute
Solo

Assignable FX

Output

Bus 

Assignable Effects in Mixer Window

Number/Name

Input
Lock/Unlock
Fader 
Channels

Fader and
Meter

Fader and 
Meter

assignment

Automation 
settingsPan slider

Assignable effects Assignable effects showing
automation controls
USING THE MIXER | 173



174 | CHAPTER 10
You can work with assignable effects controls in much the same way you work with busses. Use the same methods 
described earlier in this chapter for adjusting volume, adjusting for clipping, muting, soloing, and renaming. For more 
information, see Working with busses on page 171.

Assigning audio tracks to assignable effects chains

You can adjust the level of a track that is sent to an assignable effects chain using the multipurpose slider in the track list. 
For more information, see Assigning audio tracks to assignable effects chains on page 137.

Routing assignable effects chains to busses

When you add assignable effects to your project, you can assign them to a specific bus for output. The bus mixes the 
assignable effects chain’s plug-ins along with any tracks that may be routed to the same bus. For more information, see 
Audio signal flow on page 38.

This option is only available if the project contains multiple busses. For more information, see Adding busses to a project on 
page 169.

1. Click the Bus button ( ) on the assignable effect control. A menu displays all the 
busses in your project.

2. Choose the bus to which you want to route the assignable effects chain. 

The assignable effects chain displays the letter of the bus to which it is routed.

Automating busses and assignable effects

You can automate busses and assignable effect chains in the track view. You can view 
each of these controls on bus tracks at the bottom of the track view and to add 
envelopes to automate functions such as volume, pan, and assignable effect chain 
input/output levels. For more information, see Using Automation on page 143.

You can also add envelopes to automate effect parameters for plug-ins that support automation. For more information, 
see Adding or removing effect automation envelopes on page 146.

Viewing bus tracks

From the View menu, choose Show Bus Tracks or press U. The bus tracks appear at the bottom of the track view. A bus 
track appears for each bus or assignable effect chain in your project. 

Adding track envelopes

Right-click the track header in the track list, choose Insert/Remove Envelope from the shortcut menu, and choose the 
appropriate envelope type from the submenu. 

Modifying track envelopes

You can modify a track envelope for a bus or assignable effect in the same way you do with any other track. For more 
information, see Working with track envelopes on page 149.



Chapter 11
 Adding Audio Effects

You can use audio effects, or plug-ins, to improve the quality of the audio in a production or to create special artistic 
effects. Vegas® software supports a variety of DirectX® and VST plug-in effects from both Sony Media Software and third-
party vendors. 

Using audio effects

There are three ways to use audio plug-ins: track effects, bus effects, and assignable effects. You can access these plug-ins 

by clicking the Track FX, Bus FX or Assignable FX buttons ( ). The combination of these various methods of applying 
audio effects is important to the final mix of a project. For more information, see Audio signal flow on page 38.

• Track effects are applied to all events in a single track. 
• Bus effects are applied to a bus (including the Master bus). When you add plug-ins to a bus, the tracks that are 

assigned to the bus are processed by the plug-in(s). Since multiple tracks can be assigned to a single bus, using bus-
level audio effects is an efficient method of applying carefully customized chains of audio effects to multiple tracks. If 
plug-ins are assigned at the track level, the track’s signal flows through the track’s plug-in(s) before the bus plug-ins. 
For more information, see Using busses on page 168. 

• Assignable effects allow you to send various levels of multiple tracks to a single effect chain. Like busses, these 
controls reside in the Mixer window and support plug-in chains. In addition, assignable effects outputs can be routed 
to busses. Click the Insert Assignable FX button ( ) in the Mixer window to add an assignable effect chain to your 
project. For more information, see Using assignable effects chains on page 173.

Using plug-in chains

A plug-in chain is a sequence of plug-ins to be applied to tracks, 
busses, or assignable effects. A plug-in chain can contain one or 
more plug-ins. The same plug-in can be added to a chain more 
than once.

After the plug-in chain is created, the audio is processed by each 
plug-in in order. The plug-ins are cumulative so, in some cases, you may want to rearrange their order to achieve the 

desired effect.

Notes:

To add effects quickly, you can drag plug-ins and plug-in packages from the Plug-In Manager window to an audio or video 
track header.

If you’re working with a 5.1 surround project, you can use distinct plug-in settings for each channel (separate EQ settings 
for the front and surround speakers, for example) using effect automation. Add multiple instances of the plug-in to the 
track effects chain and select the Enable check boxes in the FX Automation Chooser for the channels you want each 
instance of the plug-in to affect.

Track FX Assignable FXBus FX

Plug-ins in a chain
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Creating a plug-in chain

Audio tracks have a built-in plug-in chain with three default plug-ins applied as a default. For bus effects and assignable 
effects, however, you must first create a plug-in chain.

Creating a bus effects plug-in chain

1. Click the Bus FX button ( ) on a bus in the Mixer window. The Plug-In Chooser dialog appears.

2. Select a plug-in and click OK. The Audio Plug-In window displays with your selected plug-in as the first in the new 
plug-in chain.

3. Adjust the settings for the plug-in to create the desired effect and click the Close button ( ) in the upper-right 
corner to close the window.

Creating an assignable effects plug-in chain

1. Click the Insert Assignable FX button ( ) on the Mixer window. The Plug-In Chooser dialog appears.

2. Select a plug-in and click OK. The Audio Plug-In window displays with your selected plug-in as the first in the new 
plug-in chain.

3. Adjust the settings for the plug-in to create the desired effect and click the Close button ( ) in the upper-right 
corner to close the window. The new assignable effect control appears in the Mixer window.

Adding plug-ins to a plug-in chain

There are two ways to add plug-ins to a chain: via the Plug-In Chooser dialog and via the Audio Plug-In window.

Adding plug-ins via the Plug-In Chooser dialog

You can access the Plug-In Chooser dialog from the track, bus, or assignable effects chain to which you are adding the 
plug-in.

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Audio Plug-In or Video Track 
FX) appears.

2. Click the Plug-In Chain button ( ) on the window. The Plug-In Chooser dialog appears. Plug-ins already in the 
chain appear at the top of the dialog.

Important: Be aware that using non-in-place audio plug-ins (such as Time Stretch, Pitch-Shift without preserving 
duration, and some Vibrato settings) will cause audio to play out of synchronization with the waveform display in the 
timeline and with other tracks. If an effects chain includes non-in-place plug-ins, the effects chain icon will be 
displayed as a . 
When input monitoring is on during audio recording, plug-in chains that cannot be used for live monitoring are 
automatically bypassed and are displayed as a .



3. Select a plug-in and click Add.

4. Repeat step three to add as many plug-ins as you need to create the desired effect.

5. Click OK to close the Plug-in Chooser dialog. The plug-in chain appears just below the title bar in the appropriate FX 
window (Audio Plug-In or Video Track FX).

Adding plug-ins via the Plug-In Manager

The Plug-In Manager is a dockable window that allows you to view and choose plug-ins to be added to a track, bus, or 
assignable effects chain.

1. If the Plug-In Manager is not displayed, press Ctrl+Alt+1.

2. In the Plug-In Manager, navigate to the Audio folder and select one of the FX folders.

3. Drag a plug-in to a track, bus, or assignable effects chain.

4. Confirm that the plug-ins were added by clicking the Track FX, Bus FX or Assignable FX button ( ) to view the 
appropriate FX window (Audio Plug-In or Video Track FX). You can customize the settings for the effects at this time.

Tip: You can select multiple plug-ins and add them at the same time by dragging them to the desired location.

Plug-ins already 
contained in 
the chain
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Saving customized plug-in presets

Each plug-in has a number of presets that you can use to set the behavior of the plug-in. However, you can also adjust the 
controls for the plug-in manually to create custom settings. You can then save the effect settings as a new preset.

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Audio Plug-In or Video Track 
FX) appears.

2. In the plug-in chain at the top of the window, click the plug-in you want to customize.

3. Adjust the settings for the effect.

4. Enter a preset name in the Preset box.

5. Click the Save button ( ) to save the preset.

Arranging the order of plug-ins

Plug-ins are cumulative during playback. Because of this cumulative effect, you may need to arrange plug-ins in a certain 
order so that one plug-in’s processing does not adversely affect the next plug-in on the chain. There is no right or wrong 
way to order plug-ins, but some plug-ins work better when arranged in a particular order.

You can arrange the order of plug-ins in a chain in either the appropriate FX window or the Plug-In Chooser dialog.

Arranging the plug-in order in the FX window

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Audio Plug-In or Video Track 
FX) appears.

2. On the plug-in that you want to move, right-click and choose Move Left or Move Right from the shortcut menu. 
Alternately, drag a plug-in to a new position.

3. Once the chain’s plug-ins are in the order that you want, click the Close button ( ) in the upper-right corner to 
close the window.

Tip: You can delete a saved preset by selecting it from the list and clicking the Delete button ( ).



Arranging the plug-in order from the Plug-In Chooser dialog

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Audio Plug-In or Video Track 
FX) appears.

2. Click the Plug-In Chain button ( ). The Plug-In Chooser dialog appears with the plug-in chain displayed at the top. 

3. Drag a plug-in to a new location in the chain, or select a plug-in and click either the Shift Plug-In Left ( ) or Shift 
Plug-In Right ( ) button.

4. Click OK to close the Plug-In Chooser dialog.

Bypassing plug-ins on the chain

You can bypass plug-ins on the chain by clearing the check box on a specific plug-in or by right-clicking the plug-in and 
choosing Bypass from the shortcut menu. The plug-in remains bypassed until you enable it again. Bypassing a plug-in 
prevents it from being processed on the mixer, track or bus.

You can bypass plug-ins from the appropriate FX window or from the Plug-In Chooser dialog.

Removing plug-ins from a chain

You can remove plug-ins from a chain in either the appropriate FX window or the Plug-In Chooser dialog.

Removing a plug-in from the chain in the FX window

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Audio Plug-In or Video Track 
FX) appears.

2. Select the plug-in that you want to remove.

3. Click the Remove Selected Plug-In button ( ).

Removing a plug-in from the chain in the Plug-In Chooser dialog

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Audio Plug-In or Video Track 
FX) appears.

2. Click the Plug-In Chain button ( ). The Plug-In Chooser dialog appears with the plug-in chain displayed at the top. 

3. Select the plug-in that you want to remove and click Remove to remove it from the chain.

4. Click OK to close the Plug-In Chooser dialog.

Saving plug-in chains

You can save and edit the plug-in chains that you add to tracks or busses or create as assignable effects chains. Saved 
chains retain the order of plug-ins and the settings that you have applied. These chains are stored as effect packages for 
use in future projects. If you use the same plug-in chains regularly, saving them as packages is faster and more consistent 
than recreating the chain manually.

Effect bypassedEffect enabled

To enable the plug-in again, click its
check box or choose Bypass from
the shortcut menu.
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Once you save a chain as a package, you can use it as either a track, bus or assignable effects plug-in chain. Saved plug-in 
chain packages appear in the Plug-In Chooser dialog.

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Audio Plug-In or Video Track 
FX) appears.

2. Click the Plug-In Chain button ( ). The Plug-In Chooser dialog appears with the plug-in chain displayed at the top. 

3. Click Save As. The Save Plug-in Package dialog appears. 

4. Enter a name for the package.

5. Click OK or press Enter to save the package.

Editing saved plug-in chains

You can add, delete, or rearrange plug-ins in a saved package at any time. You can then save your changes to the 
package, or enter a new name to save the chain as a new package.

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Audio Plug-In or Video Track 
FX) appears.

2. Click the Plug-In Chain button ( ). The Plug-In Chooser dialog appears with the package in the chain area.

3. Add, delete, rearrange, or change the settings of plug-ins in the package chain.

4. In the Plug-In Chooser dialog, click Save As to save the modified package.

5. To save the package with a new name, enter a name in the Name box. To save the changes to the existing package, 
choose the name of the package from the Name drop-down list.

6. Click OK or press Enter to save the new settings.

Organizing your plug-ins

Within the Plug-in Chooser dialog, you can create folders to organize the plug-ins. This can help you organize large 

numbers of plug-ins on your system. You can create folders and then drag plug-ins to the folders.

Plug-in chain packages that
you have created and saved



Automating effects parameters

Automation allows you to control audio and video levels, panning, and effect parameter automation over time. You can 
create fades, apply stereo panning, and add effects that come and go as you please. Automation is represented on the 
Vegas timeline as an envelope or set of keyframes. You can create automation by adding envelopes or keyframes to your 
tracks (including bus tracks), or you can record automation parameters by adjusting controls in the Vegas interface (or on 
a control surface) during playback. For more information, see Using Automation on page 143.

Applying non-real-time event effects

Non-real-time event effects are a different method of applying audio effects. In all other cases, event editing is 
nondestructive, meaning that edits and effects are applied to events in real time and not to the source media files, which 
remain unaltered. There may be times, however, when you want to create a permanent file using an effect or effects. This 
may be useful in a very complicated project or when a slower computer cannot process the effects quickly enough for a 
real-time preview.

By applying non-real-time event effects, you can make a new copy of a media file with the effects applied to it. This new 
media file is saved and added to the project as a take. For more information, see Working with takes on page 117.

1. Select an audio event.

2. From the Tools menu, choose Audio, and choose Apply Non-Real-Time Event FX from the submenu.

3. In the Plug-In Chooser dialog, add plug-ins to create a plug-in chain. For more information, see Adding plug-ins via the 
Plug-In Manager on page 177.

4. Click OK.

5. In the Take window, adjust the settings for the plug-in(s) to create the desired effect.

6. Preview the effect by clicking the Preview button ( ) in the Non-Real-Time Event FX window.

7. Click OK.

8. In the Take dialog, click Save to save the newly processed media file.

The new media file is saved and added to the project as a take.

Bypassing all audio effects

From the Options menu, choose Bypass All Audio FX to omit all audio effects (track, bus, and assignable effects) during 
playback.

Bypassing effects allows you to quickly compare your project with and without effects and conserve processing power to 
avoid playback problems.

When effects are bypassed, you can choose whether bypassed effects remain open. When the Keep bypassed FX 
running check box on the General tab of the Preferences dialog is selected, effects remain open so you can bypass/
enable effects with no pause for A/B testing. When the check box is cleared, effects are fully bypassed, conserving 
processing power.
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Chapter 12
 Recording Audio

Vegas® software can record audio into multiple mono or stereo audio tracks while simultaneously playing back existing 
audio and video tracks. You are limited only by the performance of your computer system and audio hardware. Audio is 
recorded to a media file on your computer and into an event on the timeline. You may record into an empty track, a time 
selection, an event, or a combination of time and event selection. Audio output from your computer during recording is 
not necessarily recorded with the new audio.

Recording does not alter any of the source media files in your project. Even when recording into an existing event, you 
are not overwriting the data in that event. Instead, the data is recorded into a new take for that event and saved to a 
media file on your hard drive.

Setting up your equipment

There are numerous ways to connect your equipment to your system. Refer to your equipment’s documentation for 
specific setup instructions. The following are some possible general configurations.

Basic setup

This setup includes a simple microphone and speaker that are connected to the computer’s sound card. With a more 
sophisticated microphone, you would typically want to use a preamplifier for input to the sound card.

Setup with mixer

This setup includes a mixer where the speaker and microphone connect. The mixer is then connected to the computer’s 
sound card. Mixers usually have pre-amps built into them. This diagram does not show you an instrument or a physical 
preamplifier, such as a rack-mounted component. The reason for this omission is because these types of setups vary 
widely based on your mixer, instrument, and pre-amp type. Refer to your components’ documentation for specific setup 
configurations.

Sound card out

Sound card in

Sound card out

Sound card in

Mixer out

Mixer in

Mixer
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Setup with digital multitrack

This setup includes a digital multitrack recorder with an optional MIDI synchronization component. Usually you would 
have a mixer, a microphone, etc. connected to these components. Your particular setup will vary depending on your 
equipment. Refer to your components’ documentation for specific setup configurations.

Synchronizing MIDI timecode

Vegas software can generate (output) MIDI timecode to synchronize external devices with project playback or can be 
triggered by MIDI timecode generated by an external device. To output MIDI, from the Options menu, choose Timecode, 
and choose Generate MIDI Timecode from the submenu. To allow Vegas software to be triggered by an external MIDI 
device, choose Trigger from MIDI Timecode from the same submenu. For more information, see Triggering from MIDI 
timecode on page 188 and Sync tab on page 324.

Preparing to record

Before you record, you must arm the tracks into which you will record the new audio. You must also select the recording 
settings for the tracks. You have the additional options of using a metronome or turning off playback during recording.

You may record into an empty track, a time selection, an event, or a combination of time and event selection. You can 
also record multiple takes for an event so you can maintain multiple versions of an event that you may play back and edit.

Tips: Select a media bin before recording if you want to automatically add your recorded audio to a media bin. To save 
track effects with your recorded files, create an effects package of the track effect settings and apply the chain to the event 
as a non-real time event effect.

To save track effects with your recorded files, create an effects package of the track effect settings and apply the chain to 
the event as a non-real time event effect.

Important: When input monitoring is on during audio recording, track effect chains that may delay the audio 
signal are displayed with a . Chains that cannot be used for live monitoring are automatically bypassed and are 
displayed as a .

Digital card
Digital in

Digital out

MIDI card

Sync. in

Sync. out

The dashed line indicates
an option if you are synching
Vegas software to tape via a 
MIDI timecode.

MTC converter

Digital
multitrack



Arming the track for recording

Whether recording into an existing track, an empty track, a selected event, or a time selection, you must prepare a track 
for recording. You can arm multiple tracks prior to recording.

1. Click the Arm for Record button ( ) in the track list.

The first time you arm a track to record in a project, the Project 
Recorded Files Folder dialog displays.

2. Browse to the location where you want to save your recorded 
audio files.

3. Click OK.

Once a track is armed, a record meter appears in the track list. Depending on your hardware, a record gain fader may 
also appear. 

In addition, one of two Record Device Selector buttons appears: ( ) or ( ). The button that appears is based on the 
Audio device type selected in the Audio Device tab of the Preferences dialog. For more information, see Audio Device tab 
on page 319.

Selecting recording settings

After the track has been armed for recording, select whether the track records the signal in stereo, in mono from the left 
channel, or in mono from the right channel. If you are using the Microsoft® Windows® Classic Wave Driver, you also must 
select the device from which the track will record.

Selecting recording settings for Sound Mapper

1. Click the Record Device Selector button ( ). A menu appears.

2. From the menu, choose the recording method (Stereo, Left, or Right).

Tip: You can change the location where recorded files are saved at any time. For more information, see Specifying where 
recordings are stored on page 189.

Button Description

 Stereo

 Mono left

 Mono right

This button appears when Use Microsoft® Sound Mapper™ has been selected as the audio device type 
on the Preferences Audio tab. The Sound Mapper allows you to choose how the signal will be 
recorded: stereo or mono. Click this button to view a menu with Stereo, Left, or Right.

 Stereo

 Mono left

 Mono 
right

This button appears when Windows® Classic Wave Driver has been selected as the audio device type 
on the Preferences Audio tab. When you choose this option, you can specify which device (e.g., sound 
card) you will record from on any given track prior to recording. Click this button to view a menu with 
Stereo or Mono, and a submenu with all available devices for either option.

Track is ready for recordingArm the track first.
using the Sound Mapper.

Track is ready for recording
from a specific device.
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Selecting recording settings for Windows Classic Wave Driver.

1. Click the Record Device Selector button ( ). A menu appears.

2. Choose either Stereo or Mono from the menu.

3. From the submenu, choose the input device

Using the metronome

A built-in metronome marks time to help with the timing and tempo when recording a performance. The metronome’s 
sound is not mixed in the final rendering of the project. Use the Preview fader in the Mixer window to control the 
metronome volume. For more information, see Using the Mixer Preview fader on page 168.

To use the metronome, from the Options menu, choose Metronome.

Recording

You may record into an empty track, a time selection, an event, or a combination of time and event selection. The 
recording is added to the timeline as new take and saves it to a media file on your hard drive. 

Triggering recording from MIDI timecode is also supported.

Recording into an empty track

1. Select a track. Alternately, to record to a new track, choose Audio Track from the Insert menu.

2. Place the cursor on the timeline where you want to begin recording.

3. Arm the track by clicking the Arm for Record button ( ) on the track.

If this is the first time you arm a track for recording in this project, you will be prompted to identify the location 
where the new audio files will be saved. For more information, see Arming the track for recording on page 185.

4. Start recording by clicking the Record button ( ) on the transport bar.

Depending on the recording selection, a waveform is created along the timeline as you record into the armed 
track(s).

5. Stop recording by clicking the Record button ( ) again or the Stop button ( ) on the transport bar.

6. A small dialog opens displaying the name and location of the file or files that were just created. Click Done to return 
to the main workspace.

Tip: You can customize the sound of the metronome in the Audio tab of the Preferences dialog. For more information, 
see Audio tab on page 318.

Start/stop Stop recording
recording

Recorded waveform



Recording into a time selection

By making a time selection, you specify where along the timeline 
to record. The time selection also determines how long the 
software records. Any selected events that occur within the time 
selection are split and the recorded data is placed into the time 
selection. 

The event’s waveform is displayed as it is recorded and 
automatically stops recording when the cursor reaches the end of the time selection.

Recording into an event

By recording into an event, you automatically create a new take containing the recorded material that is the same 
duration as the selected event. The edges of the selected event serve as the punch-in and -out points that are used for 
recording. Recording into an event allows you to establish a pre-roll before recording, which gives you time to prepare 
before recording starts. 

Because the entire recording is saved to the media file (not just the material between the edges of the take), you are not 
limited to the recorded material contained in the length of the new take. You can adjust the edges of the event or slip the 
contents of the event if necessary. For more information, see Shifting the contents of (slipping) an event on page 97.

The existing event that you record into is not affected or deleted. Instead, the event now contains two media files, each 
listed as a separate take in the event. For more information, see Working with multiple recorded takes on page 189.

1. Place the cursor before the event to allow for pre-roll.

2. Press Ctrl and click the event to select it.

3. Click the Arm for Record button ( ) on the event’s track. When recording into multiple selected events, arm their 
respective tracks at this time.

4. Click the Record button ( ) on the transport bar to begin recording.

5. Click the Record button ( ) again or the Stop button ( ) on the transport bar to stop recording.

Note: The Recorded Files dialog does not appear if you are triggering from MIDI timecode, as this would interrupt the 
synchronizing. Instead, files are automatically named and saved according to your preferences.

Tip: You can record into multiple events by pressing Ctrl and making selections.

Delete—removes selected file

Rename—changes the name of a selected file

Delete All—removes all files in dialog

Done—returns to track view

When a check mark appears in this box,
Vegas software displays this dialog after
each recording session.

Recorded waveform
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Recording into an event with a time selection

Recording into a time selection allows for a pre- and post- roll during recording. The time selection is adjustable to 
increase or decrease the pre- and post-roll duration. During recording, the selected event’s edges serve as the punch-in 
and -out points. You can create multiple punch-in and -out points by selecting more events within the time selection.

You may need to split an existing event into three pieces so that you can select a smaller portion of the event to record 
into. For more information, see Splitting events on page 95. 

1. Click the Arm for Record button ( ) on the desired track(s).

2. Select the event to record into.

3. On the marker bar, drag a time selection. You may adjust the time selection by dragging the selection bar’s starting 
and ending points. Make the time selection start before the event for a pre-roll.

4. Click the Record button ( ) on the transport bar to begin recording.

If input monitoring is turned on, the track’s original audio is played until the cursor reaches the selected event. When 
the cursor plays through the selected event, you’ll hear your recording input, and the track’s original audio is played 
again when the cursor moves past the selected event.

Using pre-roll

The previous technique allows you to define the playback region with a time selection and sets the punch-in and punch-
out points in the recording to the event boundaries. When you click the Record button, playback begins at the beginning 
of the time selection. The event is then filled with the newly recorded material. The audio file that is recorded to your hard 
disk is the full duration of the time selection. The event only contains a portion of the full recorded performance and can 
therefore be trimmed (both shorter and longer) and repositioned within the event.

Triggering from MIDI timecode

Recording can be triggered and synchronized by an external MIDI device that outputs (generates) MIDI timecode (MTC). 
When triggering from MIDI timecode, you should have your audio devices connected together via a master digital word 
clock. The word clock keeps the audio hardware locked together, eliminating the need for the software to constantly vary 
its playback rate to stay synchronized. The incoming timecode is only used for an absolute time reference. For more 
information, see Sync tab on page 324.

1. From the Options menu, choose Preferences and go to the Sync tab.

2. From the Trigger from MIDI Timecode settings drop-down list, select the device that you want to trigger Vegas 
software. 

3. Click OK. The Preferences dialog closes.

4. Click the Arm for Record button ( ) on the desired track(s).

Tip: You may record into multiple events by pressing Ctrl and making your selections.

Pre-roll Post-roll

Time selection bar - 

Punch-in Punch-out

defines the recorded
audio file’s duration.



5. Right-click the time display and choose MIDI Timecode In. The time display now shows the timecode being 
generated from your MIDI device. The top of the display reads MTC Input Waiting.

6. Begin generating MTC from your MIDI device. The top of the time display now reads MTC Input Locked, the time 
updates from the MIDI device, and recording automatically begins. Typically, there is a short delay between when 
you begin generating MTC and synchronization.

Working with multiple recorded takes

Clicking the Loop Playback button ( ) on the transport bar enables you to continually create takes during recording. 
Takes are different versions of a recorded event that you can quickly switch between to choose the best one. Each take 
within an event references a different source media file.

During recording with loop playback enabled, the time selection continually repeats and starts recording a new take until 
you stop recording. You can preview, select, rename, and delete takes. For more information, see Working with takes on 
page 117.

Specifying where recordings are stored

When you record, the event appears on the timeline while its media source file is written to your hard drive. The first time 
you arm a track to record in a project, you are prompted to identify the location where the recordings will be stored. 

Changing where recorded files are stored when arming a track

1. Press Shift and click the Arm for Record button ( ) on a track. The Project Recorded Files Folder dialog appears.

2. Browse for the location where you want to save recorded files.

3. Click OK.

Changing where recorded files are stored when starting to record

1. Press Shift and click the Record button ( ) on the transport bar. The Project Recorded Files Folder dialog appears.

2. Browse for the location where you want to save recorded files.

3. Click OK.

Changing where recorded files are stored in the Project Properties dialog

1. From the File menu, choose Properties. The Project Properties dialog appears.

2. Click the Audio tab to display the project’s audio properties.

3. Click Browse. The Recorded Files Folder dialog appears.

4. Browse for the location where you want to save recorded files.

5. Click OK.

Tip: You can also press Ctrl+Shift+R to specify the location for recorded files when starting to record.

Tip: You can select Start all new projects with these settings in the Project Properties dialog to store recorded media 
source files to the same location in every new project. 
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Monitoring audio levels

While you’re recording, a responsive meter is provided in the track header to 
monitor the incoming signal level of the selected recording device. It is 
important that you record with the highest signal possible without clipping.

A reading of 0 dB is the maximum for a digital signal. Clipping occurs when 
the incoming signal is too high to be represented as a digital value. The result is distortion in the recording. A clipped 
signal will be indicated by a red Clip warning at the top of the meters.

Right-click the meters and choose a command from the shortcut menu to adjust the display of the meters.

Using record input monitoring

If you’re using an ASIO audio device and you want to hear your recording signal with real-time track effects, you can turn 
on input monitoring.

To turn on input monitoring, click the Record Device Selector button (  or ) and choose Input Monitor from the 
menu, and then choose Auto or On from the submenu. During recording, your signal will be played back with the current 
track effects chain, but a dry (unprocessed) signal is recorded.

When Auto is selected, you will hear the input monitor signal when playback is stopped and during recording. If you’re 
recording into selected events, you'll hear the input monitor signal only when the cursor passes over the selected events. 

When On is selected, the behavior is similar to Auto mode, but you will always hear the input monitor during recording—
monitoring is not toggled on and off when recording in to a selected event.

Note: Your ability to monitor effects in real time is dependent on your computer's performance. Effect automation 
envelopes are bypassed during record monitoring.



Chapter 13
 Working with 5.1 Surround

Vegas® software allows you to create 5.1-channel mixes to prepare audio for DVD-Video.

What is 5.1 surround?

5.1 surround is a standard format consisting of three speakers across the front and two speakers in the rear. The “.1” is a 
sixth channel called low-frequency effects (LFE) that enhances the bass levels in the mix.

The LFE channel is commonly used in motion pictures to enhance low audio frequencies for effects such as explosions or 
crashes. Audio in this channel is commonly limited to a range from about 25 Hz to 120 Hz. Unlike the five primary 
channels, the LFE channel adds no directional information. Depending on the speaker setup and audio levels, the sound 
assigned to the LFE channel may be routed among the five main speakers or to an additional subwoofer.

Setting up surround hardware

Before you create surround projects, you should set up your system to provide 5.1 surround playback. To play a 5.1 
surround project, you must have an appropriate speaker setup such as:

• Six powered speakers
• Six passive speakers with a six-channel amplifier

Your system must also have an appropriate sound card setup such as:

• 5.1-compatible sound card
• Sound card with three stereo outputs
• Three stereo sound cards

Note: Vegas software plays and mixes uncompressed 5.1-channel audio. Authoring software such as the Sony Media 
Software 5.1 Surround Plug-In Pack is required to encode 5.1-channel audio to AC-3 for use in DVD authoring.

Left Center Right LFE

Right
Surround

Left
Surround

5.1 surround includes five main channels... ...and a sixth channel for low-frequency effects.
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There are several ways to set up your system, depending on the sound card and speaker setup you are using.

Setting up surround projects

You can configure a Vegas project to use 5.1 surround in the Project Properties dialog. You can also choose to apply a 
low-pass filter for the LFE channel. Applying a low-pass filter approximates the bass-management system in a 5.1 
decoder and ensures that you’re sending only low-frequency audio to the LFE channel.

1. From the File menu, choose Properties.

2. Click the Audio tab.

3. From the Master bus mode drop-down list, choose 5.1 surround.

4. To limit the audio sent to the LFE channel, do the following:

• Select the Enable low-pass filter on LFE check box and enter a value in the Cutoff frequency for low-pass filter 
box. The low-pass filter isolates the audio sent to the LFE channel by limiting it to frequencies lower than the 
value entered in the Cutoff frequency for low-pass filter box. 

• Choose a setting from the Low-pass filter quality drop-down list to determine the sharpness of the filter’s rolloff 
curve. Best produces the sharpest curve. 

5. Click OK.

The track list and Mixer window switch to 5.1 surround mode. The Master bus becomes the Surround Master bus, 
which contains faders for each of the six surround channels. Surround panners appear on tracks and mixer controls. 
Tracks routed to mixer controls (busses or assignable effects) do not have surround panners; panning for these 
tracks takes place on the mixer control.

Six powered speakers Six passive speakers with a six-channel amplifier
5.1-compatible 
sound card

Connect powered speakers to your sound card’s 
outputs as indicated by your sound card’s 
documentation.

Connect your sound card’s front, rear, and center/
subwoofer outputs to the appropriate inputs on a 
six-channel amplifier/home theater receiver. Connect 
front, rear, center, and LFE speakers to the amplifier.

Sound card with 
three stereo 
outputs

Connect powered speakers to your sound card’s 
outputs where you have routed each of the pairs 
of channels. The left channel of the Center/LFE 
pair is the center channel; the right channel is the 
LFE channel.

Connect your sound card’s outputs to the appropriate 
inputs on a six-channel amplifier/home theater receiver. 
Connect front, rear, center, and LFE speakers to the 
amplifier.

Three stereo 
sound cards

Connect powered speakers to your sound cards’ 
outputs where you have routed each of the pairs 
of channels. The left channel of the Center/LFE 
pair is the center channel; the right channel is the 
LFE channel.

Connect your sound card’s outputs to the appropriate 
inputs on a six-channel amplifier/home theater receiver. 
Connect front, rear, center, and LFE speakers to the 
amplifier.

Note: Before rendering your surround project, check your surround authoring application’s documentation to determine 
its required audio format. Some encoders require a specific cutoff frequency and rolloff, while other encoders require that 
no filter be applied before encoding.

Track list in 5.1 surround mode Mixer in 5.1 surround mode

Track routed
to Bus

Track routed
to LFE

Surround
panner

Front L/R Rear L/R Center LFE Surround panners



Routing to hardware in the mixer

You must route the surround audio to the correct output in the mixer.

1. From the Options menu, choose Preferences.

2. Click the Audio tab.

3. From the Audio device type drop-down list, choose an audio device type other than Microsoft Sound Mapper 
(such as Windows Classic Wave Driver).

4. Choose the playback devices for the six surround channels:

• From the Default Stereo and Front playback device drop-down list, choose the appropriate device for the front 
left and right surround channels.

• From the Default Rear playback device drop-down list, choose the appropriate device for the rear left and right 
surround channels.

• From the Default Center and LFE playback device drop-down list, choose the appropriate device for the center 
and LFE surround channels.

5. Click OK.

Overriding the default device routing

By setting up the device routing in the Audio tab of the Preferences dialog, you have set the defaults for surround 
routing. However, you can override the default device routing at any time using the Surround Master bus in the Mixer 
window.

1. In the Mixer window, click the Audio Device Selector button ( ) on the Surround Master bus. A menu of surround 
channels (Front L/R, Rear L/R, and Center/LFE) appears.

2. In the submenu, match a surround pair with the appropriate output. 

3. Repeat steps one and two to match each surround pair to the appropriate output.

Assigning audio to the LFE channel

Once the project is in 5.1 surround mode, you must decide whether a track will provide the “5” (surround panning) or the 
“1” (LFE channel) in 5.1 surround. Initially, all tracks in a surround project are set to provide surround panning, but you can 
assign a track to the LFE channel instead.

You can assign an individual track to the LFE channel or you can route the track to a mixer control (bus or assignable 
effect chain) and assign the mixer control to the LFE channel. 

To assign audio to the LFE channel, right-click the surround panner on the track header or mixer control and choose LFE 
Only from the shortcut menu. The track or mixer control is assigned to the LFE channel.

To change a track or mixer control back to surround panning, right-click the LFE indicator and choose Surround Pan from 
the shortcut menu.

Note: Before rendering your surround project, check your surround authoring application’s documentation to determine 
its required audio format with respect to the LFE channel. For more information, see Setting up surround projects on page 
192.

Right-click the surround panner and choose LFE Only... ...to assign the track or mixer control to the LFE channel.
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Adjusting volume

Adjusting track volume for 5.1 surround projects behaves almost identically to stereo projects. The controls in the track 
headers and Mixer window can function as trim controls that adjust the overall volume of the track, bus, or assignable 
effects chain, or they can adjust volume automation settings. For more information, see Track automation on page 143.

Adjusting track volume

You can adjust track volume using the Vol fader in the track header the same way you do in stereo projects. 

Click the Automation Settings button ( ) on the track header and verify Show Automation Controls is not selected if 
you want to adjust trim levels.

Select Show Automation Controls if you want to adjust volume automation. The fader handle is displayed as a  in 
automation mode.

Adjusting assignable effects send or bus send levels

You can adjust send levels for busses or assignable effects chains using the multipurpose fader in the track header. Click 
the fader label and choose an assignable effects chain or bus from the menu. The fader in the track header can function 
as a trim control that adjusts the overall send level of the track, or it can adjust send level automation settings. 

Click the Automation Settings button ( ) on the track header and verify Show Automation Controls is not selected if 
you want to adjust trim levels.

Select Show Automation Controls if you want to adjust volume automation. The fader handle is displayed as a  in 
automation mode.

Adjusting channel levels

Use the Surround Master bus control in the Mixer window to adjust the individual levels of the 5.1 channels. The faders in 
the track bus control can function as trim controls that adjust the overall level of each channel, or you can automate the 
master volume of the Surround Master bus (individual channel levels cannot be automated). 

Click the Automation Settings button ( ) in the bus control or bus track and verify Show Automation Controls is not 
selected if you want to adjust trim levels.

Track header in trim mode

Track header in automation mode



Select Show Automation Controls if you want to adjust volume automation. The fader handle is displayed as a  in 
automation mode.

Panning audio

You can pan audio in a 5.1 surround project in two ways:

• Pan tracks individually using the Surround Panner window.
• Route tracks to mixer controls (busses, assignable effect chains) and pan the mixer controls using the Surround Panner 

window.

Panning tracks

1. Click the Automation Settings button ( ) on the track you want to pan and verify Show Automation Controls is 
not selected.

2. Double-click the surround panner on the track you wish to pan. The Surround Panner window appears.

Mixer controls in trim mode

Mixer controls in automation mode
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3. Adjust the panning settings. For more information, see Using the Surround Panner window on page 197.

4. Close the Surround Panner window.

Panning mixer controls

You may choose to route tracks to busses or other mixer controls (such as assignable effect chains) and pan them as a 
group rather than panning each track individually.

1. Add a bus or assignable effect chain to the project. For more information, see Using the Mixer on page 167.

2. Route tracks to the bus or assignable effect chain. For more information, see Using the Mixer on page 167.

3. Click the Automation Settings button ( ) on the mixer control you want to pan and verify Show Automation 
Controls is not selected.

4. Double-click the surround panner on the mixer control to display the Surround Panner window.

5. Adjust the panning settings. For more information, see Using the Surround Panner window on page 197.

6. Close the Surround Panner window.

Tip: You can also use the surround panner in the track header to pan your track.

Note: When you route a track to a bus, stereo (two-channel) output is sent to the mixer control and the mixer control 
sends 5.1 (six-channel) output to the Surround Master bus.

Tip: You can also use the surround panner on the mixer control to pan your track.

Double-click to display
the Surround
Panner window

Double-click to display
the Surround
Panner window



Using the Surround Panner window

Whether you’re adjusting track panning or mixer control panning, you use the same controls in the Surround Panner 
window.

View the Surround Panner window by double-clicking a surround panner on a track header or mixer control. Once the 
Surround Panner window is open, you can dock it in the workspace. For more information, see Window docking area and 
floating window docks on page 22.

1. Click the speaker icons to mute or include channels. 

Muting a channel ensures that no audio bleeds through a channel. For example, you might want to mute all but the 
center channel when you’re panning dialogue to the center channel.

2. Drag the pan point to position the sound within the sound field. For more information, see Moving the pan point on 
page 197.

3. Click the center speaker icon to include the center channel and drag the Center fader to apply a gain to the center 
channel.

Applying a gain to the center channel may make dialogue more present in the mix.

Moving the pan point

A variety of methods are provided to help you position the pan point in the Surround Panner window.

Tip: You can also choose Surround Panner from the View menu to display the Surround Panner window. Once the 
Surround Panner window is displayed, double-click the surround panner for a track or mixer control to view its pan 
settings.

Tip: Ctrl+ click a speaker icon to solo the channel.

Note: When automating panning using keyframes, you cannot automate the gain applied using the Center fader. For 
more information, see Automating panning on page 199.

Method Description
Click to toggle through three options for constraining pan point motion 
as you drag: Move Freely ( ), Move Left/Right Only ( ), and Move 
Front/Back Only ( ).

Pan point

= Muted channel

= Active (included) channel

Toggle options for constraining

Assign track/bus to LFE channel

pan point movement

Pan type indicator
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Choosing pan types

When you pan a track or mixer control, you can choose among several pan types to determine how to pan the audio. The 
current pan type appears at the bottom of the Surround Panner window.

Right-click the Surround Panner window and choose a pan type from the shortcut menu.

• The Add Channels pan type makes the audio appear to move as a unit among the surround channels. As you 
move the pan point toward a channel (speaker icon), more and more of the signal from the other channels are 
folded into the channel you are panning towards, until at the extreme, all channels are fed at full intensity into a 
single channel. This pan type uses a linear panning curve.

• The Balance pan type is most useful for adjusting the relative signal levels of the channels. In this pan type, as 
you move the pan point from the center to a channel, the signal in the channel you are panning towards starts 
at the base dB level (either 0 dB, -3 dB, or -6 dB) and increases to 0 dB. The signal in the channel you are panning 
away from starts at a base dB level (either 0 dB, -3 dB, or -6 dB) and decays to no signal level. For example, when 
you pan fully to the right, only the right channel is audible. This pan type uses a linear panning curve.

• The Constant Power pan type maintains a constant volume as you move the pan point from channel to 
channel. This pan type, which uses the constant-power panning curve, is most useful for panning monaural 
source media.

• The Film pan type allows you to pan between pairs of speakers using a constant-power panning curve. As you 
drag the pan point to the center speaker, the sound becomes diffused through the front and rear speakers. 
When the track is panned fully to the center speaker, there is no sound from the front and rear speakers.

Using the grid to monitor panning

The grid in the Surround Panner window helps you to visualize how your panning will sound. The grid's spacing changes 
to match the current pan type.

The vertical lines represent the points where the left-to-right signal ratio is 6 dB, 0 dB, and -6 dB respectively: at the far-left 
line, the left channel is 6.0 dB louder than the right channel.

The horizontal lines represent the points where the front-to-rear signal ratio is 6 dB, 0 dB, and -6 dB respectively. As you 
adjust the Center fader, the lines move forward or backward to compensate for the center-channel gain.

Double-click Double-clicking the pan point resets it to the center front of the 
surround panner.

Double-clicking in the Surround Panner window moves the pan point 
to the double-click location.

Ctrl+drag Makes fine adjustments.
Shift+drag Constrain m.otion to a line through the center of the surround panner
Alt+drag Constrains motion to a constant radius from the center of the surround 

panner.
Shift+Alt+drag Constrains motion to the maximally inscribed circle (a constant radius 

at the greatest possible distance from the center of the surround 
panner).

Arrow keys Moves front/back/left/right.
Ctrl+Arrow keys Makes fine adjustments.
Page Up/Page Down Moves front/back.
Shift+Page Up/Page Down Moves left/right.
Numeric keypad 1-9 Jumps to a corner, edge, or center of the surround panner.
Ctrl+Numeric keypad 1,3,7, 9 Jumps to a location on the maximally inscribed circle (a constant radius 

at the greatest possible distance from the center of the surround 
panner).

Mouse wheel Moves front/back.
Shift+mouse wheel Moves left/right.
Ctrl+mouse wheel Makes fine front/back adjustments.
Ctrl+Shift+mouse wheel Makes fine left/right adjustments.

Note: The grid assumes that you're using a correctly set-up surround system (matched speakers and ideal positioning). 
Variations in your monitoring system will cause inconsistencies between the graph and perceived output.

Method Description



Automating panning

You can automate panning on a track or mixer control by adding keyframes. Keyframes are similar to envelope points in 
that they specify a settings state at a point in time. However, unlike envelope points, keyframes appear just below the 
track to which they apply. 

To add panning keyframes to a mixer control, you must first view the mixer control in track view. From the View menu, 
choose Show Bus Tracks to view the bus track at the bottom of the track view. For more information, see Viewing bus 
tracks on page 174.

Turning on panning keyframes

Before adding individual keyframes, you must first turn on the panning keyframes for the track or bus track.

1. Select the track or bus track for which you want to automate panning. 

2. From the Insert menu, choose Audio Envelopes, and choose Surround Pan Keyframes from the submenu. 

An additional row appears below the track with a single keyframe positioned at the beginning of the project. This 
single keyframe represents the current panning settings for the track.

Adding panning keyframes

With panning keyframes turned on, you can add keyframes at any location along the track or bus track.

1. Position the cursor where you want to begin panning the track.

2. Click the Automation Settings button ( ) on the track you want to pan and select Show Automation Controls.

3. Double-click the surround panner to display the Surround Panner window.

4. Adjust the panning settings. For more information, see Using the Surround Panner window on page 197.

5. Close the Surround Panner window.

A keyframe with the pan settings you created appears below the track at the cursor position.

As you add keyframes to a track or bus track, the Surround Panner window shows the path of the panning keyframes. The 
Smoothness slider controls the smoothness of the interpolation path between the keyframes. For more information, see 
Adjusting the Smoothness slider on page 201.

Note: You cannot automate muting/including channels.

Tip: You can also add keyframes by double-clicking the keyframe row or by right-clicking the row and choosing Add 
Point from the shortcut menu. Once you’ve added the keyframe, double-click it to adjust panning settings in the Surround 
Panner window.

Note: The Smoothness slider only displays at the bottom of the Surround Panner when you have inserted two or 
more keyframes on the track.

Keyframe

New keyframe
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Working with keyframes

After you add keyframes, you can work with them in much the same way as envelope points. For more information, see 
Composite level automation (video only) on page 147.

Moving keyframes

Drag a keyframe to a new position below its track. 

Duplicating keyframes

Hold Ctrl and drag a keyframe to a new position below its track.

Editing keyframes

1. Double-click a keyframe to open the Surround Panner window.

2. Adjust the panning settings as desired and close the window.

Changing keyframe interpolation curves

To control how the pan is interpolated between keyframes, right-click a keyframe and choose an interpolation curve type 
from the shortcut menu. Keyframe interpolation curves control how the pan occurs over time. The keyframe color 
changes according to the interpolation curve you have chosen.

Keyframe Interpolation curve Description
Hold No interpolation takes place. The keyframe's settings are maintained until the next 

keyframe.
Linear Panning is interpolated in a linear path.

Fast Panning is interpolated in a fast logarithmic path.

Slow Panning is interpolated in a slow logarithmic path.

Smooth Panning is interpolated along a smooth, natural curve.

The Surround Panner window shows the path of the panning keyframes.



Adjusting the Smoothness slider

If you have two or more keyframes, the Smoothness slider at the bottom of the Surround Panner controls the perceived 
motion of sound within the sound field among three or more keyframes. When you drag the Smoothness slider to 0, 
Vegas software interpolates the changes between keyframes along a linear path. As you increase the smoothness value, 
the path between keyframes grows more curved and smooth.

1. Double-click a keyframe. The Surround Panner window appears.

2. Drag the Smoothness slider to adjust the smoothness of the spatial interpolation path leading up to this keyframe.

Locking keyframes to events

If you want keyframes to move with an event when it is moved along the timeline, choose Lock Envelopes to Events 
from the Options menu. 

Hiding keyframes

1. Select the track for which you want to hide keyframes.

2. From the View menu, choose Show Audio Envelopes, and choose Surround Pan Keyframes from the submenu.

Deleting keyframes

Right-click a keyframe and choose Delete from the shortcut menu.

Smoothness slider

Three keyframes with 
smoothness=100...

...and the same three keyframes
with smoothness=0.
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Rendering surround projects

Rendering a surround project creates six monaural files (AIFF, ATRAC, WAV, W64, or PCA) or a single 5.1-channel file (AC-
3, WMA, and WMV) that your authoring application can use to create DVD-Video or 5.1-channel music projects.

1. From the File menu, choose Render As. The Render As dialog appears.

2. From the Save in drop-down list, choose the drive and folder where the file will be saved.

3. Enter a new name for the project in the File name box.

4. From the Save as type drop-down list, choose the desired file format.

5. From the Template drop-down list, choose the multiple mono template, or choose an appropriate 5.1-channel 
template if the selected file type supports it.

6. Select the Render loop region only check box if you want to save only the portion of the project that is contained 
within the loop region. Loop Playback does not need to be selected on the workspace for this option to work.

7. If the selected file type supports it, you can select the Save project markers with media file check box to include 
markers, regions, and command markers in the rendered media file. If the information cannot save in your media file, 
it will create an .sfl file (using the same base name as your media file).

8. Click Save. A dialog is displayed to show rendering progress.

9. When rendering is complete, click the Open button to play the file with its associated player, or click Open Folder to 
open the folder where you saved the file.

Note: Before rendering your surround project, check your surround authoring application’s documentation to determine 
its required audio format. Some encoders require a specific low-pass filter cutoff frequency and rolloff, and your encoder 
may require that no filter be applied before encoding. Use the Audio tab of the Project Properties dialog to configure a 
low-pass filter. For more information, see Setting up surround projects on page 192.

Tips: 

When you render a 5.1 surround project to AIFF (.aif), Perfect Clarity Audio (.pca), Wave64 (.w64), or Wave (.wav) formats, 
you can save each of the surround master busses to a separate file by choosing the multiple mono setting from the 
Template drop-down list. For example, if you'd typed My Film.wav in the File name box, the following files would be 
rendered: My Film Right.wav, My Film Right Surround.wav, My Film LFE.wav, My Film Left.wav, My Film Left Surround.wav, 
and My Film Center.wav.

When you render a 5.1 surround project to Wave or Wave64 format, you can render a single six-channel file by selecting the 
Enable multichannel mapping check box and creating a channel mapping using the Surround Master outputs. 

For more information, see Rendering multichannel audio files on page 284.



Creating a DVD with DVD Architect Software

If you have DVD Architect™ software from Sony Media Software, you can create menu-based DVDs, music compilations, 
picture compilations, or a single-movie DVD that will play back automatically in your DVD player.

DVD Architect software includes support for many file types and can convert your media to the formats required for DVD 
as needed. However, for best performance (decreased disc preparation time and recompression), render your files in the 
appropriate format.

MPEG-2 video files rendered with the DVD NTSC or DVD PAL templates will not need to be recompressed. Audio will not 
need to be recompressed if rendered as stereo or surround AC-3 files with a bitrate of less than 448 kbps or as stereo, 48-
kHz, 16-bit, WAV (PCM) files.

Note: AC-3 audio may not play back on some PAL DVD players. To ensure compatibility with PAL DVD players, use 48-
kHz, 16-bit, WAV (PCM) files for audio.

Rendering the surround project SampleProject.wav... ...results in six WAV files.
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Chapter 14
 Using Advanced Video Features

While simple to learn, Vegas® software is a powerful application with many advanced features. This chapter covers some 
of the advanced video features of this powerful tool.

Cropping video

With the Event/Pan Crop window, you can resize media in a video event or selectively crop media without resizing. The 
Stretch to fill frame drop-down list allows you to resize the media to fill the output frame (when Yes is selected), or to 
crop out a portion of the media without resizing (when No is selected).

When keyframes are added, you can use this window to create scrolling, panning, or zooming effects. For more 
information, see Using keyframe animation on page 250.

Tip: If you apply plug-ins to a event with panning or cropping, you can choose whether to process the plug-ins before or 
after the panning or cropping. For more information, see Processing plug-ins on events with panning or cropping on page 
226.
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Open the Event Pan/Crop window by clicking the Event Pan/Crop button ( ) on the event.

The Smoothness control and the keyframe controller are used when adding keyframe animation to create panning, 
zooming, or scrolling effects. For more information, see Animating event panning and cropping on page 254.

Cropping

Cropping is the process of removing the outside edges from an image or video, thereby re-framing the subject. In the 
following example, the Event Pan/Crop window on the left has been used to create a selection area around the subject, 
removing extraneous information from the outside of the video. This creates a zoom effect that is similar to zooming in 
with a camcorder. The Video Preview window on the right displays the event after cropping.

Note: If any controls shown in the figure above are not visible, enlarge the Event Pan/Crop window by dragging the 
lower right corner until all controls are revealed.

Tip: Use the Default Pan/Crop smoothness control on the Editing tab of the Preferences dialog to set the default 
Smoothness value for new keyframes.

Normal Edit Tool

Zoom Edit Tool

Enable Snapping

Lock Aspect Ratio

Size About Center

Move Freely or

Show Properties

Keyframe controller

Handles

Move in X or Y only
Selection area

Rotation area

Presets

Smoothness

Crop Area

Preview
output



1. Click the Event Pan/Crop button ( ) on the event.

2. Drag the handles (small boxes) located around the perimeter of the selection area to change the size.

3. Move the mouse to middle of the selection area until the cursor changes to a move icon ( ). Drag the selection area 
to reposition it.

Be aware of the following as you crop a video event: 

• To keep the selection area centered as you resize, select the Size About Center button ( ).
• To maintain the proportion of the selection area, select the Lock Aspect Ratio button ( ).
• To prevent distortion of the source media file, ensure that Maintain aspect ratio is is set to Yes.
• To restore the selection area to full frame, right-click the image and choose Restore from the shortcut menu.
• To set the selection area to a standard aspect ratio proportion, choose a preset from the Preset drop-down list.
• When using photographs or other media that is not the same frame aspect as your video, you'll see black bars 

on the sides or above and below the image.  To create a crop rectangle that matches the project frame aspect, 
right-click the image and choose Match Output Aspect from the shortcut menu.

4. The cropping occurs instantly and the results are updated in the Video Preview window. Cropping applies to the 
entire event and can be animated with keyframes. For more information, see Using keyframe animation on page 250. 

5. If you want to create an animated crop or zoom, use the keyframe controller at the bottom of the Event Pan/Crop 
window to establish distinct zoom settings throughout the duration of the event.

During playback, intermediate frames are interpolated to create smooth motion. Expand the Keyframe 
interpolation heading on the left side of the window and drag the Smoothness slider to adjust the interpolation.

Bézier masks

You can use the Event Pan/Crop dialog to create masks using Bézier curves. For more information, see Bézier masks on page 
240.

Rotating

You can also rotate the selection area in the Event Pan/Crop 
window. If you rotate the entire frame, the background behind 
the video shows through. Position, size, and rotation can all be 
animated with keyframes. For more information, see Using 
keyframe animation on page 250.

1. Click the Event Pan/Crop button ( ) on the event.

2. Resize and move the selection area as desired. For more 
information, see Cropping on page 206.

3. Move the mouse outside the selection area until it becomes 
a rotate icon ( ). Drag to rotate the selection area. 
Alternately, you may enter precise rotation values in the 
Angle (degrees) box.

Adding animation

Keyframe animation dramatically increases the variety of panning, zooming, and rotating effects you can create using the 
Event Pan/Crop window. A later chapter provides examples of zooming in on a still image and using pan-and-scan 
techniques. For more information, see Animating event panning and cropping on page 254.

Tip: Use the Default Pan/Crop smoothness control on the Editing tab of the Preferences dialog to set the default 
Smoothness value for new keyframes.
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Working with still images

You can use still images for a number of purposes including slide shows, overlay graphics, and titles. You can insert still 
images into projects just like any other media files. The default length for a still image event when it is first added to a 
track is five seconds (this is an adjustable preference), but this duration can be modified by dragging the edges to create 
a still image event of any length. Images cannot be looped, but share many characteristics with video files, including 
transparency. In addition, you can use many of the same tools on image events that you can on video events, such as 
track motion, panning and cropping, and video effects plug-ins. For more information, see Zooming in on a still image on 
page 255.

Creating still images for use in Vegas software

Many image formats can be imported, including BMP, GIF, JPG, PNG, TIFF (requires QuickTime™), PSD (flattened), and 
TGA. If you have the option to create PNG files in your graphics software, this is the recommended file type. PNG files use 
lossless compression and can also include alpha channel information, which is one of the cleanest methods of creating 
transparency for overlays. an alpha channel can automatically be detected, if present, in PNG files.

If you know your media file has an alpha channel and it is not detected properly, right-click the media file in the Project 
Media window or an event on the timeline and choose Properties from the shortcut menu. Then, in the Media tab, select 
the appropriate alpha channel type from the Alpha channel drop-down list. Premultiplied is the recommended setting. 
You can save this setting so that the alpha channel is properly detected on other media files with the same properties. For 
more information, see Setting custom stream properties on page 221.

Correcting images for DV pixel aspect ratios

For best results when importing still images, create images that account for the pixel aspect ratio of your desired output 
format. Vegas software does a good job stretching images to fit the output format, but some distortion occurs if the pixel 
aspect ratio for the source format does not match the destination format. 

To calculate pixel aspect ratio correction, use this formula:

Output frame pixel width X Output format pixel aspect ratio = Still image pixel width

For example, this is the formula for NTSC DV format:

720 (DV screen frame pixel width) X .9091 (DV pixel aspect ratio)= 655 (pixel width)

Use these figures as a guide when creating images:

• Full frame, pixel-aspect-corrected still images for use in NTSC DV projects are 655x480.
• Full frame, pixel-aspect-corrected still images for use in PAL DV projects are 787x576.

Note: The alpha channel may not be automatically detected in TGA images. Right-click a TGA image in the Project Media 
window or an event on the timeline and choose Properties. Then, in the Media Properties dialog, select the type of alpha 
channel from the list.



Capturing a timeline snapshot

You can create still images of a single frame of your project. Once saved, the snapshot can be used just like any other still 
image.

1. Position the cursor on the frame of the project you wish to capture as a still image.

2. Click the Save Snapshot to File button ( ) on the Video Preview window. The Image Filename dialog appears.

3. Select a file format (JPEG or PNG) and enter a name for the new still image file.

4. Click Save. The image is added to the Project Media window. 

Creating a slide show

A slide show composed of still images and an accompanying soundtrack can be an excellent way to show off your 
pictures. You can insert multiple images to instantly create a slide show, complete with crossfades. 

Importing high-resolution still images and using panning, cropping, and track motion tools can add interest to an 
otherwise static slide show. For more information, see Cropping video on page 205 and Adding track motion on page 258.

1. In the Options menu, verify that Automatic Crossfades is selected.

2. From the Options menu, choose Preferences. Adjust the following settings on the Editing tab:

• Enter the length for the still images in the New still image length box.
• Select Automatically overlap multiple selected media when added. 
• Enter the length of the automatic overlap in the Amount box in the Cut-to-overlap conversion section of the 

dialog.
3. Click OK. The Preferences dialog closes.

4. Select all of the images you want to use in the Explorer.

5. Right-click and drag these files to the timeline.

6. From the shortcut menu, choose Add Across Time.

If you want, you can replace the crossfades between images by dragging transitions to the crossfade regions at a later 
time. For more information, see Using transition effects on page 245.

Creating titles

Most video projects include titles and credits. There are two ways to add text to your project. You can use the titling 
engine (text generator) or you can use an external image-editing program to create titles. For more information, see Using 
generated media on page 228.

Note: When using photographs or other media that is not the same frame aspect as your video, you'll see black bars on 
the sides or above and below the image. To create a crop rectangle that matches the project frame aspect, right-click the 
image and choose Match Output Aspect from the shortcut menu.
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Creating titles from images

While every software application is slightly different, the general procedure for creating titles with a transparent 
background is as follows.

1. Start your image-editing application.

2. From the File menu, choose New. Set the dimensions of the new image to be the same as the frame size for the 
project. For more information, see Correcting images for DV pixel aspect ratios on page 208. Make the default canvas 
(background) color a solid color. The background will be transparent in the final image, so any solid color works.

3. Select the Text tool and enter the text for your title.

4. From the File menu, choose Save As.

5. From the Save as type drop-down list, choose TGA, PNG, PSD or BMP (PNG is recommended). Make sure that you 
save the alpha channel information (for TGA and PNG), which is used for transparency.

6. Enter a name and click Save.

7. Insert the image in a track just above the one with the video that will be in the background. 

8. Click the Compositing Mode button ( ) on the title track and choose Source Alpha if your image has an alpha 
channel associated with it. If it does not, you may need to add a chroma key filter to the image and key out the 
background. For more information, see Chroma keying on page 243.

Fading titles

Another common technique is to fade a still title in and out. You can create this effect by using an opacity envelope on a 
title event. For more information, see Using opacity envelopes on page 162.

You can also create multiple title images and then use crossfades or custom transitions between them. For more 
information, see Using transition effects on page 245.

Note: Size and position your titles carefully to fit within the Title Safe Area or the titles may extend beyond the edges of 
your television. For more information, see Identifying safe areas on page 270.

Note: The alpha channel is saved as a selection area in some programs. If you cannot save the alpha channel, use a black 
background and a mask will be created from the background. The alpha channel of TGA images may not be detected 
automatically. For more information, see Modifying media file properties on page 221.



Adding closed captioning to Windows Media Video (WMV) files

Closed captioning makes your final video accessible to a wider audience. You can use text commands to add captions 
line-by-line to a Windows Media® Video (WMV) file, or for longer projects, you can add captioning from a script.

Adding closed captioning line-by-line

1. Position the cursor where you want the closed captioning 
text to appear.

2. From the Insert menu, choose Command. The Command 
Properties dialog appears.

3. From the Command drop-down list, choose Text.

4. In the Parameter box, enter the closed captioning text you 
want to display.

5. Click OK.

6. Repeat steps 1-5 for each line of closed captioning text you want to add.

7. Render your file in Windows Media Video format. For more information, see Rendering a project on page 282.

Adding closed captioning from a script

Using a script to generate closed captioning involves several steps. First, you must copy and paste the lines from the 
script into a spreadsheet. You can create the spreadsheet from scratch (using the steps that follow) or use the sample 
shell (Vegas Captioning Shell.txt) provided in the Sample Projects folder on the Vegas software CD. You can open this 
tab-delimited shell with a spreadsheet application or, in the absence of a spreadsheet application, any text editor.

Once the spreadsheet is complete, you can copy and paste the lines into the Edit Details window. You can set the 
position for each line of closed captioning during playback.

Creating a script spreadsheet

1. Create a four-column, tab-delimited spreadsheet.

2. In the first column, enter 00:00:00:00 in each of the cells as a placeholder. You will set the actual position of each line 
during playback.

3. In the second column, enter TEXT in each of the cells to specify the command type.

4. In the third column, enter the text that you want to display as a closed caption. Enter each line in its own cell.

5. In the fourth column, enter a label to identify your captions. An entry such as Line 001 can help you sort the captions 
once you paste them into your Vegas project.

Tip: Take steps to ensure that the closed captioning displays when the video is played. For more information, see 
Displaying closed captioning on page 213.

Tip: If you have a script, you can copy and paste individual lines into the cells.
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Copying and pasting captions into Vegas software

1. Select the cells in the spreadsheet and copy them.

2. Switch to Vegas software and choose Edit Details from the View menu. The Edit Details window appears.

3. From the Show drop-down list, choose Commands.

4. Right-click the gray box in the upper-left corner and choose Paste from the shortcut menu. The spreadsheet data is 
pasted into the Edit Details window.

5. Click the column header for the Comments column. This sorts the captions by line number.

Setting closed captioning timing

1. Position the cursor shortly before where you want the first caption to occur.

2. Select the row for the first caption in the Edit Details window.

3. Click the Play button ( ) to start playback.

4. When playback reaches the place where the first caption should occur, 
press Ctrl+K. The first caption is inserted at the cursor position, 
updates the Position setting in the Edit Details window, and selects 
the next caption.

5. Press Ctrl+K to insert each subsequent caption.

6. Render your file in Windows Media Video format. For more information, see Rendering a project on page 282.

Note: The final caption displays in the Microsoft® Windows Media® Player until the end of the video. To clear the final 
caption sooner, add a final command with no text (as shown above).

Click the Comments column header
to sort the captions by line number.

Right-click to paste the spreadsheet
contents into the Edit Details window.



Displaying closed captioning

You may use one of two methods for displaying the closed captioning when the video is played:

• Instruct your audience to turn on captioning:
In Windows Media Player 7 and 8: from the View menu, choose Now Playing Tools, and then choose Captions from 
the submenu.

In Windows Media Player 9: from the Play menu, choose Captions and Subtitles, and then choose On if Available 
from the submenu.

• Create an HTML page with the Windows Media Player embedded in it. See the online help for a sample HTML page.
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Resampling video

Resampling allows Vegas software to interpolate frames in an event when the frame rate of a media file is lower than the 
project’s frame rate. With resampling, the intervening frames are interpolated from the source frames, much like a 
crossfade between the original frames. 

You can instruct Vegas software to resample the video of a single video event or to resample the entire project at the 
time of final rendering:

• To resample an event, right-click a video event and choose Properties from the shortcut menu. In the Video Event tab 
of the Properties dialog, choose the Smart resample, Force resample, or Disable resample radio button. For more 
information, see Accessing event properties on page 159.

• To resample the project, choose Render As from the File menu. In the Render As dialog, click the Custom button to 
access custom rendering settings. Select the Resample the frame rate of all video check box. For more information, see 
Customizing the rendering process on page 288.

Resampling at either the event or project level perform the same function. There are few cases where resampling may be 
particularly important:

• When the frame rate of the source media for an event is slower than the project’s frame rate. For example, when you 
are using a source media file that has a 10 fps rate in a 29.97 fps rate project, resampling is recommended.

• When changing the speed of a video event. For example, when slowing a clip to 30% using a velocity envelope, 
resampling is recommended.

• When creating vertically scrolling titles.

When any of the above situations are true, there are only ten frames of source material for every second of project time. 
When the project is rendered, there must be roughly thirty frames in each second. The frames must be created between 
the source media frames, sometimes known as padding. The easiest way to do this is to simply duplicate the previous 
frame. This can result in less than smooth video playback. Resampling allows Vegas software to interpolate the 
intervening frames more smoothly.

Without resampling, the intervening frames are simply the previous frame repeated.

With resampling, the intervening frames are interpolated from the source frames. 

The original media file looks

To convert these three frames into nine frames for a faster frame rate, Vegas software must generate

something like this over
three frames.

It is similar to a crossfade effect between the original frames.

the intervening frames.



Using Edit Decision Lists (EDL)

Vegas Edit Decision Lists (EDL) are text lists of all of the media files used, where they are placed, and how they are 
trimmed. Vegas EDLs are not the same as those used in traditional linear editing suites and are not intended as a project 
interchange for other editing applications.

Creating an EDL

1. From the File menu, choose Save As. The Save As dialog appears.

2. From the Save as type list choose EDL Text File (.txt).

3. Enter a name for the file and browse for a destination.

4. Click Save.

You can open EDLs created in another application in order to work with a rough copy of a project. For example, you could 
create an EDL from a project in a third-party editing application and then import the project into Vegas software via the 
EDL. For best results, save the EDL file and source media files in a single folder before opening the EDL. 

Opening an EDL

1. From the File menu, choose Open.

2. Locate the EDL file, select it, and click the Open button. If you are working on another project, you are prompted to 
save your work before a new project is opened.

Because of the significant differences between editing applications, third-party EDL files may not bring all of the project 
data into Vegas software. Among other differences, events are inserted into the timeline on a single track, all transition 
effects are replaced with crossfades, and only four audio tracks can be imported.

Working in DV format

Vegas software is optimized for DV editing. If your project is destined for tape or television, the DV format is an excellent 
choice. The Sony Media Software DV codec provides video with excellent image quality, even over multiple generations, 
and provides audio that is better than CD-quality. If you start with well-shot DV footage and stay within the DV format 
throughout the editing process, you can output broadcast-quality video programs. This section provides guidelines for 
working in the DV format.

Selecting source media

Wherever possible, use DV source video clips. You can capture video from DV cameras and decks using an IEEE-1394 card 
with no quality loss. You can also convert analog footage to DV using a media converter or by passing the video through 
a DV camcorder.

Setting project properties

Set your project to match the DV format of your final output. This provides a true WYSIWYG view of the project when you 
use an external monitor for previewing. This also prevents you from stretching output or changing field order 

unnecessarily. You can match the project settings to a video source file by using the Match Media Settings button ( ) 

in the Project Properties dialog. For more information, see Setting video properties based on a media file on page 42 and 
Modifying project video properties on page 220.

Note: EDLs do not contain any information about the location of source media. Therefore, the EDL file should be saved in 
the same directory as the source media. If it is not, or if media is stored in a number of different locations, you are prompted 
to relink these files when the EDL is imported.
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Selecting templates

Always select a DV template when performing any of the following tasks in a DV project:

• prerendering video (pg. 267)
• rendering to a new track (pg. 142)
• printing video to tape from the timeline (pg. 296)
• rendering a project (pg. 282)

When prerendering video or rendering to a new track, a DV template not only optimizes playback performance, but also 
helps you avoid needless recompression of DV footage. DV material is recompressed only when necessary. Cuts-only DV 
sequences are not recompressed when you output the project to DV from the timeline or in Video Capture.

The DV templates are designed to provide high quality, pixel aspect-correct, DV-compliant renders when rendering a 
project or printing to tape from the timeline. Do not select an uncompressed setting when choosing rendering or print-
to-tape options. An uncompressed setting produces a large file that will not print back to DV tape from Video Capture or 
from the timeline.

Eliminating out-of-range colors

The DV format allows color values to exceed broadcast 
NTSC and PAL color level standards. If you have a scene 
whose colors are too hot, or if you want to be sure that 
your video stays within legal broadcast levels, apply the 
Broadcast Colors effect to specific events or the entire 
project. 

Be aware that applying the Broadcast Colors effect 
results in recompression of the video. As a result, render 
times can increase significantly when the effect is 
applied to the entire project. 



Working in HDV format

HDV cameras record high-definition video to standard DV tapes using a highly compressed variation of the MPEG-2 
format. Because of this compression, you can capture HDV clips at data rates that are no higher than DV capture. 

You can use HDV files just like any other supported media type on the timeline. 

If you're working on a system with limited processing power, you may choose to convert your HDV clips to an 
intermediate (lower-resolution) format for timeline editing and preview. You can then replace the intermediate files with 
the original high-definition clips before rendering and printing to tape.

Capturing HDV Clips

If you have an HDV camera, you can use Vegas software to capture your clips as MPEG-2 transport streams.

1. Enable the Sony Video Capture application:

a. From the Options menu, choose Preferences.

b. Click the Video tab.

c. Clear the Use external video capture application check box.

d. Click the OK button.

2. From the File menu, choose Capture Video (or click the Capture Video button  in the Project Media window) to 
start the Sony Video Capture application.

3. Configure your HDV device in Video Capture:

a. Click the  button in the Capture window to open the Capture Preferences dialog.

b. Click the Device tab.

c. From the Device type drop-down list, choose IEEE 1394/MPEG2-TS Device.

d. From the Device drop-down list, choose your HDV camera.

4. Capture your clip:

a. Use the transport controls below the Video Preview window to cue your tape.

b. Click the Start Capture button  to start capturing.

c. Press the Play button on your camcorder.

d. Click the Stop button  (or press Esc) to end the capture procedure. 

Your clip is saved to the folder specified on the Disk Management tab of the Capture Preferences dialog. This path is 
displayed in the Capture Folder box in the Video Capture window.

5. If you plan to edit the HDV clips (transport streams), you’re ready to start editing on the timeline. 

If you plan to edit intermediate files on the timeline, you can convert your captured clips to an intermediate format.

Tip: If you will be delivering your project in standard definition (SD) via DVD or DV tape, you can use the camera’s built-in 
downconversion (if available) to convert your HDV video to the DV format. Use the camera’s Options menu to set the 
camera to output DV, and you can capture and edit video in the same way that you normally use DV in Vegas projects with 
no need for intermediate files.
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Creating intermediate files

If you’re working on a system with limited processing power, converting to an intermediate, lower-resolution format will 
streamline the editing process and allow you to preview your project.

1. Capture your HDV clips. For more information, see Capturing HDV Clips on page 217.

2. Start a new project.

3. Add your captured HDV clips (MPEG-2 transport streams) to the timeline.

4. Render your clips to an appropriate intermediate format. 

You can verify a template’s codec by looking at the Video format drop-down list on the Video tab of the Custom 
Template dialog.

If you’re performing frame rate or frame size conversion, ensure the Video rendering quality is set to Best on the 
Project tab of the Custom Template dialog.

5. After rendering is complete, you’re ready to start editing on the timeline.

Destination Intermediate Format
HDCAM over HD-SDI Render an .avi file that uses the Sony YUV codec. The frame rate and 

frame size should match your HDCAM master.
Digital Betacam or XDCAM 
over SD-SDI

Render an .avi file that uses the Sony YUV codec. The frame rate and 
frame size should match your master.

24p DVD Render an .avi file that uses one of the following codecs:

-Sony YUV (offers the highest quality, but requires a high-performance 
drive array).

-CineForm HD (offers excellent quality with good playback 
performance).

-Sony NTSC DV Widescreen (use the NTSC DV Widescreen 24p (2-3-3-2) 
pulldown .avi template).

Windows Media HD Render an .avi file using one of the following templates. Choose the 
template that matches your HDV source:

-HDV 720-30p intermediate.

-HDV 720-25p intermediate.

-HDV 1080-60i intermediate.

-HDV 1080-50i intermediate.

Tips: If you don’t want to convert all clips in their entirety, create regions to indicate the portions of the captured HDV clips 
that you want to convert to an intermediate format, and then the Batch Render script to render the regions to the desired 
format.

Remember that Vegas software supports multiple instances. You can use one instance of the application to render your 
intermediate files while you continue editing in another instance. Use network rendering to queue multiple render jobs.

Using DVD Architect software, you can create a DVD that contains an SD version of your project and place an HD Windows 
Media version in the Extras folder on the disk. When you browse to the Extras folder via Windows Explorer, you can play the 
HD version and output it to your computer's display, a home theater, or a projector.



Editing HDV video on the timeline

You can use native HDV footage (called transport streams) files just like any other supported media type on the timeline. 
Depending on your workflow, you may want to convert them to a lower-resolution intermediate format for efficient 
timeline editing and previewing.

1. Import the clips from your HDV camera to your local hard drive. For more information, see Capturing HDV Clips on 
page 217.

2. If you're editing on a computer with limited processing power, convert your captured clips to an intermediate 
format. For more information, see Creating intermediate files on page 218.

If you plan to edit HDV clips, skip to step 3.

3. Drag your captured clips from the Explorer or Project Media window to the timeline to create events.

4. Edit your project as needed. For more information, see Working with Events on page 157.

5. If you’re working with intermediate files and you plan to render to a format that supports high-definition video, 
replace the intermediate clips with the original HDV clips before rendering your project or printing to tape.

a. Right-click the HDV intermediate file in the Project Media window.

b. Choose Replace from the shortcut menu.

c. Browse to the MPEG-2 transport stream that corresponds to the intermediate file, and then click Open.

6. Render your project or print to tape. For more information, see Printing HDV video to tape on page 300.

Note: If your intermediate files were rendered using the CineForm HD codec, you don't need to replace the intermediate 
files with the transport streams.
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Modifying project video properties 

You can access project video properties by clicking the File menu and choosing Properties or by clicking the Project 
Video Properties button ( ) on the Video Preview window. Many of these settings are identical to the settings found on 
the Project tab of the Custom Template dialog. Final render properties set up in the Custom Template dialog override the 
following Project Properties settings. For more information, see Video tab on page 306.

These properties control all of the default settings for your project. Without making any changes, these are also the 
settings that are used to create a final rendered movie file.

• Select a preset template from the Template drop-down list 
to automatically configure the remaining video controls in 
this dialog. Many popular formats are included, but you 
should consult your hardware manuals if you have any 
questions. You can also save your own custom template.

• Click the Match Media Settings button ( ) to set your 
project properties to match the properties of a media file of 
your choosing.

• The values in the Width and Height boxes set the frame 
size of your final movie.

• Choose an option from the Field Order drop-down list to 
set the field order. Choose None (Progressive) for video to 
be viewed on a computer monitor. For DV output, choose 
Lower Field First. If the output is jittery or shaky, or your 
hardware’s manual specifies it, choose Upper Field First.

• Choose the pixel aspect ratio for the final movie’s 
destination from the Pixel aspect ratio drop-down list. For 
more information, see Pixel Aspect Ratio on page 373.

• Choose a frame rate for the final movies destination from 
the Frame rate drop-down list. For more information, see 
Frame Rate (Video) on page 371.

• Choose a rendering quality level from the Full resolution 
rendering quality drop-down list. For most projects, Good is the recommended setting. If you have critical material 
where nothing but the highest quality rendering will do, select Best. Please note that rendering time may increase 
dramatically as large amounts of extra processing is required for the Best setting.

• Some effects and transitions can involve motion or animation. The Motion blur type drop-down list allows you to 
select whether the frames are blurred slightly to create the illusion of motion on individual frames. This can make 
computer generated animation appear more smooth and natural. Gaussian is the best choice in most situations where 
blurring is required. 

• The Deinterlace method drop-down list provides several options relating to interlacing. Source video from a television 
is interlaced. When Vegas software renders effects, it needs to deinterlace the two fields that make up a frame. You can 
choose the exact method used in this list. If you choose the None option, the fields are left interlaced. If you choose the 
Blend option, contents are used from both fields, which is a good choice for high-detail, low-motion material. If you 
choose the Interpolate option, a single field is used at a time, which is good for low-detail, high-motion material.

• Choose the location for saving prerendered preview files in the Prerendered files folder box. For more information, see 
Prerendering video on page 267.

• Select the Start all new projects with these settings check box to always use these settings for new projects.



Modifying media file properties

Vegas software tries to automatically detect the properties of your media files. In most cases, these properties do not 
need to be modified, but there are times when you may need manual control over some of these attributes, depending 
on the type of file and your specific hardware configuration.

1. Right-click a file in the Project Media window or an event on the timeline and, from the shortcut menu, choose 
Properties.

2. Modify the parameters on the Media tab as needed. See Setting 
general media properties on page 221 and Setting custom stream 
properties on page 221.

3. Click OK.

Setting general media properties

The following general properties appear in the top of the Media tab: 

• The File name box displays the file name (cannot be edited).
• The Tape name box displays the name of the tape for media files 

captured in Video Capture. You can edit the name here or in the 
corresponding column in the Edit Details window. 

Setting timecode media properties

These properties appear in the Timecode section of the Media tab:

• The Use timecode in file radio button is the default setting, where 
the media file’s timecode is used.

• The Use custom timecode radio button allows you to set the media 
file’s timecode manually.

• If you have selected the Use Custom timecode radio button, a drop-down list contains the available timecode formats. 
SMPTE Drop (29.97 fps, Video) for example, is the timecode format for NTSC DV. Changing the timecode format does 
not change the source media file in any way. It merely changes how the file is measured in time. For more information, 
see Timecode on page 365.

Setting custom stream properties

Media files are opened with a set of default values based on the media file type. When you change any of the values for a 
media file, these changes are saved for that file in the current project only. If you want to change the default settings for a 
particular type of video file whenever that type of file is used, click the Save settings to video profiles for future auto-

detection button ( ) to the right of the Stream list. This adds an entry to a file called vegas video profiles.ini that can be 
referenced for future use.

The following properties appear in the Stream properties section of the Media tab:

• If the file has more than one stream of the given type, you can choose the particular stream for which you want to view 
properties from the Stream drop-down list.

• The Attributes, Format, and Frame rate boxes display basic information about the file.
• Choose an option from the Field order drop-down list to control how the video field order is handled on a television 

monitor. Choose None (Progressive) for video to be viewed on a computer monitor. For DV output, choose Lower 
Field First. If the output is jittery or shaky, or your hardware’s manual specifies it, choose Upper Field First.

• While you can choose a different value from the Pixel aspect ratio drop-down list, this value should always match the 
source video’s properties.

• The option selected in the Alpha channel drop-down list determines how transparency is handled in a file. The default 
alpha channel setting for most video files is None. PNG image files can have an alpha channel that is automatically 
detected. The options in this drop-down list are described on the following page.
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Alpha channel option Description
Undefined Because the image format provides no alpha channel information, this 

setting ignores any alpha channel information in the file.
None Either there is no alpha channel or there is an alpha channel but it’s 

completely opaque (solid).
Straight (unmatted) Transparency information is maintained in only the alpha channel. 

Alpha information must be applied to the RGB channels before 
compositing.

Premultiplied The standard method of handling alpha information. Transparency 
information is maintained in the alpha and RGB channels, and the 
image is ready for compositing.  No RGB component exceeds the alpha 
value.

Premultiplied (dirty) Similar to Premultiplied, but RGB components may exceed the alpha 
value. This option is used mainly for images created by 3D applications 
involving compositing of 3D images over a non-solid color image 
background.



Chapter 15
 Using Video FX, Compositing, and Masks

Video plug-ins in Vegas® software include effects and generators. Effects cover a broad range of electronic modifications 

that can be used to improve substandard video or artistically enhance a production. Generators can be used to create 
custom video events such as credit rolls or gradient overlays. 

A variety of options are provided in compositing video and using masks. Compositing involves mixing visual elements 
together into a final output. Multiple compositing modes are provided from which to choose. Masks, which are used 
extensively in television and movies, are an important part of creating overlays. Together, these professional tools can 
help you polish your productions.

Using video effects

A great variety of video effects plug-ins are provided that are 
ready for you to drag-and-drop onto your projects, media files, 
tracks, and events. Previews of the different effect presets 
appear in the Video FX window. In addition to the presets, each 
plug-in has individual controls that allow you to customize the 
effects in precise detail. You can also animate video effects using 
keyframes. For more information, see Using keyframe animation 
on page 250.

The mix of video effects applied at different levels (to events, 
tracks, files, etc.) is important to the final mix of a project. For 
more information, see Video signal flow on page 39. 

In general, effects are applied in the following order: 

• to files in the Project Media window
• to events
• to tracks
• to the project (video output effects)

Adding a video effects plug-in

You can apply video effects to events, tracks, files in the Project Media window, or to an entire project. You can add a 
plug-in by selecting it in the Plug-In Chooser dialog, or you can drag-and-drop the plug-in from the Video FX or Plug-Ins 
windows.

Note: The compositing model in this version of Vegas software differs significantly from the Vegas 4.0 model. To 
reproduce the Vegas 4.0 parent/child masking behavior, set the compositing mode of the parent track to Multiply, and 
then apply the Mask Generator plug-in as a track effect on the parent track.
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Adding a plug-in using the Plug-In Chooser

1. Click the Video FX button ( ) in one of the following locations (see the illustration):

• Media FX are applied before a media file is inserted into an event on the timeline. Every occurrence of this 
media file in a project has the effect applied to it. Media effects can be applied only to video files.

• Event FX are applied to events on the timeline.
• Track FX are applied to the output of a particular track.
• Video Output FX are applied to the final output and affect every event in a project.

2. In the Plug-In Chooser dialog, select the effect that you would like to apply and click OK.

3. Modify the effect in the Video FX window and close the window when you are finished. For help on the different 
controls in the Video FX window, click the Plug-In Help button ( ) to access online help.

Adding a plug-in from the Video FX or Plug-In Manager window

1. If the Video FX or Plug-In Manager window is not currently visible, choose either Video FX or Plug-In Manager from 
the View menu to view the appropriate window. 

Track FX Video Output FXEvent FX Media FX



2. Drag a plug-in from the window to one of the following locations:

• file in the Project Media window
• event
• track list or empty section of a track
• Video Preview window (video output effects)

3. Modify the effect in the Video FX window and close the window when you are finished. For help on the different 
controls in the Video FX window, click the Plug-In Help button ( ) to access online help.

Working with video effects plug-in chains

You can apply plug-ins in chains of two or more for even greater flexibility. A plug-in chain is a sequence of all of the plug-
ins to be applied to a media file, event, track, or project. The same plug-in can be added to a chain more than once. Use 
the same steps to add additional plug-ins to a chain as you use to add a single plug-in. For more information, see Adding a 
video effects plug-in on page 223.

After you apply a plug-in chain, the video is processed by each plug-in in order. The plug-ins are cumulative so, in some 
cases, you may want to rearrange their order to achieve the desired effect.

To view and work with a plug-in chain, click the Video FX button ( ) for the event, track, Project Media window file, or 
Video Preview window to open the Video FX window.

Bypassing plug-ins

Video effects plug-ins can also be temporarily bypassed (turned off ) by deselecting them (clearing the check box on the 
plug-in). Since the effects are rendered very quickly in the Video Preview window, turning a plug-in on and off allows you 
to see the results of the plug-in on your project.

Clear the check box
on a plug-in to 
bypass the plug-in.

Drag a plug-in
to move it
within the chain.

Plug-in chain

Click a plug-in to 
modify its settings
in the lower part of
the window.
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Changing the plug-in order

Video effects plug-ins are applied in the order that 
they appear in the chain. You can change this order by 
dragging a plug-in to a new location in the chain. 
Alternately, you can click the Plug-In Chain button 
( ) in the Video FX window and reorder the plug-ins 
in the Plug-In Chooser dialog. 

In the following illustration, you can see how the order 
of plug-ins is important.

The goal of the above example is to use video effects plug-ins to create a very high-contrast mask out of a video clip of 
fire. In the image on the left, a Brightness and Contrast plug-in is applied first and then a Black and White plug-in. In the 
image on the right, the Black and White plug-in was applied first, removing the color, and then the Brightness and 
Contrast plug-in was applied. The mask created by the second example is much cleaner, even though all of the settings of 
the two plug-ins are identical.

Processing plug-ins on events with panning or cropping

When you add a plug-in to a video event that has panning or cropping applied to it, you have the choice of processing 
the plug-in before or after the pan/crop. For example, you might want to apply a Radial Blur plug-in before the video is 
cropped and then a Noise plug-in is applied after the cropping is complete. 

You can choose whether an effect is applied pre- or post-pan/crop in the keyframe controller at the bottom of the Video 
FX window. Click the Before/After Pan/Crop button to the left of the effect name to determine whether the effect is 

processed before ( ) or after ( ) Vegas software pans or crops the event.

Plug-in chain Shift Plug-In Left/Right

Here, the Deform plug-in is 
applied before the pan/crop. 
The Glow and Color Curves
plug-ins are applied after
the pan/crop.



Removing a plug-in

1. Click the FX button ( ) on the event, track, Project Media window file, or Video Preview window that has the plug-
in applied to it. The Video FX window appears. 

2. Click the plug-in that you want to remove.

3. Click the Remove Selected Plug-In button.

Modifying a video effects plug-in

Video effects plug-ins are highly customizable. You can select from a variety of presets or adjust the settings for custom 
effects. You can also save custom settings to be used again as a new preset.

1. Click the FX button ( ) on the event, track, Project Media window file, or Video Preview window that has the plug-
in applied to it. The Video FX window appears. 

2. Select a preset from the Preset drop-down list or adjust the parameters as needed. For help on the different controls 
in the Video FX window, click the Plug-In Help button ( ) to access online help.

Changes you make are automatically updated in the Video Preview window, using the current cursor position as the 
example. To see the effect as applied to the video in motion, create a time selection (looped region) and preview in loop 
playback.

Saving custom plug-in settings as a preset

1. Click the Preset text box. The name of the current preset is highlighted.

2. Type a new name for the preset and click the Save button ( ).

Tip: To use a saved custom preset, simply choose it from the drop-down list.
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Using keyframe animation with plug-ins

You can use keyframe animation to control a plug-in over time. Keyframes are added to the keyframe controller at the 
bottom of the Video FX window. Since a number of plug-ins can be added to a single event, track or project, click the 
plug-in’s button in the chain and modify the particular attributes and keyframe controller for that plug-in. For more 
information, see Using keyframe animation on page 250 and Animating video effects plug-ins on page 256.

Using generated media

Generated media plug-ins are a special class of plug-in 
that creates virtual media files contained in events on 
the timeline. These virtual files are stored in the Project 
Media window, where their properties can be viewed 
and modified.

Generated media provide an easy way to add text, 
backgrounds, or test patterns to your project. You can 
view the generators by choosing Media Generators 
from the View menu to display the Media Generators 
window.

Generated media events can be animated using 
keyframes. For more information, see Using keyframe 
animation on page 250 and Animating generated text on 
page 257.

Generated media Description
Checkerboard Creates checked and striped patterns.
Color gradient Creates gradient colored events to be used behind overlays, as 

masks, or for fades.
Credit roll Creates events that format your text into credits. Text can be 

formatted within the Video Event FX dialog in Vegas software, or 
pasted into this dialog from a word processing processing 
program.

Noise texture Creates realistic-looking textures.
Solid color Creates solid colored events to be used behind overlays or for 

fades.
Test pattern Creates standard test patterns that can be used to calibrate your 

video output stream. Many studios and broadcast facilities 
require a color bar pattern at the beginning of your video so that 
engineers can calibrate their equipment. 

Text Creates events containing text for titles or simple credits. Text 
can be formatted with color, shadows, and other effects.



Adding a generated media event

You can add a generated media event by choosing Generated Media from the Insert menu. This adds the event at the 
cursor position in the selected track. However, perhaps the simplest way to add generated media is through drag-and-
drop.

1. From the View menu, choose Media Generators. The Media Generators window displays.

2. Drag a generator from the Media Generators window to the project. The mouse cursor changes to indicate when 
you can drop the generator.

3. Modify the generator in the Video FX window and close the window when you 
are finished. To modify settings at a later time, click the Generated Media button 
( ) on the event. For help on the different controls in the Video FX window, click 
the Plug-In Help button ( ) to access online help.

Duplicating a generated media event

Once you have added a generated media event and modified its settings, you can duplicate it. For more information, see 
Duplicating events on page 93. 

When you duplicate a generated media event, you have two options: 

• Select the Create a new copy of the source media radio button if 
you want the new event to be modified on its own. The new 
event is completely independent of the original event.

• Select the Create a reference to the original media radio button 
to keep the new event linked to the original generated media 
event. Any change to either event is mirrored in the other.

Compositing

Compositing is the process of mixing visual elements together into a final output. In Vegas software, this means mixing 
tracks together vertically. Masks, generated text, and chroma keying all involve compositing. Understanding how 
compositing works is important to understanding these and many other video track mixing techniques.

Understanding the parent/child track relationship

The key to understanding overlays, masks, transparency, and compositing is to 
understand the parent/child relationship between tracks. In general terms, the parent 
track is the highest track in a group of tracks (often only two) and the behavior of the 
child tracks (i.e., how they are composited together) is determined by the parent 
track. 

You can also produce complex compositing by creating nested parent/child groups 
with compositing parents and children at various levels.

When you have multiple levels of parent and child tracks, clicking the Make 

Compositing Child button ( ) moves the track in one level and clicking the Make 

Compositing Parent button ( ) moves out one level.

Hold Ctrl while clicking the Make Compositing Child button to move a track and all 
its child tracks in one level.

The following three examples demonstrate different compositing relationships.

Tip: A generated media event is ten seconds long as a default. However, you can trim the event to any length. For more 
information, see Trimming an event on page 93.

Generated
Media
button
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The first example shows two independent tracks. The top track contains a generated text event that has a transparent 
background. The second track therefore shows through the transparent areas in the Video Preview window. Since the 
second track does not have any transparent areas, any tracks below it would be completely obscured.

In the second example, track two is the child track of track one (the parent track), and the compositing mode of track one 

is set to Mask. This parent/child relationship was set up by clicking the Make Compositing Child button ( ) in the track 
list for track two. This makes the text in track one act as a mask over track two, allowing the fire to show through the mask 
(i.e., the text). The region outside of the text is still transparent, but there is nothing below these tracks, so it appears 
black.

In the third example, a generated media event was added to the track below the first two tracks, which are already paired 
in a parent/child relationship. The color gradient event in track three shows through the transparent area of the top two 
paired tracks. 

Selecting compositing modes

The Compositing Mode button ( ) determines how the 
transparency in a video track is generated. Since lower tracks show 
through higher tracks, it is the compositing mode of the higher track 
that determines how much of the lower track shows though. 

To select a compositing mode, click the Compositing Mode button 
and choose a mode from the menu that appears, or choose Custom 
to customize compositing with a 2-to-1 transform plug-in.

Note: The compositing mode of the lowest video track is a special 
case. Selecting a mode for the lowest track affects its transparency 
against a black background.

Make Compositing
Child button

Parent track

Child track

Click to choose a 
compositing mode



The sample below uses a generated text event that is partially transparent. For more information, see Using generated 
media on page 228.

The following table shows how these two sample tracks are blended using each of the compositing modes. 

Compositing mode Sample Description
Add Adds the overlay color values to the background.

Subtract Subtracts the overlay color values from the background.

Multiply (Mask) Multiplies the overlay color values by the background color values. This 
makes overlay colors stronger and more present and results in a darker 
video image. The opposite of this mode is Screen.

Source Alpha Uses the alpha channel to determine transparency in the overlay.

This compositing mode is based on the alpha channel characteristics of 
an event or media file. If no alpha channel is present in the overlay, the 
Source Alpha compositing mode has no effect.

Cut Cuts out the overlay color values from the background.

Screen Multiplies the inverse of the overlay color values with the background 
color values. This makes overlay colors weaker and less present and 
results in a lighter video image. The opposite of this mode is Multiply.

Set compositing
mode for 
overlay track

Overlay track

Background track
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Adjusting opacity with the composite level slider

You can precisely control the transparency or blending of the overlay with the 
composite level slider. Left is transparent and right is 100% opaque. You can also 
double-click the current value to enter a specific numeric percentage.

Overlay Heightens contrast by using Multiply mode on darker colors and Screen 
mode on lighter colors.

Hard Light Adds overlay colors as if the overlay were lit by a bright, focused 
spotlight.

Dodge Brightens the background based on the overlay color values.

Burn Darkens the background based on the overlay color values.

Darken Compares the overlay and background pixel by pixel and selects the 
darker color value for each pixel. 

Lighten Compares the overlay and background pixel by pixel and selects the 
lighter color value for each pixel. 

Difference Compares the overlay and background pixel by pixel and subtracts the 
darker color value from the lighter color to generate a new color value 
(difference). 

Difference Squared Remaps color values along a parabolic curve. The color values of the 
layers in the composite group are subtracted, and then the subtracted 
values are squared.

The resulting image will have less extreme changes in color values as the 
colors approach black (RGB 0,0,0) and more extreme changes in color 
values as colors approach white (RGB 255,255,255).

Compositing mode Sample Description

Composite level slider



Using a 2-to-1 transform plug-in to customize compositing

Click the Parent Composite Mode ( ) or Composite Mode button and choose Custom from the menu to use plug-ins to 
control how the parent track modifies the tracks in its composite group.

The included Displacement Map, Height Map, and Bump Map plug-ins can create interesting lens, mirror, water, fire, and 
other light-bending effects. These plug-ins are explained below:

• Displacement Map: Uses the parent image as a guide to offset the pixels in the composited child tracks along the 
horizontal and vertical axes. The X and Y offsets are independently encoded in the image color channels.

• Height Map: Uses the parent image as a guide to offset the pixels in the composited child tracks. The gradient of the 
image in the parent track is used to determine the amount of offset for the image displayed at that location, much like 
how light bends through a lens.

• Bump Map: Uses the parent image as a guide to add texture and lighting to the composited child tracks. The texture of 
the bump map is applied to the composited child tracks: light sections of the map represent high areas, and dark 
sections represent low areas.

3D Compositing

With 3D compositing, you can move video tracks anywhere in space to simulate realistic motion and lighting.

With 2D compositing (and in previous versions of Vegas software), you can move video or images along the X or Y axes, 
and you can rotate video along the Z axis. With 3D compositing, you can move or rotate along the X, Y, or Z axes to create 
distance, depth, and perspective.

There are two basic rules to 3D compositing:

1. When you have a 2D track in the track list, 3D tracks below that track are rendered in 3D and then composited as a 
2D image. 

2. A 2D track at the root level (flush to the left of the track list) acts as a barrier to interaction between 3D tracks.

In the following examples, both text tracks have been rotated in 3D: the “hot” track is rotated toward the user, and the 
“cool” track is rotated away from the user. 

In the first example, the two tracks intersect along their rotation axis. In the second example, adding a 2D track above the 
“cool” track causes it to be rotated in 3D and composited as a 2D image so the “hot” text is displayed above it without 
intersecting.
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Single-track 3D motion

1. Click the Track Motion button ( ) on the track that contains the overlay that you want to animate. The Track 
Motion window is displayed. 

2. From the Compositing Mode drop-down list, choose 3D Source Alpha. 

3. Choose a setting from the Layout drop-down list to choose the workspace display that you want to use. The Layout 
setting allows you to see your track from various points of view.

4. Adjust the selection area to change the viewable area of the track and its position in space. Guides are displayed in 
bold to indicate how the track will be moved or rotated: 

5. Use the buttons at the top of the dialog to allow or prevent movement or scaling. For more information, see Changing 
editing options on page 236.

6. The 3D track motion occurs instantly, and the results are updated in the Video Preview window. 

7. Use the keyframe controller at the bottom of the Track Motion window to establish distinct track motion settings 
throughout the duration of the track. 

During playback, immediate frames are interpolated to create smooth motion. Expand the Keyframe interpolation 
heading on the left side of the window and drag the Smoothness slider to adjust the interpolation. For more 
information, see Using keyframe animation on page 250.

Tip: Right-click the workspace to display a shortcut menu that displays commands to restore, center, or flip the 
selection box. You can also force the box to match the source media's aspect ratio or your project's output aspect 
ratio. Matching the output aspect ratio can prevent black bars from appearing when you use source media (such as 
photographs) that does not match your project's aspect ratio.

Moving closer to or farther 
from viewer. Drag across 
corners to flip the track.

Dragging the track. Rotating left to right 
around the Y axis.

Rotating forward or
backward around the
X axis.

Rotating around the
Z axis.



Composited group 3D motion

1. Click the Make Compositing Child button ( ) on the tracks you want to group 
to create a compositing group. For more information, see Understanding the 
parent/child track relationship on page 229.

2. Click the Parent Composite Mode button ( ) on the parent track and choose 
3D Source Alpha. 

3. Click the Parent Motion button ( ) on the parent track. The Track Motion 
window is displayed.

Parent track motion affects the parent track and all child tracks.

In the sample track list to the right, parent track motion on track 1 will affect 
tracks 1 through 6.

Parent track motion applied to track 4 will affect only tracks 4 through 6.

4. Choose a setting from the Layout drop-down list to choose the workspace 
display you want to use. The Layout setting allows you to see your track from 
various points of view.

5. Adjust the selection area to change the viewable area of the track and its position in space. Guides are displayed in 
bold to indicate how the track will be moved or rotated: 

6. Use the buttons at the top of the dialog to allow or prevent movement or scaling. For more information, see Changing 
editing options on page 236.

7. The 3D track motion occurs instantly, and the results are updated in the Video Preview window. 

8. Use the keyframe controller at the bottom of the Track Motion window to establish distinct track motion settings 
throughout the duration of the track. 

During playback, immediate frames are interpolated to create smooth motion. Expand the Keyframe interpolation 
heading on the left side of the window and drag the Smoothness slider to adjust the interpolation. For more 
information, see Using keyframe animation on page 250.

Tip: Right-click the workspace to display a shortcut menu that displays commands to restore, center, or flip the 
selection box. You can also force the box to match the source media's aspect ratio or your project's output aspect 
ratio. Matching the output aspect ratio can prevent black bars from appearing when you use source media that does 
not match your project's aspect ratio.

Parent 
motion

Moving closer to or farther 
from viewer. Drag across 
corners to flip the track.

Dragging the track. Rotating left to right 
around the Y axis.

Rotating forward or
backward around the
X axis.

Rotating around the
the Z axis.
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Changing editing options

Use the toolbar at the top of the Track Motion window to change your editing options.

Examples of various 3D compositing scenarios

In the following examples, track two (blue-and-yellow checkerboard) is rotated forward in 3D space, track 4 (green-and-
gray checkerboard) is rotated backward in 3D space, and track 3 (red-and-white checkerboard) is a 2D track.

Track 1 is used to rotate tracks 2 through 4 so you can see the compositing interaction.

In the first example, the 2D track is a compositing child to track 2. The 2d child is inserted in the composited output at a 
depth of zero on the Z axis, and tracks 2 and 4 intersect in 3D space.

In the next example, clicking the Make Compositing Parent button ( ) on track 3 forces the track below (at the same 
compositing level) to be rendered in 3D and composited as a 2D image.

Icon Command Description

Enable Rotation Select this button if you want to be able to rotate, or spin, the video. 

When the button is not selected, video is locked so you can move it along the X, Y, or Z axis, but 
the event will not rotate.

Enable Snapping to 
Grid

Select this button if you want your editing to snap to the grid.

Edit in Object Space Select this button if you want to edit in the object's space rather than the camera's space. 

For example, if a video object is rotated, its X axis may not correspond to the X axis of the of the 
Video Preview window. Selecting the Edit in Object Space button in conjunction with the Prevent 
Movement buttons allows you to move the object along its own X, Y, and Z axes.

Prevent Movement 
(X)

Select this button if you want to prevent horizontal movement of the track.

Prevent Movement 
(Y)

Select this button if you want to prevent vertical movement of the track.

Prevent Movement 
(Z)

Select this button if you want to prevent movement of the track along the Z axis (closer to or 
farther from the viewer).

Lock Aspect Ratio Select this button if you want the selection box to retain its aspect ratio during resizing. 

When the button is not selected, the height and width can be resized independently.

Scale About Center Select this button if you want the selection box to retain its center point when you resize the box 
by dragging its edges.

When the button is not selected, the opposite side of the selection box will remain anchored 
when you drag the edges to resize it.

Prevent Scaling (X) Select this button if you want to lock the horizontal dimension of the selection box.

Prevent Scaling (Y) Select this button if you want to lock the vertical dimension of the selection box.

Prevent Scaling (Z) Select this button if you want to lock the Z-axis dimension of the selection box.



Track 4 (green-and-gray checkerboard) now has the appearance of depth—the checkerboard tapers to a vanishing 
point—but is inserted in the composited output as a 2D image at a depth of zero on the Z axis. Track 2 is still rotated in 3D 
space.

In the next example, clicking the Make Compositing Parent button ( ) on track 3 again forces the track below (at the 
same compositing level) to be rendered in 3D and composited as a 2D image. However, in this case, the 3D rotation that 
was applied as parent motion on track 1 is not applied to tracks 3 and 4.

In the next example, all tracks are compositing parents. The 3D track on track 2 is on top, the 2D track in track 3 is 
composited below track 2, and the 3D track in track 4 is composited below tracks 3 and 4.

Creating masks

Masks are used to create overlays, limit the effects of a filter, and to create transparent titles. In their simplest form, masks 
work by making a particular color in an image or video transparent. More complex effects can be created with gradients 
(smoothly blending transparent areas together) and by altering the sensitivity of the mask.
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Creating image masks

You can use media generated by Vegas software to create simple masks. You can also create masks from just about any 
image file.

1. Create an image of a solid white circle on a black background in any paint program. This will be the mask.

2. Add the mask image file as an event into the top-most track on the timeline.

3. Insert a video event just below the mask track. This is the background video behind the mask and is the event that is 
masked.

4. Click the Make Compositing Child button ( ) located in the track list of the background video (lower) track. This 
makes the lower track the child of the mask track (the parent track).

In the following example, the white circle is a BMP image file. Black is 100% opaque and white is completely transparent.

Masks can also be partially transparent. By using gradients and grayscale images, you can achieve smooth blending. 
Black is still 100% transparent and white is opaque, but the grays in between are only partially opaque.

The effects of the masks are very clear in these examples, but this is not how they would actually be used in a real 
production. Masks are commonly used to isolate a portion of the video from an effect. Masks do not need to be black and 
white, or grayscale, nor do they need to be still images.

Tip: It is best to use images that are the same size as your project’s frame size. You may also need to change the pixel 
aspect ratio of an image file to get it to display correctly. For more information, see Correcting images for DV pixel aspect 
ratios on page 208 and Modifying media file properties on page 221.

Masks created
using color
gradient
generated 
media events

Compositing

Compositing
Child indicator

Child button



Creating video masks

You can also use video files to create masks, although the process can be more complicated than using an image as a 
mask. The key to any mask is contrast. You can increase the difference between the light and dark areas of a video file 
using video effects plug-ins.

1. Insert the video that you want to use as a mask into a video track.

2. Drag a Black and White plug-in from the Video FX window to the event to remove the color. For more information, 
see Adding a video effects plug-in on page 223.

3. Drag a Brightness and Contrast plug-in from the Video FX window to the event.

4. Adjust the Brightness and Contrast to create the 
mask. Watch the Video Preview window for a real-
time preview of the mask. Adjust the effect so that 
parts of the video are completely black (opaque) 
and other parts are completely white (transparent). 
This can often mean increasing the contrast while 
decreasing the brightness.

5. If necessary, mask areas can be inverted (reversing 
the black and white areas) with an Invert plug-in or 
by selecting the Invert check box in the Mask 
Generator window. For more information, see Using the Mask Generator on page 242.

After you have created the mask, place it in the highest track. Add another video event to another track below the mask 

and click the Make Compositing Child button ( ) on that track. Any video that appears in a lower track below the Parent 
mask track and its Child shows through the areas outside of the mask. The entire setup is pictured in the following 
illustration.

Original color event Black and White Invert plug-inBrightness and Contrast
plug-inplug-in

Mask track

Masked video

Background

(Parent)

(Child)
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Bézier masks

You can use the Event Pan/Crop dialog to create masks using Bézier curves. 

Use the controls in the Path heading on the left side of the Event Pan/Crop dialog to create masks using Bézier curves. 
Each event can contain multiple Bézier masks.

When you use a single setting for the duration of an event, you are masking the contents of the event. You can add 
keyframes to change the shape, size, or position of the mask to create an animated effect.

Creating a Bézier mask

1. From the Tools menu, choose Video, and choose Video Event Pan/Crop (or click the Event Pan/Crop button ( ) 
on the event). The Event Pan/Crop window is displayed.

2. Select the Mask row in the keyframe controller. When the Mask row is selected, Bézier curve-drawing tools are 
displayed so you can create your mask. 

3. Select the Mask check box to apply the mask so you can see the results of your masking in the Video Preview 
window, or clear the check box to bypass the mask.

4. Select the anchor creation tool ( ) on the left side of the Event Pan/Crop window and click in the workspace to 
create a mask. See the following table for a description of the tool's behavior.

Editing the path

Use the tools on the left edge of the Event Pan/Crop window to edit your mask.

Tip: Right-click the curve, choose Initialize Tangents, and choose a command from the submenu to smooth the 
path (or portions of the path) to help you get started with your editing.

Icon Tool Description

Normal 
Edit

Use to select and edit control points and tangents.

Click a point to select it, or drag to move the point.

Hold Ctrl while clicking to select/deselect multiple points.

Hold Alt and click a segment to select all points on the path. The pointer is displayed as a . 

Hold Alt+Shift while clicking an anchor point to invert the selection state of each anchor on the path. The 
pointer is displayed as a .

Drag a segment between two anchor points to modify the tangents on each side of the segment. The 
pointer is displayed as a .

Hold Ctrl while clicking an existing point in a closed path to show or hide the tangents. The pointer is 
displayed as a .

Drag a tangent control to manipulate the curve. Both sides of the tangent control move about the anchor 
point. The pointer is displayed as a .

Hold Ctrl while dragging a tangent control to split the halves of the control and adjust them independently 
or join the two halves of the control if the tangent was previously split.

Tracks Mask Output



Setting path options

1. Select a path with the Normal Edit tool .

2. Expand the Path heading on the left side of the window to set options for the selected path.

3. Choose a setting from the Mode drop-down list to choose the selected path's masking behavior. 

• Positive — The area inside the path is visible in your video output.
• Negative — The area outside the path is visible in your video output. The area inside the path is transparent.
• Disabled — The path is bypassed.

4. Select the Anti alias box and choose Yes or No from the drop-down list to indicate whether you want to apply an 
anti alias filter to smooth the edges of the path.

5. Select the Opacity box and type a value in the box (or click the  to display a slider) to set the opacity of the area 
inside the path.

6. Select the Feather type box and choose a setting from the drop-down list to fade the edges of the path. 

• In — Feathering is applied to the inside edge of the path.
• Out — Feathering is applied to the outside edge of the path.
• Both — Feathering is applied to both sides of the path.
• None — No feathering is applied.

7. Select the Feather % box and type a value in the box (or click the  to display a slider) to set the amount of 
feathering that is applied to the path. 

Anchor 
Creation

Use to create control points.

Click to create an anchor point. Drag before releasing the mouse button to modify the tangents of the new 
point.

Click the first or last point of an open path to close the path. The tool is displayed as a . Drag before 
releasing the mouse button to move the entire path.

Click between two anchor points to create a new point. The tool is displayed as a .

If all paths are closed, click to create a new path.

Anchor 
Deletion

Use to remove control points.

Split 
Tangent

Use to adjust control point tangents. 

Click a point to display tangent controls, or click the center of a tangent control to reset it.

Drag center of the tangent control to manipulate the curve. Both sides of the tangent control move about 
the anchor point. The pointer is displayed as a .

Drag the point at either end of the tangent control to manipulate that half of the curve. The pointer is 
displayed as a . 

Hold Shift while dragging a tangent control to split the halves of the control and adjust them independently 
or join the two halves of the control if the tangent was previously split.

Icon Tool Description
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Fine-tuning masks

Depending on the source material, creating a clean mask can be a tricky exercise. There are a few tools and tricks you can 
use to fine tune a mask.

• Solo the track: Click the Solo button ( ) in the track list to isolate the masked track. This allows you to concentrate 
exclusively on the mask.

• Toggle effects: Turn individual plug-ins on and off to isolate effects 
in a plug-in chain. Keep in mind that the order of the plug-ins in the 
chain is important in determining the final composited output.

• Isolate channels: Isolate individual color channels in the Video 
Preview window by clicking the Overlays button ( ). Click the arrow on the button 
to select the specific channel to be isolated and whether to display this channel in 
grayscale only. Then click the main button to toggle the channel display on and off. The 
Alpha as Grayscale option isolates the alpha channel mask and displays it in grayscale. 
For more information, see Understanding the Video Preview window on page 265.

Using the Mask Generator

The Mask Generator is a plug-in that controls the transparency of events to be used as 
masks when you use events that are not grayscale. Apply the plug-in to an event (or a 
track) in the same way as any other plug-in: just drag-and-drop. The Mask Generator plug-
in can be found in the Video FX window (from the View menu, choose Video FX).



How the Mask Generator works

The following illustration demonstrates some of the effects of the Mask Generator. The background image is the original 
mask. There are five ellipses on the mask: white, red, green, blue and an invisible alpha channel. Note especially the 
checkered ellipse in the lower left of the mask; this is the alpha channel. You can base the alpha channel on a color or 
define the alpha channel in a graphics program that supports alpha channel creation. Masks with alpha channels must be 
saved in a format that supports this method of transparency, such as PNG or TGA. As in this example, the alpha channel 
may be invisible in the actual mask.

The top-right example uses luminance to determine the transparency in the mask. The white area is completely 
transparent. Since white is made up of 100% values of red, green, and blue (255,255, and 255), those three colors are all 
33% transparent as well. In the lower-right example, blue is the selected transparent index. The blue area is 100% 
transparent and so are all areas that have a value of 255 for blue (0,0,255), including white (255,255,255).

Chroma keying

Chroma keying or bluescreening is a special case of overlay transparency. A color key is a specific color or a range of 
similar colors in an image that are made transparent, allowing a background video to show through. The idea is to take a 
video subject and film it against a solid, uniform background color. It is critical that the color be smooth and uniformly lit 
with no shadows, and that the color chosen for the background not be used in the subject.

The most important factors in successful blue screening 
happen during shooting, well before the footage is imported 
into Vegas software. Compression of the source video is also 
an important consideration. While almost all video is 
compressed in some way, highly compressed video does not 
key well because colors can be smeared together and edges 
tend to not be very sharp.

If your source footage is good and the captured video file is 
also of high quality, color keying is an easy process.

1. Insert a video with a blue (or any solid colored) 
background into a track. This is the overlay video.

Luminance

Blue

Mask track
(Parent)

Masked track
(Child)

Magnified 
area

Uncompressed video

Compressed video
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2. Insert the background video that will show through the blue areas into the next lower track.

3. Click the overlay video (foreground, higher track) to select it.

4. Drag a Chroma Keyer plug-in from the Video FX window onto the overlay video. The Video Event FX window 
displays.

5. Click the down arrow to the left of the Split Screen View button ( ) on the Video Preview window and choose 
FX Bypassed. This will bypass the effect of the Chroma Keyer plug-in until you are ready to view the effect.

6. In the Video Event FX window, click the Eyedropper button 
( ). The cursor changes to an eyedropper icon.

7. Draw (click and drag) a small rectangular selection area 
around the color(s) to key out. Although you can select the 
color range from just about anywhere, the Video Preview 
window is the best location.

8. Click the Split Screen View button ( ) on the Video 
Preview window to restore the video effects. The Video 
Preview window shows the result of the Chroma Keyer plug-
in.

When a subject is 
filmed against a solid colored background in a studio, you can key out the 
background color using the Mask Generator or the Chroma Keyer plug-in. 
You can select a wider range of colors using the Chroma Keyer plug-in, 
making it the perfect tool for less-than-perfect blue screens.

This procedure selects a small range of colors to use as a key. In the 
example above, the blue sky around the dome is far from uniform and it 
would be difficult to key it out with a traditional blue screen key. The color 
is uniform enough, however, that a range of blues can be selected directly 
from the preview image. Use the controls at the bottom of the dialog box 
to determine the sensitivity of the colors selected. Since the filter selects a 

range of colors, it is a good idea to try to select a relatively small range of similar colors. Drawing a color selection area 
that spans both blue and red colors would make very large sections of an overlay transparent.

Note: You do not need to set the lower track as a child track when using the Chroma Keyer plug-in as you would with a 
mask.

Note: Other effects that can change the color of the event 
should be bypassed when using the Eyedropper tool.

Tip: It is possible to use multiple Chroma Keyer plug-ins on a single event, keying out the blues with one and the reds with 
the other, without keying out any colors between blue and red.



Chapter 16
 Adding Video Transitions and Motion

Want something other than a cut or crossfade between video events? Vegas® software provides a wide variety of 
transitions you can add to your project. This chapter also covers track motion and keyframe animation, which allows you 
to automate video effects, media generators, cropping, panning, and more.

Understanding basic transitions

Transitions occur between two video events. Most professional productions, on television or on the big screen, use only 
two types of transitions. The first is a simple cut, where one scene immediately cuts to the other without delay or effects. 
The other is a fade, otherwise known as a crossfade or a dissolve.

Cuts

A cut is actually not a transition. Instead, the last frame from an event is immediately followed by the first frame of the 
next event. This is what happens with two adjacent events on the timeline, either in the same track or in different tracks. 
This can also happen when an event is punched into another (with fade edge edits turned off ). 

Crossfades

You can fade one event out and fade into the next event by simply overlapping the two. The duration of the transition is 
determined by the amount of overlap. For more information, see Crossfading events on page 101.

Using transition effects

Transition effects are more complex than a simple cut or crossfade. You can replace a crossfade with a transition and then 
customize the transition to meet your needs.

Tip: Select the Event Fade Lengths option on the View menu to display fade lengths between selected and nonselected 
events in the timeline. You can use this display as a quick indicator of a transition’s length.

Adjacent events Events on different tracks Punch-in events
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Adding a transition

1. Insert a video event onto the timeline.

2. Insert another event so that it overlaps the first to create an 
automatic crossfade.

3. In the Transitions window, browse for a transition effect. If the 
Transitions window is not visible, choose Transitions from the 
View menu. 

4. Drag the effect onto the crossfade between the two events.

 

Adding a transition to the end of an event

Typically, a transition occurs between two events on a track, but you can also use transitions 
to fade to and from the background, whether that is an underlying image, video, or 
background color. For example, you can drag a Clock Wipe transition to the end of a video 
event and have the wipe go from the video event to black.

Note: The duration of a transition is automatically 
determined by the amount of overlap between the two events. 
As with other events, you can control the precise duration of a 
transition by dragging the edges in and out. You can also slide a 
transition for more precise control. For more information, see 
Sliding a crossfade on page 102.

Tip: Some transitions also have their own shortcut keys. On the numeric keypad, press / to insert a crossfade, * to insert a 
dissolve, and - to insert a linear wipe. Hold Ctrl while pressing / to convert the transition to a cut at the cursor position.

Tip: Select the Event Fade Lengths option on the View menu to display fade lengths between selected and nonselected 
events in the timeline. You can use this display as a quick indicator of a transition's length.

The original crossfade... ...and the new transition effect.



Adding a transition to all selected events

If you tend to use the same transitions often, you can save yourself some time by adding a transition to all selected events 
at once.

1. Select the events where you want to add the transition.

2. From the View menu, choose Transitions to display the 
Transitions window.

3. Select a transition from the list on the left side of the window. The 
thumbnail images on the right side of the window represent each 
of the existing presets for the selected transition. Hover your 
cursor over a preset to see an animated example.

4. After you’ve found the setting that you want to use, drag it to the 
position where you want it to occur on the timeline.

5. The Video Event FX dialog is displayed to allow you to edit the 
transitions settings, and a  is displayed in the timeline to show 
you where the transition takes place. You can also click this icon to 
edit the transition’s settings.

Dropping on existing cuts, crossfades, or transitions

• If you drop the preset on an existing transition, only transitions within the selection will be changed. Cuts and 
crossfades are preserved.

• If you drop the preset on an existing crossfade, only crossfades and transitions within the selection will be changed. 
Cuts are preserved.

• If you drop the preset on an existing cut, all cuts, crossfades, and transitions within the selection will be changed.

Dropping on event edges

• If you drop the preset on a transition that is at the beginning or end of an event (but does not span two events), only 
single-event transitions that occur on the same end of the event within the selection will be changed.

• If you drop the preset on an event fade-in or -out, event fade-ins/outs and single-event transitions that occur on the 
same end of the event within the selection will be changed.

• If you drop the preset on an event edge with no fade, all other event edges, event fade-ins/outs, and single-event 
transitions that occur on the same end of the event within the selection will be changed.

Adding a transition progress envelope

Normally, a transition progresses from 0 to 100% in a linear fashion over the length of the transition. A transition progress 
envelope gives you complete control over a transition: you can hold, reverse, and repeat individual transitions. 

1. Right-click a transition.

2. From the shortcut menu, choose Insert/Remove Envelopes, and then choose Transition Progress from the 
submenu. An envelope is added to your transition.

3. Add points and adjust the fade curves as desired. For more information, see Using the Envelope Edit tool on page 152.

In the following example, the transition starts, progresses to 50%, reverses direction, and then finishes.

Note: To change the length of the transition for cuts that are converted to transitions, use the Cut-to-overlap conversion 
settings on the Editing tab of the Preferences dialog.
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Understanding track layers

If you want, you can view and modify transitions in an A/B roll 
mode. Right-click the track header and choose Expand Track 
Layers from the shortcut menu to expand the track to reveal three 
layers within the main track. These layers are called the A roll, the B 
roll, and the transition roll.

The concept of an A/B roll is fundamentally different from the multitrack philosophy. 
Every track is in some way mixed (composited) into the final output in a multitrack 
system, but events are not mixed on the A/B roll. Instead, either the A roll or the B roll 
is playing, with the two trading places during a transition. You could mix the two for 
as long as you want with a transition, but they do not blend without an intervening 
transition. Transitions move from one roll and into the other. This could be from A to 
B or from B to A. The direction of the transition is automatically set. The small arrows 
on the side of the transition event indicate this direction. 

As the sequence at the 
right shows, the video output can shift from the A to the B and 
back to A many times during a production, but there is only one 
video output from any particular roll at a time. This means that 
the A and B rolls are not composited.

Converting a cut to a transition

The transition between two events that are adjacent to each other on the same track is instantaneous and is called a cut. 
However, if the first event is trimmed back from the end and the second event is trimmed back from the beginning (in 
other words, both have enough media to overlap), you can transform the cut into a transition effect using this extra 
media.

1. Right-click the line between two adjacent events at the cut position.

2. From the shortcut menu, choose Transition and then choose the transition that you want to insert (e.g., Insert Sony 
Iris).

You can also drag a transition to the cut from the Transitions window.

A roll

Transition roll

B roll

Transition direction arrow



The duration of the newly inserted transition event is determined by the Cut-to-overlap conversion time set in the 
Editing tab of the Preferences dialog. To access this dialog, choose Preferences from the Options menu.

Converting a crossfade or transition to a cut

1. Click to position the cursor within the transition.

2. Hold Ctrl while pressing the / key on your numeric keypad.

The transition will convert to a cut, using the Cut-to-overlap conversion settings on the Editing tab of the 
Preferences dialog to determine where the cut occurs.

Previewing a transition

The easiest way to preview a transition is to set the loop region to the duration of the transition and then loop the 
playback. This allows you to adjust the transition while it is playing and make changes in real time.

1. Double-click the transition. This automatically creates a time selection equal to the 
length of the transition.

2. Click the Loop Playback button ( ) to turn loop playback on. The selection area bar is 
dark blue when loop playback is turned on.

3. Click the Play button ( ).

To preview complicated transitions, you may want to build a dynamic RAM preview or 
prerender the effect. For more information, see Building dynamic RAM previews on page 268 or 
Prerendering video on page 267.

Modifying a transition

All of the transitions include several presets that create standard transitions. If a preset doesn’t meet your needs, you can 
customize a transition to suit your taste.

Notes: There must be enough media in the respective events to cover the transition (e.g., the end of the first event must 
not be the end of the media file).

You can also convert cuts between audio events to crossfades. Click the cut and press / on the numeric keypad to create a 
crossfade. There must be enough media on either side of the cut to create the crossfade.

Tip: You can also animate the parameters of a transition with keyframes. For more information, see Using keyframe 
animation on page 250.

This event’s media is
longer than the trim.

This event’s media extends
before the beginning.

Cut
After the conversion, both events are
longer and extend into the transition.
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1. Click the Transition Properties 
button ( ) on the transition or right-
click the transition and choose 
Transition Properties from the 
shortcut menu. The Video Event FX 
window appears.

2. Change the parameters. Changes 
update in real time in the Video 
Preview window. For help on the 
different controls in the Video FX 
window, click the Plug-In Help button 
( ) to access online help.

Saving custom settings as a preset

After you modify a transition, you can save 
your settings as a preset for use at a later 
time. You can apply presets by choosing 
them from the Preset drop-down list.

1. Modify the settings in the window to 
create your desired transition effect. 
For help on the different controls in the window, click the Plug-In Help button ( ) to access online help.

2. Click the name in the Preset drop-down list. The current text is highlighted.

3. Enter a name for the new preset.

4. Click the Save Preset button ( ).

You can save any additional changes to the custom preset by clicking the Save Preset button.

Using keyframe animation

Keyframe animation is a technique that computer artists use 
to quickly make complex animated sequences. Instead of 
drawing every frame of a title scrolling in from top to 
bottom by hand, an animator simply has to set a starting 
and ending position for the animation and let the computer 
interpolate the intermediate frames. The animation pictured 
on the right has three keyframes: a starting, middle, and 
ending keyframe. More complex animations use more 
keyframes. 

While keyframing motion may be the most obvious use for 
keyframe animations, just about any parameter of an effect 
can be animated with keyframes. Keyframe animation 
techniques are used in many areas, including transition 
effects, video effects, event panning and cropping, 
generated media, and track motion. You can animate color, 
brightness, transparency, motion, size, perspective, and 
many other parameters with keyframes.

Transition

Keyframe
controller

parameters

These three frames show the progression
of a title across three keyframes. 



Understanding the keyframe controller

The keyframe controller appears at the bottom of the Video FX window (used for transitions, effects, and generated 
media), the Track Motion window, and the Event Pan/Crop window.

The cursor position is marked by a flashing line on the controller. This position can also be automatically updated on the 

timeline, with the Video Preview window also updating in real time to reflect changes. Click the Sync Cursor button ( ) 
on the keyframe controller to sync the keyframe cursor with the timeline cursor. 

Adding keyframes

Every effect has a starting keyframe at the beginning (left side) of the keyframe controller. This sets the initial parameters 
for the effect. In order to animate the effect, you must add another keyframe to the effect and change some of the 
parameters. When you first add a new keyframe, it has the same settings (for the transition, effect, pan/crop, etc.) as the 
first keyframe. You can then modify the settings of the new keyframe to create the animation from the first keyframe 
settings to the second.

1. Click the keyframe controller timeline to move the cursor where you want to add a keyframe. The current position is 
marked by a blinking cursor. 

2. Click the Create Keyframe button ( ). 

3. Modify the settings in the window for the new keyframe as desired.

Deleting keyframes

1. Select a keyframe in the keyframe controller.

2. Click the Delete Keyframe button ( ).

Navigating in the keyframe controller

Use the keyframe navigation buttons (First, Previous, Next, and Last) to quickly jump to a keyframe. Alternately, press 
Ctrl+left arrow  or Ctrl+right arrow  to move to the previous or next keyframe.

Modifying keyframes

After you create your keyframes, you can move them, copy and paste them, and change the interpolation curves 
between them.

Tip: You can also add a new keyframe by positioning the cursor in the keyframe controller and changing any parameters 
in the window. A keyframe is added with the new settings at the cursor position.

KeyframesCursor position

Previous

Create

Delete

Next

Sync Cursor

Last

First

Each effect
in a video effects
chain can have
its own keyframes.
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Moving keyframes

You can move a keyframe within the keyframe controller by dragging it to a new position. For track-level keyframes, you 
can also move the keyframes in the track view. For more information, see Working with keyframes in track view on page 253.

Copying and pasting keyframes

Keyframes on the controller can be copied, pasted, and duplicated. 

1. Right-click a keyframe.

2. From the shortcut menu, choose Copy.

3. Right-click the keyframe controller at the position where you want to paste the keyframe. 

4. From the shortcut menu, choose Paste.

Duplicating keyframes

1. Right-click and drag a keyframe to a new position.

2. From the shortcut menu, choose Copy. A duplicate keyframe is created at the new position.

You can also duplicate a keyframe by holding the Ctrl key while dragging it. 

Changing the interpolation curve

The interpolation curve determines the rate at which Vegas software animates between two keyframe settings. You can 
right-click a keyframe to choose a different shape for the interpolation curve. The shortcut menu provides six options: 
Linear, Fast, Slow, Smooth, Sharp, and Hold. Selecting Hold from the shortcut menu prevents any animation from being 
interpolated between two keyframes. The color of the keyframe indicates which interpolation curve is being used. 

Changing the relative spacing of keyframes

You can change the relative positions of the keyframes as a group. This can be useful if you need to change the overall 
length of an animated sequence or if you need to copy a set of keyframes to another event that has a different duration 
than the original.

1. Click on the first keyframe, hold the Shift key, and click on the last keyframe in the sequence to select all of the 
keyframes.

2. Hold Alt and drag the first or last keyframe to scale the keyframes.

When copying keyframes from longer events to shorter events, you must temporarily lengthen the duration of the 
shorter event so that all of the keyframes appear on the keyframe controller. Once you have pasted the keyframes, you 
can rescale the keyframes using the above procedure, and then resize the event to its original length.

Hold (red)

Linear (gray)

Fast (green)

Slow (gold)

Smooth (lilac)

Sharp (pink)



Creating keyframe presets

The 2D and 3D track motion dialogs allow you to create, save, and recall keyframe presets. Keyframe presets save the 
settings of the selected keyframe row at the cursor position.

Saving a preset

1. Adjust your Position, 2D Shadow, or 2D Glow settings as desired to create a keyframe.

2. Type a name in the Preset box.

3. Click the Save Preset button ( ).

Recalling a preset

1. Click in the Position, 2D Shadow, and 2D Glow keyframe row to select a row and position the cursor where you 
want to apply the preset.

2. Choose a setting from the Preset drop-down list. 

If no keyframe exists at the cursor position, one is created using the settings from the preset. If a keyframe exists at 
the cursor position, the keyframe’s settings are replaced with the settings from the preset.

Deleting a preset

Click the Delete Preset button ( ) to delete the current preset.

Working with keyframes in track view

You can move and modify track keyframes in track view. These keyframes are used in the following three track-level 
effects:

• Track effects plug-in (pg. 223)
• Track motion (pg. 258)
• Mask generator plug-in on a parent compositing track (pg. 242)

Viewing and moving track keyframes

Once you have added keyframes to one of these track-level effects, the track keyframes appear at the bottom of the track 

on the timeline. Click the Expand Track Keyframes button ( ) to view the keyframes. 

Notes: Presets for the Position, 2D Shadow, and 2D Glow keyframe rows are saved separately. 
Presets for 2D and 3D track motion are saved separately: presets you create in the 2D Track Motion window will not be 
available in the 3D Track Motion window.

Notes: 

Presets for the Position, 2D Shadow, and 2D Glow keyframe rows are saved separately.

Presets for 2D and 3D track motion are saved separately: presets you create in the 2D Track Motion window will not be 
available in the 3D Track Motion window.
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You can drag a keyframe on the track in the same way you would in the keyframe controller. To move several keyframes 

at once, use the Envelope Edit tool ( ) to select and drag multiple keyframes.

Adding new track keyframes

You can add new track keyframes to an existing track-level effect by double-clicking the track keyframe area.

Editing track keyframes

Double-click a track keyframe to open the associated window and adjust the settings. To change a keyframe 
interpolation curve, right-click the keyframe and choose a curve type from the shortcut menu.

Locking track keyframes to events

When track keyframes are locked, you can move events along the track and the keyframes move along with them. Only 
keyframes that occur within the selected events move. 

Select the Lock Envelopes to Events button ( ) to lock track keyframes to the events on the track.

Hiding track keyframes

If track view becomes too cluttered, you can hide track keyframes from view. From the View menu, choose Show Video 
Envelopes, and choose Track Keyframes from the submenu to hide track keyframes.

Sample uses for keyframe animation

The following section provides several examples of how keyframe animation can be used with features such as event 
panning and cropping, video effects plug-ins, and generated text events.

Animating event panning and cropping

You can combine event panning and cropping tools with keyframe animation to create several special effects. For more 
information, see Cropping video on page 205.

Tip: You can use ripple editing to automatically move track keyframes as you edit in the timeline. For more information, 
see Applying post-edit ripples on page 99.

Expand Track Keyframes button

Collapse Track Keyframes button

With track keyframes
collapsed, keyframes
are minimized.

With track keyframes
expanded, each
set of keyframes
displays. You can 
move any keyframe
by dragging it to a

Keyframe

Keyframe

new position.



Zooming in on a still image

By using keyframe animation in the Event Pan/Crop window, you can zoom in and out on a still image. In this example, 
four keyframes are used to zoom in on faces in an old photograph and zoom back out again. A generated color gradient 
event masks the edges of the image during the zoom to enhance the effect. For more information, see Using generated 
media on page 228.

1. Click the Event Pan/Crop button ( ) on the still image event.

2. Click the keyframe controller to position the cursor for the second keyframe.

3. Click the Add Keyframe button ( ). Resize and move the selection area to zoom in on a portion of the image.

4. Click the keyframe controller to position the cursor for the third keyframe.

5. Click the Add Keyframe button ( ). Resize and move the selection area to zoom in on a different portion of the 
image.

6. Click in the keyframe controller near the end of the event to place the final keyframe. 

7. Click the Add Keyframe button ( ).

8. Right-click in the selection area and choose Restore from the shortcut menu. The selection area is zoomed out to 
include the full image for the last keyframe.

9. Preview the event in the Video Preview window. Adjust the settings in the Event Pan/Crop window as you preview 
the zoom effect.
First keyframe Second keyframe Third keyframe Last keyframe
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Using pan-and-scan

Another way to use keyframe animation in the Event Pan/Crop window is panning, or pan-and-scan. Pan-and-scan is a 
technique commonly used when film is converted for television. Movie screens and film are usually wider (~2.35:1) than 
television (~1.33:1). When you transfer the film to video, you have four choices: (1) squash the film horizontally to fit, 
distorting it in the process; (2) crop it, possibly losing information on the sides; (3) letter box it so the top and bottom 
have black areas and the picture is shorter overall; and (4) pan-and-scan. Pan-and-scan is a variation of cropping, where 
someone goes through the movie and moves the crop area back and forth to follow the action or subject.

1. Click the Event Pan/Crop button ( ) on the event. The Event Pan/Crop window appears.

2. Confirm that the Stretch to fill frame check box is selected.

3. Right-click the selection area and choose Match Output Aspect from the shortcut menu.

4. Select a starting position, size, and angle of rotation for the crop rectangle. This is the start position (first keyframe).

5. Click in the keyframe controller and press Ctrl+End. This moves the cursor to the end of the event.

6. Click the Create Keyframe button ( ). A new keyframe appears in the keyframe controller at the end of the event. 

7. Change the position, size, and angle of rotation. This is the final position (last keyframe).

8. Preview the event. Add and adjust keyframes as needed to create the desired effect. You can adjust both temporal 
and spatial interpolation for each keyframe:

• Temporal interpolation (how the pan occurs over time) is controlled by the keyframe interpolation curve type. 
Experiment with temporal interpolation by right-clicking a keyframe to change the interpolation curve type 
(hold, linear, fast, slow, smooth) and previewing the result. For more information, see Changing the interpolation 
curve on page 252.

• Spatial interpolation (how the pan occurs within the video image) is controlled by the Smoothness setting of 
each keyframe. A smoothness value of 0 makes the movement linear from one keyframe to the next. A higher 
smoothness value makes the path of the pan more curved. Select a keyframe and change the Smoothness value 
to adjust spatial interpolation.

Animating video effects plug-ins

You can use keyframe animation to smoothly and gradually apply an effect to an event. This example uses the Add Noise 
plug-in. The Add Noise plug-in adds static or noise to a video sequence. When added to a simple solid-colored 
background with a monochrome setting and animated, a pattern is produced that is similar to a television that is not 
tuned to any station.

1. Add an Add Noise plug-in to an event. For more information, see Adding a video effects plug-in on page 223. The Video 
FX window appears with the keyframe controller at the bottom of the window.

2. Add two keyframes to the event for a total of three including the one at the beginning. New keyframe attributes are 
copied from the previous keyframe.

3. Click the first keyframe to select it. Drag the Noise level slider to 0.

4. Click the last keyframe to select it. Drag the Noise level slider to 0.

5. Click the second keyframe to select it. From the Preset drop-down list, select Grainy.

6. Hold Ctrl and drag the second keyframe to duplicate it. Position this new keyframe between the second and final 
keyframes.



The effect is off at the first keyframe and smoothly transitions to a grainy effect at the second keyframe, at which point 
the effect remains constant until the third keyframe. Then the effect gradually fades out until it reaches a minimum value 
at the last keyframe. 

Animating generated text 

You can add a generated text event to a project by dragging a text generator from the Media Generator window. For 
more information, see Using generated media on page 228. You can then animate the text by adding keyframes. 

Not all attributes of generated text media can be animated using keyframes, however. You cannot, for example, morph 
one text message into a different one. Some aspects can be easily and smoothly animated using the keyframe controller, 
such as text, color, transparency, leading, tracking, and position.

Other aspects of generated text do not allow interpolated keyframe animation. For example, if you set the text to “One” 
initially and then at five seconds change it to “Two”, the text will suddenly jump to the new value at the five second 
keyframe. This behavior is different from the behavior of other keyframe animation techniques. 

In this example, keyframes are used to make a title appear one letter at a time across the screen.

1. Drag a text generator from the Media Generator window to the timeline.

2. Right-click the new event and choose Edit Generated Media.

3. Enter the first letter of the title, for example “T”.

4. Click the keyframe controller at the 1.000 second mark and enter the second letter, for example “y”. The title now 
reads “Ty”. A new keyframe appears in the keyframe controller at the 1.000 second mark.

5. Proceed down the keyframe controller to 2.000 and enter the letter “p”.

6. Proceed down the keyframe controller repeating this process until the title is finished: “Typing”.

Keyframe 1
Noise = None

Keyframes 2 and 3
Noise = Grainy

Keyframe 4
Noise = None

The results of gradually transitioning into an effect using keyframe animation.
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7. Preview the event in the Video Preview window. The word “Typing” appears one letter per second until finished.

Adding track motion

The Track Motion window (accessible by clicking the Track Motion button  on any video track) is used to move a 
video track across a background. This background can be a solid color, another video event, or an image. Picture-in-
picture effects and scrolling title sequences are two simple cases where this tool is important.

The gray area in the center of the window (covered by the blue/gray rectangle) represents the actual screen or area that 
is visible in the movie. The area outside of the main screen, which is filled with dotted lines, is the general workspace. The 
video you are moving can be positioned off of the visible screen and then animated onto and across the screen. The dots 
are markers to help position the video window. If snapping is enabled, these serve as snapping points. 

The main window allows you to control the placement, size, and orientation of the overlay video through time. The blue 
and gray rectangular overlay in the middle represents the video on the track. The selection box in the workspace is used 
to represent the orientation of the track.

You can also use 3D compositing to move tracks through space. For more information, see 3D Compositing on page 233.

Text box

Keyframe
Controller

Keyframe controller

Track area

Properties 
Controls

Keyframe presets



Controlling track motion

1. Click the Track Motion button ( ) on the track that contains the overlay that you want to animate. The Track 
Motion window is displayed. 

2. Adjust the selection area to change the viewable area of the track and its position in space. Guides are displayed in 
bold to indicate how the track will be moved or rotated: 

3. Use the buttons at the top of the dialog to allow or prevent movement or scaling. For more information, see Changing 
editing options on page 260.

4. The track motion occurs instantly, and the results are updated in the Video Preview window. 

5. Use the keyframe controller at the bottom of the Track Motion window to establish distinct track motion settings 
throughout the duration of the track. 

During playback, immediate frames are interpolated to create smooth motion. Expand the Keyframe interpolation 
heading on the left side of the window and drag the Smoothness slider to adjust the interpolation. For more 
information, see Using keyframe animation on page 250.

Using the track motion shortcut menu

When you right-click anywhere in the Track Motion window, a shortcut menu appears:

• Restore View returns the workspace display to its original state.
• Restore Box returns the overlay to its original state (size, rotation, and position).
• Restore Rotation returns the overlay to its unrotated state.
• Restore Size returns the overlay to its original size.
• Restore Center moves the overlay to the center of the frame.
• Flip Horizontal flips the overlay backwards or left to right.
• Flip Vertical flips the overlay upside-down.
• Match Output Aspect sets the aspect ratio to the frame value.
• Make Square Aspect sets selection box to a square aspect.

Tip: Use the Default Track Motion smoothness control on the Editing tab of the Preferences dialog to set the 
default Smoothness value for new keyframes.

Moving closer to or farther 
from viewer. Drag across 
corners to flip the track.

Dragging the track. Rotating around the
Z axis.
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Changing editing options

Use the toolbar at the top of the Track Motion window to change your editing options.

Using keyframes in track motion

Keyframes are what create the motion in the track motion feature. You can create, modify, and remove keyframes in the 
keyframe controller in the same way as with any other feature that uses keyframes. In addition, for track motion and 3-D 
track motion, you can use keyframe presets to save and recall the settings of the selected keyframe row at the cursor 
position. For more information, see Using keyframe animation on page 250.

The keyframe controller in the Track Motion window has three attributes that can be animated: position, shadow, and 
glow. Each effect can be animated independently. The shadow and glow effects can be turned on and off. Each effect has 
its own set of controls that appear on the left-hand side of the window. You can access these controls by clicking the 
respective item on the keyframe controller.

Icon Command Description

Enable Rotation Select this button if you want to be able to rotate, or spin, the video. 

When the button is not selected, video is locked so you can move it horizontally or vertically, but 
the track cannot be rotated.

Enable Snapping 
to Grid

Select this button if you want your editing to snap to the grid.

Edit in Object 
Space

Select this button if you want to edit in the object's space rather than the camera's space. 

For example, if a track is rotated, its X axis may not correspond to the X axis of the of the Video 
Preview window. Selecting the Edit in Object Space button in conjunction with the Prevent 
Movement buttons allows you to move the object along its own X and Y axes.

Prevent 
Movement (X)

Select this button if you want to prevent horizontal movement of the track.

Prevent 
Movement (Y)

Select this button if you want to prevent vertical movement of the track.

Lock Aspect Ratio Select this button if you want the selection box to retain its aspect ratio during resizing. 

When the button is not selected, the height and width can be resized independently.

Scale About 
Center

Select this button if you want the selection box to retain its center point when you resize the box by 
dragging its edges.

When the button is not selected, the opposite side of the selection box will remain anchored when 
you drag the edges to resize it.

Prevent Scaling (X) Select this button if you want to lock the horizontal dimension of the selection box.

Prevent Scaling (Y) Select this button if you want to lock the vertical dimension of the selection box.

Tip: If any controls described in this section are not visible on the screen, enlarge the Track Motion window by dragging 
the lower right corner until all controls are revealed.



Position 

You can control the position of the overlay in the main window by dragging the 
selection box or editing the controls on the left side of the window. However, the 
Position, Orientation, and Rotation controls in the window are invaluable when you 
need precision in resizing, moving, or rotating the overlay. 

The Smoothness box allows you to modify the smoothness of the interpolation curve 
among three or more keyframes. 

You can use the Workspace controls to adjust the magnification and viewable area of 
the workspace. Use the Snap Settings controls to adjust the grid in the workspace. 

2D Shadow 

This creates a simple drop shadow that appears under the entire window or only under the opaque (nontransparent) 
parts of the overlay. You can control the size and offset of the shadow as well as the shadow color. A shadow is especially 
effective under a picture-in-picture window or to emphasize text and titles. Use the Eyedropper tool to select a specific 
color from anywhere on the screen.

The shadow effect creates a drop shadow under an object, window, or title. A shadow is especially effective under a 
picture-in-picture window.

1. Select the 2D Shadow row in the keyframe controller. When the 2D Shadow row is selected, shadow controls are 
displayed in the Track Motion dialog.  
 
Select the 2D Shadow check box to apply the shadow so you can see the results of your shadow in the Video 
Preview window, or clear the check box to bypass the shadow.

2. Use the 2D Shadow controls on the left side of the window to set the color and appearance of the shadow:

• Blur % — type a number in the box or click the  button to display a slider you can use to soften the edge of 
the shadow. Set to 0 for a hard edge, or increase the setting to feather the edge of the shadow.

• Intensity — type a number in the box or click the  button to display a slider you can use to establish the 
transparency of the shadow's blurred edge. Decrease the setting for a translucent shadow, or increase the 
setting for a more opaque shadow.

• Color — click the down arrow next to the color swatch to display a color picker. Use the sliders or edit boxes in 
the color picker to set the shadow color, or use the eyedropper tool ( ) to sample a color from your screen.

3. Adjust the size position of the shadow by dragging the box in the workspace or using the Position, Orientation, and 
Rotation controls on the left side of the window. For more information about manipulating the selection box, see 
Controlling track motion on page 259.
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4. To animate the shadow, click in the 2D Shadow row of the Keyframe Controller to set the cursor to a later time and 
adjust the shadow settings.

2D Glow 

Glow is a bright haze surrounding an overlay. In general, light colors are used for glow effects, but you can emphasize 
bright text on complex backgrounds by using a very small black glow, with little or no feathering, and 100% intensity.

1. Select the 2D Glow row in the keyframe controller. When the 2D Glow row is selected, glow controls are displayed in 
the Track Motion dialog. 

Select the 2D Glow check box to apply the glow so you can see the results of your shadow in the Video Preview 
window, or clear the check box to bypass the glow.

2. Use the 2D Glow controls on the left side of the window to set the color and appearance of the glow:

• Blur % — type a number in the box or click the  button to display a slider you can use to soften the edge of 
the glow effect. Set to 0 for a hard edge, or increase the setting to feather the edge of the glow.

• Intensity — type a number in the box or click the  button to display a slider you can use to establish the 
transparency of the glow’s blurred edge. Decrease the setting for a translucent glow, or increase the setting for 
a more opaque glow.

• Color — click the down arrow next to the color swatch to display a color picker. Use the sliders or edit boxes in 
the color picker to set the glow color, or use the eyedropper tool ( ) to sample a color from your screen.

3. Adjust the size position of the glow by dragging the box in the workspace or using the Position, Orientation, and 
Rotation controls on the left side of the window. For more information about manipulating the selection box, see 
Controlling track motion on page 259. 

Cropped video

Shadow



4. To animate the glow, click in the 2D Glow row of the Keyframe Controller to set the cursor to a later time and adjust 
the glow settings.

Creating a picture-in-picture effect

Picture-in-picture is an easy effect to reproduce using track motion. 

1. Insert the background video into a track.

2. Insert the overlay video into another track just above the background video track.

3. Click the Track Motion button ( ) on the upper overlay track.

4. In the Track Motion window, position and resize the track area.

Cropped video

Glow
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The illustration below shows some of the relevant parts of this procedure. Note the shadow cast by the overlay video. 
This is added by selecting the 2D Shadow check box on the keyframe controller. The Video Preview window displays the 
results.

Animating the overlay

You can animate many aspects of an overlay using the keyframes at the bottom of the Track Motion window.

1. Insert a video event onto the timeline.

2. Click the Track Motion button ( ) in the track list.

3. In the Track Motion window, resize the overlay by dragging the handles at the edges of the overlay.

4. Drag the middle of the overlay to position it. This will be the size and position for the start of the animation.

5. Click the timeline of the keyframe controller at a later time to move the cursor to that position.

6. Reposition the overlay. A new keyframe is automatically added to the keyframe controller at the new cursor position.

When you preview the video, the position of the overlay interpolates between the two keyframes with a smooth 
animation.

Tip: While overlay picture-in-picture windows are often completely opaque, you can fade them in and out using opacity 
envelopes. For more information, see Using opacity envelopes on page 162.

Tip: With the Sync Cursor button ( ) enabled, you can also navigate to a new position on the main timeline. The 
cursor is automatically moved on the keyframe controller to the same location.



Chapter 17
 Previewing and Analyzing Video

As you work in Vegas® software, you can preview your video by using the Video Preview window or by connecting to an 
external monitor. You can optimize previews by adjusting preview quality, prerendering video, or building a dynamic 
RAM preview. The Video Preview window also provides features such as safe area overlays, grid overlays, and isolated 
color channel displays to further enhance your productivity.

Understanding the Video Preview window

The workspace for editing video can get quite crowded, so the Video Preview window can be configured in a number of 
ways to make it more useful. The Video Preview window can be used on a separate monitor or Windows display (if your 
video hardware supports this feature), docked at the bottom of the workspace, or floated freely on the screen.

Docked window Floating window

Preview Quality

Copy Snapshot to Clipboard

Project Video Properties

Preview on External Monitor

Video Output FX

Properties status bar

Save Snapshot to File

Split-Screen View Overlays
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Using the Video Preview window shortcut menu

Right-click the Video Preview window to adjust the following options:

• Choose Default Background, Black Background, or White Background to set the background color for the window.
• Simulate Device Aspect Ratio displays the output in square pixels. This can prevent distortion of the preview when 

using sources with rectangular pixels. This does not affect the final render.
• Choose Scale Video to Fit Preview Window if you want the preview to fill the Video Preview window. This setting is 

used for previewing only.
• Show Toolbar toggles the toolbar at the top of the window.
• Show Status Bar toggles the information display at the bottom of the window.
• Preview Device Preferences displays the Preview Device tab of the Preferences dialog, allowing you to configure an 

external monitor.

Optimizing the Video Preview window

Timing and synchronization are critical aspects of any multimedia production. Because complex multimedia projects are 
challenging for any computer, a number of tools are provided to maintain real-time playback even though the computer 
may not be able to process the data quickly enough.

Adjusting preview quality and resolution

You can adjust the resolution of the Video Preview window and the quality of the preview rendering in order to improve 
playback. Lower-resolution previews are less clear but allow more frames to be displayed per second. This may be 
particularly important with projects that use overlays, transitions, and effects. Click the Preview Quality button and 
choose a setting from the menu to change the quality and resolution for rendering your video preview.

The Auto setting will adjust the frame size to fit the Video Preview window size. The Full setting processes frames at the 
project frame size. The Half setting processes frames at half the project frame size. The Quarter setting processes frames 
at one-quarter of the project’s frame size. For example, if you have an NTSC (720x480) project, Half creates a 360x240 
preview; Quarter creates a 180x120 preview.

Button Description
Project Video 
Properties

Displays the project’s properties (pg. 220).

Preview on External 
Monitor

Sends the preview out to an external monitor. This only functions if your hardware supports this 
feature (pg. 314).

Video Output FX Opens the Video Output FX window for adding video effects plug-ins for the entire project 
(pg. 223).

Split-Screen View Turns split-screen previews on or off. Split-screen previews allow you to split the preview window 
so you can see your affected and unaffected video or your video and the contents of your clipboard 
at the same time.

Preview Quality Changes the preview resolution and display size. You can choose a lower resolution to drop fewer 
frames during playback. Choose an Auto option to display the preview at the current Video 
Preview window size; choose a Full option to display the preview at project size.

Note: If your project properties are set to either the Blend or Interpolate deinterlace method, you 
will not see the effects of deinterlacing in Draft and Preview quality preview modes. Deinterlacing 
only occurs in the Good and Best quality preview modes.

Overlays Options include safe areas, grids, and individual channels.
Copy Snapshot to 
Clipboard

Copies the contents of the frame to the clipboard

Save Snapshot to File Saves the contents of the preview window as a JPEG or PNG. The new image file is automatically 
saved to the Project Media window (pg. 209).

Tip: Choosing a Quarter or Half setting can improve playback performance when previewing high-definition source 
material.



If you want to display square pixels in the Video Preview window even if the Pixel aspect ratio setting in the Project 
Properties dialog is using nonsquare pixels (DV), right-click the display and choose Simulate Device Aspect Ratio from 
the shortcut menu.

If you want the preview to fill the Video Preview window, right-click the display and choose Scale to Fit Preview Window 
from the shortcut menu.

This setting is used for previewing only and has no effect on the final rendered video. Decreasing the preview resolution 
can allow the Vegas Video Preview window to display a higher frame rate, especially for complex projects that contain 
overlays, transitions, and effects.

Prerendering video

There are times where nothing but a full, high-quality preview will do. In these cases, Vegas software can take the time 
necessary to selectively render only the portions of your project that need extra processing. These sections are 
prerendered and short files are created to use for previews. The prerendering can take anywhere from a few seconds to a 
few minutes, depending on the length and complexity of the video. 

Once these temporary files have been created, they are used whenever those sections of the project are played back, 
increasing playback quality and performance. As long as no changes are made to the events in the prerendered sections, 
the newly created files continue to be used for previews, even if changes are made to other sections of the project.

1. To prerender a portion of the project, create a selection containing the portion you want to prerender.

2. From the Tools menu, choose Selectively Prerender Video. The Prerender Video dialog appears. 

3. Select the type of prerender file to create in the Prerender as drop-down list. Click Custom to configure any custom 
compression options.

4. To preview just a portion of the project, verify that Render loop region only is selected. To create a prerender of the 
entire project, clear this check box.

5. Select the Stretch video to fill output frame size (do not letterbox) check box when you are rendering to an output 
format with a slightly different aspect ratio than your project settings. This will prevent black bars from appearing on 
the top and bottom or the sides of the output.

6. Click OK. A progress bar displays the progress of the render. 

Tip: Try setting the preview quality to Preview > Full and enabling Scale to Fit Preview Window.

Note: To view the effects of the deinterlacing method you chose in your project properties, you will need to use the Good 
or Best quality preview mode. The Draft and Preview quality preview modes do not deinterlace.

Notes: 

You'll need to choose a rendering template that inserts pulldown fields to create a standard DV file if your project 
properties are set to 24p or if you selected the Allow pulldown removal when opening 24p DV check box on the 
General tab of the Preferences dialog. Use the NTSC DV 24p (inserting 2-3-3-2 pulldown) template if you intend to use 
the file on the Vegas timeline.

If you cleared the Allow pulldown removal when opening 24p DV check box before adding your media and your 
project properties are not set to 24p, your 24p video is read as 29.97 fps interlaced video (60i), so you can choose whichever 
NTSC DV or PAL DV template suits your project requirements.
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When prerendering is complete, bars appear at the top of the timeline indicating the sections that have been 
prerendered.

As a default, these preview files are saved when a project is closed. To delete these files when you close the project, from 
the Options menu, choose Preferences and, on the General tab, clear the Save active previews on project close check 
box. 

You can set the location of these preview files by clicking the Project Video Properties button ( ) and choosing a 
Prerendered files folder in the Project Properties dialog. Ideally, this folder should be on a different physical drive from 
where Windows is installed. You can delete prerendered preview files from your hard disk by choosing Clean Up 
Prerendered Video from the Tools menu.

Building dynamic RAM previews

Video frames are automatically dropped when previewing if the computer can’t keep up with processing demands. This 
means that you may not be seeing all video frames as you preview your project. If you prefer not to prerender your 
project, there is another option for improving previews of selected portions of a project. A portion of your RAM is 
dedicated to cache video frames that Vegas software cannot render in real time. 

A cache of 16 MB is automatically maintained for dynamic RAM previews. To change the cache amount, choose 
Preferences from the Options menu and change the Dynamic RAM Preview Max value on the Video tab.

You can make a time selection and add each frame in the selection to the cache. Once the frames are cached, all video 
frames can display in a selection. 

1. Select a region containing the frames you want to cache.

2. From the Tools menu, choose Build Dynamic RAM Preview.

Vegas software plays through the time selection and builds the cache frame by frame. 

Note: Each prerendered section will consist of no more than 10 seconds (approximately 40 megabytes). Because selective 
prerendering creates multiple files, minor editing on the timeline will not invalidate all of your prerendered video—only 
the sections you modify will need to be rerendered.

Note: Although not all frames appear in previews of a project, all frames are included when you render a file. For more 
information, see Rendering a project on page 282.

Prerendered sections



Using split-screen previewing

Click the Split-Screen View button ( ) in the Video Preview window to turn split-screen previews on or off.

Split-screen previews allow you to split the Video Preview window so you can see your affected and unaffected video or 
your video and the contents of the clipboard at the same time. Use split-screen previews to fine-tune video effects or to 
match colors for color correction.

Previewing affected and unprocessed video

1. Click the down arrow next to the Split-Screen View button ( ) and choose FX Bypassed from the menu.

2. Select the Split-Screen View button ( ). The cursor is displayed as a .

3. Choose a preset selection or drag in the Video Preview section to create a selection. This selection will display the 
unprocessed video. In the following example, the Add Noise plug-in was applied to the event, and the selection 
displays the original video.

Showing the video at the cursor position and the contents of the clipboard

1. Position the cursor on the timeline and click the Copy Snapshot button ( ) in the Video Preview window to copy a 
frame to the clipboard.

2. Position the cursor at another point on the timeline.

3. Click the down arrow next to the Split-Screen View button ( ) and choose Clipboard from the menu.

4. Select the Split-Screen View button ( ). 

5. Choose a preset selection or drag in the Video Preview section to create a selection. This selection will display the 
contents of the clipboard.

Note: The Video Preview window temporarily enters split-screen preview mode when you slip-trim a video event. This 
temporary split-screen mode allows you to see the event's first and last frame as you trim. You can toggle this preview 
mode by selecting or deselecting the Video Event Edge Frames option on the View menu.

Tip: Double-click in the Video Preview window to select the full window, or drag again to replace the existing 
selection.

Tip: Double-click in the Video Preview window to select the full window, or drag again to replace the existing selection.
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Changing the selection for displaying split-screen views

Click the down arrow next to the Split-Screen View button ( ) and choose Select Right Half, Select Left Half, or 
Select All to indicate which portion of the Video Preview window you want to use to display unprocessed video or the 
contents of the clipboard.

When the Split-Screen View button ( ) is selected, the cursor is displayed as a . Drag a rectangle in the Video 
Preview window to create a custom selection.

Identifying safe areas

The Video Preview window displays the entire video frame data. However, most television monitors do not display all of 
this data. Previewing the video on a television monitor is the only way to verify what frame information will display. You 
should also note that individual television monitors vary in what they display. While there is no substitute for previewing 
on a television, safe areas are a good method of estimating the extent of the masking.

1. Click the down arrow next to the Overlays button ( ) and 
choose Safe Areas.

2. Click the Overlays button to toggle the safe areas display on 
or off. The display shows two areas:

• The safe action area is the frame area that is visible on a 
television screen.

• The safe title area is a suggested area to limit the extent 
of titles. It is always smaller than the safe action area.

Viewing the grid

The Video Preview window can display vertical and horizontal lines over your video. You can use the grid to help you 

align objects. To view the grid, click the down arrow next to the Overlays button ( ) and choose Grid.

Set the grid spacing using the Horizontal grid divisions and Vertical grid divisions settings on the Video tab in the 
Preferences dialog.

Isolating color channels

The Video Preview window allows you to select a specific channel to be isolated and whether the channel should be 

displayed in grayscale only. To display a channel, click the down arrow next to the Overlays button ( ) and choose a 
color channel.

Monitoring video with scopes

From the View menu, choose Video Scopes to toggle the display of the Video Scopes window.

Broadcast video uses a narrower range of color than the RGB you see on your computer. When you broadcast a project 
that contains out-of-range colors, you can introduce image problems or even noise into the audio stream.

Use the scopes to analyze the your video and adjust accordingly with the Brightness and Contrast, Broadcast Colors, 
Color Corrector, Color Corrector (Secondary), and Levels plug-ins before rendering.

Tip: To customize safe area sizes, choose Preferences on the 
Options menu, and on the Video tab, enter the Action safe 
area and Title safe area values as a percent of the frame size. 
For more information, see Video tab on page 306.

Note: Use the Alpha as Grayscale setting to isolate the Alpha channel mask and display it in grayscale.

Safe actionSafe title



Choose a setting from the drop-down list to choose which scope you want to display.

Displaying chrominance using the vectorscope monitor

The vectorscope monitor in the Video Scopes window allows you to monitor the chrominance (color content) of your 
video signal. The monitor plots hue and saturation on a color wheel.

The vectorscope displays targets for broadcast-legal saturations of red (R), magenta (Mg), blue (B), cyan (Cy), green (G), 
and yellow (Yl). Individual colors in your video signal are displayed as dots in the vectorscope. A dot's distance from the 
center of the scope represents its saturation, and the angle of the line from the dot to the center of the scope represents 
its hue.

For example, if an image has a blue cast, the distribution of dots in the vectorscope will be concentrated toward the blue 
portion of the color wheel. If the image includes out-of-range blue values, vectorscope display will extend beyond the 
blue target.

You can use the vectorscope to calibrate color between scenes. Without calibration, you may see noticeable color 
differences between scenes from multicamera shoots.

1. From the View menu, choose Video Scopes to toggle the display of the Video Scopes window.

2. Choose Vectorscope from the drop-down list.

3. Position the cursor in the frame you want to analyze. If the Update Scopes While Playing button ( ) is selected, 
you can monitor your video during playback.

Note: If your video hardware will add a 7.5 IRE setup, click the Settings button ( ) and select the 7.5 IRE Setup check 
box in the Video Scopes Settings dialog. Black will be displayed as 7.5 in the waveform monitor. If your video hardware 
does not add a 7.5 setup, clear the check box, and black will be displayed as 0.

Choose setting Display video scopes settings

Update scopes
while playing
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4. The vectorscope monitor displays the chrominance of the video signal:

5. Hover over a portion of the monitor to display the chroma value at the pointer position:

Displaying luminance using the waveform monitor

The waveform monitor in the Video Scopes window allows you to monitor the luminance (brightness or Y component) of 
your video signal. The monitor plots luminance on the vertical axis and the width of the current frame on the horizontal 
axis.

If you want to include chroma (color or C component) information in the waveform monitor, choose Composite from the 
drop-down list at the top of the monitor window. When you choose Luminance, chroma information is omitted.

1. From the View menu, choose Video Scopes to toggle the display of the Video Scopes window.

2. Choose Waveform from the drop-down list.

3. Position the cursor in the frame you want to analyze. If the Update Scopes While Playing button ( ) is selected, 
you can monitor the waveform during playback.

Frame Vectorscope display of frame

Chroma value



4. The waveform monitor displays the luminance of the video signal:

5. Hover over a portion of the monitor to display the luma value at the pointer position:

Displaying color levels and contrast using the histogram monitor

The histogram monitor in the Video Scopes window allows you to monitor color levels and contrast of your video. Use 
the histogram before rendering your project to find and correct out-of-range values that could cause problems on the 
destination playback device.

The bar graph plots the number of pixels that exist for each color intensity. For example, when using the Blue setting, the 
vertical axis represents the number of pixels, and the horizontal axis represents the RGB color range from 0,0,0 to 0,0,255.

To get acquainted with the histogram, use an external monitor to preview your video and watch the video output and 
histogram as you use plug-ins to modify the colors.

1. From the View menu, choose Video Scopes to toggle the display of the Video Scopes window.

2. Choose Histogram from the drop-down list.

3. Choose a histogram type from the menu:

• Luminance: charts the luminance or brightness of colors in your video.
• Red: charts the red tones in your video.
• Green: charts the green tones in your video.
• Blue: charts the blue tones in your video.
• Alpha: charts the alpha channel (transparency) in your video.
• Luminance/R/G/B: stacks luminance and RGB charts.

4. Position the cursor in the frame you want to analyze. If the Update Scopes While Playing button ( ) is selected, 
you can monitor your video during playback.

Frame Waveform display of frame

Luma value
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5. Use the histogram to evaluate the colors in your video. The Mean value indicates the average intensity of all pixels in 
the graph, and the Standard Deviation value indicates the average percentage by which pixels in the graph vary 
from the Mean value.

6. Use plug-ins such as Brightness and Contrast, Broadcast Colors, and Levels to adjust the color. For more information, 
see Using video effects on page 223. 

Displaying RGB components with RGB parade monitor

The RGB parade monitor in the Video Scopes window displays waveforms for the red, green, and blue components of 
your video signal. The monitor plots RGB values from 0-255 on the vertical axis and three times on the horizontal axis.

The parade monitor helps you determine whether the individual RGB components of your video signal are within limits 
and whether the total video signal is clipping.

1. From the View menu, choose Video Scopes to toggle the display of the Video Scopes window.

2. Choose RGB Parade from the drop-down list.

3. Position the cursor in the frame you want to analyze. If the Update Scopes While Playing button ( ) is selected, 
you can monitor your video during playback.

4. The waveform monitor displays the RGB values of the video signal. Hover over the monitor to display the RGB value 
at the pointer position:

Adjusting video scope settings

Click the Settings button ( ) in the Video Scopes window to set your display options. These options adjust the display of 
data in the Video Scopes window and have no effect on your data.

Frame Histogram display of frame

Mean and
standard
deviation
hues

Graph

RGB value



7.5 IRE setup

If your video hardware will add a 7.5 IRE setup, you can configure the Video Scopes window so the display will be 
consistent with an external scope connected to a device that adds 7.5 IRE setup.

NTSC video in the United States adds 7.5 IRE setup to convert black to 7.5 IRE. Consumer video hardware typically does 
not add 7.5 IRE setup, and most professional hardware allows you to turn 7.5 IRE setup on or off. PAL video and NTSC 
video in Japan do not add setup.

Refer to your video hardware documentation to determine whether your hardware adds 7.5 IRE setup. 

1. Click the Settings button ( ) in the Video Scopes window.

2. Select the 7.5 IRE Setup check box in the Video Scopes Settings dialog.  
 
Black will be displayed as 7.5 in the waveform monitor. If your video hardware does not add 7.5 setup, clear the 
check box. 

Studio RGB display

RGB values on your computer can range from 0 to 255. Studio RGB values range from 16 to 235. If you want to limit the 
display of the Video Scopes window to studio RGB standards, perform the following steps:

1. Click the Settings button ( ) in the Video Scopes window.

2. Select the Studio RGB (16 to 235) check box in the Video Scopes Settings dialog.

Whether you need to use the Studio RGB (16 to 235) setting depends on the codec you will use to render your video 
before printing to tape. Suggested settings follow. Refer to the codec’s documentation to determine whether the Studio 
RGB (16 to 235) check box should be selected. 

If the Use Microsoft DV codec check box is selected on the General tab of the Preferences dialog, the Microsoft DV codec 
will be used.

If the Ignore third-party DV codecs check box is selected and the Use Microsoft DV codec check box is cleared on the 
General tab of the Preferences dialog, the Sony Media Software DV codec will be used.

You can render using a third-party DV codec by choosing a specific codec from the Video format drop-down list on the 
Video tab of the Custom Template dialog.

Codec Studio RGB Setting
Sony DV On
Microsoft® DV Off
Matrox® DV Off
MainConcept™ DV Off
Canopus® On
Apple® QuickTime™ DV Off
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Previewing in a player

You can create a full-quality preview that automatically plays in the appropriate media player. You can preview the entire 
project or select a portion.

1. To preview a portion of the project, create a selection containing the portion you want to preview.

2. From the Tools menu, choose Preview in Player.

3. Select the type of preview file to create. Select a template 
or click Custom to configure any compression options.

4. To preview just a portion of the project, verify that 
Render loop region only is selected. To create a preview 
of the entire project, clear this check box.

5. Click OK.

A progress bar displays the progress of the render. When 
finished, the file automatically plays in the appropriate 
media player. 

Using an external monitor

You can feed video directly from the timeline to a television monitor or secondary Windows display. With this feature, 
you can free up valuable space in the Vegas window by viewing a full-screen preview of your project on a different 
display, or you can make your final editing decisions on a broadcast monitor (which differs significantly from a computer 
monitor) before printing the project to tape.

This feature supports video output only; audio is not output to the external monitor.

Configuring an external monitor

Prior to previewing on an external monitor, you’ll need to configure your system to use this feature. From the Options 
menu, choose Preferences and then click the Preview Device tab to configure an external monitor. Your video will be 

sent to this device when you click the Preview on External Monitor button ( ) in the Video Preview window. For more 
information, see Setting preferences on page 311.

Previewing video on a secondary Windows display

If your Windows desktop is extended across multiple displays, you can one of those displays to preview the timeline with 
no A/V synchronization drift—for ADR and foley work.

Notes:

• If you intend to deliver your project in an interlaced format, previewing on a computer monitor is not a substitute for 
previewing on an interlaced broadcast monitor.

• Vegas software allows you to use one external video device at a time. The external monitor display will be unavailable 
during video capture.

• When using an external video monitor, you need to enable external-monitor preview each time you start Vegas. This 
change was made to prevent the possibility of hiding the main Vegas window behind the secondary display when 
monitors are improperly configured.

Important: If you intend to deliver your project in an interlaced format, previewing on a computer monitor is not a 
substitute for previewing on an interlaced broadcast monitor.



Secondary Windows display preview requirements:

• A multiple-output graphics card that supports 3D acceleration (or multiple graphics cards: you could install AGP and 
PCI video cards in your system, for example)

• A CRT, LCD, or projector connected to your computer’s secondary video output
• The Extend my Windows desktop onto this monitor check box must be selected on the Settings tab or the Display 

Properties dialog (Start > Settings > Control Panel > Display).

Follow the steps below to set up your preview:

1. Use the Preview Device tab in the Preferences dialog to configure the display you want to use as a video preview 
monitor. For more information, see Preview device tab on page 314.

2. Select the Preview on External Monitor button ( ) in the Video Preview window.

• When playback is stopped, the secondary display will match the display of the Video Preview window. 
• When you start playback, the Video Preview window will be blank, and the video is played on the secondary 

display.

Viewing on an external monitor via IEEE-1394

You can send video directly from the timeline to a television monitor. With this feature, you can make your final editing 
decisions on a broadcast monitor (which differs significantly from a computer monitor) before printing the project to 
tape.

IEEE-1394/FireWire/i.Link external monitor requirements:

• OHCI-compliant IEEE-1394 DV card
• DV camcorder or DV-to-analog converter box

While configuring your computer for DV external monitor previewing is not difficult, the setup may require some 
troubleshooting. The Vegas forum is a good resource for peer-to-peer system troubleshooting:

http://mediasoftware.sonypictures.com/forums

Note: Vegas software allows you to use one external video device at a time. The external monitor display will be 
unavailable during video capture.

Tip: Video is sent to your secondary display and the Video Preview window at the same time. If you experience 
dropped frames, try clearing the Display frames in Video Preview window during playback check box on the 
Preview Device tab of the Preferences dialog.

Note: Vegas software allows you to use one external video device at a time. The external monitor display will be 
unavailable during video capture.
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Setting up an external monitor

The diagram below shows the preferred setup for sending video from the timeline to an external television monitor. 

The video is converted to DV format and is sent through the IEEE-1394 card to the DV device (camcorder or DV-to-analog 
media converter). The DV device sends analog output to the television monitor.

Use the Preview Device tab in the Preferences dialog to configure your IEEE-1394 card.

Previewing audio

External monitor previewing differs in one respect from printing to tape from the timeline: no audio is sent through the 
preview device. As shown in the illustration above, the audio is routed to the sound card and then on to the mixer (if 
present) and speakers. This allows you to mix your audio on better speakers than are typically found in television 
monitors. 

Before printing to tape, you may wish to preview the audio through the television monitor speakers to ensure a good TV 
mix. You can use the print-to-tape feature to send the full video and audio to the external monitor. Follow the steps for 
printing to tape from the timeline (pg. 296) but do not set the camcorder to record. Both the video and audio are sent 
through the 1394 card to the external monitor.

Enabling external-monitor preview

1. Use the Preview Device tab in the Preferences dialog to configure the display you want to use as a video preview 
monitor. For more information, see Preview device tab on page 314.

2. Select the Preview on External Monitor button ( ) in the Video Preview window.

You can turn off external preview by pressing Alt+Shift+4.

Note: The DV device must support pass-through in order to use an external monitor. Some PAL camcorders do not 
support this feature.

Tip: Video is sent to the external monitor and the Video Preview window at the same time. If you experience dropped 
frames, try clearing the Display frames in Video Preview window during playback check box on the Preview Device 
tab of the Preferences dialog. For more information, see Preview device tab on page 314.

Computer

Sound card Speakers

Video to 
camcorder

Analog to 

Audio to 

Television monitor

speakers

television
1394 card

Camcorder or 
Media converter



Optimizing preview quality

Keep in mind that complex effects and/or transitions may not play back in real time from the timeline. What effects can 
and cannot be played back depends on the speed of your computer. You may want to prerender more complex portions 
of a project. For more information, see Prerendering video on page 267.

Viewing on an external monitor via SDI

You can send video directly from the timeline to a video monitor connected to a DeckLink™ or AJA SDI card.

1. Use the Preview Device tab in the Preferences dialog to configure your SDI card. For more information, see Preview 
device tab on page 314.

2. Select the Preview on External Monitor button ( ) in the Video Preview window.

You can turn off external preview by pressing Alt+Shift+4.

Note: The compression settings used to create the prerendered video must be identical to your captured files for timeline 
playback to work.

Important: 

Your system must conform to all DeckLink system requirements to use the card with Vegas software. For more information 
about DeckLink system requirements and for DeckLink support information, please refer to the Blackmagic Design Web 
site at http://www.blackmagic-design.com.

AJA Xena LH, LHe, LS, and LSe cards are supported.

Note: Vegas software allows you to use one external video device at a time. The external monitor display will be 
unavailable during video capture.

Tip: Video is sent to the external monitor and the Video Preview window at the same time. If you experience dropped 
frames, try clearing the Display frames in Video Preview window during playback check box on the Preview Device 
tab of the Preferences dialog. For more information, see Preview device tab on page 314.
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Chapter 18
 Saving, Rendering, and Printing Projects

Vegas® software allows you to save and render projects into many different multimedia formats. When you render your 
Vegas project, the project itself is not altered, but rather can be rendered in any number of different formats.

This chapter explains saving a project and using the Save As and Render As functions. In addition, you will find reference 
information for the rendering options available. This chapter also describes the different options for delivering your 
projects, such as printing to tape, burning a Video CD, or burning a multimedia CD.

Saving a project

A Vegas project is saved as a small VEG file. This file contains all of the information needed to recreate your project: source 
file locations, trimming, track and bus plug-ins, volume and panning envelopes, bus assignments, assignable effects 
settings, etc. This is not the same as creating a final media file, which is done with the Render As command.

1. Click the Save button ( ). The first time a project is saved, the Save As dialog appears.

In subsequent saves, the Save As dialog is bypassed, your existing file name is retained, and your project is updated 
to include any changes.

2. Select Vegas Project File (.veg) from the Save as type list (default).

3. Select the drive and folder where you want to store the project.

4. Type the project name in the File name box.

5. Click Save.

Renaming or creating a copy of a project (using Save As...)

After you have been working with your project, you can use the Save As command in the File menu to create a copy of 
the small project file with a different name. Since multimedia projects can be very complex, and since Vegas project files 
are so small, saving a number of different versions of a project is a low-risk way to try new techniques.

1. From the File menu, choose Save As. The Save As dialog appears. 

2. Select the drive and folder where you want to store the project.

3. Type a new name in the File name box.

4. From the Save as Type drop-down list, choose the format in which you want to save the project.

5. Select the Copy and trim media with project check box if you want to create copies of each of the project’s media 
files in the same location as the project file. This allows you to collect all of a project’s assets in a single location.

6. Click the Save button.

Note: The option is also provided of saving a project as an Edit Decision List (EDL). For more information, see Creating an 
EDL on page 215.

Ext. Format Name Description
.veg Vegas project This option saves the references to media files used in the project. Also saved is 

project information, track effects, envelopes, bus assignments, and output properties. 
The .veg file does not combine events into a single file.

.txt EDL text file This option creates a text version of event placements in the track view. This text 
description can then be imported into a database or text application for modification 
or other purposes.

.aaf Edit Protocol Compliant AAF File These options create AAF (Advanced Authoring Format) files that you can use to 
exchange projects between applications. For example, if your postproduction facility 
uses a tool other than Vegas software, you could provide your project as an AAF file.

.aaf Avid Legacy AAF File
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7. If you selected the Copy and trim media with project check box, a dialog is displayed to allow you to specify how 
you want to copy media files:

• Select the Copy source media radio button to copy the entire source media files to your project folder.
• Select the Create trimmed copies of source media radio button and enter a value in the Extra head and tail 

box to reduce the number and size of media files necessary to represent your project.
Your project will be scanned to determine how much of each media file is being used and those regions will be 
rendered to new media files. The amount of time specified in the Extra head and tail setting will be added before 
and after the media file to allow subsequent edits. All events are then updated to point to the new files. Finally, 
inactive takes are removed from the project, and the project is saved.

Autosaving a project

A backup copy of your project is automatically saved every five minutes. If your system crashes, you are prompted to 
open the backup file the next time you start the program.

Backup files are saved in the location specified in the Temporary files folder box on the General tab of the Preferences 
dialog. Files are saved with the .autosave.veg extension and are deleted when you close Vegas software.

If you prefer not to autosave your project, you can clear the Enable autosave check box on the General tab of the 
Preferences dialog.

Vegas software also creates .veg.bak files in your project folder when you save a project to allow you to return to the 
project’s last-saved state. Creation of .veg.bak files is independent of autosaving. 

Rendering a project

Rendering refers to the process of converting a project into a single new multimedia file and formatting it for the desired 
playback method: media player, Internet streaming media, CD-ROM, video tape, etc. The project file is not overwritten, 
deleted, or altered during the rendering process. You can return to the original project to make edits or adjustments and 
render it again later.

Rendering a video file can take quite a bit of time, depending on the complexity of your project, the speed of your CPU, 
and the final format you have selected. For longer projects, you might want to plan to render your movie overnight or 
when you are not using your computer.

The process for rendering a project is essentially the same, regardless of the final format of the rendered file.

Note: The newly rendered files will match the source files’ properties as closely as possible:

• Audio/video events are saved in a new AVI file. You can trim DV AVI, uncompressed AVI, Sony YUV AVI, and CineForm AVI 
files. Because of the lossy nature of other video formats, those video files will not be trimmed, but will simply be copied to 
the project folder.

• Audio-only events will be rendered to the Wave format if under 2 GB (or Wave64 if over 2 GB), and DV files will be rendered 
as DV AVI files.

Notes: 

When you route busses to hardware outputs, the outputs from those busses will not be included in the mix when you 
render your project.

For specific information on 5.1 surround projects, see Rendering surround projects on page 202.



1. From the File menu, choose Render As. The Render As 
dialog appears.

2. Select the drive and folder where you want to save the 
rendered file.

3. Type a new name in the File name box, if necessary.

4. In the Save as type drop-down list, choose the 
appropriate format.

5. If you’re rendering to .wav, .w64, .avi, or .mxf format, 
you can select the Enable multichannel mapping 
check box to render a file with multiple audio channels. 

For more information, see Rendering multichannel audio 
files on page 284.

6. In the Template drop-down list, select the appropriate 
template.

You can customize the rendering settings by clicking Custom. For more information, see Customizing the rendering 
process on page 288.

7. Select the Save project as path reference in rendered media check box to save the path to your Vegas project in the 
rendered file. Saving the project path allows you to easily return to the source project if you use your rendered file in 
another project. The check box will be unavailable if you haven’t saved your project or if you’re rendering using a 
third-party file-format plug-in. For more information, see Project references in rendered media files on page 56.

8. Select the Render loop region only check box to render only the portion of your project within the loop region. 
Loop Playback does not need to be selected for this option to work.

9. Select the Stretch video to fill output frame size (do not letterbox) check box when you are rendering to an output 
format with a slightly different aspect ratio than your project settings. This will prevent black bars from appearing on 
the top and bottom or the sides of the output.

Tip: If your source media is in DV format, select a DV 
template. For more information, see Working in DV 
format on page 215.

Notes: 

When you render a 5.1 surround project to AIFF (.aif ), Perfect Clarity Audio (.pca), Wave64 (.w64), or Wave (.wav) formats, 
you can save each of the surround master busses to a separate file by choosing the multiple mono setting from the 
Template drop-down list. For example, if you'd typed My Film.wav in the File name box, the following files would be 
rendered: My Film Right.wav, My Film Right Surround.wav, My Film LFE.wav, My Film Left.wav, My Film Left Surround.wav, 
and My Film Center.wav.

You'll need to choose a rendering template that inserts pulldown fields to create a standard DV file if your project 
properties are set to 24p or if you selected the Allow pulldown removal when opening 24p DV check box on the 
General tab of the Preferences dialog. Use the NTSC DV 24p (inserting 2-3-3-2 pulldown) template if you intend to 
bring the file back into the timeline as source material.

Notes: 

The project information in the rendered file is a reference to a project file only. If you modify the project file after rendering, 
the project data will no longer match the rendered file. To edit a project using a path reference, the project file and all 
media must be available on your computer.

The check box will be unavailable if you haven't saved your project or if you're rendering using a third-party file-format 
plug-in.
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10. If the selected file type supports it, you can select the Save project markers in media file check box to include 
markers, regions and command markers in the rendered media file.

11. Select the Render using networked computers check box if you want to queue multiple renders on a single 
computer or to harness the power of those other computers to speed up your rendering times. For more information, 
see Rendering with networked computers on page 290. 

12. Click Save. A dialog is displayed to show the progress of the render. You can cancel the rendering process by clicking 
the Cancel button in the dialog box. You can also view the progress of the render or cancel the render using the 
status bar in the lower-left corner of the window.

13. When rendering is complete, click the Open button to play the file with its associated player, or click Open Folder to 
open the folder where you saved the file.

Rendering multichannel audio files

If you want to render a single audio file with multiple audio channels, you can render to one of the following formats:

• WAV/WAV64
• AVI
• MXF

1. Create your project.

2. In the Mixer window, add a bus for each channel (or channel pair) you want to include in your rendered file.

For example, if you wanted to create a six-channel .wav file, you could set up your mixer with three or six busses. If 
you use three busses, the left and right channels of each bus will be saved to a separate channel. If you use six busses, 
you can save the mono downmix from each bus as a separate channel.

3. Assign tracks to busses to map the audio in your project to the desired channel.

4. From the File menu, choose Render As to display the Render As dialog.

5. Choose a drive and folder from the Save in drop-down list, or use the browse window to locate the folder where you 
want to save your file.

6. Type a name in the File name box, or select a file in the browse window to replace an existing file.

7. Choose a file type from the Save as type drop-down list.

8. Select the Enable multichannel rendering check box.

9. Click the Channels button if you want to map the busses in your project to channels in the rendered file. If you don't 
specify a channel mapping, Vegas will not render a multichannel file.

a. In the Channel Mapping dialog, select the check box for each bus you want to include in the rendered file. Each 
stereo bus will be saved to two channels in the rendered file. If you want to save a bus to a single channel, select 
the (Mono downmix) check box for that bus.

b. If you want to change order of the busses in the channel mapping, select the bus and click the Move Up or Move 
Down button.

c. Click OK to close the Channel Mapping dialog and return to the Render As dialog.

Note: WMV/WMA, AC-3, and ATRAC support multichannel surround formats; channel mapping is not 
supported. For more information, see Rendering surround projects on page 202.

Note: If you're working with a 5.1 surround project, you can map the six channels from the Surround Master bus to six 
output channels.

Tip: Channel mapping is also available when printing to tape from the timeline, rendering to a new track, and 
exporting video to an XDCAM disc.



10. Choose a template from the Template drop-down list to specify the parameters that should be used for rendering 
your file, or click the Custom button to create a new template.

11. Select the Save project as path reference in rendered file check box if you want to save the path to your Vegas 
project in the rendered file. Saving the project path allows you to easily return to the source project if you use your 
rendered file in another project.

12. Select the Render loop region only check box if you want to save only the portion of the project that is contained 
within the loop region. Loop Playback does not need to be selected for this option to work.

13. Select the Stretch video to fill output frame size (do not letterbox) check box when you are rendering to an output 
format with a slightly different aspect ratio than your project settings. This will prevent black bars from appearing on 
the top and bottom or the sides of the output.

14. If the selected file type supports it, you can select the Save project markers in media file check box to include 
markers, regions, and command markers in the rendered media file.

15. Select the Render using networked computers check box if you want to queue multiple renders on a single 
computer or to harness the power of those other computers to speed up your rendering times. For more information, 
see Rendering with networked computers on page 290. 

16. Click the Save button. A dialog is displayed to show rendering progress.

17. When rendering is complete, click the Open button to play the file with its associated player, or click Open Folder to 
open the folder where you saved the file.

Rendering surround projects

Rendering a surround project creates six monaural files (AIFF, ATRAC, WAV, W64, or PCA) or a single 5.1-channel file (AC-3, 
WMA, and WMV) that your authoring application can use to create DVD-Video or 5.1-channel music projects. For more 
information, see Rendering surround projects on page 202.

Notes: 

If you choose a rendering template that specifies more channels than you have set up in the Channel Mapping dialog, the 
additional channels will be rendered as silence.

If you choose a template that specifies fewer channels than you have set up in the Channel Mapping dialog, the setting 
from the template will be used. Additional mapped channels will be ignored.

Notes: 

The project information in the rendered file is a reference to a project file only. If you modify the project file after rendering, 
the project data will no longer match the rendered file. To edit a project using a path reference, the project file and all 
media must be available on your computer.

The check box will be unavailable if you haven't saved your project or if you're rendering using a third-party file-format 
plug-in.
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Rendering MPEG format

Use the MainConcept plug-in to render MPEG files for Video CDs, Super Video CDs, and DVDs. The plug-in includes 
templates that will work well for most of your encoding needs, and you can create custom templates if you have special 
encoding requirements.

Notes: Vegas software does not create SVCDs or DVDs, but you can use the MPEG plug-in to render files for your SVCD/
DVD-creation application. Consult the application's documentation to determine the file requirements before rendering.

If you choose to save markers in your rendered MPEG-2 file, DVD Architect will read those markers as chapter markers. 
Ensure the Render I-frames at markers check box is selected before rendering (in the Render As dialog, choose 
MainConcept MPEG-2 from the Template drop-down list, and then click the Custom button. In the Custom Template 
dialog, select the Video tab and select the Render I-frames at markers check box).

Important: MPEG video requires frame widths that are divisible by 16 and frame heights that are divisible by 2. 
Noncompliant frame dimensions can cause unpredictable results or system instability.



Using default MPEG templates

Template Use for Description
MPEG-1 Templates
VCD NTSC Use this template to create an NTSC Video CD-compliant 

MPEG-1 file.

NTSC is used in the United States, North and Central 
America, parts of South America, and Japan.

Audio is a 224 kbps, 44.1 kHz MPEG-1 layer 2 
stream.

Video is 29.97 fps with a frame size of 352x240 
pixels.

VCD PAL Use this template to create a PAL Video CD-compliant 
MPEG-1 file. PAL is used in Europe and much of Asia.

Audio is a 224 kbps, 44.1 kHz MPEG layer 2 
stream.

Video is 25 fps with a frame size of 352x288 pixels.
MPEG-2 Templates
SVCD NTSC Use this template to create an NTSC Super Video CD (SVCD) 

compliant MPEG-2 file.
Audio is a 224 kbps, 44.1 kHz MPEG layer 2 
stream.

Video is 29.97 fps with a frame size of 480x480 
pixels.

SVCD PAL Use this template to create a PAL SVCD-compliant MPEG-2 
file.

Audio is a 224 kbps, 44.1 kHz MPEG layer 2 
stream.

Video is 25 fps with a frame size of 480x576 pixels.
DVD NTSC Use this template to create an MPEG-2 file with an NTSC 

DVD-compliant video stream and an MPEG layer 2 audio 
stream.

Audio is a 224 kbps, 48 kHz MPEG layer 2 stream.

Video is 29.97 fps with a frame size of 720x480 
pixels.

DVD PAL Use this template to create a PAL DVD-compliant MPEG-2 
file.

Audio is a 224 kbps, 44.1 kHz MPEG layer 2 
stream.

Video is 25 fps with a frame size of 720x576 pixels.
DVD NTSC video 
stream

Use this template to create an NTSC DVD-compliant MPEG-2 
video elementary stream file. The rendered file will have the 
extension .m2v.

You must render your audio separately in a format 
compliant with your specific DVD-authoring software. 
Consult your DVD-authoring software documentation to 
determine the supported audio formats.

Video is 29.97 fps with a frame size of 720x480 
pixels.

DVD PAL 
separate streams

Use this template to create separate to create separate PAL 
DVD-compliant video and audio elementary files. The video 
file will use an .m2v extension, and the audio file will use an 
.mpa extension.

Audio is a 224 kbps, 44.1 kHz MPEG layer 2 
stream.

Video is a 25 fps .m2v file with a frame size of 
720x576 pixels.

DVD Architect 
NTSC video 
stream

Use this template to create an NTSC video stream for use in 
DVD Architect (you'll need to render your audio stream 
separately).

Video is 29.97 fps with a frame size of 720x480 
pixels.

DVD Architect 
NTSC 
Widescreen 
video stream

Use this template to create a 24 fps, progressive-scan, DVD-
compliant, video-only, widescreen MPEG-2 file for use in 
DVD Architect.

No audio.

Video is 23.976 fps with a frame size of 720x480.

DVD Architect 
24p NTSC video 
stream

Use this template to create a 24 fps, progressive-scan NTSC 
video stream for use in DVD Architect (you'll need to render 
your audio stream separately).

Video is 23.976 fps with 2-3 pulldown and a frame 
size of 720x480 pixels.

DVD Architect 
24p Widescreen 
NTSC video 
stream

Use this template to create a 24 fps, progressive-scan NTSC 
video stream for use in DVD Architect (you'll need to render 
your audio stream separately).

Video is 23.976 fps with 2-3 pulldown and a frame 
size of 720x480 pixels.

DVD Architect 
PAL video 
stream

Use this template to create a PAL video stream for use in 
DVD Architect (you'll need to render your audio stream 
separately).

Video is 25 fps with a frame size of 720x576 pixels.

DVD Architect 
PAL Widescreen 
video stream

Use this template to create a widescreen PAL video stream 
for use in DVD Architect (you'll need to render your audio 
stream separately).

Video is 25 fps with a frame size of 720x576 pixels.

HDV 720-25p Use this template to create HDV MPEG-2 transport streams 
(.m2t).

Audio is a 384 Kbps, 48 kHz, MPEG layer 2 stream.

Video is 25 fps with a frame size of 1280x720.
HDV 720-30p Use this template to create HDV MPEG-2 transport streams 

(.m2t).
Audio is a 384 Kbps, 48 kHz, MPEG layer 2 stream.

Video is 29.97 fps with a frame size of 1280x720.
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Creating custom MPEG templates

In the Render As dialog, choose MainConcept MPEG-1 or MainConcept MPEG-2 from the Save as Type drop-down list 
and click the Custom button if you want to create your own MPEG encoding templates.

For information about the active page in the Custom Template dialog, click the  button.

Viewing MPEG-2 files on a computer

MPEG-2 files require an MPEG-2 decoder in order to view them in Windows Media Player and other applications. The 
Windows operating system does not include an MPEG-2 decoder, but you can download MPEG-2 decoders at  
http://www.vcdhelp.com. Sony Media Software does not endorse or support any 3rd-party MPEG-2 decoders.

Customizing the rendering process

Every media file format has different variables and controls. You can use a template to automatically configure a 
particular format for a particular destination. 

You can also choose to create custom settings for your render by clicking Custom. Once you have customized the 
settings, you can create your own template so that you can reuse the custom settings at a later time.

HDV 1080-50i Use this template to create HDV MPEG-2 transport streams 
(.m2t).

Audio is a 384 Kbps, 48 kHz, MPEG layer 2 stream.

Video is 25 fps (interlaced) with a frame size of 
1440x1080.

HDV 1080-60i Use this template to create HDV MPEG-2 transport streams 
(.m2t).

Audio is a 384 Kbps, 48 kHz, MPEG layer 2 stream.

Video is 29.97 fps (interlaced) with a frame size of 
1440x1080.

Important: Custom templates have many available options, and consequently, a lot of room for error. Verify your file 
requirements before creating a template. If you're using third-party DVD-burning software, for example, refer to the 
application's documentation to determine the application's file requirements.

Template Use for Description

Selected template Click Custom
to change
control settings
or create/delete
a template

and description

Selected rendering
format

http://www.vcdhelp.com
http://www.vcdhelp.com


Customizing the Render As settings

1. From the File menu, choose Render As.

2. In the Render As dialog, choose the format [e.g., Video for Windows (.avi)]. 

3. Click Custom. The Custom Template dialog appears.

4. Adjust the settings in each of the tabs as desired.

5. Click OK to close the Custom Template dialog.

6. Enter a name and location for the new file and click Save.

Saving custom settings as a template

You can save customized rendering settings for future use. One of the most important reasons to save a new template is 
to save the specific compression codec used to create the final media file, since this is not predetermined by the project 
properties.

1. Modify the parameters in the Custom Template dialog.

2. In the Template drop-down list, enter a name for the new template.

3. Click the Save Template button ( ).

To use the new template in the future, choose it from the Template list in the Save As dialog.

Exporting a movie to a PSP

If you want to render your project to Sony AVC/AAC format and transfer it to a USB-connected PSP® (PlayStation® 
Portable) system, you can do this using the Vegas Export to PSP® feature.

1. Click in the timeline to position your cursor on the frame you want to use to represent your movie. This image will be 
displayed as a thumbnail on the PSP® navigation system. 

2. Connect the USB cable and AC adapter to the PSP® system and place it in USB mode.

Note: Built-in templates cannot be edited.

Note: When determining bit rates, 1K=1024.

Note: When determining bit rates, 1K=1024.

Note: Built-in templates cannot be edited.

Tip: To delete a template, select it from the drop-down list and click the Delete button ( ).

Notes: 

PSP firmware version 2.0 is required to use this feature. To check your firmware version, choose Settings > System 
Settings > System Information on the PSP. For the latest firmware, go to http://us.playstation.com (in the United States) 
or http://www.playstation.com (outside the United States).

If you’re using high-resolution video, choose Best from the Full-resolution rendering quality drop-down list on the 
Video tab of the Project Properties dialog before exporting your movie to prevent resizing artifacts
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3. From the Tools menu, choose Export to PSP® (PlayStation®Portable). The Export to PSP® (PlayStation®Portable) 
dialog is displayed.

4. The Title box displays the title of your project from the Summary tab of the Project Properties dialog. This title will be 
displayed on the PSP® system.  
 
Editing the title in the Export to PSP® (PlayStation®Portable) dialog will also update the Project Properties dialog. 

5. The File path box displays the folder and file name that will be used to render your movie. 

If you want to replace an existing movie, choose its name from the File path drop-down list. Click the Refresh button 
if you need to rescan the device.

6. Choose a setting from the Template drop-down list to specify the settings that will be used to save your file. 
 
You can choose to encode with QVGA or QVGA widescreen frame aspect. Both settings create 320x240 video, but the 
widescreen templates use anamorphic widescreen encoding, which is properly decoded on the PSP® system. 
 
When you use the Automatic frame size templates, the video is encoded using the Pixel aspect ratio setting from 
the video tab of the Project Properties dialog. When using these templates, set your project aspect ratio to DV for 4:3 
content or DV Widescreen for 16:9 content. 
 
All templates use 128 Kbps audio. The 512 Kbps templates are useful when you want to minimize file size, and the 
896 Kbps templates will produce higher-quality video, especially in scenes with high-motion video.

7. Select the Render loop region only check box if you only want to render a portion of your project. If the check box is 
cleared, the entire project will be rendered to a new file.

8. Select the Stretch video to fill output frame size (do not letterbox) check box if you want to reformat your video so 
it fills the output frame size listed in the Description box. When the check box is cleared, the current aspect ratio is 
maintained and black borders are added to fill the extra frame area (letterboxing). This option is useful when the 
desired output format does not match the frame aspect ratio of your project.

9. Click OK. Your movie file (MAQ0nnnn.MP4) and thumbnail file (MAQ0nnnn.THM) are created and transferred to the 
appropriate folder on the PSP® system.

Rendering with networked computers

Network rendering allows you to designate a specific computer to render the entire output file, or you can distribute a 
single rendering job among several computers. 

• Distributed network rendering splits the video into segments that are rendered by multiple computers. In this mode, 
each computer renders a portion of the project, and the rendered sections are then reassembled into a single file by 
the one computer (called the stitch host). 
 
Distributed rendering is a good way to reduce the time it takes to render a project containing a significant amount of 
processed video (video effects, transitions, panning/cropping, track motion, and compositing). However, distributed 
rendering requires increased disk space and network traffic because each segment must be saved before the final 
output can file be generated. 
 
Nontemporal video output formats, such as DV or uncompressed AVI, are also well suited for distributed network 
rendering because segments can be reassembled without re-encoding.

• Nondistributed network rendering behaves very much like standard rendering, but you can choose which computer 
you want to render the project. In this mode, each computer renders a complete file from a Vegas project or the loop 
region.  
 

Note: If you want to render an AVC video without transferring to a PSP, use the Render As dialog and choose Sony AVC/
AAC (*.mp4) from the Save as Type drop-down list. Name the rendered file in the format MAQ0nnnn.MP4 (where nnnn is 
a number) to conform to the PSP file-naming convention. 

Note: The settings for the selected template are displayed in the Description box. 



If you want to encode the same project to multiple streaming formats and bit rates, it is best to queue up multiple 
nondistributed jobs because streaming formats use temporal compression and you can assign different renderers to 
different output formats. If you have a project or output format with audio only, choose nondistributed rendering 
because only video is rendered in the first phase of a distributed job.

Both distributed and nondistributed rendering jobs can be queued to be performed as computing resources become 
available so you can render multiple projects or render the same project in multiple formats. 

Rendering using a computer other than your main editing computer allows you to continue working without waiting for 
the render job to complete.

Setting up your computers for network rendering

The computer that initiates and manages a network render is considered the owner of the job. Each networked computer 
that you use for rendering is called a renderer. The computer that reassembles rendered segments in a distributed 
rendering job is called the stitch host. The computer that is designated to perform a nondistributed network render job is 
called the render host.

To use network rendering effectively, we recommend the following:

• 256 MB RAM in each renderer.

• 100 Mbps switched local area network.

• Your media files and output file must be in shared folders, preferably on a dedicated file server, All renderers must have 
permission to read, write, create, and delete files in the shared folders. 

Before network rendering begins, a copy of your project will be saved in the shared output folder for use by the renderers. 
This version will have all media paths remapped based on the Network Render Service file mappings. For more 
information, see Setting file mappings on page 294.

Setting up a rendering computer

1. Install Vegas software as a render-only client. 

You can install Vegas software as a render-only client on two computers for each Vegas license you purchase. 
However, certain file formats, such as MPEG-2, AC-3, and MP3, cannot be used on render-only clients.

2. Start the Vegas Network Render Service application (VegSrv70.exe). The service must be running and you must be 
logged into the computer before you can use it for rendering.

3. If necessary, you can change the TCP port the render service uses to communicate with other renderers:

a. Exit the Vegas Network Render Service application if it is running. 

b. Open the NetRenderService.config file in a text editor. This file is located in the Vegas installation folder. 

c. Edit the <channel ref="tcp" port="53704" /> tag in the file to reflect the port you want to use.

d. Save the file.

e. Restart the Vegas Network Render Service application.

Note: In order to use network rendering with nested projects, the nested project must contain only media from folders 
that do not require remapping. Before nesting your Vegas project, update the project so that all media in the project is 
added from a network folder or a local, shared folder that is mapped to the same drive letter on all renderers and the 
render host.
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Adding renderers to a host

1. Start the Vegas Network Render Service application (VegSrv70.exe) on the computer you will use to initiate network 
rendering. 

If you do not start the service before starting a rendering job, it will start automatically, but it will not be visible. 
Right-click the  icon in the system tray and choose Show from the menu to display the window.

2. Select the Renderers tab. This tab allows you to edit the list of computers running the render service.

3. Click the Host box of a blank row in the table, and then type the IP address or name of the computer you want to use 
as a renderer.  
 
To find your computer name, right-click My Computer and choose Properties from the shortcut menu to display the 
System Properties dialog. Click the Computer Name tab, and your computer name is displayed in the Full computer 
name entry.

4. Press Enter to connect to the renderer. If the connection is made, the Status column will display Ready.

Troubleshooting initiation problems

If you receive an error message that indicates the Network Render Service cannot start when you start the application, 
you may need to resolve DNS suffixes on your computer.

1. Open a DOS window:

a. From the Start menu, choose Run to display the Run dialog.

b. In the Open box, type CMD.

c. Click OK. A DOS window is displayed.

2. Type ipconfig at the command prompt.

Your Windows IP Configuration information is displayed. Note the Connection-specific DNS suffix setting.

3. Update your computer’s DNS suffix:

a. Right-click My Computer on your desktop and choose Properties from the shortcut menu (or press the 
Windows key + Pause) to open the System Properties dialog.

b. Select the Computer Name tab.

c. Click the Change button to display the Computer Name Changes dialog.

d. Click the More button to display the DNS Suffix and NetBIOS Computer Name dialog.

e. In the Primary DNS suffix of this computer box, type the DNS suffix you recorded in step 2. 

4. Click OK to close all dialogs and restart your computer.

Note: A computer will be displayed on the Renderers tab only if you have logged on to Windows and the Vegas 
Network Render Service is running. If the computer is not in an area you can monitor easily, you can use 
Ctrl+Alt+Delete to lock the computer after logging on and starting the service.



Using nondistributed network rendering

1. Save your project.

Your original project does not need to be saved in a shared folder. Before network rendering begins, a copy of your 
project will be saved in the shared output folder (see step 4) for use by the renderers. This version will have all media 
paths remapped based on the Network Render Service file mappings. For more information, see Setting file mappings 
on page 294.

After rendering begins, you can continue to make edits to your original project without disrupting in-progress 
network render tasks.

2. If you want to render only a portion of your project, create a time selection that includes the portion you want to 
render.

3. From the File menu, choose Render As.

4. Use the Render As dialog to choose the file format and location where you want to save your file. The location of the 
output file must be in a shared folder.

5. Select the Render loop region only check box in the Render As dialog if you want to render the selected portion of 
your project.

6. Select the Render using networked computers check box in the Render As dialog, and then click the Save button. 
The Network Render dialog is displayed.

7. From the Render Host drop-down list, choose the URL of the renderer you want to use to render your project.

8. The Temporary Files Location box displays the path to the folder where the temporary .veg project will be saved. If 
you want to use a folder other than the output folder you choose in step 4, you can choose a folder from the drop-
down list or click the Browse button to choose a folder.

This folder must be in a shared location.

9. Click OK to start rendering.

10. To add a project to the queue, open the project and repeat steps 1 through 8. 

You can choose a different renderer for each project or time selection if you want to render the files concurrently on 
separate computers. If you choose the same renderer, the rendering jobs will be queued to run sequentially on that 
computer.

Using distributed network rendering

1. Save your project.

Your original project does not need to be saved in a shared folder. Before network rendering begins, a copy of your 
project will be saved in the shared output folder (see step 4) for use by the renderers. This version will have all media 
paths remapped based on the Network Render Service file mappings. For more information, see Setting file mappings 
on page 294.

After rendering begins, you can continue to make edits to your original project without disrupting in-progress 
network render tasks.

2. From the File menu, choose Render As.

3. Use the Render As dialog to choose the file format and location where you want to save your file. The location of the 
output file must be in a shared folder.

4. Select the Render using networked computers check box in the Render As dialog, and then click the Save button. 
The Network Render dialog is displayed.

Note: In order to use network rendering with nested projects, the nested project must contain only media from folders 
that do not require remapping. Before nesting your Vegas project, update the project so that all media in the project is 
added from a network folder or a local, shared folder that is mapped to the same drive letter on all renderers and the 
render host.

Note: In order to use network rendering with nested projects, the nested project must contain only media from folders 
that do not require remapping. Before nesting your Vegas project, update the project so that all media in the project is 
added from a network folder or a local, shared folder that is mapped to the same drive letter on all renderers and the 
render host.
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5. Select the Distribute Rendering check box in the Network Render dialog.

6. From the Stitch Host drop-down list, choose the computer you want to use to assemble the rendered segments.

7. Choose a file format for your rendered segments.

• Select the Use Final Render Template check box if you want to render segments using the format you chose for 
your final output in the Render As dialog.  
 
Use this option when you’re working with uncompressed or DV files. Using the final rendering template for 
rendered segments makes the final stitching process fast because the segments can be copied and assembled 
without being re-encoded.

• Clear the Use Final Render Template check box and choose settings from the Save as Type and Template drop-
down lists if you want to render segments using a format other than your final output format.  
 
Use this option when you’re rendering to a format that uses temporal compression, such as QuickTime, 
RealMedia, or Windows Media. Rendering segments as uncompressed or DV AVI files allows transitions and 
composited tracks to be rendered in a high-quality format. When the segments are stitched, the project is re-
encoded using the format you chose for your final output in the Render As dialog.

8. The Temporary Files Location box displays the path to the folder where the temporary .veg project and rendered 
segments will be saved. If you want to use a folder other than the output folder you chose in step 3, you can choose 
a folder from the drop-down list or click the Browse button to choose a folder.

This folder must be in a shared location.

9. Click OK to start rendering.

Monitoring rendering progress

1. Right-click the  icon in your system tray and choose Show from the menu to display the Sony Vegas Network 
Render Service window.

2. Select the Progress tab. The Progress tab displays a list of the segments that are queued to render, the assigned 
peer, and the status.

3. Choose Details or Summary from the drop-down list in the Progress tab to see more or less information.

Setting file mappings

File mappings help remote renderers find the media used in your project. When you import media from a local disk, the 
file paths saved in your project are often valid only on the local machine. This can be the case even if the media resides in 
a shared folder.

Use the File Mappings tab to map local folders to universal paths.

Adding a file mapping

1. Right-click the  icon in your system tray and choose Show from the menu to display the Sony Vegas Network 
Render Service window.

2. Select the File Mappings tab. The tab displays a list of local folders and their universal paths.

3. Click a blank row in the table.

4. In the Local box, type the path to the local folder (c:\media, for example).

Tip: Choosing a folder other than the final output folder can help improve performance during the stitching phase when 
you render a project with uncompressed segments.

Note: In order to use network rendering with nested projects, the nested project must contain only media from folders 
that do not require remapping. Before nesting your Vegas project, update the project so that all media in the project is 
added from a network folder or a local, shared folder that is mapped to the same drive letter on all renderers and the 
render host.



5. In the Universal box, type the UNC path or mapped drive letter to the folder (\\renderer\media\, for example).

Creating file mappings automatically

1. Right-click the  icon in your system tray and choose Show from the menu to display the Sony Vegas Network 
Render Service window.

2. Select the File Mappings tab. The tab displays a list of local folders and their universal paths.

3. From the Action menu, choose Auto-Fill File Mappings. Shared folders on the local machine are added to the list as 
universal paths.

However, no mappings will be added in the following circumstances:

• If all shared folders are already listed in the table.
• If the computer does not have any shared folders.
• If your user account does not allow you to create or modify folder sharing.

Removing file mappings

1. Right-click the  icon in your system tray and choose Show from the menu to display the Sony Vegas Network 
Render Service window.

2. Select the File Mappings tab. The tab displays a list of local folders and their universal paths.

3. Right-click a mapping and choose Delete File Mapping from the shortcut menu to delete it. Click a blank row in the 
table. Choose Delete All File Mappings to delete all file mappings.

Setting render service options

1. Right-click the  icon in your system tray and choose Show from the menu to display the Sony Vegas Network 
Render Service window.

2. Select the Options tab. 

Note: Before you start rendering, verify that the remote renderer has access to the folder and is logged in. 
On the renderer, choose Run from the Start menu to display the Run dialog. In the Open box, type the UNC path to the 
folder (\\renderer\media\ in our previous example). If you're prompted to log on, type your username and password.

Item Description
Enable rendering Select this check box if you want the local computer to be available as a renderer.
Automatically run 
after login

Select this check box if you want to start the service automatically after logging in to the Windows operating 
system.

Exit service when 
window is closed

Select this check box if you want to keep the service running after closing the window. If the check box is 
cleared, the service is minimized to the system tray when you close the window.

Exit Vegas when 
idle

Select this check box if you want to close the instance of Vegas software that is launched by the network 
render service when no jobs are in the queue.

If the check box is cleared, the application continues running until you close it or exit the service.
Remove completed 
jobs from progress 
display after

Choose a setting to indicate how long jobs should be maintained on the Progress tab of the Sony Vegas 
Network Render Service window. 

Default segment 
length

Choose a setting to indicate the number of frames per segment when using distributed rendering.

Adjusting this value can increase performance slightly depending on the complexity of the project and your 
specific rendering computers.

If the setting yields more than 90 segments for a rendering job, the segment length for that job is 
automatically increased to limit the number of segments.
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Printing video to tape 

Vegas software provides two methods for printing your final movie to tape: you can print to tape directly from the Vegas 
timeline, or you can use Sony Media Software Video capture to print an existing rendered file to DV tape.

Printing video to tape from the timeline

You can print either a portion of your project or the entire video right from the project timeline to a camera or deck. Your 
project is examined, any complex portions are prerendered, and then printed to tape all in one action. For more 
information, see Prerendering video on page 267.

Printing to a DV device

1. To print just a portion of your project, make a time selection in the timeline.

2. From the Tools menu, choose Print Video to Tape. The Device Setup dialog is displayed.

3. Use the Device Setup dialog to configure your camera or deck:

a. From the Device drop-down list, choose OHCI-Compliant IEEE 1394/DV.

b. If necessary, drag the Record engage delay slider to specify the number of frames it takes your camera or deck to 
switch from Record Pause to Record mode. If you’re missing frames from the beginning of your file after printing 
to tape, increase the setting. If you see duplicated frames at the beginning of your video, decrease the setting.

c. Click the Next button. The Conform Timeline to Device Format dialog is displayed.

4. Use the Conform Timeline to Device Format dialog to choose the format you want to use to print your video to tape.

a. Select the Enable multichannel mapping check box if you’re working with multichannel source files and need 
to specify which channels to use in the stereo file when printing to tape. Click the Channels button to choose 
which channels you want to render. 

For example, if your video source contained 6-channel audio, you could route each channel’s track to a separate 
bus. Then, when printing to tape, you could click the Channels button and choose which bus should be printed 
to tape.

For more information, see Rendering multichannel audio files on page 284.

b. From the Template drop-down list, choose the setting that matches your destination format, or click Custom to 
create a new template. 

c. Select the Render loop region only check box if you want to print only the portion of your project that you 
selected in step 1.

d. Select the Render audio to proxy file check box if you want to prerender the audio portion of your project 
before printing to tape.

e. Click Next. The Leader and Trailer dialog is displayed. 

Note: Printing to tape from the timeline can require significant drive space for temporary prerendered files. Set the 
Prerendered files folder on the Video tab of the Project Properties dialog to an A/V-capable drive with sufficient space. 
Prerendering a DV project uses approximately 228 MB/minute, so plan accordingly.

Note: Multichannel audio is not supported when printing to a DV device.

Notes: 

You’ll need to choose a rendering template that inserts pulldown fields to create a standard DV file if your properties are set 
to 24p or if you selected the Allow pulldown removal when opening 24p DV check box selected on the General tab of 
the Preferences dialog. Use the NTSC DV 24p (inserting 2-3-3-2 pulldown) template if you intend to bring the file back 
into the timeline as source material.

If you cleared the Allow pulldown removal when opening 24p DV check box before adding your media and your 
project properties are not set to 24p, your 24p video is read as 29.97 fps interlaced video (60i), so you can choose whichever 
NTSC DV or PAL DV template suits your project requirements.



5. Use the Leader and Trailer dialog to set up the data that will be printed before and after your project:

a. Select the Add test pattern leader check box if you want to print a test pattern before your video.

b. From the Test pattern style drop-down list, choose a test pattern type and video format.

c. Type a value in the Duration box to determine the length of the test pattern.

d. Select the Play 1 kHz tone with test pattern check box to add an audio test tone that will play along with the 
test pattern.

e. Select the Add black leader check box and type a value in the Duration box if you want to print black frames 
before your video.

f. Select the Add black trailer check box and type a value in the Duration box if you want to print black frames 
after your video.

g. Click Next. The Device Control dialog is displayed.

6. Use the Device Control dialog to indicate whether Vegas software will have control of your DV recorder and how you 
want to print to tape:

• Select Manual if your IEEE-1394 DV device is not OHCI-compliant or if the application is unable to obtain device 
control of your DV recorder. You will need to cue the tape and press the Record button on your DV camcorder 
before recording.

• Select Crash Recording if you are using an OHCI-compliant IEEE-1394 DV device and the application is able to 
obtain device control of your DV recorder. 

Recording will begin automatically at the timecode position specified in the Device timecode box when you 
click Finish.

7. Click Finish. If you have not already prerendered, portions of your project that cannot be rendered and printed to 
tape in real time will be selectively prerendered.

a. If you’re using Manual mode, a dialog will be displayed after rendering is finished. You can specify a delay time in 
the Delay playback countdown timer box and select the Beep each second during countdown check box if 
you want to count down before sending video to your device.

b. If you’re using Crash Recording mode, your DV recorder will start and begin recording after rendering is finished.

Printing to a tape deck connected to a DeckLink card

1. To print just a portion of your project, make a time selection in the timeline.

2. From the Tools menu, choose Print Video to Tape. The Device Setup dialog is displayed. 

3. Use the Device Setup dialog to configure your camera or deck:

a. From the Device drop-down list, choose Blackmagic Design Decklink.

b. If necessary, drag the Record engage delay slider to specify the number of frames it takes your camera or deck to 
switch from Record Pause to Record mode. If you’re missing frames from the beginning of your file after printing 
to tape, increase the setting. If you see duplicated frames at the beginning of your video, decrease the setting.

c. If you’re performing insert editing and find that print-to-tape is not frame accurate after adjusting the Record 
Engage Delay setting, drag the Timecode Offset and Timecode Tolerance sliders to fine-tune timecode.

d. Click the Next button. The Conform Timeline to Device Format dialog is displayed.

4. Use the Conform Timeline to Device Format dialog to choose the format you want to use to print your video to tape.

a. Select the Enable multichannel mapping check box if you want to render a file with multiple audio channels. 
For more information, see Rendering multichannel audio files on page 284.

b. From the Template drop-down list, choose the setting that matches your destination format, or click Custom to 
create a new template. For more information, see Customizing the rendering process on page 288.

c. Select the Render loop region only check box if you want to print only the portion of your project that you 
selected in step 1.

Notes: 

You’ll need to choose a rendering template that inserts pulldown fields to create a standard interlaced file if your project 
properties are set to 24p or if you selected the Allow pulldown removal when opening 24p DV check box on the 
General tab of the Preferences dialog.

If you cleared the Allow pulldown removal when opening 24p DV check box before adding your media and your 
project properties are not set to 24p, your 24p video is read as 29.97 fps interlaced video (60i), so you can choose whichever 
template suits your project requirements.
SAVING, RENDERING, AND PRINTING PROJECTS | 297



298 | CHAPTER 18
d. Select the Render audio to proxy file check box if you want to prerender the audio portion of your project 
before printing to tape.

e. Click Next. The Leader and Trailer dialog is displayed.

5. Use the Leader and Trailer dialog to set up the data that will be printed before and after your project:

a. Select the Add test pattern leader check box if you want to print a test pattern before your video.

b. From the Test pattern style drop-down list, choose a test pattern type and video format.

c. Type a value in the Duration box to determine the length of the test pattern.

d. Select the Play 1 kHz tone with test pattern check box to add an audio test tone that will play along with the 
test pattern.

e. Select the Add black leader check box and type a value in the Duration box if you want to print black frames 
before your video.

f. Select the Add black trailer check box and type a value in the Duration box if you want to print black frames 
after your video.

g. Click Next. The Device Control dialog is displayed.

6. Use the Device Control dialog to indicate whether Vegas software will have control of your deck:

7. Click Finish. If you have not already prerendered, portions of your project that cannot be rendered and printed to 
tape in real time will be selectively prerendered.

• If you’re using Manual mode, a dialog will be displayed after rendering is finished. You can enter a delay time in the 
Delay box and select the Beep check box if you want to count down before sending video to your deck.

• If you’re using Crash Recording or Auto Edit mode, your deck will begin recording after rendering is finished.

Setting Description
Manual Select this radio button if the application is unable to obtain device control of your deck. 

You will need to cue the tape and press the Record button on your deck before recording.
Crash Recording Select this radio button if the application can perform basic device control of your deck.

You will need to cue the tape to the location where you want to begin printing. The device’s timecode 
location is displayed in the Device timecode box.

When you click Finish, recording will begin automatically and will stop after reaching the end of the 
selection or project.

Auto Edit Select this radio button if your deck supports Auto Edit/Insert Edit mode.

Important: When using Auto Edit mode, use a striped tape to ensure continuous timecode over the portion 
of the tape where you plan to record.

1.Select the Preview only check box if you want to preview your print-to-tape operation without engaging 
the deck's record head. 
Use Preview only mode to double-check and adjust your Start printing at timecode setting as needed.

2.The Start printing at box displays the current device timecode location. You can cue the tape or type a 
value to indicate where you want to begin recording. The End at box displays the frame where recording 
will end (much like punch-in audio recording). 

3.When you click Next, the Select Channels page is displayed.
4.On the Select Channels page, select a radio button to choose which channels you want to print to tape.

Write all rendered channels: Select this radio button to print video and all audio channels to tape.

Write only selected channels: Select this radio button if you want to choose which channels you want to 
print to tape. Select the check box for each channel you want to print.

5.Click Finish. Recording will begin and end automatically at the specified timecode positions. 



Printing to a tape deck connected to a AJA SDI card

1. To print just a portion of your project, make a time selection in the timeline.

2. From the Tools menu, choose Print Video to Tape. The Device Setup dialog is displayed. 

3. Use the Device Setup dialog to configure your camera or deck:

a. From the Device drop-down list, choose AJA Video Device.

b. If necessary, drag the Record engage delay slider to specify the number of frames it takes your camera or deck to 
switch from Record Pause to Record mode. If you’re missing frames from the beginning of your file after printing 
to tape, increase the setting. If you see duplicated frames at the beginning of your video, decrease the setting.

c. Select the Use progressive segmented frame (psf) video formats check box if you’re using a camera or deck 
that stores progressive-scan frames in an interlaced format.

d. Click the Next button. The Conform Timeline to Device Format dialog is displayed.

4. Use the Conform Timeline to Device Format dialog to choose the format you want to use to print your video to tape.

a. Select the Enable multichannel mapping check box if you want to render a file with multiple audio channels. 
For more information, see Rendering multichannel audio files on page 284.

b. From the Template drop-down list, choose the setting that matches your destination format, or click Custom to 
create a new template. For more information, see Customizing the rendering process on page 288.

c. Select the Render loop region only check box if you want to print only the portion of your project that you 
selected in step 1.

d. Select the Render audio to proxy file check box if you want to prerender the audio portion of your project 
before printing to tape.

e. Click Next. The Leader and Trailer dialog is displayed.

5. Use the Leader and Trailer dialog to set up the data that will be printed before and after your project:

a. Select the Add test pattern leader check box if you want to print a test pattern before your video.

b. From the Test pattern style drop-down list, choose a test pattern type and video format.

c. Type a value in the Duration box to determine the length of the test pattern.

d. Select the Play 1 kHz tone with test pattern check box to add an audio test tone that will play along with the 
test pattern.

e. Select the Add black leader check box and type a value in the Duration box if you want to print black frames 
before your video.

f. Select the Add black trailer check box and type a value in the Duration box if you want to print black frames 
after your video.

g. Click Next. The Device Control dialog is displayed.

Notes: 

You’ll need to choose a rendering template that inserts pulldown fields to create a standard interlaced file if your project 
properties are set to 24p or if you selected the Allow pulldown removal when opening 24p DV check box on the 
General tab of the Preferences dialog.

If you cleared the Allow pulldown removal when opening 24p DV check box before adding your media and your 
project properties are not set to 24p, your 24p video is read as 29.97 fps interlaced video (60i), so you can choose whichever 
template suits your project requirements.
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6. Use the Device Control dialog to indicate whether Vegas software will have control of your deck:

7. Click Finish. If you have not already prerendered, portions of your project that cannot be rendered and printed to 
tape in real time will be selectively prerendered.

• If you’re using Manual mode, a dialog will be displayed after rendering is finished. You can enter a delay time in the 
Delay box and select the Beep check box if you want to count down before sending video to your deck.

• If you’re using Crash Recording or Auto Edit mode, your deck will begin recording after rendering is finished.

Printing HDV video to tape

From the Tools menu, choose Print Video to HDV Tape to print your project to an HDV camera or deck.

Printing to HDV tape from the timeline

1. Load your HDV project. 

2. To print just a portion of your project, make a time selection in the timeline.

3. From the Tools menu, choose Print Video to HDV Tape. The HDV Print to Tape - Device page is displayed.

4. Choose your HDV camera or deck from the Device drop-down list. 

5. Click Next. The HDV Print to Tape - Select Format/File page is displayed.

6. Choose render settings:

a. Select the Render format radio button. 

b. In the File path box, type the path to the file you want to render, or click the Browse button to browse to the 
folder you want to use and they type a file name. 

c. From the Template drop-down list, choose the setting that matches your destination format. This list will include 
only formats that are supported by the selected device.

Information about the selected rendering template is displayed in the Description box.

d. Select the Render loop region only check box if you want to print only the portion of your project that you 
selected in step 2.

e. Select the Delete file after print check box if you want to delete the rendered file after the print-to-tape 
operation is finished.

7. Click Next. The HDV Print to Tape - Device Control page is displayed.

Setting Description
Manual Select this radio button if the application is unable to obtain device control of your deck. 

You will need to cue the tape and press the Record button on your deck before recording.
Crash Recording Select this radio button if the application can perform basic device control of your deck.

You will need to cue the tape to the location where you want to begin printing. The device’s timecode 
location is displayed in the Device timecode box.

When you click Finish, recording will begin automatically and will stop after reaching the end of the 
selection or project.

Auto Edit Select this radio button if your deck supports Auto Edit/Insert Edit mode.

Important: When using Auto Edit mode, use a striped tape to ensure continuous timecode over the portion 
of the tape where you plan to record.

1.Select the Preview only check box if you want to preview your print-to-tape operation without engaging 
the deck's record head. 
Use Preview only mode to double-check and adjust your Start printing at timecode setting as needed.

2.The Start printing at box displays the current device timecode location. You can cue the tape or type a 
value to indicate where you want to begin recording. The End at box displays the frame where recording 
will end (much like punch-in audio recording). 

3.When you click Next, the Select Channels page is displayed.
4.On the Select Channels page, select a radio button to choose which channels you want to print to tape.

Write all rendered channels: Select this radio button to print video and all audio channels to tape.

Write only selected channels: Select this radio button if you want to choose which channels you want to 
print to tape. Select the check box for each channel you want to print.

5.Click Finish. Recording will begin and end automatically at the specified timecode positions. 



8. Select the Manual or Use device control radio button to indicate whether Vegas software will have control of your 
HDV recorder:

• Select Manual if your HDV device is not OHCI-compliant or if the application is unable to obtain device control 
of your HDV recorder. You will need to cue the tape and press the Record button on your DV recorder before 
recording.

• Select Crash Recording if you are using an OHCI-compliant IEEE-1394 HDV device and the application is able to 
obtain device control of your HDV recorder. 

You will need to cue the tape to the location where you want to begin printing. The device’s timecode location is 
displayed in the Device timecode box.

When you click Finish, recording will begin automatically and will stop after reaching the end of the selection or 
project.

9. Click Finish. Your project will be rendered to the file you specified in step 6.

• If you’re using Manual mode, a dialog will be displayed after rendering is finished. You can specify a delay time 
in the Delay playback countdown timer box and select the Beep each second during countdown check box if 
you want to count down before sending video to your device.

• If you’re using Crash Recording mode, your HDV recorder will start and begin recording after rendering is 
finished.

Printing a rendered file to HDV tape

Use this procedure when you have a rendered MPEG 2 transport stream that you want to print to HDV tape.

1. Load your HDV project. 

2. To print just a portion of your project, make a time selection in the timeline.

3. From the Tools menu, choose Print Video to HDV Tape. The HDV Print to Tape - Device page is displayed.

4. Choose your HDV camera or deck from the Device drop-down list. 

5. Click Next. The HDV Print to Tape - Select Format/File page is displayed.

6. Choose the file you want to print:

a. Select the Use an existing file radio button. 

b. In the File path box, type the path to the file you want to print, or click the Browse button to choose the file you 
want to print. 

7. Click Next. The HDV Print to Tape - Device Control page is displayed.

8. Select the Manual or Use device control radio button to indicate whether Vegas software will have control of your 
HDV recorder:

• Select Manual if your HDV device is not OHCI-compliant or if the application is unable to obtain device control 
of your HDV recorder. You will need to cue the tape and press the Record button on your HDV recorder before 
recording.

• Select Crash Recording if you are using an OHCI-compliant IEEE-1394 HDV device and the application is able to 
obtain device control of your HDV recorder. 
You will need to cue the tape to the location where you want to begin printing. The device’s timecode location is 
displayed in the Device timecode box.

When you click Finish, recording will begin automatically and will stop after reaching the end of the selection or 
project.

9. Click Finish. 

• If you’re using Manual mode, a dialog will be displayed before printing begins. You can specify a delay time in 
the Delay playback countdown timer box and select the Beep each second during countdown check box if 
you want to count down before sending video to your device.

• If you’re using Crash Recording mode, your HDV recorder will start and begin recording after you click the 
Finish button.

Important: If you are printing a rendered file to HDV tape, the file must precisely conform to the target HDV device and 
file type requirements, or the print-to-tape operation will fail. Rendering using the provided HDV MPEG-2 render 
templates—unmodified in any way—is required to successfully print to HDV tape. 
SAVING, RENDERING, AND PRINTING PROJECTS | 301



302 | CHAPTER 18
Printing to tape using Video Capture

1. If you have not already done so, connect your video camera to your video capture card using the cable provided with 
the card.

2. In the Project Media window, click the Capture Video button ( ). The Sony Video Capture application starts.

3. Follow the instructions for printing to tape provided in the Video Capture online help. To access online help, click the 
Help menu within the Sony Video Capture application, and choose Contents and Index. The Video Capture online 
help file displays.

Note: If your video camera is properly connected, the Video Preview window in the center of the application area should 
display “Device connected.”



Chapter 19
 Customizing Vegas software

You can customize Vegas® software to suit your project needs and working preferences. Many of the settings depend on 
your equipment or studio setup. Vegas software can be set to work with the components that you use in your studio.

In this chapter, you will find information about functions that allow you to customize the appearance of Vegas software, 
set a project’s properties, and set the application’s preferences.

Displaying frame numbers

You can display frame numbers on video events. Once you have 
enabled frame numbering, a small box appears at the bottom of 
the event thumbnail with the frame offset, time or timecode. The 
small black arrow marks the exact position of that frame in time. 

When the workspace is zoomed in far enough, each thumbnail 
represents a single numbered frame in the source video file. At 
intermediate zoom levels, marks between the frame numbers 
show the location of intermediate frames. These frame marks are 
not visible at lower magnifications. 

1. From the Options menu, choose Preferences. 

2. Click the Video tab.

3. Choose an option from the Show source frame numbers on event thumbnails as drop-down list.

4. Click OK. 

Changing the ruler format

You can customize the ruler to display a number of different standard formats. The format that you select affects how the 
ruler and time display window display time units. For more information, see Timecode in Vegas software on page 366.

To change the ruler’s format, right-click the ruler and choose the desired time format from the shortcut menu or, from the 
Options menu, choose Ruler Format and choose the desired time unit. You can also change ruler settings on the Project 
Properties dialog’s Ruler tab. For more information, see Ruler tab on page 307.

The following are the different time units available (hh=hours, mm=minutes, ss=seconds, and ff=frames): 

Time format name Units
Samples numbered (starting with zero)
Time hh:mm.ss.sss
Seconds sssss.sss (to three decimal places)
Time & Frames hh:mm:ss.ff
Absolute Frames frames are numbered starting with 0
Measures & Beats measures.beats.ticks, where 64 ticks = 1 beat
Feet & Frames 16mm (40 fpf ) feet+frames, where 40 frames = 1 foot
Feet & Frames 35mm (16 fpf ) feet+frames, where 16 frames = 1 foot
SMPTE Film Sync IVTC (23.976 fps, Video) hh:mm:ss:ff
SMPTE Film Sync (24 fps) hh:mm:ss:ff
SMPTE EBU (25 fps, Video) hh:mm:ss:ff
SMPTE Non-Drop (29.97 fps, Video) hh:mm:ss:ff
SMPTE Drop (29.97 fps, Video) hh:mm:ss:ff
SMPTE 30 (30 fps, Audio) hh:mm:ss:ff
Audio CD Time hh:mm:ss or hh:mm:ss:ff when zoomed in tightly
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Editing the ruler offset

The ruler doesn’t necessarily need to start with zero at the far left side. You can enter an offset to change the orientation 
of the ruler in a project. One use of this is to create a lead-in into a project. A five-second offset would mean that the ruler 
would start at -5 seconds and would be at 0 five seconds into the project.

1. Position the cursor at the desired location along the timeline.

2. Right-click the ruler and choose Set Time at Cursor from the shortcut menu. The current 
ruler value is highlighted.

3. Enter a time value. 

4. Press Enter to set the ruler’s time. The value that you enter at the cursor’s position affects the entire ruler.

Changing grid spacing

Grid spacing is different from the ruler and provides an alternate method of subdividing a project’s time. This can be 
useful if you want the ruler to display SMPTE video timecode, but you need to create your music in terms of beats and 
measures. You can display the grid spacing in time, frame, measure, or note units. The grid can also be set to match the 
ruler’s time format. The grid appears across all tracks in your project and the grid’s lines can be used as snap points.

To change grid spacing, choose Grid Spacing from the Options menu, and choose the desired time unit from the 
submenu. The grid spacing changes to reflect your selection.

Using the Time Display window

The Time Display window reflects the cursor’s position on the timeline and the end point of a time selection. You can 
customize the time display’s settings, including what time the window displays and what colors it uses.

You can move the Time Display window from its docked position above the track list to float on the workspace. In 
addition, you can dock the time display in the window docking area. For more information, see Window docking area and 
floating window docks on page 22.

Note: You cannot create a ruler offset in an audio CD layout project.

Note: In some cases, the grid lines and the ruler do not match. This is because they are two independent functions. 

Ruler and grid increments can be different. 
This new project is set with Ruler = SMPTE non-drop and Grid = Quarter notes.



Changing the time display settings

The time display always reflects the ruler settings that are selected. You can change the ruler settings via the time display 
or vice versa. For more information, see Changing the ruler format on page 303.

1. Right-click the time display. A shortcut menu appears.

2. From the shortcut menu, choose Time Format, and choose the desired time format from the submenu.

Both the time display and ruler display the chosen time format.

Changing the time display colors

You can change the background color and text color used in the time display.

1. Right-click the time display to display the shortcut menu.

2. From the shortcut menu, choose Text Color or Background Color and then choose Custom. The Time Display Color 
dialog appears. 

3. Choose the color setting that you want.

4. Click OK to set the text or background color or click Cancel to keep the existing color settings and close the dialog.

Setting the time display to monitor MIDI timecode

You can use the time display to monitor the status of incoming or outgoing MIDI timecode. Vegas software can monitor 
MIDI timecode being generated from an external device or monitor MIDI timecode and MIDI clock information generated 
by Vegas software. From within Vegas software, the time display settings work in conjunction with your project’s 
properties and MIDI setup options. For more information, see Sync tab on page 324.

1. Right-click the time display.

2. From the shortcut menu, choose the type of MIDI monitoring to be displayed.

Once you have made your selection, the time display displays both the MIDI timecode being input or output and a status 
message.

Tip: To return the time display’s text or background color to its default settings, choose either Text Color or Background 
Color from the shortcut menu, and choose Default from the submenu.

Monitors incoming MIDI timecode

Monitors MIDI timecode generated by Vegas software

Monitors MIDI clock generated by Vegas software
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Working with project properties

A large range of formats and various types of media files are 
supported. Some settings in a project’s properties are simply 
informational details about the project, while others control 
how your project is handled and its output. If you have 
multiple projects, the settings used for each project are stored. 
These settings can be saved as templates for future use.

To view and modify project properties, choose Properties from 
the File menu. The Project Properties dialog has five tabs: 
Video, Audio, Ruler, Summary, and Audio CD. An overview of 
each tab and its settings follows. 

Video tab

This tab allows you to set different characteristics the project 
uses to handle the video. Also, this tab displays information 
about the video contained in your project. For more 
information, see Modifying project video properties on page 220.

Audio tab

This tab allows you to set different characteristics the project uses to handle the audio. This page also displays the 
available drive space where recorded audio is stored.

Item Description
Master bus mode Choose Stereo to create a two-channel stereo project. Choose 5.1 Surround if you want to perform 

advanced 5.1-channel mixing.
Number of stereo busses Enter the number of stereo busses that you want in your project. You may add up to 25 additional 

busses. The busses appear in the Mixer.
Sample rate (Hz) Choose a sample rate from the drop-down list or enter your own rate. The sample rate range is 2,000 Hz 

to 96,000 Hz. Higher sample rates result in better quality sound, but also mean larger audio files.
Bit depth Choose a bit depth from the drop-down list. A higher bit depth results in better quality sound, but also 

means larger audio files.
Resample and stretch quality Choose Preview, Good, or Best to determine the accuracy with which audio files will be resampled to 

match your project settings. This setting also determines the quality of processing when time-stretching 
audio events.

Enable low-pass filter on LFE 
(surround projects only)

Applies a low-pass filter to each track in a 5.1 surround project that is assigned to the LFE channel.

Cutoff frequency for low-pass 
filter (Hz)

Choose a frequency to set the frequency above which audio will be ignored by the LFE channel.

Low-pass filter quality Choose Preview, Good, or Best to determine the sharpness of the filter’s rolloff curve. Best produces the 
sharpest curve.

Recorded files folder Displays the path where recorded audio is stored. The Browse button allows you to select a new 
location to store recordings.

Free storage space in 
selected folder

Displays the available disk space where recorded audio is stored.

Start all new projects with 
these settings

Use the project properties that you have specified whenever a new project is created.



Ruler tab

This tab allows you to change ruler settings used in your project. You can also change ruler settings in track view. For 
more information, see Changing the ruler format on page 303.

Summary tab

This tab allows you to enter information about the project. You can leave the boxes on this tab blank or, if information 
exists, you can change it at any time.

Audio CD tab

This tab allows you to enter information used when burning audio CDs.

Using the toolbar

The main toolbar is automatically displayed below the menu bar. However, you may hide and customize the toolbar to 
suit your preferences. The settings that you apply to the toolbar remain set until you change them again.

Hiding and displaying the toolbar

If you prefer to use shortcut keys when working with your project, you may hide the toolbar to create more workspace. 
Choose Toolbar from the View menu to hide it. The check mark next to the command is removed and the toolbar 
disappears. The toolbar remains hidden until you choose Toolbar from the View menu to display it again.

Item Description
Ruler time format Choose a ruler time format from the drop-down list.
Ruler start time Enter a value that the ruler will use at the beginning of your project. This feature is useful for 

synchronization purposes.
Beats per minute Enter the desired number of beats per minute for the project. 
Beats per measure Enter the desired number of beats to occur per measure for the project.
Note that gets one beat The value entered will determine the time signature used by the ruler when its format is set to Measures 

and Beats. For example, if the entered value is 4, then a quarter note gets one beat.
Start all new projects with 
these settings

Use the project properties that you have specified whenever a new project is created.

Property Description
Title Enter the name or title of the open project.
Artist Enter the name of the narrator, band, or artist(s) being recorded into the project.
Engineer Enter the name(s) of the people who mixed and edited the project.
Copyright Enter the date and ownership rights of the project.
Comments Enter information that identifies and describes the project.
Start all new projects with 
these settings

Use the project properties that you have specified whenever a new project is 
created.

Property Description
Universal Product Code/
Media Catalog Number

If your CD-R device supports writing UPC/MCN codes, you may specify the value in this field. If you leave 
the field blank, no UPC/MCN value will be written to the CD. Otherwise, the value consists of 13 digits. 

First track number on disc This sets the number for the first track on the disc.
CUSTOMIZING VEGAS SOFTWARE | 307



308 | CHAPTER 19
Reordering toolbar buttons

You can change the main toolbar’s button order to suit your preferences. The Customize Toolbar dialog allows you to 
control the order and functionality available on the main toolbar. You may return the toolbar to its default settings by 
clicking the Reset button.

1. From the Options menu, choose Customize Toolbar. The Customize Toolbar dialog appears.

2. In the Current toolbar buttons list, select the button that you want to move and click Move Up or Move Down.

3. Click Close to save the toolbar changes and close the dialog.

Adding buttons to the toolbar

A series of buttons are included that you may add to the main toolbar. These buttons are listed in the Customize Toolbar 
dialog. You may also add separators on the toolbar to organize the buttons to suit your preferences.

You may return the toolbar to its default settings by clicking the Reset button on the dialog.

1. From the Options menu, choose Customize Toolbar. The Customize Toolbar dialog appears.

2. In the Available toolbar buttons list, use the scroll bars to locate the button that you want to add, and then select it.

3. On the Current toolbar buttons pane, select the button that you want the newly added button to proceed in order.

4. Click Add. The new button is added above the selected button in the Current toolbar buttons list.

5. Click Close to save the toolbar settings and close the dialog.

Removing buttons from the toolbar

You may remove buttons and separators from the main toolbar. If you have added buttons to the toolbar, removing 
unused or unwanted buttons allows you to maximize the toolbar’s space. 

1. From the Options menu, choose Customize Toolbar. The Customize Toolbar dialog appears.

2. On the Current toolbar buttons pane, select the button that you want to remove.

3. Click Remove. The button is removed from the Current toolbar buttons pane and will not appear on the toolbar.

4. Click Close to save the toolbar settings and exit the dialog.

Note: You may also double-click a button to add it to the toolbar.



Saving and recalling window layouts

A window layout stores the sizes and positions of all windows and floating window docks in the Vegas workspace.

You can store any number of window layouts on your computer, and up to ten window layouts are available in the View 
menu (and via keyboard shortcuts) so you can quickly recall frequently used layouts. For example, you could have a 
layout dedicated to multitrack audio recording and another for ADR work.

Saving a window layout

1. Arrange the windows and docked windows as desired.

2. From the View menu, choose Window Layouts, and then choose Save Layout As from the submenu. The Save 
Layout As dialog is displayed.

Choose Save Layout from the submenu if you want to update the current window layout. A bullet ( ) is displayed 
next to the current layout.

3. In the Name box, type the name you want to use to identify the layout. This name will be used in the Organize 
Layouts dialog.

4. Choose a setting from the Shortcut drop-down list to set the shortcut that will be used to load the layout.

For example, if you choose 4, you could press Alt+D, release the keys, and then press 4 on your keyboard to load the 
layout.

5. The Folder box displays the path to the folder where the layout will be saved.

Window layouts are saved in the following folder by default:  C:\Documents and Settings\<user name>\Application 
Data\Sony\Vegas\7.0\. You can click the Browse button to choose a different folder.

6. Click OK to save the new layout.

Loading a saved layout

From the View menu, choose Window Layouts, and then choose the window layout you want to use from the submenu.

If you’ve modified the current window layout, choose Window Layouts, and then choose Reload Selected Layout from 
the submenu to reset the window layout to the last-saved version.

Adding a layout to the View > Window Layouts submenu

1. From the View menu, choose Window Layouts, and then choose Organize Layouts from the submenu. The 
Organize Layouts dialog is displayed.

2. Select a layout in the Available layouts in current folder box. 

This box lists the .VegasWindowLayout files in the folder displayed in the Current layout folder box. If the layout you 
want to use is saved in a different folder, you can click the Browse button to choose a new folder.

3. Select a layout in the Current layouts in menu box.

Note: Window layouts are saved in the following folder: C:\Documents and Settings\<user name>\Application 
Data\Sony\Vegas\7.0\. You can transfer layouts between computers by copying the .VegasWindowLayout files.

Tip: Press Ctrl+Alt+D, release the keys, and then press a number on your keyboard (not the numeric keypad) to save the 
layout in that space.

Tip: To load a layout quickly, press Alt+D, release the keys, and then press a number on your keyboard (not the numeric 
keypad) to recall the layout saved in that in that space.
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4. Click the Assign (or Replace) button to add the layout to the View > Window Layouts submenu.

You can click the Move Up or Move Down buttons to change the order of the layouts in the menu.

5. Click the Activate button to apply the selected layout to the Vegas workspace.

6. Click OK to close the Organize Layouts dialog and apply your changes.

Removing a layout from the View > Window Layouts submenu

1. From the View menu, choose Window Layouts, and then choose Organize Layouts from the submenu. The 
Organize Layouts dialog is displayed.

2. Select a layout in the Current layouts in menu box.

3. Click the Clear button to remove the selected layout from the View > Window Layouts submenu.

If you want to replace the selected layout, select a layout in the Available layouts in current folder box and click the 
Replace button.

4. Click OK to close the Organize Layouts dialog and apply your changes.

Deleting a layout from your computer

1. From the View menu, choose Window Layouts, and then choose Organize Layouts from the submenu. The 
Organize Layouts dialog is displayed.

2. Select a layout in the Current layouts in menu box.

3. Click the Delete Layout button to remove the selected layout from your computer.

4. Click OK to close the Organize Layouts dialog and apply your changes.

Customizing keyboard shortcuts

From the Options menu, choose Customize Keyboard to customize the keyboard shortcuts available in the Vegas 
interface.

The Keyboard mapping box displays the currently assigned shortcut keys. Click a tab in the middle of the dialog to 
choose which shortcuts you want to see.

Editing or creating new shortcuts

1. From the Options menu, choose Customize Keyboard. The Customize Keyboard dialog is displayed.

2. Click a tab in the middle of the dialog to indicate the type of command you want to assign to a keyboard shortcut.

3. Select a command in the list.

4. Click the Shortcut keys box and press the key combination you want to assign to the selected command.

5. Click the Add button to assign the key combination in the Shortcut keys box to the selected command.

Note: Removing a layout from the View > Window Layouts submenu does not remove the .VegasWindowLayout file 
from your computer.

Note: You cannot delete a layout that is included in the Current layouts in menu list. First, select the layout in the 
Current layouts in menu list and click the Clear button. Next, select the layout in the Available layouts in current folder 
list and click the Delete Layout button.

Tip: You can type a word in the Show commands containing box to filter the list of commands to display only 
commands that contain the word you typed.



Saving a keyboard mapping

1. From the Options menu, choose Customize Keyboard. The Customize Keyboard dialog is displayed.

2. Click the Save as button and type a name to save your current keyboard shortcuts to an .ini file in the C:\Documents 
and Settings\[user name]\Application Data\Sony\Vegas\7.0 folder.

You can use this file as a backup or to share your keyboard shortcuts with other Vegas users.

Deleting a keyboard mapping

1. From the Options menu, choose Customize Keyboard. The Customize Keyboard dialog is displayed.

2. Choose a mapping from the Keyboard mapping drop-down list and click the Delete button to remove the selected 
keyboard mapping.

Importing or renaming a keyboard mapping

Copy a Vegas keyboard mapping .ini file to the C:\Documents and Settings\[user name]\Application 
Data\Sony\Vegas\7.0 folder.

The next time you start Vegas, the new keyboard mapping will be available from the Keyboard mapping drop-down list 
in the Customize Keyboard dialog.

Resetting the default keyboard mapping

1. From the Options menu, choose Customize Keyboard. The Customize Keyboard dialog is displayed.

2. Choose [Default] from the Keyboard mapping drop-down list and click OK to restore the default configuration.

Setting preferences

The preferences options are different from project properties. Project properties are unique to each project, while 
preferences affect how Vegas software functions. Any changes that you make to the preferences remain set until you 
change them again or reset Vegas software to use the default presets. 

You can access the Preferences dialog by choosing Preferences from the Options menu. This dialog contains tabbed 
pages. The following sections explain the settings on each tab.

Note: The Application Data folder is not visible unless the Show hidden files and folders radio button is selected on the 
View tab of the Windows Folder Options control panel.

Note: You cannot delete the default Vegas keyboard mapping.

Note: The Application Data folder is not visible unless the Show hidden files and folders radio button is selected on the 
View tab of the Windows Folder Options control panel.

Tip: If you want to edit a the name used to identify a keyboard mapping in the Customize Keyboard dialog, open the .ini 
file in a text editor and change the <Display Name> portion of the Name=<Display Name> entry. Save the .ini file and 
restart Vegas to use the new name.
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General tab

The General tab includes a variety of settings. The following is a list of these preferences and their meaning.

Preference Description
Automatically open last 
project on startup

When Vegas software is run, the last project saved automatically opens.

Show logo splash screen on 
startup

Briefly shows the Vegas software logo while the program is loading. The logo does not increase 
loading time.

Animate video frames in 
Trimmer

Animates the thumbnail representations of frames in a media file opened in the Trimmer. This can 
visually aid trimming.

Prompt to keep files after 
recording

Opens a dialog where you can enter a name and select a location where audio will be saved after 
recording into a track. 

Create undos for FX 
parameter changes

Allows you to undo changes made in the FX, Transition, Event Pan/Crop and Track Motion windows.

Confirm media file deletion 
when still in use

When deleting media in the Explorer or Project Media windows, Vegas software warns you if any 
events in the project are using these files.

Double-click on media file 
loads into Trimmer instead of 
tracks

The default Explorer double-click behavior is to insert an event at the cursor position on the timeline. 
Select this option to open the media file in the Trimmer instead.

Show Trimmer history with file 
name first, then folder

The Trimmer history drop-down list displays the media file’s name first, followed by the folder it is in. 
Select this to reverse the names.

Automatically save Trimmer 
markers and regions with 
media file

Markers and regions created at the media file level in the Trimmer can be saved to the file.

Show progress in Video 
Preview window while 
rendering

Frames can be displayed in the Video Preview during a render. This will slow a render somewhat.

Save active prerenders on 
project close

Full quality preview renders are cleaned up and deleted when a project is closed, Select this if you want 
these prerendered files to be available later.

Close media files when not the 
active application

This allows media files to be edited in external editors (audio, image, etc.) while they are contained in 
events.

Close audio and MIDI ports 
when Vegas is not the active 
application

Select this check box if you want Vegas software to close audio and MIDI ports when you switch to 
another application.

Render large Wave files as 
Wave64

The WAV format is limited by a maximum file size of ~2GB. You can choose to render larger files as 
Wave64™ files.

Automatically name regions 
and markers if not playing

When regions and markers are added, this option automatically prompts you for a name. This does not 
happen when adding markers on-the-fly during playback.

Ignore third party DV codecs Clear this check box to enable third-party DV codecs.
Use Microsoft DV codec Vegas software uses the Sony Media Software DV codec (which offers improved DV video quality over 

the Microsoft codec) as a default. Select this option to have Vegas software use the Microsoft codec to 
read DV files instead.

Strictly conform to AVI2 
specification

Select this option to create 100% AVI2 compliant files. While these files conform to the standards, not 
all applications follow these specifications and some programs may not be able to read them.

Disable multi-processor AVI 
rendering

Suspends dual processor rendering for AVI files. Selecting this option does not affect other dual 
processor operations.

Allow pulldown removal 
when opening 24p DV

Select this option to have Vegas software remove pulldown on DV video files in 24 fps progressive-
scan (24p) format. When this check box is cleared, Vegas software will open 24p files as 29.97 fps 
interlaced video (60i).

Create project file backups 
(.veg.bak)

Automatically create backups of your project files.

Use Net Notify to stay 
informed about Sony product 
updates

Select this option to have Vegas software periodically display information about available updates 
from Sony Media Software at startup.

Enable autosave Creates a temporary project file that can aid in crash recovery. When enabled, autosave occurs every 
five minutes. The autosave process does not overwrite the original project file.

Use linear scrub range When this check box is selected, the scrub control uses a linear range. When this check box is cleared, 
the scrub control uses a logarithmic range.

Allow Ctrl+drag cursor style 
scrub over events

Vegas software allows scrubbing on empty sections of the timeline using Ctrl+drag on the cursor. 
Select this option to enable timeline scrubbing over events as well.

Make spacebar and F12 Play/
Pause instead of Play/Stop

Changes the spacebar and F12 keys to start and pause playback rather than start and stop.



Always draw marker lines Select this check box if you want Vegas software to extend marker and region lines across tracks in the 
timeline. When the check box is cleared, marker lines are drawn only when Enable Snapping is turned 
on.

Build 8-bit peak files Vegas sofware builds 16-bit peak files as a default. Select this option to build 8-bit peak files instead.
Disable pop-up animations Turns off the animation applied to windows such as Video FX, Event Pan/Crop, and Track Motion when 

these windows are opened.
Automatically hide docking 
area

Select this check box if you want the window docking area to hide automatically. Hover over the 
bottom of the Vegas software window to show the window docking area.

Build peaks for visible events 
only

Select this check box if you want Vegas software to build peak files as needed. Vegas software will not 
build a peak file until a file is visible in the timeline. You can open your projects more quickly, but there 
may be occasional pauses as Vegas software builds peaks.

Clear the check box if you want Vegas software to build all necessary peak files when you open your 
project. Opening a project can take longer, but after peak files are built, you can scroll through and 
view your project.

Keep bypassed FX running (to 
avoid pause on bypass/
enable)

Select this check box if you want effects to remain open so you can bypass/enable effects with no 
pause for A/B testing. When the check box is cleared, effects are fully bypassed, conserving processing 
power.

Enable joystick support Select this checkbox if you want to have joystick control for editing in Vegas software.
Enable Windows XP theme 
support

When this check box is selected, the Vegas window will inherit the appearance of the current theme 
when using Microsoft® Windows® XP. When the check box is cleared, user interface elements will 
maintain the classic Windows operating system appearance.

Allow edit cursor to be 
dragged

Select this check box if you want to be able to drag the cursor to change its position on the timeline 
and in the Trimmer window. When this check box is selected, you can position the cursor without 
losing your loop region

To create a time selection without moving the cursor, hold the Shift key.
Ignore fact chunk when 
opening compressed WAV 
files

When this check box is selected, Vegas will ignore fact chunks when opening compressed WAV files.

A fact chunk stores information about the number of samples contained in a compressed WAV file. If 
you experience problems opening a compressed WAV file, select this check box and reopen the file.

Note: If you change the setting of this check box, please delete any proxy (.sfap0) files associated with 
compressed WAV files.

Save media-usage 
relationships in active media 
library

When this check box is selected, the Media Manager™ will save information about media usage so you 
can perform searches for media relationships.

You can search for projects that use a media file, projects where a media file was previewed, media that 
was rendered with a media file, and so on.

Enable Media Manager 
(requires Vegas restart)

When this check box is selected, the Media Manager will start when you start Vegas software.

Clear the check box to turn off the Media Manager and prevent it from starting with the application. If 
you're not using the Media Manager, you may want to turn it off to conserve processing power or 
memory.

AAF Export - Use frame unit 
for audio

Select this check box if you want to use frame units for audio tracks when you export your project as an 
AAF file. When the check box is cleared, audio will be exported as sample units.

Selecting the check box will improve compatibility with other applications for project interchange: 
some applications will not import your project correctly when frame units are used for video and 
sample units are used for audio. 

Clear the check box only if your project contains audio only or if you know the application that will 
import your AAF file supports frame units for video and sample units for audio. 

This setting has no effect when you export your project as an AAF and choose Avid Legacy AAF File 
from the Save as Type drop-down list. Avid legacy AAF files are always exported using frame units for 
audio.

AAF Export - Use clip-based 
audio envelope

Select this check box if you want to combine track and event gain envelopes and save them as clip-
based gain envelopes when exporting AAF files. For more information, see Importing and 
exporting AAF files on page 49.

When the check box is cleared, track envelopes are saved as track envelopes, and event envelopes are 
saved as clip envelopes.

Check project file type 
associations at startup

When this check box is selected, Vegas will check whether Vegas files are associated with Vegas 
software and will prompt you to restore the file association if necessary.

Import MXF as multichannel When this check box is selected, Vegas will import MXF files with all 8 channels and create tracks for 
each. When this check box is cleared, Vegas will import MXF files as a single stereo track.

Enable XDCAM Explorer When this check box is selected, the XDCAM Explorer window will start when you start Vegas software.

Clear the check box to turn off the XDCAM Explorer and prevent it from starting with the application. If 
you're not using the XDCAM Explorer, you may want to turn it off to conserve processing power or 
memory. For more information about the XDCAM Explorer, see page 28.

Preference Description
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Video tab

The Video tab in the Preferences dialog controls the display of video media, video events and video tracks.

Preview device tab

This tab allows you to identify an external monitor for Vegas software to communicate with. The selected video device is 
used to display previews on an external monitor. Vegas uses this device when you click the Preview on External Monitor 

button ( ) in the Video Preview window.

Configuring a Blackmagic Design DeckLink SDI

If you have a Blackmagic Design DeckLink™ SDI card, you can configure Vegas software to work with it.

1. From the Options menu, choose Preferences to display the Preferences dialog.

2. Select the Preview Device tab.

Recently used project list Select the number of files to be listed at the bottom of the File menu.
Temporary files folder Select a location for all temporary files.
Free storage space in selected 
folder

Displays the available disk space in the folder specified in the Temporary files folder box.

Default All Restores all general preferences to the default settings.

Preference Description
Dynamic RAM Preview max 
(MB)

Determines the size of the RAM cache for building dynamic RAM previews in the Video Preview 
window. For more information, see Building dynamic RAM previews on page 268.

Maximum number of 
rendering threads

This setting specifies the maximum number of threads that will be used for rendering files.

Increasing the setting will not increase performance beyond the number of available processors; for 
example, if you have a single-processor computer, choosing 2 will not improve rendering performance.

Decrease the setting if you have a multiprocessor (or multicore) computer and want to limit processor 
use or turn off multithreaded rendering. For example, if you had a dual-processor hyperthreaded 
computer, choosing 3 would allow you to keep one thread available for other tasks while rendering.

Note: Not all video plug-ins are capable of multithreaded rendering. Plug-ins that do not support 

multithreaded rendering are displayed with this icon ( ) in the Plug-In Manager and Plug-In Chooser 

windows and with this icon ( ) in the Video FX window.

Show source frame numbers 
on event thumbnails as

Display frame, time, or timecode numbering on video event thumbnails.

Use external video capture 
application

Select the check box and browse for the application to be launched when you click the Open Video 

Capture button ( ).
Action safe area and Title safe 
area

Sets the reference overlay safe areas in the Video Preview window. For more information, see 
Identifying safe areas on page 270.

Horizontal grid divisions and 
Vertical grid divisions

Sets the spacing of the grid overlay in the Video Preview window used in aligning visual elements in a 
project. For more information, see Changing grid spacing on page 304.

Display at project size Sets the Video Preview window to always display the video at full project size.
Simulate device aspect ratio Determines how the video is displayed in the Video Preview window. In short, televisions display 

rectangular pixels and computer monitors display square pixels. This can result in a distorted preview, 
although the source media and rendered video is unaffected.

Background color Sets the background color of the Video Preview window (black by default) that shows either when 
there is no visual content or when using a transparent overlay with no background visual content.

Default track fade colors Sets the default top and bottom colors when adding a Fade to Color envelope to a video track. For 
more information, see Working with track envelopes on page 149.

Default All Restores all video preferences to the default settings.

Note: Audio is not output to the external monitor. If your project contains complex effects or compositing and you 
cannot attain full-frame-rate playback, use selective prerendering to prerender the sections of your project that cannot be 
rendered in real time.

Preference Description



3. From the Device drop-down list, choose Blackmagic Design DeckLink. Information about the device displays in the 
Details area.

4. Use the Conform output to the following format controls to adjust the video to display properly on your external 
monitor.

a. Choose the desired format from the Conform output to the following format drop-down list.

b. Select a radio button to indicate when you want to adjust the output to the selected format.

5. If audio and video do not play back in synchronization, drag the Sync offset slider to specify a frame offset to restore 
synchronization.

6. Select the Recompress edited frames check box to recompress any edited frames in your project before previewing. 
When the check box is cleared, edited frames will not be passed to the device.

7. Select the Display frames in Video Preview window during playback check box if you want to preview on the 
external monitor and in the Vegas Video Preview window simultaneously.

When the check box is cleared, video is sent only to the external monitor.

8. To replace all custom functions with the default settings, click the Default All button.

Configuring an AJA Xena LHe, LH, LSe, or LS SDI

If you have an AJA SDI card, you can configure Vegas software to work with it.

1. From the Options menu, choose Preferences to display the Preferences dialog.

2. Select the Preview Device tab.

3. From the Device drop-down list, choose AJA Video Device. Information about the device displays in the Details 
area.

Setting Description
Only when the project does not 
match any available format

Select this radio button if you want to adjust the video only if the project settings do 
not match a standard format. For more information, see Working with project 
properties on page 306.

Always Select this radio button if you want to adjust the video output to the selected format 
whenever you preview on the external monitor.

Use this setting when you do not have a preview device that supports your required 
project format.

For example, if you’re creating a PAL project, but you don’t have a PAL monitor, you 
could use this setting to preview on an NTSC monitor.

Note: This setting affects preview synchronization only. Audio and video synchronization in your project is unaffected. 
Depending on your hardware setup, you may need to adjust your settings. For example, you might need one setting when 
previewing directly to a monitor and a slightly higher setting when previewing through a monitor that is connected to a 
deck.
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4. Use the Conform output to the following format controls to adjust the video to display properly on your external 
monitor.

a. Choose the desired format from the Conform output to the following format drop-down list.

b. Select a radio button to indicate when you want to adjust the output to the selected format.

5. If audio and video do not play back in synchronization, drag the Sync offset slider to specify a frame offset to restore 
synchronization.

6. Select the Use progressive segmented frame (psf) video formats check box if your project properties are set to a 
progressive-scan format and you want to preview on a device that stores and transfers progressive scan frames by 
dividing fields.

7. Select the Recompress edited frames check box to recompress any edited frames in your project before previewing. 
When the check box is cleared, edited frames will not be passed to the device.

8. Select the Display frames in Video Preview window during playback check box if you want to preview on the 
external monitor and in the Vegas Video Preview window simultaneously.

When the check box is cleared, video is sent only to the external monitor.

9. To replace all custom functions with the default settings, click the Default All button.

Configuring an OHCI-compliant IEEE 1394/DV device

If you have an OHCI-compliant IEEE 1394/DV device, you can configure it to work with Vegas software.

1. From the Options menu, choose Preferences to display the Preferences dialog.

2. Select the Preview Device tab.

3. In the Device drop-down list, select OHCI-compliant IEEE 1394/DV. Information about the device displays in the 
Details area.

Setting Description
Only when the project does not 
match any available format

Select this radio button if you want to adjust the video only if the project settings do 
not conform to a standard format.

For more information, see Working with project properties on page 306.
Always Select this radio button if you want to adjust the video output to the selected format 

whenever you preview on the external monitor.

Use this setting when you do not have a preview device that supports your required 
project format.

For example, if you’re creating a PAL project, but you don’t have a PAL monitor, you 
could use this setting to preview on an NTSC monitor.

Note: This setting affects preview synchronization only. Audio and video synchronization in your project is unaffected. 
Depending on your hardware setup, you may need to adjust your settings. For example, you might need one setting when 
previewing directly to a monitor and a slightly higher setting when previewing through a monitor that is connected to a 
deck.



4. Use the Conform output to the following format controls to adjust the video to display properly on your external 
monitor.

a. Choose the desired format from the Conform output to the following format drop-down list.

b. Select a radio button to indicate when you want to adjust the output to the selected format.

5. If audio and video do not play back in synchronization, drag the Sync offset slider to specify a frame offset to restore 
synchronization.

6. Select the Recompress edited frames check box to recompress any edited frames in your project before previewing. 
When the check box is cleared, edited frames will not be passed to the device.

If you're previewing a project that consists of DV media with no compositing or transitions, the DV will be passed 
directly to your preview device. If, however you'd added a 6-frame crossfade, the crossfade would be passed to the 
preview device only if the check box is selected.

7. Select the Display frames in Video Preview window during playback check box if you want to preview on the 
external monitor and in the Vegas Video Preview window simultaneously.

When the check box is cleared, video is sent only to the external monitor.

8. To replace all custom functions with the default settings, click the Default All button.

Configuring a Windows Secondary Display

If you have a Windows secondary display device, you can configure it to work with Vegas software.

1. From the Options menu, choose Preferences to display the Preferences dialog.

2. Select the Preview device tab.

3. In the Device drop-down list, select Windows Secondary Display. Information about the device displays in the 
Details area.

4. From the Display Adapter drop-down list, choose the device where your preview monitor is connected. 

You can click the Identify Displays button to determine which display corresponds to each setting in the drop-down 
list. A number will be displayed on each monitor.

Setting Description
Only when the project does not 
match any DV format

Select this radio button if you want to adjust the video only if the project settings do 
not conform to a standard DV format. For more information, see Working with 
project properties on page 306.

Always Select this radio button if you want to adjust the video output to the selected format 
whenever you preview on the external monitor.

Use this setting when you do not have a preview device that supports your required 
project format.

For example, if you’re creating a PAL project, but you don’t have a PAL monitor, you 
could use this setting to preview on an NTSC monitor.

Note: This setting affects preview synchronization only. Audio and video synchronization in your project is unaffected. 
Depending on your hardware setup, you may need to adjust your settings. For example, you might need one setting when 
previewing directly to a monitor and a slightly higher setting when previewing through a monitor that is connected to a 
deck.

Note: If the monitor number is displayed in red, the graphics card does not support 3D acceleration or acceleration has 
been turned off. In Windows, you can go to Start > Settings > Control Panel > Display > Settings >Advanced > 
Troubleshoot to turn on acceleration if your adapter supports it.
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5. From the Display Mode drop-down list, choose the frame size and refresh rate you want to use for the secondary 
display.

6. Select the Scale output to fit display check box if you want the video preview to fill the display.

7. Select the Apply deinterlace filter check box if you’re previewing interlaced video on a noninterlaced display. This 
filter can reduce the artifacts you often see on the edges of moving areas.

8. If you want to adjust color reproduction for video previews, use the color management controls.

a. Select the Use color management check box.

b. Select the Use Studio RGB check box if your source media conforms to studio RGB color (black=16 and 
white=235) and you will be previewing on your computer’s CRT or LCD monitor. When the check box is selected, 
the studio RGB range is expanded to 0 to 255 to conform to a computer display.

Clear the check box if you will be previewing on a TV monitor or if your source media does not conform to studio RGB 
color.

c. From the Monitor color profile drop-down list, choose the color profile that best matches your display. 

You can obtain ICC/ICM color profiles from the display manufacturer, or you can create your own if you have a 
calibration system.

9. Select the Recompress edited frames check box.

10. Select the Display frames in Video Preview window during playback check box if you want to preview on the 
secondary monitor and in the Vegas Video Preview window simultaneously. 

When the check box is cleared, video is sent only to the secondary monitor.

11. To replace all custom functions with the default settings, click the Default All button.

Audio tab

The Audio tab allows you to set preferences to optimize how your computer’s components are used to handle resource-
intensive audio. This tab also allows you to configure Vegas software to the equipment that is connected to your 
computer.

Setting Description
Use current settings Video is displayed using the monitor’s resolution and refresh rate specified in the Windows Display 

Properties control panel.
Automatic size settings The software will attempt to choose the optimum resolution and refresh rate. This setting overrides 

the Windows Display Properties setting as long as the secondary display window is active.
Use custom settings You can choose the resolution and refresh rate you want to use. This setting overrides the Windows 

Display Properties setting as long as the secondary display window is active. 

Note: The Apply deinterlace filter check box will be unavailable if your video adapter does not support pixel shading.

Note: The Use color management check box will be unavailable if your video adapter does not support gamma 
adjustment.

Preference Description
Waveform display while 
recording

Allows you to display or hide waveforms when recording into an audio track.

Normalize peak level (dB) Sets the maximum level that is used when normalizing an event.
Import audio at project tempo When this check box is selected, ACID loops are automatically stretched to match the project tempo 

(specified on the Ruler tab of the Project Properties dialog) when you add them to the timeline or 
preview from the Explorer window.

When the check box is cleared, tempo information is ignored.
Preferred audio editor Displays the path of the audio editor that you can start directly from Vegas software to perform 

destructive edits to audio.
Metronome Allows you to use a default metronome sound or to select custom sound files to be used as the 

metronome beats.
Default All Restores all audio preferences to the default settings.



Audio Device tab

Preference Description
Audio device type Choose a driver type from the drop-down list. The Microsoft Sound Mapper is the default setting. If you 

want to activate specific sound cards, choose Windows Classic Wave Driver or ASIO and choose a device 
from the Default Stereo and Front playback device drop-down list. For more information, see Routing 
busses to hardware on page 170.

Default stereo and front 
playback device

Choose the device that you want to use for playing stereo sound data and the front-left and -right 
channels of a 5.1 surround project.

Selecting the Microsoft Sound Mapper allows Windows to select an appropriate device to use for the 
current sound data.

Note: If you have selected Microsoft Sound Mapper, you will not be able to assign busses to different 
devices.

Default rear playback device Choose the device that you want to use for playing the rear channels of a 5.1 surround project.
Default center and LFE 
playback device

Choose the device that you want to use for playing the center and low-frequency effect channels of a 5.1 
surround project.

Playback buffering 
(seconds)

Sets the amount of memory used during project playback. For more information, see Adjusting the 
playback buffering slider on page 320.

Enable track buffering Select this check box and drag the Track buffering slider if you want to adjust the amount of audio that 
is prerendered ahead of the cursor position.

When the check box is selected, a separate processing thread is used to render audio from tracks. On 
multiprocessor or multicore computers, a thread will be created for each logical processor.

When the check box is cleared, a single processing thread is used to render audio from tracks and busses.
Default audio recording 
device

Sets the default device for recording into a track.

Automatically detect and 
offset for hardware 
recording latency

Select the check box to automatically compensate for offset between the time you initiate recording and 
when your sound card starts recording.

Clear the check box and drag the User offset (samples) (ms) slider to specify an offset value.
Advanced Clicking this button opens the Advanced Audio Preferences dialog. For more information, see below.
Default All Restores all audio device preferences to the default settings.
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Advanced audio preferences

You can access advanced settings by clicking the Advanced button on the Audio Device tab. The Advanced Audio 
Configuration dialog displays all of the audio devices that are installed on your computer and allows you to set the 

controls for each device.

Adjusting the playback buffering slider

The playback buffer controls how much memory is used when playing back your project. This preference is useful, but 
must be carefully adjusted. If you set the buffer size too high, you may experience gapping during playback. Conversely, 
if you set the buffer size too low, you may experience gapping as well because Vegas software has too little memory to 
work with during playback. 

The playback buffer slider should be set to balance RAM usage and playback buffering. The rule is to set this slider as low 
as possible without introducing gapping.

1. Open a project that has multiple events.

2. On the Audio device tab, move the Playback buffering (seconds) slider to 0.25.

3. Start playing back the project.

4. If the playback still gaps, increase the Playback buffering (seconds) slightly.

You may have to experiment to find the correct settings. If you continue to experience gapping, you can try the following 
to control the gapping:

• Decrease the number of events you are trying to play back. This may mean muting tracks or soloing a couple of tracks. 
RAM is mostly affected by the number of unique events that are playing back simultaneously.

• Use the Render to New Track command (on the Tools menu) to combine all the events into one event. For more 
information, see Rendering to a new track on page 142.

Preference Description
Audio devices This list contains all of the audio devices that are installed in your computer. Selecting one 

from the list allows you to set the options below for that device.
Interpolate position During project playback, you may notice that the cursor position is different than what you 

are hearing. This problem stems from inaccuracies in some audio devices. Select this 
control’s check box to have Vegas software attempt to compensate for the inaccuracies by 
interpolating the cursor’s correct position during playback or recording.

Position bias The position bias control gives you additional cursor control when it is inaccurately 
displayed during project playback and recording. If you have enabled the Interpolate 
position control and are still experiencing cursor position inaccuracies, move the Position 
bias control forward or backward to compensate for the inaccuracies of the audio device.

Do not pre-roll buffers 
before starting playback

When this option is not selected, Vegas software begins storing (buffering) project audio 
information prior to playback. This storing is very fast and unnoticeable in most cases. 
However, some audio devices stutter when you begin playback as a result of the buffering 
process. If your audio stutters when you start playback, select this check box to prevent 
buffering audio information prior to playback.

Audio buffers Drag the slider to set the number of audio buffers that will be used. Adjusting this setting 
can help you synchronize the input and output for record input monitoring.

Buffer size (samples) Choose a setting from the drop-down list to indicate the buffer size you want to use. Choose 
MME to use the Playback buffering setting on the Audio Device tab in the Preferences 
dialog.

Priority Choose a setting from the drop-down list to set the priority that is assigned to your audio 
buffers. Increasing the buffers’ priority can help you attain smoother playback, but it can also 
adversely affect other processes.

Enable input monitoring Select this check box to enable the monitoring of your recording input through Vegas 
software while you are recording.



MIDI tab

Use the MIDI tab to set options for using MIDI devices with Vegas software. To display this tab, choose Preferences from 

the Options menu, then click the MIDI tab.

Preference Description
Make these devices available for 
MIDI output

Select the check box for each MIDI device that you want to use as a MIDI output for a control 
surface.

Make these devices available for 
MIDI input

Select the check box for each MIDI device that you want to be available for a control surface.

Default All Restores all MIDI preferences to the default settings.
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VST Effects tab

Editing tab

Preference Description
Default VST search folder Displays the location where the software looks for VST effects.
Alternate VST search folder X Click Browse to choose an alternate location where VST effects can be found.
Select VST effects to be 
available as audio plug-ins

Select the VST effects that you want available for use as Vegas audio plug-ins. Only the VST effects 
located in the default or alternate search folders appear in this box.

Preference Description
Enable looping on events by 
default

Sets events that are trimmed longer than their source media to automatically loop. When this option is 
not selected, extended events repeat the final frame of a video file.

Preserve pitch when 
stretching audio events

Prevents pitch shifting when you stretch an audio event.

Collapse loop region when no 
time selection is present

When selected, a loop region does not persist when there is no time selection. This means that when 
you click the timeline and move the cursor (destroying the any previous time selection), the loop 
region is also reset to zero. By default, this option is not selected and loop regions persist until 
modified or until a new time selection is created.

Cut, copy and delete grouped 
events

When this check box is selected, cutting, copying, or deleting an event will affect all events in the same 
group.

JKL/shuttle speed Choose a setting from the drop-down list to set the speed that will be used for scrubbing the timeline 
with the JKL keys or with a multimedia controller.

Quick fade length for audio 
events (ms)

Sets a fast fade on the edges of audio events (10ms by default) to soften potentially harsh beginnings 
and endings.

New still image length 
(seconds)

Sets the default duration of inserted still image files (e.g., BMP, PNG).

Default time between CD 
tracks

Sets the default time created between CD tracks when using the Add Media as CD Tracks 
command in the Project Media window. For more information, see Adding media as CD tracks to a new 
project on page 330.

Cursor preview duration 
(seconds)

Enter a value in the edit box to specify the length of the time Vegas software will preview when you 
preview the cursor.

To preview the cursor, press the 0 key on the numeric keypad. Vegas software creates a temporary 
selection (centered over the cursor) and begins playback automatically.

Cursor preview will loop if the Loop Playback mode is enabled.
Automatically overlap 
multiple selected media when 
added

Creates automatic crossfades between events when multiple media files are added to the same track 
across time. When this check box is not selected, multiple media files are added end-to-end across 
time with no overlap. For more information, see Creating a slide show on page 209.

Cut-to-overlap conversion Sets the behavior of the cut-to-overlap feature. The cut-to-overlap feature allows you to transform a 
cut from one event to another into a transition. The Amount field sets the duration of the extended 
overlap. The Alignment value determines the direction of the extension. For more information, see 
Converting a cut to a transition on page 248.

Audio default type Choose a fade type from the Audio default type drop-down list to set the default fade type that will be 
used when you add volume and panning envelopes. This setting is used only when you create new 
envelopes—when you add a point to an existing envelope, the new point always uses the same fade 
type as the preceding envelope point. Also, this setting is not used for event envelopes.

Video default type Choose a fade type from the Video default type drop-down list to set the default fade type that will be 
used when you add fade-to-color, composite level, and event velocity envelopes. This setting is not 
used for track motion or keyframe envelopes.

Default Track Motion 
smoothness

Type a value in the box (or use the spin control) to set the default Smoothness value for track motion 
and 3D track motion keyframes. For more information, please see Adding track motion on page 258 
and 3D Compositing on page 233.

Default Pan/Crop smoothness Type a value in the box (or use the spin control) to set the default Smoothness value for event pan/crop 
keyframes.

Default All Restores all editing preferences to the default settings.



Display tab

Preference Description
Track colors Use these controls to change the default colors used to display tracks in your project.

Select a track from the Track drop-down list, and then click the color swatch to display a color picker.

You can choose any color using the RGBA or HSLA controls. Click the  button to switch between 

RGB and HSL color modes, or click the eyedropper  to sample a color from your screen. 

When you click OK or Apply, all tracks that used the selected color are updated.
Envelope colors Use these controls to change the default colors used to display envelopes in the timeline.

Choose an envelope type from the Envelope type drop-down list and click the color swatch to display 

a color picker, where you can choose any color using the RGBA or HSLA controls. Click the  button 

to switch between RGB and HSL color modes, or click the eyedropper  to sample a color from your 
screen.

Snap colors Use these controls to change the default colors used to snapping indicators in the timeline.

Choose an snap indicator type from the Snap type drop-down list and click the color swatch to display 

a color picker, where you can choose any color using the RGBA or HSLA controls. Click the  button 

to switch between RGB and HSL color modes, or click the eyedropper  to sample a color from your 
screen.

Icon color saturation Drag the slider to adjust the color intensity of icons in the Vegas window. Drag to the left to decrease 
the color saturation, or drag to the right to increase it.

Icon color tint Drag the slider to adjust the amount of tinting that is applied to the icons in the Vegas window. Drag 
the slider to the right to add an average of the title bar colors to the icons. Drag to the left to decrease 
the amount of tinting applied.

Automatically hide docking 
area

Select this check box if you want the window docking area to hide automatically when you're not 
using it. Hover over the bottom of the Vegas window to show the window docking area.

Note: If the Dock windows at top of main window check box is also selected, double-click the splitter 
above the timeline to make the docking area visible again.

Dock windows at top of main 
window

Select this check box if you want to display the window docking area at the top of the Vegas window. 
The timeline will be displayed at the bottom of the window.

Position tabs at top of docked 
windows

Select this check box if you want to display tabs at the top of docked windows:

Default All Restores the Display page options to the default settings.
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CD Settings tab

The CD Settings tab allows you to set preferences for burning CDs and extracting audio from your own CDs.

Sync tab

These preferences are used to set up Vegas software to generate or trigger from MIDI timecode from external MIDI 
devices. For more information, see Synchronizing MIDI timecode on page 184.

Setting advanced Sync preferences

From the Sync tab, you can access advanced settings by clicking Advanced. The Advanced Sync Preferences dialog has 
three tabs: MTC Input, MTC Output, and MIDI Clock Output. The display of these tabs is dependent on your selections in 
the Sync tab. See the following sections on each tab for more information.

Preference Description
Use strict Red Book 
specification for DAO 
validation

Select this check box if you want to be notified prior to burning a disc-at-once CD if anything about 
your CD project is against strict Red Book standards.

These warnings are not critical, and in most cases you will not write an unreadable disc if you proceed. 
Clearing this check box will not suppress critical warnings that will result in an unreadable disc. 

Include wide SCSI devices 
when searching for drives

Select this check box if you want Vegas software to scan for wide SCSI CD drives when you attempt to 
extract data from or burn CDs.

When the check box is cleared, Vegas software will not scan for wide SCSI devices, which can increase 
compatibility with some USB device drivers that incorrectly identify themselves as wide SCSI.

Skip drive database; 
autodetect drive capabilities 
on startup

When the check box is cleared, Vegas software will use an internal configuration file to determine your 
drive's capabilities.

If you encounter problems burning CDs, select this check box, and Vegas software will test your drive 
to determine its capabilities.

Automatically detect plug-
and-play CD/DVD drives

Select this check box if you want to automatically detect when optical drives are connected or 
disconnected.

When the check box is cleared, only drives that were connected during application startup are 
available. If you connect a drive while the application is running, you'll need to exit and restart the 
application before using the drive.

Use SPTI direct Select this check box if you want to use SPTI (SCSI Pass-Through Interface) to communicate with your 
CD burning drive.

Default All Restores all CD preferences to the default settings.

Preference Description
Generate MIDI Timecode 
settings

Sets the output device and frame rate used when generating MIDI timecode.

Generate MIDI Clock settings Sets the output device used when generating MIDI Clock information. You can choose the same device 
that you chose for Generate MIDI Timecode settings.

Trigger from MIDI Timecode 
settings

Sets the input software or device and frame rate used when triggering from MIDI timecode.

Note: When Sync is active (Vegas software is triggering from MTC), media files are not closed (i.e., cannot be edited 
outside of Vegas software) when Vegas software is not the active application. You will also not be prompted to rename or 
delete recorded takes as this may interrupt the synchronization.



MTC Input

This tab displays only if you choose a device in the Trigger from MIDI Timecodes settings drop-down list on the Sync 
tab.

MTC Output

This tab displays only if you choose a device in the Generate MIDI Timecode settings drop-down list on the Sync tab.

MIDI Clock Output

This tab displays only if you choose a device in the Generate MIDI Clock Settings drop-down list on the Sync tab.

Preference Description
Free-wheel for timecode loss When selected, Vegas software continues to play for a specified period of time without chasing if 

timecode is lost. Enabling this option can compensate for infrequent losses in timecode monitoring. If 
losses in timecode are frequent, troubleshooting should be done on your hardware to find the cause of 
the problem.

Free-wheel slack time 
(seconds)

Specifies the amount of time that timecode can be lost before the Free-wheel playback time starts. A 
longer time is more tolerant of losses in the incoming timecode.

Free-wheel playback time 
(seconds)

Specifies the amount of time that Vegas software plays back after the Free-wheel slack time has been 
exceeded.

Synchronization delay time 
(seconds)

Specifies the amount of time required for Vegas software to synchronize itself to incoming timecode. 
On slower computers, this time should be set to around two seconds. On faster computers, it may be 
set lower.

Offset adjust (quarter frames) If Vegas software is consistently behind or ahead of the MTC generator, enter a value to adjust a 
synchronization offset with quarter-frame accuracy.

If Vegas software is behind the MTC generator, enter a negative number such as -4. If Vegas software is 
ahead of the MTC generator, enter a positive number such as 4.

Preference Description
Full-frame message 
generation

Specifies when Vegas software sends full-frame timecode messages. Full-frame messages are used by 
some external audio synchronizers to seek a proper location prior to synchronization. For example, 
tape-based recorders benefit from seeking to full-frame messages because of the time required to 
move the transport to the proper location. However, full-frame messages are ignored by some devices 
and may actually cause unexpected behavior in other devices. Check your hardware documentation to 
find out if it supports full-frame messages.

Preference Description
Send Start instead of Continue 
when beginning playback

When selected, Vegas software sends a Start command rather than a Continue command. Normally, 
Vegas software sends a Continue command to allow the chasing device to start at a specific time. 
However, some older MIDI sequencers do not support the Continue command and must start from the 
beginning every time.

Song Position Pointer 
generation

Specifies when Vegas software sends Song Position Pointer messages. Song Position Pointer messages 
are used by MIDI applications and devices to seek to a proper location prior to starting the 
synchronization process.
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External Control & Automation tab

Use the External Control & Automation tab to set up and customize control surfaces. To display this tab, choose 
Preferences from the Options menu, then click the External Control & Automation tab.

Connecting a control surface

You can use one Mackie® Control Universal or up to five generic control surfaces with Vegas software. Perform the 
following steps for each device.

1. Connect the MIDI Out port on your MIDI interface to the MIDI In port on your control surface.

2. Connect the MIDI In port on your MIDI interface to the MIDI Out port on your control surface.

3. Configure Vegas software to use your control surface.

4. Use the MIDI tab in the Preferences dialog to select the device to which your control surface is connected. For more 
information, see MIDI tab on page 321.

5. Add your device on the External Control & Automation tab.

Configuring a Mackie Control Universal

The Mackie Control Universal is fully supported by Vegas software. An overlay is available from Mackie that you can use to 
label the buttons and controls with their mapped functions in Vegas software.

The overlay identifies the default control mapping. You can also customize the buttons and controls on the Mackie 
Control Universal. When you use the default mapping, the Mackie Control is divided into several functional areas. For 
more information, see Using a Mackie Control Universal with Vegas on page 343.

Preference Description
Smooth and thin automation 
data after recording

When recording automation, Vegas software creates as many envelope points or keyframes as possible 
to represent your control movements. 

Select this check box if you want to reduce the number of envelope points/keyframes after recording is 
finished. 

For more information, see Recording automation settings on page 154.
Set controls to default values 
when automation is turned off

Select this check box if you want controls to return to their default values when set the track's 
automation recording mode to Automation Off. Automated effect parameters do not have default 
settings and will retain their last-set values when you turn automation off.

When the check box is cleared, controls will retain their last-set values when you turn automation off.
Available devices Choose a device from the drop-down list and click Add to choose the control surfaces that will be 

available to Vegas software. Adding a device loads its default profile.
Active control devices Lists the control devices that you’ve added. Double-click a device name to customize its behavior.
Default all Restores all control surface preferences to the default settings.

Note: For information about your specific device, please refer to the manufacturer's documentation.



Configuring a generic control surface

If you have a MIDI controller that includes buttons and knobs or faders, you can use the device as an external control 
surface.

For example, let’s assume that you have a MIDI keyboard that has 8 knobs. This section will show you how you can use 
those knobs to control the volume on the tracks in your project.

1. From the Options menu, choose Preferences to display the Preferences dialog.

2. Select the MIDI tab, and verify that the port where your controller is connected is selected in the Make these devices 
available for MIDI input list.

3. Select the External Control & Automation tab.

4. From the Available devices drop-down list, choose Generic Control, and then click the Add button. The Generic 
Control is added to the Active control devices list.

5. Double-click the Generic Control entry in the Active control devices list to display the Configure Generic Control 
dialog.

6. Because the MIDI keyboard in our example has 8 knobs, type 8 in the Number of channels box.

7. Now, let’s assign buttons to shift the channel banks up and down so you can control all the tracks in your project. 

For example, when you start using the controller, the knobs will adjust tracks 1-8. When you shift the banks down, 
you can control tracks 9-16, and so on.

a. From the View function group drop-down list, choose Channels.

b. Select the Learn check box. 

c. Select Channel Bank Down from the Host Command list.

d. Press the button or key you want to use to switch to the next group of 8 tracks. 

e. Select Channel Bank Up from the Host Command list.

f. Press the button or key you want to use to switch to the previous group of 8 tracks. 

8. Choose Audio Channels from the View function group drop-down list. 

9. Program each knob:

a. Verify that the Learn check box is still selected. 

b. Select Channel 1 Fader from the Host Command list.

c. Turn knob 1 on your MIDI keyboard. You'll notice that the Channel, MIDI Message, and MIDI Data columns are 
updated.

d. Repeat steps 9a and 9b to program knobs 2 through 8 on your keyboard.

10. Now, let’s assign a button to toggle the controller in and out of automation mode so we can use the knobs to adjust 
the track’s volume (trim) or record volume automation:

a. From the View function group drop-down list, choose Assign.

b. Select Toggle Automation Mode from the Host Command list.

c. Verify that the Learn check box is still selected, and then press the button or key you want to use to switch your 
control surface in and out of automation mode. 

You'll notice that the Channel, MIDI Message, and MIDI Data columns are updated.

11. Click OK to close the Configure Generic Control dialog, and then click OK to close the Preferences dialog.

Notes: 

• You can use this same process to assign a controller to any configurable parameter. To adjust track volume, we're 
selecting Channel x Fader in the Host Command list in step 9 below. However, if you wanted to adjust panning, you 
could choose Channel x Pan, or if you wanted to adjust the bus send level, you could choose Channel x Send.

• Effect parameters cannot be controlled with a generic controller.

Important:

A generic control surface can control either trim or automation settings. In order to control automation settings, you 

must assign a button to place the control surface in automation mode, and the Automation Settings button  on the 
track or bus you want to edit must be set to Automation Write (Touch) or Automation Write (Latch).
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12. From the Options menu, choose External Control to enable your controller.

You’re ready to start using your controller. 

• Turn each knob on your controller and notice that turning knob 1 adjusts the volume (trim) of track 1, turning 
knob 2 adjusts the volume of track 2, and so on.

• Press the button that you assigned to scroll the channel bank down in step 7.
Turn each knob on your controller and notice that turning knob 1 now adjusts the volume (trim) of track 9, 
turning knob 2 adjusts the volume of track 10, and so on.

• Press the button that you assigned to scroll the channel bank up in step 7 so you can control tracks 1-8 again.
• Press the button that you assigned to toggle automation mode in step 10.

Select the Automation Settings button  on each track to enable automation recording.

Start playback, and turn each knob on your controller, and notice that turning knob 1 records volume 
automation on track 1, turning knob 2 records automation on track 2, and so on.

• Press the automation mode toggle button once more, and you can use the knobs to adjust track trim levels 
again.



Chapter 20
 Burning CDs

You created your project in Vegas® software, and now you are ready to write the project to a CD. With the CD-burning 
capabilities of Vegas software, you can place and arrange audio files to produce professional audio CDs. You can burn 
CDs for multiple- or single-track projects and build audio CD layouts automatically or manually. You can also create video 
CDs that can be played in many home DVD players and on computers with a CD-ROM drive and VCD player software, and 
multimedia CDs that can be played in any computer with the appropriate player.

Understanding track-at-once and disc-at-once

Two ways are provided for recording audio to a CD-R disc: track-at-once and disc-at-once.

Track-at-once

Track-at-once writing records individual tracks to the disc and results in a partially recorded disc. However, the CD-R disc 
remains unplayable on most systems until you close the disc. The advantage of track-at-once writing is that you can 
record tracks onto the disc as you finish them versus waiting until you have finished your whole album. Track-at-once 
writing burns the entire project as a single track.

Disc-at-once (Single Session or Red Book)

Disc-at-once writing is the most common burning method in the music industry. This writing mode is used when creating 
a master disc to be sent to a disc manufacturer for mass replication. Disc-at-once works just as it sounds. Multiple tracks of 
audio are written to the CD in one recording session.

Understanding tracks and indices

You are ready to burn a CD. If you plan to use track-at-once to record a single track, you can proceed right on to writing 
the entire project to a CD. However, you are more likely to set up tracks—and perhaps indices—within your project and 
burn several tracks at once. 

Tracks distinguish songs in the project and have a starting and ending point. Tracks are used to indicate to the CD-R 
device where to mark the beginning and ending of a track during the writing process.

Indices are single markers that subdivide a track. Indices are useful for navigating to specific areas within a track. For 
example, a sound effects CD may have one track of breaking glass. The track is then indexed to allow navigation to a 
specific glass-breaking effect within the track. However, be aware that not all CD players allow navigation to indices.

Tracks and indices are identified in a track list, which is a chronological text list of all tracks and indices defined in the 
audio CD project. 

Setting up to burn audio CDs

You can set the project properties and adjust preferences to better accommodate writing audio CDs. The ruler and time 
display are set up for you automatically. 

Viewing the ruler and time display

The ruler and time display are automatically changed to audio CD time for you when you mark CD tracks in a project. 

Audio CD time formats are as follows:

Display Format

Ruler hh:mm:ss (hours:minutes:seconds) or 

hh:mm:ss:ff (hours:minutes:seconds:frames, with fps=75) when zoomed in tightly

Time display tt+mm:ss:ff (track number +/- minutes:seconds:frames, with fps=75)
BURNING CDS | 329



330 | CHAPTER 20
Setting project properties

Click the Properties button ( ) to access project properties. On the Audio CD tab, you can set the Universal Product 
Code/Media Catalog Number (UPC/MCN) or set the number for the first track on the CD. For more information, see Audio 
CD tab on page 307.

Setting preferences

From the Options menu, choose Preferences to access the Preferences dialog. On the CD Settings tab, you can set 
several options related to your CD/DVD drive(s) and CD burning. For more information, see CD Settings tab on page 324.

You can also enter the number of seconds added between tracks when adding Project Media window files as CD tracks. 
In the same Preferences dialog, click the Editing tab, and enter a value in the Default time between CD tracks box.

Finally, you may want to turn off the Quantize to Frames command in the Options menu. When quantizing to frames is 
active, your edits are limited to the starting edge of frame boundaries. In a CD layout project, you can turn this feature off 
to allow greater precision in editing and track placement. For more information, see Quantizing to frames on page 114.

Importing CD Architect files

You can use Vegas software to open projects created in CD Architect™ version 4.0 software.

1. From the File menu, choose Open. The Open dialog appears. 

2. Browse to the location of the project file.

3. In the Files of type drop-down list, select CD Architect 4 Project Files (.cdp).

4. Select the file.

5. Click Open.

Creating audio CD layout projects

Several ways are provided to create an audio CD layout project. If you have a set of audio files you wish to burn to a CD, 
you can add the files as tracks to a new audio CD layout project. Or, if you want to burn an audio CD from an existing 
project, you can mark the tracks in your project either automatically or manually.

Adding media as CD tracks to a new project

You have a collection of completed audio files that you want to write to a CD. An audio CD layout project can quickly be 
assembled from sound files in the Project Media window. You can add the tracks one at a time, or use the Project Media 
window to sort them into track order and add them all at once.

1. Create a new project.

2. Add all the media to be included in the project to the Project Media window. For more information, see Using the 
Project Media window on page 44.

CD layout bar Track markers



3. To add all tracks at once, use the following steps to sort the files into track order:

• In the Project Media window, click the arrow on the Views button ( ) and choose Details from the menu. 
The Project Media window changes to Details view.

• In the Comments column, enter the track number for each media file (01, 02, etc.).
• Click the Comments column header to sort the list into track order.
• Select the sorted files in the Project Media window.

4. Right-click a media file (or the selected media files) and choose Add as CD Track from the shortcut menu.

The files are added to a new track and the audio CD tracks are marked on the CD layout bar. The name of the media file is 
used to name each track. If necessary, you can edit the information for the new audio CD tracks using the markers on the 
CD layout bar or using the Edit Details window. For more information, see Working with tracks and indices on page 333.

Marking tracks in an existing project

Once you have laid out your audio project with the appropriate pauses, you can mark tracks and indices either 
automatically or manually.

Adding pauses

Each audio CD track in your project should have a two-second pause following it. This default setting is based on the Red 
Book specification for audio CDs. The exception to this standard is a continuous recording, such as a live concert CD. For a 
continuous recording, you can omit the pauses after tracks for continuous playback. For more information, see Red Book 
specification on page 375.

Note: In DAO CD burning, Vegas software burns from the beginning of the timeline to the last track marker, regardless of 
the location of the first track marker. Material before the first marker is included as a hidden track on the disc (if your drive 
supports burning this material).

Note: The Red Book specification also requires a two-second pause at the beginning of an audio CD. If the first track in 
your project begins before the two-second mark, a ruler is added offset to ensure the project begins with the required two-
second pause.

Right-click files in the Project Media window to add them as CD tracks to a audio CD layout project.
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If you use the Add as CD Track command to add tracks from the Project Media window, the appropriate pauses are 
added automatically. However, if you are laying out your project manually, you must create these pauses between audio 
CD tracks.

1. Position the cursor where you want to insert the pause.

2. From the Insert menu, choose Time. The Insert Time dialog appears.

3. Enter two seconds in the Amount of time to insert box.

4. Click OK. Two seconds are inserted in the timeline at the cursor position.

Marking tracks automatically

Vegas software can examine the events in your project and mark the audio CD tracks for you. Once the tracks are marked, 
you can adjust them manually if necessary. For more information, see Moving track and index markers on page 333.

1. Lay out your project with two-second pauses between tracks.

2. From the Tools menu, choose Lay Out Audio CD from Events.

The new audio CD track markers appear on the CD layout bar above the timeline. The name of the media file for each 
event is used to name the tracks. 

Marking tracks manually

You can make a time selection and then mark that selection as an audio CD track. 

1. Make a time selection that includes the audio for the new track. 

2. From the Insert menu, choose Audio CD Track Region. The markers for the new audio CD track appear on the CD 
layout bar.

Marking indices

You can create an index marker in much the same way as you create track markers.

1. Position the cursor where you want the index mark to appear.

2. From the Insert menu, choose Audio CD Track Index. The new index marker 
appears on the CD layout bar.

Two-second pauses



Working with tracks and indices

Once you have marked your tracks and indices, you can edit, move, rename, or delete them as needed.

Navigating to and selecting tracks and indices

Several shortcuts are provided for navigating to and selecting audio CD tracks on the CD layout bar. 

• Double-click a track marker to select the track.
• Press . (period) to jump the cursor to the next track or index marker. 
• Press , (comma) to jump the cursor to the previous track or index marker. 
• Press Ctrl+. (period) to jump the cursor to the next track marker (index markers are skipped). 
• Press Ctrl+, (comma) to jump the cursor to the previous track marker (index markers are skipped). 
• Add Shift to any of these keystrokes to select rather than jump. For example, press Ctrl+Shift+. (period) to select from 

the cursor position to the next track marker.

The shortcut keystrokes can be used to jump the cursor while working on a project or during playback. 

Moving track and index markers

Track and index markers function just like markers and regions in Vegas software (pg. 104). You can drag a track or index 
marker to move it along the CD layout bar. Alternately, you can use the Edit Details window to make precise adjustments. 

Renaming track and index markers

1. Right-click a marker and choose Rename from the shortcut menu that appears. 

2. Type a new name for the marker and press Enter.

Deleting track and index markers

You can delete a single track or index marker by right-clicking it and choosing Delete from the shortcut menu. To delete 
all markers at once, right-click the CD layout bar and choose Delete All from the shortcut menu.

Editing markers using the Edit Details window

The Edit Details window provides a way to adjust the settings for a track or index. 

1. From the View menu, choose Edit Details. The Edit Details window displays.

2. From the Show drop-down list, choose Audio CD Track List. The track settings display.

3. Double-click a setting to edit it:

• In the Position column, adjust the track starting position or index position.
• In the End column, adjust the track ending position.
• In the Length column, adjust the track length.
• in the Name column, enter the name of the track or index.
• In the Prot column, select the check box to apply copy protection to the track.
• In the Emph column, select the check box to enable a simple noise reduction process that is implemented by a 

CD player. For more information, see Emphasis on page 370.
• In the ISRC column, enter the ISRC number for the track (if used).

Tip: Move both the starting and ending markers for a track by pressing Alt and dragging either of the markers.
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Copying a track list from the Edit Details window

You can use the Edit Details window to copy your track list and 
paste it into another application.

1. Click the gray box in the upper-left corner of the Edit Details 
window to select all the cells.

2. Press Ctrl+C to copy the cells.

3. Switch to another application and paste the information into 
a document or spreadsheet.

Burning audio CDs

You can burn either single tracks (track-at-once) or the entire disc (disc-at-once).

Burning single tracks (track-at-once)

You can burn your Vegas project as a single track (track-at-once). Once you have burned all your tracks to the CD, you 
must close the disc before it can be played.

Burning a track-at-once CD

1. From the Tools menu, choose Burn CD, and choose Track-at-Once Audio CD from the submenu. The Burn Track-at-
Once Audio CD dialog displays the length of the current file and the amount of time remaining on the disc in your 
CD recorder. 

2. Choose a setting from the Action drop-down list:

• Burn audio begins recording audio to your CD when you click the Start button. You will need to close the disc 
before it can be played in an audio CD player.

• Test, then burn audio performs a test to determine whether your files can be written to the CD recorder 
without encountering buffer underruns. Recording begins after the test if it is successful.

• Test only performs a test to determine whether your files can be written to the CD without encountering buffer 
underruns. No audio is recorded to the CD.

• Close disc closes your disc without adding any audio when you click the Start button. Closing a disc allows your 
files to be played on an audio CD player.

• Erase RW disc erases your rewritable CD when you click the Start button.

3. Select your burning options:

• Buffer underrun protection: Select this check box if your CD recorder supports buffer underrun protection. Buffer 
underrun protection allows a CD recorder to stop and resume burning.

• Erase RW disc before burning: If you’re using a rewritable CD, select this check box to erase the CD before you 
begin burning.

• Close disc when done burning: Select this check box to close the CD after burning. Closing a disc allows your 
files to be played on an audio CD player.

• Eject disc when done: Select this check box to eject the CD automatically when burning has completed.
• Burn selection only: Select this check box to burn only the audio within the loop region.

4. From the Drive drop-down list, choose the CD drive that you want to use to burn your CD.

5. From the Speed drop-down list, choose the speed at which you want to burn. Max will use your drive’s fastest 
possible speed; decrease the setting if you have difficulty burning.

6. Click the Start button.

7. When the writing process is complete, a confirmation message displays. Click OK to clear the message.

Warning: Clicking the Cancel button after the disc-writing process has begun will render your disc unusable.



Closing a track-at-once CD

1. From the Tools menu, choose Burn CD, and choose Track-at-Once Audio CD from the submenu. The Create CD 
dialog appears.

2. Click the Close Disc button.

3. When the disc is closed, a confirmation message displays. Click OK to clear the message.

Burning a disc (disc-at-once)

1. From the Tools menu, choose Burn CD, and choose Disc-at-Once Audio CD from the submenu. The Burn Disc-at-
Once Audio CD dialog appears

2. From the Drive drop-down list, use the CD drive that you want to use to burn your CD.

3. From the Speed drop-down list, choose the speed at which you want to burn. Max will use your drive’s fastest 
possible speed; decrease the setting to prevent the possibility of buffer underruns.

4. Select the Buffer underrun protection check box if your CD recorder supports buffer underrun protection. Buffer 
underrun protection allows a CD recorder to stop and resume burning.

5. Choose a radio button in the Burn mode box:

• Burn CDs begins recording audio to your CD immediately.
• Test first, then burn CDs performs a test to determine whether your files can be written to the CD recorder 

without encountering buffer underruns. No audio is recorded to the CD during the test, and recording begins 
after the test if it is successful.

• Test only (do not burn CDs) performs a test to determine whether your files can be written to the CD recorder 
without encountering buffer underruns. No audio is recorded to the CD.

6. Select the Render temporary image before burning check box if you want to render your CD project to a temporary 
file before recording. Prerendering can prevent buffer underruns if you have a complex project that cannot be 
rendered and burned in real time.

7. Select the Automatically erase rewritable discs check box if you’re burning to rewritable media and want to erase 
the disc before burning.

8. Select the Eject when done check box if you want the CD to eject automatically when burning has completed.

9. Click OK to start burning.

Note: Buffer underrun protection can create a disc that can be played in CD players, but may contain a bit error where 
burning stopped and restarted. Consider clearing this check box when creating a premaster disc.

Note: The rendered temporary file will remain until you modify your project or exit. If an image file exists when you open 
the Burn Disc-at-Once Audio CD dialog, the check box is displayed as Use existing rendered temporary image.
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Burning video CDs

Video CDs can be played in many home DVD players and on computers with a CD-ROM drive and VCD player software.

1. From the Tools menu, choose Burn CD and choose Video CD from the submenu. The Burn Video CD dialog is 
displayed.

2. From the Burn drive drop-down list, use the CD drive that you want to use to burn your Video CD.

3. From the Burn speed drop-down list, choose the speed at which you want to burn. Max will use your drive’s fastest 
possible speed; decrease the setting to prevent the possibility of buffer underruns.

4. Select the Buffer underrun protection check box if your CD recorder supports buffer underrun protection. Buffer 
underrun protection allows a CD recorder to stop and resume burning.

5. Select the Automatically erase rewritable discs check box if you’re burning to rewritable media and want to erase 
the disc before burning.

6. Select the Eject when done check box if you want the CD to eject automatically when burning has completed.

7. Choose a radio button in the Burn mode area:

• Burn CDs begins recording the video file to your CD immediately.
• Test first, then burn CDs performs a test to determine whether your file can be written to the CD recorder 

without encountering buffer underruns. The file is not recorded to the CD during the test, and recording begins 
after the test if it is successful.

• Test only (do not burn CDs) performs a test to determine whether your file can be written to the CD recorder 
without encountering buffer underruns. The file is not recorded to the CD.

Note: Buffer underrun protection can create a disc that can be played in CD players, but may contain a bit error where 
burning stopped and restarted. Consider clearing this check box when creating a premaster disc.



8. Choose the movie file you want to use:

• If you want to render the current project, select the Render format radio button.
a. Edit the contents of the File path box to specify the name and location of your rendered file.

b. Choose a template from the Template drop-down list to specify the parameters that should be used for 
rendering your file, or click the Custom button to create a new template.

c. Select the Render loop region only check box if you want to use only a portion of your project. If the check 
box is cleared, the entire project will be rendered and saved to the Video CD.

d. Select the Stretch video to fill output frame check box if you want your video to be reformatted so it fills the 
output frame size listed in the Description box. When the check box is cleared, the current aspect ratio is 
maintained and black borders are added to fill the extra frame area (letterbox). This option is useful when 
the desired output format does not match the frame aspect ratio of you project.

• If you want to use an already-rendered MPEG file, select the Use an existing file radio button, and enter the path 
to the file in the File path box (or click the Browse button to locate the file).

9. Click OK.

10. Your movie is recorded to the CD. When recording is finished, you can select the Save movie file check box to keep 
the MPEG file that was rendered, or you can clear the check box to delete the file.

11. Click Finish.

Note: Clear the Fast video resizing check box if you see unacceptable artifacts in the rendered video. Turning off this 
option can correct the artifacts, but your rendering times will increase significantly.
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Creating a multimedia CD

From the Tools menu, choose Burn CD and choose Multimedia CD from the submenu to render your project and burn it 
to a data CD. The rendered project can be played in any computer with the appropriate player.

1. From the Tools menu, choose Burn CD, and choose Multimedia CD from the submenu. The Burn Multimedia CD 
dialog appears.

2. From the Burn drive drop-down list, use the CD drive that you want to use to burn your multimedia CD.

3. From the Burn speed drop-down list, choose the speed at which you want to burn. Max will use your drive’s fastest 
possible speed; decrease the setting to prevent the possibility of buffer underruns.

4. Select the Buffer underrun protection check box if your CD recorder supports buffer underrun protection. Buffer 
underrun protection allows a CD recorder to stop and resume burning.

5. Select the Automatically erase rewritable discs check box if you’re burning to rewritable media and want to erase 
the disc before burning.

6. Select the Eject when done check box if you want the CD to eject automatically when burning has completed.

7. Choose a radio button in the Burn mode area:

• Burn CDs begins recording the media file to your CD immediately.
• Test first, then burn CDs performs a test to determine whether your file can be written to the CD recorder 

without encountering buffer underruns. The file is not recorded to the CD during the test, and recording begins 
after the test if it is successful.

• Test only (do not burn CDs) performs a test to determine whether your file can be written to the CD recorder 
without encountering buffer underruns. The file is not recorded to the CD.

Note: Buffer underrun protection can create a disc that can be played in CD players, but may contain a bit error where 
burning stopped and restarted. Consider clearing this check box when creating a premaster disc.



8. Choose the movie file you want to use:

• If you want to render the current project, select the Render format radio button.
a. Edit the contents of the File path box to specify the name and location of your rendered file.

b. Choose a template from the Template drop-down list to specify the parameters that should be used for 
rendering your file, or click the Custom button to create a new template.

c. Select the Render loop region only check box if you want to use only a portion of your project. If the check 
box is cleared, the entire project will be rendered and saved to the multimedia CD.

d. Select the Stretch video to fill output frame check box if you want your video to be reformatted so it fills the 
output frame size listed in the Description box. When the check box is cleared, the current aspect ratio is 
maintained and black borders are added to fill the extra frame area (letterbox). This option is useful when 
the desired output format does not match the frame aspect ratio of you project.

• If you want to use an already-rendered MPEG file, select the Use an existing file radio button, and enter the path 
to the file in the File path box (or click the Browse button to locate the file).

9. Select the Play movie inside Web page check box if you want to create an HTML file that will automatically play your 
movie when the CD is inserted.

10. Select the Include movie player installer check box if you want to include movie player software with your CD. Click 
the Browse button to locate the movie player's installation program.

11. Click OK.

12. Your movie is recorded to the CD. When recording is finished, you can select the Save movie file check box to keep 
the MPEG file that was rendered, or you can clear the check box to delete the file.

13. Click Finish.

Note: Clear the Fast video resizing check box if you see unacceptable artifacts in the rendered video. Turning off this 
option can correct the artifacts, but your rendering times will increase significantly.
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Chapter 21
 Using Scripting

Using the scripting features, Vegas® software becomes an even more powerful and flexible tool. You can use scripting to 
streamline repetitive tasks, integrate with external applications, and implement customized features. 

To use scripting, you’ll need to install the Microsoft® .NET Framework. This component is available from the Microsoft 
Windows® Update site. (Choose Windows Update from the Start menu.)

Running a script

1. From the Tools menu, choose Scripting, and then choose Run Script from the submenu. The Run Script dialog is 
displayed.

2. Browse to the script file (.vb or .js) you want to run.

3. Select the file and click the Open button. The script runs.

Adding scripts to the Scripting menu

When you start the program, Vegas software looks at the Script Menu folder in the Vegas program folder to determine 
which scripts appear in the Scripting submenu. This folder is c:\Program Files\Sony\Vegas 7.0\Script Menu by default.

1. Add or delete scripts in the Script Menu folder to change the contents of the submenu.

2. From the Tools menu, choose Scripting, and then choose Rescan Script Menu Folder to update the menu.

Creating a script

The Microsoft .NET framework is used for scripting. You can write scripts in JScript or Visual Basic .NET.

For more information on JScript®, see 
http://msdn.microsoft.com/library/en-us/jscript7/html/jsoriJScript.asp.

For more information on Visual Basic® .NET, see 
http://msdn.microsoft.com/library/en-us/vbcn7/html/vaconProgrammingWithVB.asp.

Note: To use scripts that were created for Vegas 4.0 software, you'll need to revise the script's namespace from 
SonicFoundry.Vegas to Sony.Vegas. For example, the line that includes “import SonicFoundry.Vegas;” should be changed 
to “import Sony.Vegas;” before running the script.

Note: To prevent duplication of script files, you can use shortcuts in the Script Menu folder.
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Editing an existing script

All you need to edit a script is a simple text editor (and a working knowledge of JScript or Visual Basic .NET scripting). The 
scripts that are included are fully commented to help you find and edit the parameters you need.

1. Create a copy of the script (.vb or .js) file you want to edit, assigning a descriptive name to the copy.

2. Open the new copy of the script in your text editor.

3. Edit the script as needed. The comments in the script will help you find the parameters you need to edit.

Comments are indicated with double forward slashes: //.

For example, the AddEffectToAllMedia.js script includes the following lines:

// This is the full name of the effect plug-in you want to add.

var plugInName = "Sony Timecode";

// This is the name of the preset you want. Set this to null if you

// want the default preset.

var presetName = "SMPTE Drop (29.97 fps)";

The default script applies the Sony Timecode plug-in to all video media in your project using the SMPTE Drop (29.97 
fps) preset. If you wanted to apply the Broadcast Colors plug-in’s Extremely Conservative - 7.5 Setup preset to all 
audio media, you could edit the script as follows (changes appear in red):

// This is the full name of the effect plug-in you want to add. 
var plugInName = "Sony Broadcast Colors";

// This is the name of the preset you want. Set this to null if you 
// want the default preset. 
var presetName = "Extremely Conservative - 7.5 Setup";

The plugInName variable should use the plug-in name that is displayed in the Plug-In Chooser. The presetName 
variable should use the preset name that is displayed in the Preset box in the FX window.

4. Save the script.

http://msdn.microsoft.com/library/en-us/jscript7/html/jsoriJScript.asp
http://msdn.microsoft.com/library/en-us/vbcn7/html/vaconProgrammingWithVB.asp
http://msdn.microsoft.com/library/en-us/vbcn7/html/vaconProgrammingWithVB.asp


Appendix A
 Using a Mackie Control Universal with Vegas

The Mackie Control is fully supported by Vegas® (versions 5, 6, and 7) software and lends a tactile element to your editing 
sessions. An overlay is available from Mackie that you can use to label the Mackie Control buttons and controls with their 
mapped functions in Vegas. For more information about Mackie Control overlays, please check the Mackie Web site: 
http://www.mackie.com/products/mcu/index.html

The overlay identifies the default control mapping. You can also customize the buttons and controls on the Mackie 
control. For more information, see Configuring or customizing control mappings on page 346. When you use the default 
mapping, the Mackie Control is divided into several functional areas. All functionality described in this document refers to 
the default control mapping. 
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Hardware setup

You can use one Mackie Control Universal (with up to four Mackie Control Extenders) with Vegas. Perform the following 
steps for each device.

If you’re using Mackie Control Extenders, you’ll need a multiport MIDI interface with MIDI In/Out ports for each device.

Connecting the Mackie Control Universal

1. Connect the MIDI Out port on your MIDI interface to the MIDI In port on your Mackie Control Universal.

2. Connect the MIDI In port on your MIDI interface to the MIDI Out port on your Mackie Control Universal.

3. Repeat Steps 1 and 2 for each Mackie Control Extender.

Configuring the software to use the Mackie Control Universal

1. From the Options menu, choose Preferences to display the Preferences dialog.

2. Enable your MIDI input and output ports:

a. Select the MIDI tab in the Preferences dialog.

b. In the Make these devices available for MIDI output box, select the check box for the MIDI port that is 
connected to the Mackie Control Universal’s In port.

c. In the Make these devices available for MIDI input box, select the check box for the MIDI port that is connected 
to your Mackie Control Universal’s Out port.

d. Repeat Steps 2b and 2c for each Mackie Control Extender.

e. Click Apply.

3. Choose your control surface:

a. Select the External Control and Automation tab in the Preferences dialog.

b. From the Available devices drop-down list, choose Mackie Control and click the Add button to load the default 
profile.

4. Click OK to apply your changes and close the Preferences dialog.

5. From the Options menu, choose External Control to enable the Mackie Control Universal.

Configuring channel mappings for Mackie Control Extenders

If you’re using Mackie Control Extenders, you’ll need to set up your channel mapping. Channel mapping tells the software 
how the devices are arranged on your desktop.



For example, if your Mackie Control Universal is on the left of your Mackie Control Extender, you could configure the 
Mackie Control to adjust channels 1 through 8 and use the Mackie Control Extender to adjust channels 9 through 16. If 
you have a Mackie Control Universal positioned between two Mackie Control Extenders, you could adjust channels 1 
through 8 on the left Extender, adjust channels 9 through 16 on the Mackie Control Universal, and adjust channels 17 
through 24 on the right Extender.

1. From the Options menu, choose Preferences to display the Preferences dialog.

2. Select the External Control & Automation tab.

3. Double-click your Mackie Control in the Active control devices list to display the Configure Mackie Control dialog. 
The current channel mapping is displayed on each device's LCD.

4. Choose the channels you want to control with the Mackie Control Universal:

a. From the Device Type drop-down list, choose Mackie Control.

b. From the Channel Mapping drop-down list, choose the channels you want to adjust with the Mackie Control 
Universal. 

5. Choose the channels you want to control with the Mackie Control Extender:

a. From the Device Type drop-down list, choose Mackie Control Extender.

b. From the Channel Mapping drop-down list, choose the channels you want to adjust with the Mackie Control 
Extender.

6. Repeat Step 5 for each Mackie Control Extender.

7. Click OK to apply your changes and close the Configure Mackie Control dialog.

8. Click OK to apply your changes and close the Preferences dialog.
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Configuring or customizing control mappings

Use the External Control & Automation tab in the Preferences dialog to select the control surfaces you want to use and 
adjust their configuration. 

1. From the Options menu, choose Preferences to display the Preferences dialog.

2. Select the External Control & Automation tab.

3. Double-click your Mackie Control in the Active control devices list to display the Configure Mackie Control dialog.

4. To add or change a function do the following:

a. Select an item in the User defined surface control mappings list.

b. Select an item in the Available host functions list.

c. Click the Assign button.

5. To remove a function, select an item in the User defined surface control mappings list and click the Clear button.

6. To remove all functions, click the Clear All button.

7. To replace all custom functions with the default settings, click the Default All button.

Reminder: When you customize your control mappings, button functions may not match the labels on the overlay. You 
can click the Default All button in the Configure Mackie Control dialog to restore the default settings.



Using the Mackie Control Universal

The following sections describe the default control mapping for the Mackie Control Universal when used with Vegas.

Channel section

The channel section includes V-Pots (knobs), buttons, and faders that you can use to edit your tracks and busses.

If you’re using Mackie Control Extender units, you can control eight additional channels with each Extender. For more 
information, see Configuring channel mappings for Mackie Control Extenders on page 344. 

The Mackie Control Universal can control either trim or automation settings. In order to control automation settings, 
the Automation button in the Audio/Video section must be selected, and the track or bus you want to edit must be set 
to Automation Write (Touch) or Automation Write (Latch). Hold the F1 button while turning the V-Pot (or use the 
Automation Settings button) to change the automation recording mode for each track and bus track. 

Item Description

1 V-Pot Adjusts values for panning, volume (when Flip button is selected), video track opacity (when Flip button is 
selected), video track fade-to-color, and effect parameter values.

• Audio track volume: Adjusts track volume when the Pan or Sends button is selected and the Flip button is 
selected.

• Audio track panning: Adjusts audio track panning when the Pan button is selected.

• Bus send levels: Adjusts bus send levels when the Sends button is selected.

• Video track opacity: Adjusts video track opacity when the Video and Flip buttons are selected.

• Video track fade to color: Adjusts video track fade-to-color envelope when the Video button is selected, the 
Automation button in the Audio/Video section is selected, and the track is in Automation Write (Touch) or 
Automation Write (Latch) mode.

• Compositing mode: Adjusts the track compositing mode when the Video button is selected and you press 
the Output/Compositing button twice to change the track assignment to CO.

• Effect parameters: Adjusts effect parameters when the Inserts button is selected.

The V-Pot is velocity sensitive, so rotating quickly changes values quickly, and you can press the button to 
choose a selection.

When the Pan or Sends button is selected, press the V-Pot to edit the track or bus chain.

2 Rec/Ready 
Button

Arms audio tracks for recording.

3 Signal LED Indicates whether an audio track or bus is outputting a signal.

4 Solo Button Press to solo a track or remove it from the solo group.

5 Mute Button Press to mute or unmute a track.

1
2
3
4
5
6

7
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Footswitches (not shown)

The Mackie Control has two switched inputs (labeled User Switch A and User Switch B) that you can use to connect 
footswitches.

By default, footswitch A toggles playback, and footswitch B starts and stops recording.

You can customize the footswitches in the Configure Mackie Control dialog. Double-click Mackie Control in the Active 
control devices list on the External Control & Automation tab of the Preferences dialog to display the Configure Mackie 
Control dialog. For more information, see Configuring or customizing control mappings on page 346.

6 Select 
Button

Press to select a track.

7 Fader Adjusts the track or bus level (unless the Flip button is selected). 

When the Automation button is selected, the fader adjusts the automation envelope if the track is in 
Automation Write (Touch) or Automation Write (Latch) mode. 

The fader can also adjust settings for the following items when you select other buttons in the Channel section.

• Audio track panning: Adjusts audio track panning when the Pan and Flip buttons are selected.

• Bus send levels: Adjusts bus send levels when the Sends and Flip buttons are selected.

• Video track opacity: Adjusts video track opacity when the Video button is selected.

• Video track fade to color: Adjusts video track fade-to-color settings when the Automation, Video, and Pan/
Fade to Color buttons are selected. 
 
Adjusts video track fade-to-color envelope when the following conditions are met: 
—The Video button is selected. 
—The Automation button in the Audio/Video section is selected 
—The Pan/Fade to Color button is selected. 
—The track is in Automation Write (Touch) or Automation Write (Latch) mode.

The fader is touch sensitive, so if you're recording automation parameters, recording will begin when you touch 
the fader and stop when you release it. The current setting is displayed in the Mackie Control display.

Item Description



Control buttons

The buttons in the Control section determine the operation of the V-Pots and faders in the channel section of your Mackie 
Control. In every mode, the fader adjusts track volume, and the V-Pot adjusts the selected control mode. You can press 

the Flip button to reverse the V-Pot and fader function.

Item Description

1 Output/
Compositing

Press the Output button to set the output device for each track or bus. Turn the V-Pot in the channel section to 
choose an output device and press the V-Pot to select it.

When the Video button is selected, you can set the compositing mode for each track using the V-Pot.

2 Input/
Motion Blur

Press to set the recording input device for each track. Turn the V-Pot in the channel section to choose an input 
device and press the V-Pot to select it. 

When the Video button is selected, press the V-Pot to enable or bypass motion blur for each video track.

3 Pan/Fade to 
Color

Press to adjust track panning using the V-Pot in the channel section.

In 5.1 surround projects, pressing the Pan button toggles left-to-right panning, front-to-rear panning, and 
center-channel level adjustment using the V-Pot.

When the Video button is selected, you can adjust the opacity of video tracks with the fader in the channel 
section and adjust fade-to-color settings with the V-Pot when the Automation button in the Audio/Video 
section is selected and the track is in Automation Write (Touch) or Automation Write (Latch) mode.

4 Sends Press to adjust bus and assignable effects send levels. Press the Sends button to scroll through the available 
busses and assignable effects chains, and then turn the V-Pot to adjust the send level.

1
2
3
4
5
6
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5 Inserts Press to adjust effects settings.

Press the button once to display PL in the Mackie Control Assignment display. The Mackie Control LCD displays 
the effects that are assigned to each track or bus. The following example shows a three-track project:

Turn the V-Pot to scroll through the effects, and press the V-Pot to edit the current effect. In editing mode, PE is 
displayed in the Assignment display. The following example shows the settings for the Noise Gate plug-in on 
track one: 

PE mode uses the following controls: 

• V-Pots 1-4: Turn to edit the effect's parameters. For “switch” parameters such as Bypass, press the V-Pot to 
change the setting.

• V-Pot 5: Turn to scroll through an effect's property pages.

• V-Pot 6: Turn to choose from a plug-in's available presets. Press the V-Pot to choose a preset.

• V-Pot 7: Turn to edit the current effect for a different channel.

• V-Pot 8: Turn to choose other effects for the current channel.

Press the Inserts button again to view effects chains. PS is displayed in the Assignment display. The following 
example shows the effects chain on track one:

PS mode uses the following controls: 

• V-Pots 1, 3, and 5: Turn to choose other effects for the current channel. Press to edit the selected effect and 
enter PE mode.

• V-Pots 2, 4, and 6: After choosing an effect with V-Pot 1, 3, or 5, press V-Pot 2, 4, or 6 to add it to the channel.

• V-Pot 7: If a channel has multiple pages of effects in the chain, turn to display additional effects. In the 
previous example, Aud 1 1/2 means that track one has two pages of effects.

• V-Pot 8: Turn to choose effects chains for other channels. 
 
When <No Insert> is displayed above a V-Pot, you can turn the V-Pot to view effects that you can add to the 
chain. New effects are displayed with a *. Press the next V-Pot (to the right) to add the effect.

6 Settings Press to adjust track or bus settings using the F1 through F6 buttons.

• F1: Hold the button and turn the V-Pot to change the automation recording mode for each track and bus 
track.

• F2: Hold the button and turn the V-Pot to change the current panning mode.

• F3: Hold the button and press the V-Pot to change the track phase.

• F4: Hold the button and turn the V-Pot to change record input monitoring settings when you're using an ASIO 
audio device.

• F5: When the Pan button is selected, press the Settings button and then hold F5 while pressing the V-Pot to 
change the bus or assignable effects output fader to Pre FX or Post FX. 
 
When the Sends button is selected, press the Settings button and hold F5 while pressing the V-Pot to change 
a track's bus or assignable effects send level to Pre Volume or Post Volume. Press the Sends button to scroll 
through the available bus and effects sends.

• F6: Press the Settings button and hold F6 while pressing the V-Pot on a channel to return the channel's 
settings to the track defaults.

Item Description



Fader Banks buttons

The Fader Banks buttons control the behavior of the channel section controls.

Display buttons

The Display buttons control the behavior of the channel section controls.

Item Description

1 Bank Press the left or right arrow button to scroll the channels 8 units at a time.

For example, if tracks 1-8 are currently displayed, pressing the right arrow will change to tracks 9-16.

2 Channel Press the left or right arrow button to scroll the channels 1 unit at a time.

For example, if tracks 1-8 are currently displayed, pressing the right arrow will change to tracks 2-9.

Hold the Option button while pressing either Channel button to change track order. For example, if track two is 
selected and you press Option+ < Channel, track two becomes track one. Conversely, if track one is selected and 
you press Option + Channel >, track one becomes track two. 

3 Flip Press to exchange the behavior of the fader and V-Pot when allowed.

4 Video Press to toggle audio and video modes.

For example, you press the Pan/Fade button in audio mode, you can perform audio track panning with the V-
Pot. 

If you press the button in video mode, you can adjust fade-to-color settings if the Automation button in the 
Audio/Video section is selected and the track is in Automation Write (Touch) or Automation Write (Latch) 
mode.

Item Description

1 Meters/
Values

When you're working with audio tracks or busses, press to display meters or numeric values. Even in Meters 
mode, numeric values are displayed when you edit a value.

In Audio mode, hold the Shift button in the Modifiers section while pressing the Meters/Values button to toggle 
control of tracks, busses, or tracks and busses.

• Press once to show audio tracks.

• Press again to show audio tracks.

• Press again to show busses.

• Press again to show tracks and busses.

2 Time Fmt 
Zero

Press and hold to display the current time format. Turn V-Pot 8 while holding the button to change the format.

Hold the Shift button in the Modifiers section while pressing the Time Fmt/Zero button to set the current cursor 
position to zero. 

1
2

3
4

1
2
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Markers buttons

The Markers buttons control additional track and channel settings.

Add New buttons

The Add New buttons add busses or tracks to your project.

Item Description

1 Marker 1/9 
Automation 
Mode

Press to place the cursor at marker 1, or hold Shift and press to place the cursor at marker 9.

When the Settings button is selected, hold the button and turn the V-Pot to change the automation recording 
mode for each track and bus track.

2 Marker 2/10 
Pan Mode

Press to place the cursor at marker 2, or hold Shift and press to place the cursor at marker 10.

When the Settings button is selected, hold the button and turn the V-Pot to change the current panning mode.

3 Marker 3/11 
Track Phase

Press to place the cursor at marker 3, or hold Shift and press to place the cursor at marker 11.

When the Settings button is selected, hold the button and press the V-Pot to change the track phase.

4 Marker 4/12 
Input 
Monitor

Press to place the cursor at marker 4, or hold Shift and press to place the cursor at marker 12.

When the Settings button is selected, hold the button and turn the V-Pot to change record input monitoring 
settings when you're using an ASIO audio device. 

5 Marker 5/13 
Pre/Post

Press to place the cursor at marker 5, or hold Shift and press to place the cursor at marker 13.

When the Pan button is selected, press the Settings button and then hold F5 while pressing the V-Pot to change 
the bus or assignable effects output fader to Pre FX or Post FX. 
 
When the Sends button is selected, press the Settings button and hold F5 while pressing the V-Pot to change a 
track's bus or assignable effects send level to Pre Volume or Post Volume. Press the Sends button to scroll 
through the available bus and effects sends.

6 Marker 6/14 
Default

Press to place the cursor at marker 6, or hold Shift and press to place the cursor at marker 14.

Press the Settings button and hold F6 while pressing the V-Pot on a channel to return the channel's settings to 
the track defaults.

7 Marker 7/15 Press to place the cursor at marker 7, or hold Shift and press to place the cursor at marker 15.

8 Marker 8/16 Press to place the cursor at marker 8, or hold Shift and press to place the cursor at marker 16.

Item Description

1 Track Press to add a new audio track. When the Video button is selected, a new video track is added.

2 Bus Press to add an audio bus to your project.

1
2
3
4
5
6
7
8
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Windows buttons

The Windows buttons control the display of various Vegas windows.

View buttons

The View buttons control the display of various sections of the Vegas window.

Item Description

1 Mixer Press to show the Mixer window. If the window is not docked, pressing the button shows/hides the window. 

2 Video 
Preview

Press to show the Video Preview window. If the window is not docked, pressing the button shows/hides the 
window. 

3 Plug-Ins Press to show the Plug-In Manager window. If the window is not docked, pressing the button shows/hides the 
window.

Item Description

1 Bus Tracks Press to show or hide audio bus tracks in the Vegas timeline. 

When the Video button is selected, press to show or hide the video bus track.

2 Dock Area Press to show or hide the Window Docking Area at the bottom of the Vegas window.

3 Track List Press to show or hide the track list in the timeline.

1
2
3

1
2
3
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Modifiers buttons

The Modifiers buttons extend the functionality of other buttons on the Mackie Control.

Item Description

1 Shift Hold the Shift button while pressing a button labeled with inverse text to perform the shift function. 

For example, hold Shift while pressing the Undo/Redo button to reverse an undo action.

2 Option/Track 
Order

Hold the Option/Track Order button while pressing a button in the Settings, Add New, or Windows group for 
alternative functions. 

Hold the Option/Track Order button while pressing a the Channel < or Channel > button to change track order.

Hold the Option/Track Order button while pressing F1 to F16 to perform custom functions you can define. 

For more information, see Configuring or customizing control mappings on page 346.

3 Ctrl Hold the Ctrl button while using a control for alternative functions.

4 Alt Hold the Alt button while using a control for alternative functions. 

Hold Alt while pressing F1 through F10 to run scripts 1-10 from the Tools > Scripting submenu.

1
2

3
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Audio/Video buttons

The Audio/Video buttons control various audio and video settings for your project.

Project buttons

The Project buttons perform various project-level commands.

Item Description

1 Automation Press to place the controls on the Mackie Control in automation mode. The controls in the channel section of the 
Mackie Control will affect the automation parameters on the track or bus if Automation Write (Touch) or 
Automation Write (Latch) mode is selected.

When the button is not selected, the buttons control trim (static) values.

2 Bypass FX Press to bypass/enable all audio effects.

3 Metronome Press to turn the metronome on or off.

4 Surround/ 
Ext Monitor

Press to toggle the project properties between stereo and 5.1 surround mode.

When the Video button is selected, press the Surround/Ext Monitor button to send your video preview to an 
external monitor.

5 Downmix/ 
Split Screen

Press to toggle the state of the Downmix Output button in the Mixer window.

When the Video button is selected, press the Downmix/Split Screen button to toggle split-screen video 
previews.

6 Dim/ 
Overlays

Press to toggle the state of the Dim Output button in the Mixer window.

When the Video button is selected, press the Dim/Overlays button to toggle the display of overlays (grid, safe 
areas, and RGB channels) in the Video Preview window.

Item Description

1 Save Press to save your project.

2 Undo/Redo Press to reverse edit operations. 

Hold Shift while pressing the button to reverse an undo operation.

3 OK Not used.

4 Cancel Not used.

1
2
3

4
5
6
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2
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Timeline buttons

The Timeline buttons perform various commands for the project timeline.

Item Description

1 Marker/ 
CD Index

Press to place a marker at the cursor position. 

Hold the Shift button while pressing the Marker/CD Index button to place a CD index marker at the cursor 
position.

Hold the Ctrl button while pressing the Marker/CD Index button to remove a marker.

Hold the Ctrl and Shift buttons while pressing the Marker/CD Index button to remove a CD index marker.

2 Region/ 
CD Track

Press to convert the current selection to a region. 

Hold the Shift button while pressing the Region/CD Track button to convert the current selection to a CD track 
region.

Hold the Ctrl button while pressing the Region/CD Track button to remove a region.

Hold the Ctrl and Shift buttons while pressing the Region/CD Track button to remove a CD track.

3 Loop/ 
Select

Press to toggle looped playback mode. 

Hold the Shift button while pressing the Loop/Select button to create a time selection from the loop region.

4 Mark In/ 
Go to In

Press to set the beginning of the loop region at the cursor position. 

Hold the Shift button while pressing the Mark In/Go to In button to move the cursor to the beginning of the 
loop region.

5 Mark Out/ 
Go to Out

Press to set the end of the loop region at the cursor position. 

Hold the Shift button while pressing the Mark Out/Go to Out button to move the cursor to the end of the loop 
region.

6 Event Trim/ 
Center 
Cursor

Press to toggle event edge-trimming mode. Press the right or left arrow button to select the next or previous 
event edge, and then turn the jog dial to trim the event edge.

Hold the Shift button while pressing the Event Trim/Center Cursor button to center the cursor in the timeline 
view.

7 RTZ/ 
End

Press to move the cursor to the beginning of the project.

Hold the Shift button while pressing the RTZ/End button to move the cursor to the end of the project.

1
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Transport buttons

The Transport buttons allow you to navigate the timeline and preview your project.

Item Description

1 Rewind Press and hold to move backward through the timeline at 20x speed.

2 Fast Forward Press and hold to move forward through the timeline at 20x speed.

3 Stop Press to stop playback and return the cursor to its position before playback started. 

Hold the Shift button while pressing the Stop button to create a dynamic RAM preview. 

4 Play Press to start playback. Press again to stop playback and leave the cursor at its current position. 

Hold the Shift button while pressing the Play button to preview the cursor position. To change the playback 
duration, use the Cursor preview duration control on the Editing tab of the Preferences dialog. 

5 Record Press to start recording. Press again to stop recording and leave the cursor at its current position. 

Hold the Shift button while pressing the Record button to render the current selection to a new track. 

1
2
3
4
5
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Arrow buttons

The arrow buttons allow you to navigate the timeline and preview your project.

Item Description

1 Left/Right When the Zoom button is not selected:

• Press the left or right arrow button to move left or right in small increments.

• Hold Ctrl while pressing the left or right arrow button to move to the previous or next marker.

• Hold Ctrl + Shift while pressing the left or right arrow button to select to the previous or next marker.

When the Zoom button is selected:

• Hold Shift while pressing the left or right arrow button to select left or right by pixels. 

• Hold Ctrl while pressing the left or right arrow button to move to the previous or next marker. 

• Hold Ctrl + Shift while pressing the left or right arrow button to select to the previous or next marker. 

2 Up/Down  When the Zoom button is not selected:

• Press to zoom in or out. 

• Hold Shift while pressing the up or down arrow button to change the magnification of audio waveforms.

• Hold Ctrl + Shift while pressing the up or down button to change track heights. 

When the Zoom button is selected:

• Press to zoom in or out.

• Hold Shift while pressing the up or down button to change the magnification of audio waveforms.  

• Hold Ctrl while pressing the up or down buttons to zoom to a selection or to the high in/max out. 

• Hold Ctrl+Shift while pressing the up or down buttons to change track heights.

1

2



Jog dial

The jog dial allows you to navigate the timeline when playback is stopped.

Navigating the timeline

When playback is paused and the Scrub button is not selected, the jog dial performs the following functions:

• When the Zoom button is not selected, turn the dial clockwise or counterclockwise to navigate the timeline by frames.
• When the Zoom button is selected, turn the dial clockwise or counterclockwise to navigate the timeline by pixels.
• Hold the Shift button and turn the dial to create a time selection or extend a selection.

Scrubbing the timeline

During playback, turning the jog dial increases or decreases the playback rate.

When playback is paused and the Scrub button is selected, turning the jog dial scrubs the timeline.

Trimming events

1. Press the Event Trim button to enter event trimming mode.

2. Press the left or right arrow button to select the event edge you want to trim. A red bracket is displayed to indicate 
which event edge will be trimmed.

3. Turn the jog dial to trim the event edge left or right in one-frame increments. Hold Ctrl while turning the dial to trim 
in one-pixel increments. Depending on the current zoom level, the trim duration will vary.
APPENDIX A | 359



360 | APPENDIX A



Appendix B
 Troubleshooting

Troubleshooting resources

Visit the Sony Media Software Web site to access product updates, look for answers in the knowledge base, contact 
customer support, or participate in an online forum:

http://www.sonymediasoftware.com

Common questions

Why are some of my DirectX plug-ins not working correctly?

Vegas® software is a nondestructive time-based editor. As a result, there are certain types of DirectX® plug-ins that 
perform poorly in Vegas software. These types of plug-ins are roughly classified as any plug-ins that output a different 
amount of time than what goes in. This includes all plug-ins such as time compress/expand, gapper/snipper and pitch 
shift without preserving duration. However, these types of effects plug-ins may perform suitably as bus effects, but only if 
just one bus is used in the project. Plug-ins that require a lot of pre-buffering (such as Sony Media Software Acoustic 
Mirror™ when using long impulse files) may also perform poorly.

Also, make certain that the plug-ins you use in Vegas software are DirectX plug-ins and not DXi plug-ins. DXi plug-ins are 
not supported in the application and do not perform properly.

Why do I hear gaps in my audio playback?

Check to see if any Vegas software updates have been posted on the Sony Media Software and Services Web site:

http://www.sonymediasoftware.com/download

Click Updates to access the Updates page. Any updates to the application are posted at this location.

If software updates do not address the playback problem, check these other reasons that your audio playback can gap:

• Playing back too many tracks simultaneously can overload your hard drives.
• Not enough physical RAM can cause the Windows® operating system to use virtual memory, which is slower.
• Your CPU may not be able to process a complex mix of plug-ins.
• Problematic video card settings. For more information, see Trouble-free video: hardware solutions on page 363.

The following are some things you can check and do to make sure your system is optimized to prevent gapping.

RAM usage

You could be gapping because virtual memory is being used. Virtual memory is a method used by Microsoft Windows to 
write information to your hard drive to make room in physical RAM. This process uses a lot of your computer’s resources. 
Try the following to optimize RAM usage:

• Exit all background applications not in use.
• Adjust the playback buffering slider on the Audio tab in the Preferences dialog. Adjust this slider as low as possible. 

However, be aware that setting it too low may cause gaps as well. For more information, see Adjusting the playback 
buffering slider on page 320.

• Mute/solo some of the events or tracks in the mix.
• Add more RAM to your computer.
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Disk usage

You may experience gapping when data is not being read off the hard drive fast enough. Try the following to optimize 
disk usage:

• Fully defragment your audio hard drives regularly.
• Split audio usage between different physical hard drives, not just different partitions of the same drive.
• Run fewer events simultaneously. It is not how many tracks you have in the project, but how many different events are 

playing simultaneously that matters. 
• Make sure that you trim out any silent sections of events to minimize the wasted disk access.
• Use hard drives with fast seek times and spindle speeds of 7200 RPM or greater. SCSI drives usually have better 

prolonged data transfer performance than IDE drives. Under Microsoft Windows XP and Windows 2000 operating 
systems, Vegas software can take advantage of SCSI asynchronous reads, which can be a big performance advantage.

CPU usage

If you have checked your RAM usage and disk usage and you are still experiencing gapping, you can try to adjust how 
Vegas software utilizes the central processing unit (CPU). Try the following to optimize CPU usage:

• Zoom out (Ctrl+down arrow ) fully on the track view while playing so that the screen does not have to scroll to keep 
the cursor on it.

• Run fewer DirectX or VST plug-ins.
• Make sure that the peak files are built for all of the audio data in the project before playing. Peaks are only built for 

those files on screen. If all peak files are not build, you can encounter gapping when the screen scrolls as it plays and 
the application must build peaks on the fly. Press F5 before playback to rebuild peaks for all of the events, on or off of 
the screen.

Why do mono events increase 6 dB when panning a track hard?

In Vegas software, all audio events are treated as stereo. A mono audio event is interpreted as a stereo event with the 
same data in both channels. If you’re using the add channels panning mode, this duplication doubles the amplitude and 
results in a 6 dB increase in volume when you pan a track hard left or right. Try using the constant power panning mode 
instead. Right-click the multipurpose slider and choose Constant Power from the shortcut menu. For more information, 
see Adjusting stereo panning on page 136.

Why do buffer underruns occur during a test or real write to a CD?

Buffer underruns occur when data transferred to the CD-R is too slow. This may be caused by a variety of factors relating 
to optimizing your system. Try writing the CD at a slower speed or prerendering the audio. For more information, see 
Burning a disc (disc-at-once) on page 335.

Why can’t I work with footage captured using an MJPEG card?

Vegas software requires that you have the MJPEG codec (for the MJPEG card used to capture the video) installed locally 
on your workstation. Check to make sure that the appropriate MJPEG codec is installed on your PC.



Trouble-free video: software solutions

There are literally dozens of possible configurations of hardware for editing video on a PC. While it is impossible to go 
into detail for each and every system, the following explains some of the concepts behind the various settings in Vegas 
software. Editing and playing back full-frame, 30 fps video is one of the most demanding activities for any computer. The 
hardware you use is an important part of the equation, but there are a number of things you can do to optimize your PC 
for video. The following list is arranged from the most to the least important.

• Close all other applications. When capturing video or playing it back, it is critical that no other applications interrupt 
this process. Close any applications that are not vital. This includes screen savers, task schedulers, and even virus-
detection software. You can ensure that you have closed all unnecessary applications by pressing Ctrl+Alt+Delete, 
selecting the individual applications, and clicking the End Task button to close them. Certain processes are required 
and should not (cannot) be terminated (for example, Explorer).

• Check your virtual memory. Windows operating system uses virtual memory when RAM is low. This is a method for 
Windows to use the hard disk to create more memory and is sometimes called a paging file. If Windows tries to write to 
the paging file during playback or capture, this can interrupt the video software and cause problems. Make sure that a 
different disk drive is being used for virtual memory other than the one from which you are capturing or playing your 
video. If you have enough space, use C:\ for virtual memory and use a physically distinct drive for capturing and playing 
back video.

• Make sure you have the latest drivers for your video card and capture card and the latest updates and patches to all 
relevant software. One caveat to this is that you shouldn’t try to fix a program that is working correctly. Many times 
patches and updates fix relatively minor bugs that only affect a small number of users. If you are not experiencing any 
problems, it is probably best not to upgrade unless the manufacturer recommends it.

• Uncompressed video may be high quality, but it results in very large files with very high data rates. Selecting a more 
appropriate compression scheme (codec) will definitely improve the situation. If you are creating movies that need 
maximum quality, however, this may not be an option.

Trouble-free video: hardware solutions

Even with a fast computer, video is still a hardware challenge. On the other hand, it is definitely possible to properly 
configure a 400 MHz Pentium to work with large video files. There are three parts of your PC that are important and the 
speed of your CPU is not necessarily the most critical. The following list is arranged from the most to the least important.

Video subsystem

Many graphics cards (video boards, primary display cards) on a PC cannot handle full-screen, full-frame rate video. While 
this leads to jerky, hesitating playback, it may not actually be a serious problem. A common video configuration is to have 
a separate video capture card and a primary display card. In this case, the playback using the primary display on the 
computer may be jerky, but when you finally output the video to tape and view it on your television monitor there may 
not be any problems. If you are not creating movies to go back to the television or VCR and you are experiencing 
stuttering playback, you should consider using a smaller frame size (320X240) and frame rate (15 fps).

Hard disk

The second most common problem is slow hard disks. Until recently, fast, expensive SCSI AV hard disks were required to 
properly capture and play back video on a PC. Slow hard disk problems also manifest themselves with jerky video 
playback, although the stutters are less frequent and of longer duration than if the video subsystem is the problem. 
Slower hard disks (e.g., 5400 RPM IDE) can cause an occasional dropped frame. DV enthusiasts have fewer problems due 
to the low data rate (~3.6 MB/sec.) of that format. The following section outlines some recommendations arranged in 
order of importance.

• Buy a dedicated video drive. This is easily the most important piece of hardware advice. A dedicated, physically 
distinct hard drive is almost a requirement for any type of serious video work. This means that you have one primary C:\ 
drive (or wherever your operating system is installed) and a separate drive for video. You can use your dedicated drive 
for other purposes, especially storage, but it is a good idea not to run any applications from it and to keep Windows 
virtual memory off of it. It is very important that the drive only be used for video when playing and capturing, and that 
other programs (including Windows) are not trying to access it. Since video files are so large, a dedicated drive is not an 
unreasonable item even if digital video is just a hobby. You can never have too much hard disk space.
APPENDIX B | 363



364 | APPENDIX B
• Buy a faster hard drive. Older 5400 RPM hard drives may not be fast enough for capturing and playing back video for 
any length of time, while newer 7200 RPM drives are almost always adequate. Be careful: manufacturers are usually 
talking about burst transfer rates when they talk about the speed of a drive. A drive that can transfer data at 80MB/sec 
is worthless for video if it cannot sustain a much slower rate of 8MB/sec for thirty minutes (or more) without dropping a 
frame. Look to other computer video enthusiasts for additional advice. Again, the RPMs are a very good indicator, 
because 7200 RPM IDE drives are usually newer (c.1998) and older 7200 RPM drives are usually SCSI, which are already 
higher quality drives to begin with.

• IDE vs. SCSI. While this was a big issue just a few years ago, it has fortunately faded in importance. Hard drives can be 
hooked up to your computer in a number of ways, with the two largest divisions being IDE and SCSI. This interface 
simply determines how much data can be transferred to and from the drive in a second. The interface almost always far 
outstrips the performance of even the best hard disks and even the slower interfaces exceed the transfer requirements 
of video data. SCSI hard disks are usually more expensive and require a special controller, and while SCSI-2 promises 
80MB/sec transfer rates, this is overkill for most people. Newer IDE hard disks with designations of EIDE, DMA, Ultra-
DMA, ATA-33, and ATA-66 (and newer drives that came out after this writing) can all handle most sustained video 
requirements.

CPU and RAM (memory)

While the CPU and the RAM are probably the most important overall aspects of a PC’s speed and performance, these 
factors are only third on the list for video. For the most part, these critical components do not affect the capture or 
playback of video. This does not mean that a faster CPU or more RAM will not help, because bigger and faster is always 
better: CPU and RAM definitely impact rendering speeds. Creating a final AVI file, especially in a movie project that uses a 
lot of effects and transitions, can take a long time. A thirty-minute movie could easily take six or more hours to render, 
depending on the format and effects used. CPU speed is also important for more advanced compression codecs, such as 
MPEG and newer streaming formats.

Audio proxy files (.sfap0)

Working with certain types of media files with particular audio compression schemes can be inefficient and slow. To 
compensate for this, Vegas software creates audio proxy files for formats that are known to dramatically impact 
performance. There are two cases where this occurs.

Multimedia video files often contain both video and audio information. In certain formats, these two streams can be 
packed together in such a way as to make editing slow and inefficient. Vegas software therefore takes the audio stream 
from these files (e.g., type-1 DV, QuickTime™) and saves it to a separate and more manageable audio proxy file.

QuickTime audio-only files can also be compressed in a way that makes editing slower. Vegas software also uses audio 
proxy files in this situation as well. While audio proxy files may be large (because they are uncompressed), the 
performance increase is significant.

The file is saved as a proprietary .sfap0 file, with the same name as the original media file and has the same characteristics 
as the original audio stream. So movie.avi yields a movie.avi.sfap0 audio proxy. Additional audio streams in the same file 
are saved as movie.avi.sfap1, movie.avi.sfap2, etc. This is a one-time process that greatly speeds up editing. The conversion 
happens automatically and does not result in a loss of quality or synchronization. The original source file remains 
unchanged (the entire process is nondestructive). Audio proxy files can be safely deleted at any time since the 
application recreates these files as needed.

Note: Vegas software saves audio proxy files to the same folder as the source media. If the source media folder is read-
only (e.g., CD-ROM), the files are saved to a temporary directory.



Timecode

Timecode is a method of labelling frames with a unique and searchable identifier. It is primarily important for 
synchronizing video (in frames per second) with time in the real world and, in the case of Vegas software, with other 
media in a project. 

Changing the timecode used to measure a video file does not alter the contents of the file. For example, no frames are 
ever dropped or removed when using SMPTE 29.97 drop frame timecode. Instead, specific frame numbers are 
periodically dropped to compensate for differences between timecode and time in the real world. Confusion between 
using drop versus non-drop timecode can cause synchronization problems between video and audio. For very short 
periods of time, the error would be unnoticeable. After about a half an hour, you might notice that mouths and words do 
not quite match in shots of people speaking. Longer stretches of time show larger discrepancies in synchronization.

Changing the timecode displayed on an event is not equivalent to converting a video to another format. You cannot 
convert NTSC video at 29.97 fps to PAL video at 25 fps by simply changing the timecode. To convert NTSC video to PAL 
video in Vegas software, you need to re-render the video in the new format. In this situation, the conversion process 
necessarily results in some frames of video actually being removed from the original sequence.

SMPTE timecode types

The following are descriptions of each of the Society of Motion Picture and Television Engineers (SMPTE) timecode types.

SMPTE 25 EBU (25 fps, Video)

SMPTE 25 EBU timecode runs at 25 fps, and matches the frame rate used by European Broadcasting Union (EBU) 
television systems.

Use SMPTE 25 EBU format for PAL DV/D1 projects.

SMPTE Drop Frame (29.97 fps, Video)

SMPTE Drop Frame timecode runs at 29.97 fps, and matches the frame rate used by NTSC television systems (North 
America, Japan). 

Use SMPTE Drop Frame format for NTSC DV/D1 projects.

Both SMPTE Drop and SMPTE Non-Drop run at 29.97 fps. In both formats, the actual frames are not discarded, but they 
are numbered differently. SMPTE Drop removes certain frame numbers from the counting system to keep the SMPTE 
clock from drifting from real time. The time is adjusted forward by two frames on every minute boundary except 0, 10, 20, 
30, 40, and 50. For example, when SMPTE Drop time increments from 00:00:59.29, the next value is 00:01:00.02. 

SMPTE Non-Drop Frame (29.97 fps, Video)

SMPTE Non-Drop Frame timecode runs at a rate of 29.97 fps. This leads to a discrepancy between real time and the 
SMPTE time, because there is no compensation in the counting system as there is in SMPTE Drop Frame.

Use SMPTE Non-Drop format for NTSC D1 projects that are recorded on master tapes striped with Non-Drop timecode.

SMPTE 30 (30 fps, Audio)

SMPTE 30 is an audio-only format and runs at exactly 30 fps. SMPTE 30 is commonly used when synchronizing audio 
applications such as multitrack recorders or MIDI sequencers. This format should not be used when working with video.

SMPTE Film Sync (24 fps)

The SMPTE Film Sync time format runs at 24 fps (frames per second). This frame rate matches the standard crystal-sync 
16/33 mm film rate of 24 fps.
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Timecode in Vegas software

Video timecode crops up fairly frequently in Vegas software. Being a multimedia production tool, time in the application 
can be measured in real-world time (hours, minutes, seconds), in video timecode (involving frames of video), or in 
musical time (measures and beats).

Ruler format and timecode

The ruler in Vegas software can be set to measure time in any way that is convenient. This setting does not change how 
the final file is rendered, but controls the grid lines and how snapping behaves. Right-click the ruler and choose a time 
format from the shortcut list. For more information, see Changing the ruler format on page 303.

Preferences dialog timecode settings

From the Options menu, choose Preferences and click the Video tab to adjust the Show source frame numbers on 
event thumbnails as drop-down list. These settings take precedence over those found in the source media Properties 
dialog (see the next topic) and are displayed on events inserted into the timeline. None means that no numbers are 
displayed on events, Frame Numbers marks frames in the media file starting with 0, Time displays the time in seconds, 
and Timecode allows the source media’s timecode to be detected or selected.

Source media timecode format

Right-click an event, choose Properties, and click the Media tab to view these properties. By default, Use timecode in file 
is selected.

Render media file format

The timecode of a final rendered media file is determined by the specified format. The frame rate of the project ultimately 
determines the timecode and is often constrained by the type of media file being rendered or the codec being used for 
compression. For example, NTSC DV is typically limited to a frame rate of 29.97 fps and uses SMPTE drop frame timecode.

Time formats in Vegas software

A variety of time formats are provided in the application. For more information, see Changing the ruler format on page 303.

Troubleshooting DV hardware issues

Vegas software is designed to integrate seamlessly with OHCI compliant IEEE-1394 DV video capture hardware and DV 
camcorders. While most people never have any problems, the vast number of hardware configuration possibilities makes 
this a potentially complex issue. There are a number of resources at the Sony Media Software Web site that may be able 
to assist you.

More detailed information is available at: 

http://www.sonymediasoftware.com/Support/Productinfo/OHCI.asp

You can also visit the Vegas Updates Web page to access a troubleshooting document for OHCI-compliant devices. From 
the Sony Media Software home page, go to the Download page and click Updates. Click the Vegas Update link to access 
the update page.

Note: You can override these settings by choosing different settings on the Video tab of the Preferences dialog. Select 
Timecode from the Source frame numbering list to allow event-level specification.

http://www.sonymediasoftware.com/Support/Productinfo/OHCI.asp
http://www.sonymediasoftware.com/Support/Productinfo/OHCI.asp


Appendix C
 Glossary

A-Law

A companded compression algorithm for voice signals defined by the Geneva Recommendations (G.711). The G.711 
recommendation defines A-Law as a method of encoding 16-bit PCM signals into a nonlinear 8-bit format. The algorithm 
is commonly used in United States telecommunications. A-Law is very similar to μ-Law, however, each uses a slightly 
different coder and decoder.

Adaptive Delta Pulse Code Modulation (ADPCM)

A method of compressing audio data. Although the theory for compression using ADPCM is standard, there are many 
different algorithms employed. For example, the ADPCM algorithm from Microsoft® is not compatible with the 
International Multimedia Association’s (IMA) approved ADPCM.

Aliasing

A type of distortion that occurs when digitally recording high frequencies with a low sample rate. For example, in a 
motion picture, when a car’s wheels appear to slowly spin backward while the car is quickly moving forward, you are 
seeing the effects of aliasing. Similarly, when you try to record a frequency greater than one-half of the sampling rate (the 
Nyquist Frequency), instead of hearing a high pitch, you may hear alias frequencies in the low end of the spectrum.

To prevent aliasing, an anti-aliasing filter is used to remove high-frequencies before recording. Once the sound has been 
recorded, aliasing distortion is impossible to remove without also removing other frequencies from the sound. This same 
anti-aliasing filter must be applied when resampling to a lower sample rate.

Amplitude Modulation (AM)

A process whereby the amplitude (loudness) of a sound is varied over time. When varied slowly, a tremolo effect occurs. If 
the frequency of modulation is high, many side frequencies are created which can strongly alter the timbre of a sound.

Analog

When discussing audio, this term refers to a method of reproducing a sound wave with voltage fluctuations that are 
analogous to the pressure fluctuations of the sound wave. This is different from digital recording in that these 
fluctuations are infinitely varying rather than discrete changes at sample time (see Quantization).

ASIO

ASIO (Audio Stream In/Out)™ is a low-latency driver model developed by Steinberg Media Technologies AG.

Attack

The attack of a sound is the initial portion of the sound. Percussive sounds (drums, piano, guitar plucks) are said to have a 
fast attack. This means that the sound reaches its maximum amplitude in a very short time. Sounds that slowly swell up in 
volume (soft strings and wind sounds) are said to have a slow attack.

Attenuation

A decrease in the level of an audio signal.

Audio Compression Manager (ACM)

The Audio Compression Manager from Microsoft® is a standard interface for audio compression and signal processing for 
Windows. The ACM can be used by Microsoft® Windows® programs to compress and decompress WAV files.
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AVI

A file format of digital video. Vegas software allows you to open, edit and create new AVI files.

Bandwidth

Refers to the EQ plug-in that is built in. Each frequency band has a width associated with it that determines the range of 
frequencies that are affected by the EQ. An EQ band with a wide bandwidth affects a wider range of frequencies than one 
with a narrow bandwidth.

Bandwidth can also refers to the amount of data that can be transferred via a connection, such as a network or modem. 
For example, streaming media must be compressed due to the limited bandwidth of most Internet connections.

Beats Per Measure

In music theory, the time signature of a piece of music contains two pieces of information: the number of beats in each 
measure of music, and which note value gets one beat. This notion is used to determine the number of ticks to put on the 
ruler above the track view, and to determine the spacing when the ruler displays in measures and beats format.

Beats Per Minute (BPM)

In music theory, the tempo of a piece of music can be written as a number of beats in one minute. If the tempo is 60 BPM, 
a single beat occurs once every second. Lower BPM’s equal slower tempo, and vice versa.

Bit

A bit is the most elementary unit in digital systems. Its value can only be 1 or 0, corresponding to a voltage in an 
electronic circuit. Bits are used to represent values in the binary numbering system. As an example, the 8-bit binary 
number 10011010 represents the unsigned value of 154 in the decimal system. In digital sampling (specifically the PCM 
format), a binary number is used to store individual sound levels, called samples.

Bit Depth

The number of bits used to represent a single sample. Vegas software uses either 8, 16, or 24-bit samples. Higher values 
increase the quality of the playback and any recordings that you make. While 8-bit samples take up less memory (and 
hard disk space), they are inherently noisier than 16 or 24-bit samples.

Bus

A virtual pathway where signals from tracks and effects are mixed. A bus’s output can be a physical audio device in the 
computer from which the signal is heard.

Byte

Refers to a set of 8 bits. An 8-bit sample requires one byte of memory to store, while a 16-bit sample takes two bytes of 
memory to store.

Clipboard

The Clipboard is where data that you have cut or copied in Vegas software is stored. You can then paste the data back 
into Vegas software at a different location, or paste it into other applications. Some data, such as audio, cannot be pasted 
into applications such as Microsoft Word or Notepad, but the text data from the Edit Details window can be pasted. This 
allows you to then print or format the data. The Video Preview window also lets you capture still frames to the Clipboard 
for use in any image editing program. For more information, see Understanding the Video Preview window on page 265.



Clipping

Clipping is what occurs when the amplitude of a sound is above the maximum allowed recording level. In digital systems, 
clipping is seen as a clamping of the data to a maximum value, such as 32,767 in 16-bit data. Clipping causes sound to 
distort.

Codec

An acronym for COmpressor/DECompressor. A codec is an computer algorithm that is used to compress video and audio 
data, shrinking file sizes and data rates.

Compositing

Compositing is the term used to describe the way separate video sources are mixed together. Overlay titles are 
composited onto a background video sequence.

Crossfade

Mixing two pieces of overlapping audio or video by fading one out as the other fades in.

Cutoff frequency

The cutoff frequency of a filter is the frequency at which the filter changes its response. For example, in a low-pass filter, 
frequencies greater than the cutoff frequency are attenuated while frequencies less than the cutoff frequency are not 
affected.

DC Offset

DC Offset occurs when hardware, such as a sound card, adds DC current to a recorded audio signal. This current causes 
the audio signal to alternate around a point above or below the normal -infinity dB (center) line in the sound file. To see if 
you have a DC offset present, you can zoom all the way into a sound file and see if it appears to be floating over the center 
line.

Decibel (dB)

A unit used to represent a ratio between two numbers using a logarithmic scale. For example, when comparing the 
numbers 14 and 7, you could say 14 is two times greater than the number 7; or you could say 14 is 6 dB greater than the 
number 7. Where did we pull that 6 dB from? Engineers use the equation dB = 20 x log (V1/V2) when comparing two 
instantaneous values. Decibels are commonly used when dealing with sound because the ear perceives loudness in a 
logarithmic scale.

In Vegas software, most measurements are given in decibels. For example, if you want to double the amplitude of a 
sound, you apply a 6 dB gain. A sample value of 32,767 (maximum positive sample value for 16-bit sound) can be referred 
to as having a value of 0 dB. Likewise, a sample value of 16,384 can be referred to having a value of -6 dB.

Device Driver

A program that enables Microsoft Windows to connect different hardware and software. For example, a sound card 
device driver is used by Microsoft Windows software to control sound card recording and playback.

Digital Signal Processing (DSP)

A general term describing anything that alters digital data. Signal processors have existed for a very long time (tone 
controls, distortion boxes, wah-wah pedals) in the analog (electrical) domain. Digital Signal Processors alter the data after 
it has been digitized by using a combination of programming and mathematical techniques. DSP techniques are used to 
perform many effects such as equalization and reverb simulation.
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Since most DSP is performed with simple arithmetic operations (additions and multiplications), both your computer’s 
processor and specialized DSP chips can be used to perform any DSP operation. The difference is that DSP chips are 
optimized specifically for mathematical functions while your computer’s microprocessor is not. This results in a difference 
in processing speed.

DirectX Application Programming Interface

A set of interfaces designed by Microsoft for multimedia development. A DirectX® plug-in, such as the Sony Media 
Software Noise Reduction™ DirectX plug-in, uses the DirectX Media Streaming Services (DMSS) API. Because DMSS is a 
standard API, a DirectX plug-in can be used in any application that supports DMSS.

Dithering

The practice of adding noise to a signal to mask quantization noise (see also Noise Shaping).

Drag and Drop

A quick way to perform certain operations using the mouse. To drag and drop, you click and hold a highlighted selection, 
drag it (hold the left-mouse button down and move the mouse) and drop it (let go of the mouse button) at another 
position on the screen.

Dynamic Range

The difference between the maximum and minimum signal levels. It can refer to a musical performance (high volume vs. 
low volume signals) or to electrical equipment (peak level before distortion vs. noise floor). For example, orchestral music 
has a wide dynamic range, while thrash metal has a very small (always loud) range.

Emphasis

A rudimentary noise reduction process that involves a boost in the high frequencies during the recording of the CD and a 
complimentary cut in the same frequencies during the playback of the CD. The result reduces high frequency noise 
without disrupting the natural frequency response of the source material. If the emphasis flag is set for a track, any CD 
player that has a de-emphasis circuit will impart the high frequency cut on the track. Be aware that Vegas software cannot 
impart the pre-emphasis boost on a track; it can only set the emphasis flag.

Endian (Little and Big)

Little and Big Endian describe the ordering of multi-byte data that is used by a computer’s microprocessor. Little Endian 
specifies that data is stored in a low to high-byte format; this ordering is used by the Intel® microprocessors. Big Endian 
specifies that data is stored in a high to low-byte format; this ordering is used by the Motorola® microprocessors. 

Envelopes (Audio and Video)

Envelopes, as used by Vegas software, are a way of automating the change of a certain parameter over time. In the case of 
volume, you can create a fade out (which requires a change over time) by adding an envelope and creating an extra point 
to the line that indicates where the fade starts. Next, you pull the end point of the envelope down to -inf. For more 
information, see Working with track envelopes on page 149.

Equalization (EQ)

The process by which certain frequency bands are raised or lowered in level. EQ has various uses. The most common use 
in Vegas software is to simply adjust the subjective timbrel qualities of a sound.



Event

Media files that have been dragged onto the timeline in Vegas software are referred to as events. An event is actually a 
window into a media file and is a reference, or pointer, to the file. It can display all or part of a media file and can be edited 
without altering the source media (nondestructive). 

Field Order

Video that is displayed on a television is interlaced. This means that every frame of video is actually composed of two 
fields, each of which is made up of half of the lines that make the final frame. These two fields are woven together in 
alternate lines, but which of the two fields is displayed first (the field order) can be important. You can set the field order 
for video in the Project Properties dialog or, when rendering a project, in the Custom Template dialog.

File Format

A file format specifies the way in which data is stored on your floppy disks or hard drive. In Windows for example, the 
most common audio file format is the Microsoft WAV format. However, Vegas software can read and write to many other 
file formats so you can maintain compatibility with other software and hardware configurations.

Frame Rate (Audio)

Audio uses frame rates only for the purposes of synching to video or other audio.

Frame Rate (Video)

The speed at which individual images in the video are displayed on the screen. A faster frame rate results in smoother 
motion in the video. However, more times than not, frame rate is associated with SMPTE standard frame rates for video: 
29.97 for NTSC (used in US, North and Central America, parts of South America, and Japan), 25 for PAL (used in many parts 
of the world, including Europe and much of Asia), or 24 for film. 

Frequency Spectrum

The frequency spectrum of a signal refers to its range of frequencies. In audio, the frequency range is basically 20 Hz to 
20,000 Hz. The frequency spectrum sometimes refers to the distribution of these frequencies. For example, bass-heavy 
sounds have a large frequency content in the low end (20 Hz - 200 Hz) of the spectrum.

Hertz (Hz)

The unit of measurement for frequency or cycles per second (CPS).

Insertion Point

The insertion point (also referred to as the cursor position) is analogous to the cursor in a word processor. It is where 
pasted data is placed or other data is inserted, depending on the operation. The insertion point appears as a vertical 
flashing black line and can be moved by clicking the left mouse button anywhere in the timeline. 

Inverse telecine

Telecine is the process of converting 24 fps (cinema) source to 30 fps video (television) by adding pulldown fields. Inverse 
telecine, then, is the process of converting 30 fps (television) video to 24 fps (cinema) by removing pulldown.

Markers

Saved locations in the sound file. Markers can be displayed in the Trimmer window for sound files that contain them, but 
more often, markers and regions are used at the project level to mark locations or sections in the project. 
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Media Control Interface (MCI)

A standard way for Microsoft Windows programs t o communicate with multimedia devices like sound cards and CD 
players. If a device has a MCI device driver, it can easily be controlled by most multimedia Microsoft Windows software.

Media File

A media file, or multimedia file, is any image, audio or video file on a computer. In Vegas software, you can browse for 
these files in the Explorer window. You can drag media files to the timeline or insert them into the Project Media window. 
Media files that have been dragged to the timeline are referred to as events. 

MIDI Clock

A MIDI device specific timing reference. It is not absolute time like MIDI timecode (MTC); instead, it is a tempo-dependent 
number of ticks per quarter note. MIDI clock is convenient for synchronizing devices that need to do tempo changes mid-
song.

MIDI Port

A MIDI Port is the physical MIDI connection on a piece of MIDI gear. This port can be a MIDI in, out or through. Your 
computer must have a MIDI port to output MIDI timecode to an external device or to receive MIDI timecode from an 
external device.

MIDI Timecode (MTC)

MTC is an addendum to the MIDI 1.0 Specification and provides a way to specify absolute time for synchronizing MIDI-
capable applications. Basically, it is a MIDI representation of SMPTE timecode.

Mix

The process of combining multiple audio events and effects into a final output. The analogous process of combining 
video events together is called compositing.

Musical Instrument Digital Interface (MIDI)

A standard language of control messages that provides for communication between any MIDI compliant devices. 
Anything from synthesizers to lights to stage equipment can be controlled via MIDI. Vegas software utilizes MIDI for 
synchronization purposes.

Noise-shaping

Noise-shaping is a technique that can minimize the audibility of quantization noise by shifting its frequency spectrum. 
For example, in 44,100 Hz audio, quantization noise is shifted towards the Nyquist Frequency of 22,050 Hz. See also 
Dithering.

Nondestructive Editing

A type of editing used by Vegas software that involves a pointer-based system of keeping track of edits. When you delete 
a section of audio in a nondestructive system, the audio on disk is not actually deleted. Instead, a set of pointers is 
established to tell the program to play the active sections during playback.

Nonlinear Editing (NLE)

A method of editing video non-sequentially or in random order. Editing video in Vegas software is nonlinear as opposed 
to editing video tape, which is linear.



Normalize

Refers to raising the volume so that the highest level sample in the file reaches a user-defined level. Use this function to 
make sure you are fully utilizing the dynamic range available to you.

Nyquist Frequency

The Nyquist Frequency (or Nyquist Rate) is one-half of the sample rate and represents the highest frequency that can be 
recorded using the sample rate without aliasing. For example, the Nyquist Frequency of 44,100 Hz is 22,050 Hz. Any 
frequencies higher than 22,050 Hz produce aliasing distortion in the sample if an anti-aliasing filter is not used while 
recording.

OPT Plug-In

A plug-in that uses Open Plug-in Technology (OPT) standard from Yamaha™. OPT plug-ins provide tools for working with 
MIDI such as edit views, effect processors and filters, arpeggiators, and real-time panel automation.

Pan

To place a mono or stereo sound source perceptually between two or more speakers.

Peak File (.sfk)

Vegas software displays the waveform of audio files graphically on a computer monitor. This visual information must be 
generated by Vegas software when the audio file is opened and can take a few seconds. Vegas software then saves this 
information as a peak file (.sfk). This file stores the information for displaying waveform information so that opening a file 
is almost instantaneous. The peak file is stored in the directory in which the file resides and has an .sfk extension. If the 
peak file is not in the same directory as the file, or is deleted, Vegas software regenerates it the next time you open the 
file.

Pixel Aspect Ratio

Computers display pixels as squares: 1.0. Televisions display individual pixels as rectangles: 0.9091 (NTSC DV, D1), 1.0926 
(PAL DV, D1), or other rectangular variations. Using the wrong pixel aspect ratio can result in distortions or stretching of 
the video. You can set the pixel aspect ratio in the Project Properties dialog or, when rendering, in the Custom Template 
dialog. You should choose the aspect ratio based on the final movie’s destination. Consult your hardware manual if you 
are in doubt about the appropriate ratio. The pixel aspect ratio is unrelated to the frame’s aspect ratio.

Plug-In

An effect that can be added to the product to enhance the feature set. Vegas software supports DirectX compatible plug-
ins. The built-in EQ, Compression and Dithering effects are also considered plug-ins because they work in other DirectX-
compatible applications.

Plug-In Chain

Plug-ins can be strung together into a chain so that the output of one effect feeds into the input of another. This allows 
for complex effects that couldn’t otherwise be created.

Pre-roll/Post-roll

Pre-roll is the amount of time elapsed before an event occurs. Post-roll is the amount of time after the event. The time 
selection defines the pre- and post-roll when recording into a selected event.
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Preset

A snapshot of the current settings in a plug-in. Presets are created and named so that you can easily get back to a sound 
or look that you have previously created.

A preset calls up a bulk setting of a function in Vegas software. If you like the way you tweaked that EQ, but do not want 
to have to spend the time getting it back for later use, save it as a preset. Presets appear in the top of plug-in windows in 
Vegas software.

Pulldown

In telecine conversion, fields are added to convert 24 fps film to 30 fps video.

In 2-3 pulldown, for example, the first frame is scanned into two fields, the second frame is scanned into three fields, and 
so on for the duration of the film. 2-3 pulldown is the standard for NTSC broadcasts of 24p material. Use 2-3 pulldown 
when printing to tape, but not when you intend to use the rendered video in Vegas software. Removing 2-3 pulldown is 
inefficient because the pulldown fields that are created for frame 3 span two frames:

Use 2-3-3-2 pulldown when you plan to use your rendered video in Vegas software as source media. When removing 2-3-
3-2 pulldown, Vegas software simply discards frame three and merges the pulldown fields in the remaining frames:

Pulse Code Modulation (PCM)

PCM is the most common direct binary representation of a level of an uncompressed audio signal. This method of coding 
yields the highest fidelity possible when using digital storage.

Punch-In

Punching-in during recording means automatically starting and stopping recording at user-specified times. In Vegas 
software, shorter events can be punched into longer ones.

Quadraphonic

A mixing implementation that allows for four discrete audio channels. These are usually routed to two front speakers and 
two back speakers to create immersive audio mixes.

Quantization (Audio)

The process by which measurements are rounded to discrete values. Specifically with respect to audio, quantization is a 
function of the analog-to-digital conversion process. The continuous variation of the voltages of a analog audio signal are 
quantized to discrete amplitude values represented by digital, binary numbers. The number of bits available to describe 

24 fps film (top) and resulting NTSC video with 2-3 pulldown fields (bottom)

24 fps film (top) and resulting NTSC video with 2-3-2-2 pulldown fields (bottom)



these values determines the resolution or accuracy of quantization. For example, if you have 8-bit analog-to-digital 
converters, the varying analog voltage must be quantized to 1 of 256 discrete values; a 16-bit converter has 65,536 
values. Quantization is to level as sampling rate is to time.

Quantization Noise

A result of describing an analog signal in discrete digital terms (see Quantization). This noise is most easily heard in low 
resolution digital sounds that have low bit depths and is similar to a hiss while the audio is playing. It becomes more 
apparent when the signal is at low levels, such as when doing a fade out. See also Dithering.

Quantizing (MIDI)

The correction of rhythms to align with selected note lengths or beats in a MIDI sequence.

Quantizing (Video)

Limiting all editing to frame boundaries. For more information, see Quantizing to frames on page 114.

Red Book specification

The Red Book defines the specifications of every audio compact disc in every music store throughout the world. Red Book 
specifications define not only the information within the disc (digital audio recorded at 44.1 kHz), but also the disc size 
itself and the way in which the audio is arranged. 

Region

A subsection of a sound file denoted by a start and end point. You can define any number of regions in a sound file.

Rendering

The process by which Vegas software saves the project to a specific file format like AVI or WMA.

Resample

The act of recalculating samples in a sound file at a different rate than the file was originally recorded. If an audio file is 
resampled at a lower rate, Vegas software decreases sample points. As a result, the file size and the frequency range are 
reduced. When resampling to a higher sample rate, Vegas software interpolates extra sample points in the sound file. This 
increases the size of the sound file but does not increase the quality. When down-sampling, one must be aware of 
aliasing (see Aliasing). Vegas software automatically resamples all audio to the project’s sample rate.

Ripple; Ripple Editing

A type of editing where events are moved out of the way to make room for newly inserted events as opposed to simply 
being overwritten. When a one minute event is ripple inserted into a project, the duration of a project lengthens by one 
minute. If ripple editing is turned off, the same operation would not affect the overall duration of the project.

Roll

Originally, a conventional studio typically had two source decks that were used to play back video to a final destination or 
output deck. These two source decks were commonly referred to as the A and B rolls. In Vegas software, a video track can 
be configured to display an A and a B roll, which appear as sub-tracks. The concept is extended further in Vegas software 
to include a transition roll between the A and B rolls. For more information, see Understanding track layers on page 248.
APPENDIX C | 375



376 | APPENDIX C
Ruler

The ruler is the area above the tracks that shows the horizontal axis units.

Sample

The word sample is used in many different (and often confusing) ways when talking about digital sound. Here are some 
of the different meanings:

• A discrete point in time which a sound signal is divided into when digitizing. For example, an audio CD-ROM contains 
44,100 samples per second. Each sample is really only a number that contains the amplitude value of a waveform 
measured over time.

• A sound that has been recorded in a digital format; used by musicians who make short recordings of musical 
instruments to be used for composition and performance of music or sound effects. These recordings are called 
samples. In this manual, we try to use sound file instead of sample whenever referring to a digital recording.

• The act of recording sound digitally (i.e., to sample an instrument) means to digitize and store it.

Sample Rate

The sample rate (also referred to as the sampling rate or sampling frequency) is the number of samples per second used 
to store a sound. High sample rates, such as 44,100 Hz provide higher fidelity than lower sample rates, such as 11,025 Hz. 
However, more storage space is required when using higher sample rates. Sampling rate is to time as quantization is to 
level.

Sample Size

See Bit Depth.

Sample Value

The sample value (also referred to as sample amplitude) is the number stored by a single sample. In 16-bit audio, these 
values range from -32768 to 32767. In 8-bit audio, they range from -128 to 127. The maximum allowed sample value is 
often referred to as 100% or 0 dB.

.sfap0

Sony Media Software audio proxy file. For more information, see Audio proxy files (.sfap0) on page 364.

.sfk

See Peak File.

Shortcut Menu

A context-sensitive menu that appears when you right-click certain areas of the screen. The functions available in the 
shortcut menu depend on the object being clicked on as well as the state of the program. As with any menu, you can 
select an item from the shortcut menu to perform an operation. Shortcut menus are used frequently in Vegas software 
for quick access to many commands. An example of a shortcut menu can be found by right-clicking any event along the 
timeline.

Signal-to-Noise Ratio

The signal-to-noise ratio (SNR) is a measurement of the difference between a recorded signal and noise levels. A high SNR 
is always the goal.

The maximum signal-to-noise ratio of digital audio is determined by the number of bits per sample. In 16-bit audio, the 
signal to noise ratio is 96 dB, while in 8-bit audio, the ratio is 48 dB. However, in practice, this SNR is never achieved, 
especially when using low-end electronics.



Small Computer Systems Interface (SCSI)

A standard interface protocol for connecting devices to your computer. The SCSI bus can accept up to seven devices at a 
time including CD-ROM drives, hard drives and samplers.

SMPTE

SMPTE is the acronym for the Society of Motion Picture and Television Engineers (SMPTE). SMPTE timecode is used to 
synchronize time between devices. The timecode is calculated in Hours:Minutes:Seconds:Frames, where Frames are 
fractions of a second based on the frame rate. Typical frame rates for SMPTE timecode can be 24, 25, 29.97 or 30 frames 
per second, depending on your local standards.

SMPTE Drop Frame Timecode

A method of measuring time in video. Drop frame involves skipping two frame numbers (no frames are actually dropped) 
every ten minutes to compensate for the difference between NTSC 29.97 fps video and 30 frame counts per second.

Telecine

The process of creating 30 fps video (television) from 24 fps film (cinema). See inverse telecine and pulldown.

Tempo

Tempo is the rhythmic rate of a musical composition, usually specified in beats per minute (BPM).

Time Format

The format in which Vegas software displays the ruler and selection times. These include: time, seconds, frames and all 
standard SMPTE frame rates. 

Time Signature

See Beats Per Measure.

Timecode

For more information, see Timecode on page 365.

Track

A discrete timeline for audio or video data. Events are placed on tracks and determine when sound or images start and 
stop. Multiple audio tracks are mixed together to give you a composite sound that you hear. Multiple video tracks are 
composited on top of each other to create the final video output.

Track List

The track list appears at the left side of the Vegas workspace and contains the master controls for each track. From here 
you can adjust track volume or transparency, add track effects, mute or solo tracks, and reorder tracks.

Track View

The track view, or timeline, is the space events appear on tracks.
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μ-Law

μ-Law (mu-Law) is a companded compression algorithm for voice signals defined by the Geneva Recommendations 
(G.711). The G.711 recommendation defines μ-Law as a method of encoding 16-bit PCM signals into a nonlinear 8-bit 
format. The algorithm is commonly used in European and Asian telecommunications. μ-Law is very similar to A-Law, 
however, each uses a slightly different coder and decoder.

Undo Buffer

This is the temporary file created before you do any processing to a project. This undo buffer allows the ability to revert to 
previous versions of the project if you decide you don’t like changes you’ve made to the project. This undo buffer is 
erased when the file is closed or when you choose Clear Edit History from the Edit menu.

Undo/Redo

These commands allow you to change a project back to a previous state when you don’t like the changes you have made, 
or reapply the changes after you have undone them. The ability to undo/redo is only limited by the size of your hard 
drive. See Undo Buffer.

Undo/Redo History

A list of all of the functions that have been performed to a file that are available to be undone or redone. The undo/redo 
history gives you the ability to undo or redo multiple functions. To display the history list, click the down-arrow on the 

Undo ( ) or Redo ( ) button.

Video for Windows (AVI)

See AVI.

Virtual MIDI Router (VMR)

A software-only router for MIDI data between programs. Vegas software uses the VMR to receive MIDI timecode and send 
MIDI clock. No MIDI hardware or cables are required for a VMR, so routing can only be performed between programs 
running on the same PC.

WAV

A digital audio file format developed by Microsoft and IBM. One minute of uncompressed audio requires 10 MB of 
storage.

Waveform

A waveform is the visual representation of wave-like phenomena, such as sound or light. For example, when the 
amplitude of sound pressure is graphed over time, pressure variations usually form a smooth waveform.

Waveform Display

A section inside of the Trimmer window or on an audio event that shows a graph of the sound data waveform. The 
vertical axis corresponds to the amplitude of the wave. For 16-bit sounds, the amplitude range is -32,768 to +32,767. For 
24-bit sounds, the range is -8,388,607 to +8,388,607. The horizontal axis corresponds to time, with the left-most point 
being the start of the waveform. In memory, the horizontal axis corresponds to the number of samples from the start of 
the sound file.



Zero-crossing

A zero-crossing is the point where a fluctuating signal crosses the zero amplitude axis. By making edits at zero-crossings 
with the same slope, the chance of creating glitches is minimized. Vegas software simulates zero crossings by applying 
short (10 mS default) fades to trimmed audio.

Zipper noise

Zipper noise occurs when you apply a changing gain to a signal, such as when fading out. If the gain does not change in 
small enough increments, zipper noise can become very noticeable. Vegas software fades are accomplished using 64-bit 
arithmetic, thereby creating no zipper noise.
APPENDIX C | 379



380 | APPENDIX C



Index
Numerics

5.1 Surround Plug-In Pack, 203
5.1 Surround, See Surround

A

A/B roll, See Tracks, Track layers
AAF

importing and exporting, 49
Add channels panning model, 137, 198
Adding empty tracks, 133
Adding media, 43
Adding media to a bin, 47
AJA card

printing to tape deck with, 299
Alignment

fixing audio/video, 98
Alpha channel, 243

In images, 208, 210
Selecting type for media file, 208

Animation, 228
Arming tracks to record, 61, 185
ASR, See Envelopes
Assignable effects, 173–174, 175

Assigning tracks to, 137, 174
Automation, 144
Routing to busses, 174
Volume adjustment, 137, 174
Volume envelope, 149

Attributes
Copying from one event to another, 160

Audio CD tab, 307
Audio channels, 160
Audio Device preferences, 319
Audio Display preferences, 323
Audio editor program, 110–111

Opening from Trimmer, 123
Opening from Vegas, 110
Setting up, 110

Audio effects, 175–181
Adding via Plug-in Chooser dialog, 176
Adding via Plug-Ins window, 177
Assignable effects, 173–174
Automation, 146
Bypassing plug-ins, 179
Creating a plug-in chain, 176
Plug-Ins window, 26
Rearranging chain order, 178
Removing plug-ins from chain, 179

Audio preferences, 318
Advanced control settings, 320
Playback buffering slider, 320

Audio property settings, 306
Audio proxy files, 364

Audio tab, 306
Audio/video alignment problems, 98
Auto-crossfades, converting to transitions, 246
Automating

Mixer controls, 174
Surround panning, 199–201

Automation
Assignable effects automation, 144
Bus automation, 145
Composite level automation, 147
Editing envelopes, 149
Hiding envelopes, 151
Latch mode, 154
Modes, 153
Motion blur automation, 148
Mute automation, 143
Recording, 154
Removing envelopes, 151
Showing or hiding controls, 143
Touch mode, 154
Track automation, 143
Track effect automation, 146
Volume and panning automation, 144

Autosaving, 282
AVI

Creating a movie, 65
rendering, 284
Template, 289

B

Balance panning model, 137, 198
Bézier masks, 207, 240
Bins, media, 47

adding media, 47
adding recorded files automatically, 47
creating, 47
deleting media, 48
searching, 47

Blue screening, 243
Broadcast wave

importing, 51
Burning 5.1-channel audio to DVD, 203
Burning audio CDs, 329

Adding pauses between tracks, 331
Creating a CD layout, 330
Disc-at-once burning, 329, 335
Exporting a track list, 334
Importing CD Architect files, 330
Marking tracks and indices, 332
Settings and preferences, 329
Track-at-once burning, 329, 334

Burning video CDs, 336
Bus automation, 145–146
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Bus tracks, 174
Busses, 137, 138, 168–172

Adding to project, 169
Adjusting for clipping, 171
Adjusting volume, 171
Assigning plug-ins to, 175
Assigning tracks to, 61, 137, 172
Automating parameters, 145–146
Automation, 145
Bus send volume envelopes, 149
Controls, 169
Deleting from project, 170
Meter resolution, 171
Muting, 172
Naming/renaming, 172
Panning, 196
Routing to hardware, 170
Soloing, 172

Bypassed plug-ins, 176
Bypassing

Audio plug-ins, 179
Video plug-ins, 225

C

Capturing HDV clips, 217
Capturing images

From a scanner, 45
From the Video Preview window, 209

Capturing Video
Recapturing offline clips, 45

Capturing video, 45
HDV, 217

CD
Burning audio CDs, 329
multimedia, 338

CD Architect files, 330
CD layout bar, 21
CD Settings tab, 324
CDs

video, 336
Channels, audio, 160
Checkerboard, 228
Child tracks (compositing), 229, 238
Chromakeying, 243

Multiple keys, 244
Chrominance

monitoring, 271
Cinescore

adding generated music to Vegas projects, 53
editing generated music in Vegas projects, 54
using with Vegas, 53

Clean up prerendered video, 268
Clearing the edit history, 103

Closed captioning, 211–213
Adding from a script, 211–212
Adding line-by-line, 211
Displaying, 213

Color
Time Display window, 305
Track, 134

Color channels, 270
Color gradient event, 228
Color key, 243
Color levels

monitoring, 273
Command markers, 107

Closed captioning, 211–213
Command bar, 21
Editing, 109
Inserting, 108
Scott Studios, 108

Composite level automation, 147
Composite level envelope, 149
Composite level slider, 60, 138, 148, 232
Composite mode

Setting default, 140
Compositing, 229–232

Compositing modes, 60, 230–232
parent/child tracks, 229, 238

Configuring a Mackie Control Universal for use with Vegas, 343
Constant power panning model, 137, 198
Context-sensitive help, 18
Contrast

monitoring, 273
Control surface

Setup, 326
Using a Mackie Control Universal with Vegas, 343

Converting format, See Rendering, 65
Copying events, 89

Event attributes, 160
Time and events, 90
Time selections, 89

Creating a movie, 65, 282
Creating a multimedia CD, 338
Creating bins, 47
Creating DVD with DVD Architect, 203
Credit roll event, 228
Credits, 209
Cropping video, 205–207

Copying and pasting cropping settings, 160
Plug-in processing order, 226

Crossfades, 101–102, 245
Automatic, 101
Curve types, 102
Manually setting, 101
Overlapping files added to timeline, 209
Sliding, 102
Video, 245



Cursor indications, 37
Customizing DVD Architect

toolbar, 307
Customizing keyboard shortcuts, 310
Customizing Vegas, 303

Frame number display, 303
Grid spacing, 304
Preferences, 311–325
Project properties, 306
Rendering settings, 288
Ruler, 303
Time Display window, 304–305
Toolbar, 20
Video Preview window, 265

Cuts, 245
Converting to transitions, 248

Cutting events, 90–91
Ripple mode, 90
Time and events, 91
Time selections, 91

D

DeckLink card, 297
Deleting

Busses, 170
CD layout bar markers, 333
Command markers, 109
Envelope points, 150
Events, 99
Keyframes, 251
Markers, 105
Regions, 107
Takes, 118
Tracks, 133

Deleting media from a bin, 48
Digital multitrack setup, 184
DirectX plug-ins, 175, 223
Disable resample, 159
Disc-at-once CD burning, 329, 335
Display frames in Video Preview window, 318
Duplicating

Events, 93
Generated media events, 229
Keyframes, 252
Tracks, 133

DV capture cards, 366
DV format, 215

Out-of-range colors, 216
Selecting source media for, 215
Setting project properties for, 215
Templates for, 216

DV tape
printing to, 296

DVD
burning 5.1-channel audio, 203
creating with DVD Architect, 203

DVD Architect, 203
DVD camcorder

importing from, 52
Dynamic RAM video previews, 268

E

Edge trimming, 93
Edit Decision Lists (EDL), 215
Edit Details window, 25, 124

Audio CD track list category, 124
Closed captioning, 211–212
Commands category, 124
Customizing, 126
Displaying, 124
Edit functions, 124
Editing a CD layout, 333
Events category, 124
Markers category, 125
Regions category, 125
Selected events category, 125

Edit history, clearing, 103
Edit source project, 56
Editing audio in external editor, 110
Editing events, 89
Editing tools

Envelope, 164
Selection, 86
Zoom, 59

Effects
fine-tuning with split-screen previews, 269

Effects chain
non-in-place plug-ins, 176

Effects, See Plug-Ins
Empty events, 93
Envelope Edit Tool, 152, 164
Envelopes, 149–153, 161–164

Adding points, 149
ASR, 161
Changing fade curves, 151
Deleting from track(s), 151
Deleting points, 150
Event envelopes, 161–164
Fade in and out, 161, 163
Fade types, 161, 163
Hiding on track(s), 151
Mixer controls, 174
Moving points, 150
Opacity, 162
Ripple editing, 100
Track envelopes, 149–153
Velocity, 163
Video, 162
Volume (event), 161
Volume (track), 149
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Equipment setup for recording, 183–184
Basic, 183
mixer, 183
With digital multitrack, 184
With MIDI option, 184

Event editing, 89
Event properties

Copying and pasting, 160
Displaying names, 118
Name, changing, 118
Pitch shifting, 115

Event switches, 157–159
Copying and pasting, 160
Invert phase, 158
Lock, 157
Loop, 157
Maintain aspect ratio, 159
Mute, 157
Normalize, 158
Reduce interlace flicker, 159
Resample, 159

Event takes, 117
Adding files as, 117
Changing active, 118
Deleting, 118
Displaying names of, 118
Previewing, 118
Recording audio as new, 186
Renaming, 118
Selecting, 118

Events, 57
adding transitions, 247
Adjusting length, 93
Channels, 160
Copying, 89
Copying and pasting attributes, 160
Crossfading, 101–102, 209, 245
Cutting, 90
Defined, 43
Deleting, 99
Duplicating, 93
edge trimming with keyboard, 95
Editing, 89
Empty, 93
Envelopes, 161–164
Fade in and out, 161
Grouping, 164–165
J-cut, 93
L-cut, 93
Moving by small increments, 58
Moving in time, 58
Moving multiple, 58
Moving single, 58
Name, changing, 118
Pasting, 91, 92

Pitch shifting, 115
Placing, 54, 55
Playback rate, 159
Razor blade, 95
Recording into, 187
repairing audio/video alignment, 98
Reversing, 123
Selecting multiple, 86
Selecting with time, 88
Shifting the contents of, 97
Shuffling, 100
Sliding, 97
Slipping, 97
Slip-trimming, 97
Snapping, 113
Splitting, 95, 97
Switches, 157–159
Trimming, 93
Undersample rate, 159
viewing media markers, 122

Expand track keyframes, 60
Expand track layers, 248
Explorer

XDCAM, 28
Explorer window, 23

Transport bar, 43
Exporting

AAF files, 49
Exporting to PSP, 289
External Control & Automation Preferences, 326
External monitor, 276

preferences, 314
secondary Windows display, 276
TV, 277
via AJA, 279
via DeckLink, 279
via SDI, 279
viewing video on broadcast monitor, 277

F

Fade in and out, 161
Fade to color, 149
Fader

Assignable effects, 138
Bus send, 138, 172
Pan, 136
track, 135

Fading in/out
Mixer controls, 174

Field order, 220
Filters, See Video effects
Floating window docks, 22
Focus, 85
Force resample, 159
Frame

freeze, 94, 158, 163
X



Frame numbers, 303
Frame-by-frame cursor movement, 85
Freeze frame, 94, 158, 163

G

General editing, 85–111
Event vs. file, 57

General preferences, 312
Generated music

adding to Vegas project, 53
editing, 54

Generating music with Cinescore, 53
Generator

Adding, 229
Duplicating, 229
window, 26

Generic control surface setup, 327
Getting media files, 43
Glossary, 367–379
Glow, 262
Grid lines

Safe areas, 270
Snapping events to, 113
Spacing, 304

Grouping events, 164–165
Adding to groups, 164
Clearing groups, 165
Creating new groups, 164
Moving grouped events, 58
Removing events from a group, 165
Selecting events in groups, 165
Suspending grouping, 165

H

Hard disk recording unit
importing video from, 52

Hardware
Routing surround to, 193
Setting up for surround, 191

HDV
capturing clips, 217
creating intermediate files, 218
editing on the timeline, 219
printing to tape from the timeline, 300

HDV format, 217
HDV tape

printing rendered file to, 301
printing to, 296, 300

Hiding/showing
Bus tracks, 174
Toolbar, 307

Histogram, 273
Hold keyframe, 252

I

IEEE-1394 DV capture cards, 215, 278, 366

Ignore event grouping, 165
Image masks, 238
Images

Automatically crossfading, 209
Capturing in Vegas, 209, 266
Correcting for DV pixel aspect ratios, 208
Creating for use in Vegas, 208
Creating masks from, 238
Creating titles from, 210
Default length, 209
Working with, 208
Zooming in on, 255

Importing
AAF files, 49
Audio CD tracks, 46
broadcast wave files, 51
CD Architect files, 330
from DVD camcorder, 52
from hard disk recording unit, 52
Media, 44
media files, 49
Scanned images, 45
Still image sequences, 47

Input monitoring
during audio recording, 176

Inserting
Command markers, 108
Empty events, 93
Markers, 104
Media, 54
Regions, 105
Time, 93
Video files with associated audio, 55

Inserting empty tracks, 133
Installation, 17

System requirements, 17
Interlace

Deinterlacing, 220
Field order, 220
Reduce interlace flicker, 159

Intermediate files
creating for HDV, 218

Inverting
Audio event, 158
Audio track, 139
Invert track phase, 61

Isolate channels, 242
Isolating color channels, 270

J

J-cut, 93
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K

Keyboard commands, 29–36
Cursor placement, 31, 85, 87
Edit, 30
Event, 32
Miscellaneous, 36
Playback, 30
Project file, 29
Selection, 31
Track view, 34
Trimmer window, 35
View, 32
Window view, 29

Keyboard shortcuts
customizing, 310

Keyframe animation, 228, 250
Event panning and cropping, 254
Generated text, 257
Track motion, 260
Video effects, 256

Keyframe controller, 251
Navigating, 251

Keyframe presets, 253
Keyframes, 199–201

Adding, 251
Changing relative spacing, 252
Deleting, 251
In track view, 60, 253–254
Interpolation curves, 252
Modifying, 251
presets, 253
Ripple editing, 100

Keying, 243

L

Labeling busses, See Naming busses
Labeling tracks, See Naming tracks
L-cut, 93
Level slider, See Composite level slider
LFE channel, 191, 193
Locating media, 43
Locking events, 157

To track envelopes, 153
To track keyframes, 254

Loop playback, 88
Looping events, 157
Luminance, 243

monitoring, 272

M

Mackie Control Universal, 326
using with Vegas, 343

Main window, 19
Make compositing child, 60, 230, 238, 239
Marker bar, 20

Markers
CD layout markers, 109
Command markers, 107
Deleting, 105
Inserting, 104
media, adding, 121
media, viewing, 122
Moving, 105
Navigating, 105
Renaming, 105
Ripple editing, 100
Snapping, 113

Markers and regions, 104–109
Snapping events to, 113

Masks, 237–244
Bézier, 207, 240
Fine tuning, 242
Image, 238
Mask generator, 242
Video, 239

Match media settings, 42, 220
Media

adding generated music to projects, 53
adding to your project, 43
editing generated music in projects, 54
generating music with Cinescore, 53
importing, 49
locating, 43
saving with project, 281

Media bin
adding recorded files automatically, 47

Media bins, 47
adding media, 47
creating, 47
deleting media, 48
searching, 47

Media files
adding from Media Manager, 79
Auto preview setting, 43
Inserting, 54
MXF, 127
Previewing, 43
project references in, 56
Properties, 221
resolving offline, 79
searching, 75
tagging, 69
tagging loops and samples, 73
XDCAM, 127

Media generator
Adding, 229
Duplicating, 229
window, 26

Media generators, 228–229
X



Media libraries
tagging files, 69

Media library
adding media files, 68
backing up, 74
creating new, 67
opening, 67
removing media files, 69

Media Manager, 28, 67
adding custom columns, 80
adding media from, 79
automatically hiding Search pane, 80
customizing view, 80
media relationships, 78
moving columns, 80
Moving the Search pane, 80
options, 82
resizing columns, 80
resolving offline media, 79
Search Results Properties pane, 81
searching for media files, 75
showing/hiding columns, 80
thumbnail view, 81
using with multiple computers, 83

Media markers
adding, 121
viewing in event, 122

Media region
viewing in event, 122

Media regions
adding, 121

Media Relationships, 78
Metronome, 186, 318
MIDI

Using the Mackie Control Universal with Vegas, 343
MIDI clock output, 325
MIDI control surface setup, 327
MIDI timecode

Input devices, 325
Output devices, 325
Time Display window, 305
Triggering from, 188

Mixer, 24, 167
Busses, 138, 168–172
Preview fader, 168
Toolbar, 168
Viewing/hiding, 167

Mixer setup (external), 183
Mixer window

Automating controls, 174
Routing surround through, 193

Mixing
Multiple tracks to a new track, 142
Video tracks, 229–232

Monitoring
chrominance, 271
color content, 271
color levels and contrast, 273
luminance, 272
RGB components, 274

Monitoring video with scopes, 270
Motion blur automation, 148
Mouse scroll-wheel shortcuts, 36, 59, 85
Movie

exporting to PSP, 289
MPEG

rendering, 286
MTC, See MIDI timecode
Multichannel audio

rendering, 284
Multimedia CD

burning, 338
Multimedia controller

scrubbing, 63
Multiple takes

Previewing, 118
Recording, 189
Selecting among, 118

Multipurpose slider, 61, 136
Assignable effects send level, 137, 138, 174
Bus send level, 138, 172
Panning, 136, 362

Music
adding generated, 53
editing generated, 54
generating with Cinescore, 53

Mute automation, 143
Muting

All audio or video tracks, 139
Busses, 172
Events, 157
Mute button, 60, 61
Tracks, 139

MXF, 127
rendering, 284

N

Naming
Busses, 172
CD layout markers, 333
Markers, 105
Regions, 106
Takes, 118
Tracks, 133

Nesting projects, 61
Noise texture, 228
Non-in-place plug-ins, 176
Non-real-time event effects, 181
Normalize audio event, 158
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OHCI 1394-IEEE cards, 215, 276, 366
Online help, 18

context-sensitive, 18
Via the web, 19

Optimizing previews, 266, 276
Ordering of effects, 178, 226
Organizing tracks, 134–135
Overlays

Animating, 264
Compositing modes, 230–232
Masks, 237–244
Position, 261
Safe areas, 270
Shadow, 261
Transparency, 243

P

Palettes, 72
assigning buttons, 72
clearing buttons, 72
creating, 72

Pan type
Setting track default, 140

Panning
Pan types, 198
Surround, 195

Panning automation, 144
Panning, audio

Envelope, 149
Multipurpose slider, 136
Panning models, 136

Panning, video, 254
Pan-and-scan effect, 256
Plug-in processing order, 226

Parent media for subclips, 123
Parent/child tracks, 229, 238
Pasting

Event attributes, 160
paste insert, 92
paste repeat, 92

Pasting events, 92
Pasting events, 91
Phase inverting

Events, 158
tracks, 139

Picture-in-picture effect, 263
Pitch shifting, 115

Copying and pasting between events, 160
Pixel aspect ratio, 220

Custom stream properties, 221
Still images, 208

Placing media
As takes, 55
Dragging/dropping, 54
Multiple files, 55
Same track, 55

Playback
Buffer control, 320
displaying frames in Video Preview and secondary monitor 
simultaneously, 318
Event playback rate, 159
Interpolate cursor position control, 320
Keyboard shortcuts, 30
Position bias control, 320
Pre-roll buffer control, 320
Scrubbing, 63
Transport bar controls, 22

Plug-in chain
Audio hierarchy, 38
Changing order, 178, 179, 225, 226
Creating, 176, 223
Saving presets, 178, 227

Plug-ins
Animating, 228
Audio, 175
bypassed, 176
Bypassing, 179, 225
Copying and pasting event plug-ins, 160
Events with panning/cropping, 226
Generators, 228–229
Keyframes, 228
Masks, 237–244
Media generators, 228–229
Modifying, 227
non-in-place, 176
Ordering, 178, 225
Removing, 179, 227
Transitioning into, 256
Transitions, 245
Video, 223
Window, 26

Post-edit rippling, 100
Post-roll, 188
PQ list, See Track list
Preference settings, 311–325

Audio tab, 318
Audio tab, advanced settings, 320
CD Settings tab, 324
Editing tab, 322
General tab, 312
Preview device tab, 314
Sync tab, 324
Sync tab, advanced settings, 324
Video tab, 314
EX



Preferences
Audio Device tab, 319
Display tab, 323
External Control & Automation tab, 326

Preparing video for broadcast
Safe areas, 270

Preparing video for television
DV format guidelines, 215

Prerendering video, 267
Pre-roll, 188
Preset chains, 179–180

Editing, 180
Organizing, 180
Saving from existing chains, 179

Presets
keyframe, 253

Presets, saving, 178, 227, 250
Preview

playback in Video Preview and secondary monitor, 318
split screen, 269

Preview fader
Adjusting for clipping, 171
Adjusting volume, 168
Hiding/viewing, 168
Meter resolution, 168

Previewing
split-screen view, 269

Previewing video
secondary Windows display, 276

Previews, 62
Full-quality, 267
In media players, 64
Optimizing, 266
Prerendering, 267
Resolution, 266
Transitions, 249

Printing
rendered file to HDV tape, 301
to DV tape, 296
to HDV tape, 300
to tape deck with AJA SDI card, 299
to tape deck with DeckLink card, 297

Printing to tape
using Video Capture, 302

printing to tape deck with, 297
Printing video to tape, 296
Project Media window, 25, 44

Adding media, 44
Adding still image sequences, 47
Capturing video, 45
Extracting CD audio, 46
Getting images, 45
Replacing media in events, 44

Project playback
Entire, 62
Media player, 64
Time selection, 62

Project property settings, 306–307
Audio CD tab, 307
Audio tab, 306
Matching video settings of existing file, 42, 220
Ruler tab, 307
Summary tab, 307
Video tab, 306

Project references in media files, 56
Projects

adding generated music, 53
Creating, 41
editing generated music, 54
nesting, 61
publishing to the Web, 65
Renaming, 42
Rendering, 282
rendering, 65
Saving, 42, 281–282
Saving as EDLs, 215

Properties
Events, 159
Media file, 221
Project, 41, 306–307
Track defaults, 140

Properties pane, 81
Proxy files, audio, 364
PSP

exporting to, 289
Publishing a project, 65
Pulldown removal, 43, 312

Configuring, 48
Punch-in, 92, 188

Q

Quantizing to frames, 114
Quick start, 41–65

R

RAM cache for previews, 268
Razor blade, 95
RealMedia (.rm)

commands, 107
Recapturing offline video clips, 45
Recapturing video, 45
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Recording, 183–189
Arming tracks, 185
Into a time selection, 187
Into an event, 187
Into an event with time selection, 188
Multiple takes, 189
Previewing takes, 118
Selecting track input devices, 185
Specifying storage folder, 189
Starting and stopping, 186
Stereo, left, right channel options, 185, 186
with input monitoring on, 176

Red book CD burning, 329, 335
Red eye

removing from still images, 123
Red eye reduction, 123

shortcut keys, 29
Redo/Undo commands, 102–103

Clearing history, 103
Multiple, 103

Reduction
red eye, 123

Reference library, 74
Sony Sound Series Loops and Samples, 75

Region, 105
Regions

Adding as takes, 122
Deleting, 107
Inserting, 105
media, adding, 121
media, viewing, 122
Moving, 106
Naming, 106
Navigating to, 106
Ripple editing, 100
Selecting, 106

Removing
Events from a group, 165
Plug-ins, 227
plug-ins, 179
Track envelopes, 151
Velocity envelopes, 164

Renaming
Busses, 172
CD layout markers, 333
Markers, 105
Projects, 42, 281
Tracks, 133

Rendering, 65, 282
controls and templates, 288
Custom settings, 288
Surround projects, 202
To a new track, 142
with multiple audio channels, 284

Rendering MPEG, 286

Reordering tracks, 134
Resampling, 214

At final render, 214
Event, 159, 163, 214

Reversing events, 123
RGB components, 274
Ripple editing, 92

Automatically, 100
Cutting, 90
Deleting, 99
Manually, 100
Pasting, 91
Post-edit rippling, 100
Shuffling events, 100

Ruler, 20
Offset, setting, 304
Project property settings, 307
Time formats, 303, 366

Ruler tab, 307

S

Safe areas, 270
Saving a project, 42, 281–282

Autosaving, 282
Using Save As, 42, 281

Saving media with project, 281
Scopes

histogram, 273
RGB parade, 274
vectorscope, 271
video, 270
waveform, 272

Scott Studio
Commands, 104, 108

Scribble strip, 60, 133
Scrolling, 59
Scrubbing, 63–64

Keyboard, 64
Playhead, 63
Scrub control, 22, 64
Timeline, 64
with multimedia controllers, 63

SDI card
printing to tape deck with, 297, 299

Search pane
autohiding, 80
automatically hiding, 80

Searching for media files
by keyword, 75
Media Manager, 75
using tags, 76

Searching media bins, 47
Secondary monitor

simultaneous playback with Video Preview, 318



Selecting
all members of a group, 165
Audio CD tracks, 333
Envelope points, 152
Events and a time range, 88
Events to the end of the track, 86
grouped events, 165
Multiple events, 86
Range of events, 86
Regions, 106
Takes, 118
time range, 87
Tracks, 88

SFAP files, 364
Shadow, 261
Shortcuts

customizing, 310
Shuffling events, 100
Signal flow, 38–39
Single session CD burning, 329
Slide show, creating, 209
Slider

Multipurpose, 136
Sliding

Crossfades, 102
Events, 97

Slipping events, 97
Slip-trimming events, 97
Smart resample, 159
SMPTE timecode, 365

Changing, 303
Snap offset, 114
Snapping events, 113

Quantizing to frames, 114
Snap offset, 114
To grid lines, 113
To marker lines, 113

Solid color event, 228
Soloing

Assignable effects chains, 173
Busses, 172
Solo button, 60, 61
Tracks, 140

Sorting media with bins, 47
Split-screen previews, 269
Splitting, 95, 97

All events at cursor, 96
Selected events, 96
Time selection, 96

Status bar, 22, 142
Stills

removing red eye, 123
Streaming media commands, 107

RealPlayer, 107
Windows Media, 107, 211

Stretching events, 116
Subclips, 123
Subtags, 71
Summary tab, 307
Surround, 191–202

Automating panning, 199–201
Hardware setup, 191
Keyframes, 199–201
LFE channel, 191, 193
Panning, 195
Rendering, 202

Surround panner, 27
Surround Panner window, 197
Switches, 157–159

Invert phase, 158
Lock, 157
Loop, 157
Maintain aspect ratio, 159
Mute, 157
Normalize, 158
Reduce interlace flicker, 159
Resample, 159

Sync tab, 324
Advanced control settings, 324

Synchronization
audio/video alignment problems, 98

Synchronizing MIDI timecode, 184, 188
System requirements, 17

T

Tagging media files, 69
loops and samples, 73

Tags
applying to media file, 70
arranging in the tag tree, 71
creating, 69
creating palettes, 72
deleting from library, 71
editing names or images, 71
removing from library, 71
removing from media file, 70
saving to media files, 73
subtags, 71
viewing palettes, 72

Takes, 117
Adding files as, 117
Deleting, 118
Displaying names of, 118
Placing media as, 55
Previewing, 118
Recording audio as new, 186
Renaming, 118
Selecting, 118

Tape deck
printing to, 297, 299

Technical support, 17
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Test pattern
Event, 228

Text
Credit roll event, 228
Keyframing, 257
Media Generators window, 26
Text event, 228
Titles, 209

Thumbnails, 81
Time compressing events, 116
Time Display window, 20, 304–305

Changing color, 305
Changing time format, 305
MIDI timecode settings, 305

Time selection, 87
Copying, 89
Cutting, 91
Recording into, 187
With events, 88

Timecode
MIDI, 184, 188, 324–325
Video, 365

Timeline
Adding media to, 54
editing HDV, 219
Moving events along, 58
Playback on external monitor, 276
printing to DV tape, 296
printing to HDV tape, 300

Titles
Creating, 209
Fading, 210
Safe areas, 270
Text generator, 228–229

Toolbar, 20
adding buttons, 308
customizing, 307
hiding/showing, 307
removing buttons, 308
reordering buttons, 308

Track automation, 143–145
Track automation envelopes, 149
Track effects

Setting default, 140
Track envelopes, 149–153

Adding points, 149
Changing fade curves, 151
Colors, 149
Deleting points, 150
Envelope Edit Tool, 152
Hiding on track(s), 151
Locking to events, 153
Moving points, 150
Removing from track(s), 151
Types, 149

Track FX button, 60, 61
Track list, 21, 59–60
Track list (audio CD)

Creating from events, 332
Editing in Edit Details window, 333
Exporting, 334

Track motion, 258–264
Button, 60
Glow, 262
Keyframes, 260
Picture-in-picture effect, 263
Position, 261
Shadow, 261
Shortcut menu, 259

Track name, 60
Changing, 133

Track view, 21
Track-at-once CD burning, 329, 334
Tracks, 58, 133–142

Adding empty, 133
Arming for recording, 61
Assigning plug-ins to, 175, 223
Assigning to a bus, 61, 137, 172
Automating parameters, 143–145
Color, changing, 134
Compositing modes, 60, 230–232
Default properties, 140
Deleting, 133
Duplicating, 133
Height, changing, 134
Height, setting default, 140
inserting empty, 133
Making compositing child, 60, 238
Mixing to a single track, 142
Multipurpose slider, 61
Muting, 60, 61, 139
Naming/renaming, 133
Number, 60
Organizing, 134–135
Panning, 195
Phase inverting, 61, 139
Reordering, 134
Resizing, 135
Scribble strip, 60, 133
Selecting, 88
Soloing, 60, 61, 140
Track effects, 60, 175–181, 223–228
Track FX button, 61
Track keyframes, 60, 253–254
Track layers, 248
Track motion, 60, 258–264
View buttons, 60
View options, 134
Volume fader, 61, 135
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Transition
adding to all selected events, 247

Transitions, 245
Adding, 246
Animating, 250
From auto-crossfades, 246
From cuts, 248
Modifying, 249
Using, 245
Window, 25

Transparency, 162
And overlays, 243

Transport bar, 22, 62, 63
Keyboard shortcuts, 30

Triggering recording from MIDI timecode, 188
Trimmer window, 24, 119–123

Audio editor, opening from, 123
Events, placing on track, 120
Opening a file in, 119
Overview, 119
Regions and markers, adding, 121
Subclips, 123
Three-point editing, 121
Working with, 120

Trimming, 93–94
Adjacent events, 94
Beyond event edges, 94
events with keyboard, 95
selected events, 93
Time and event selection, 94
Time selection, 94

Troubleshooting
Audio, 361–362
Video, 361–366

U

Undersample rate, 159
Undo/Redo commands, 102–103

Clearing history, 103

V

Vectorscope, 271
Vegas

Installing, 17
Overview, 19–37

Velocity envelope, 163

Video
editing HDV on the timeline, 219
importing from hard disk recording unit, 52
monitoring with scopes, 270
previewing on secondary Windows display, 276
printing to tape, 296
printing to tape using Video Capture, 302
viewing on broadcast monitor, 277
viewing on external monitor via AJA, 279
viewing on external monitor via DeckLink, 279
viewing on external monitor via SDI, 279

Video Capture, 302
Capturing video with, 45
Recapturing offline clips with, 45

Video CDs
burning, 336

Video effects, 223–228
Animating, 228
Keyframes, 228
Modifying, 227
Ordering, 225
Removing, 227
Window, 26

Video masks, 239
Video motion, See Track motion
Video preview

split-screen, 269
Video Preview window

displaying frames simultaneously with secondary 
monitor, 318

Video previews
Capturing images from, 209, 266
Dynamic RAM previews, 268
External monitor, 276
Optimizing, 266, 276
Prerendering, 267
Previewing in a player, 276
Resolution, 266
Shortcut menu, 266
Window, 24

Video property settings, 306
Video scopes, 27, 270

histogram, 273
RGB parade, 274
vectorscope, 271
waveform, 272

View buttons, 60
Viewing

media markers, 122
media regions, 122
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Volume
Assignable effects fader, 137, 174
Bus send fader, 172
Event envelopes, 161
Setting track default, 140
Track envelopes, 149
Track fader, 61, 135

Volume automation, 144
VST plug-ins, 175

W

WAV/WAV64
rendering, 284

Web site
Accessing help, 19
Technical support, 17
Troubleshooting resources, 361, 366

Window docking area, 22
saving layout, 309
saving window layout, 28

Window layouts
deleting, 28
recalling, 28
saving, 28, 309

Windows
saving layout, 309
Surround Panner, 197

Windows Media streaming commands, 107
Working with MXF files, 127
Working with XDCAM video, 127
Workspace

saving window layout, 309

X

XDCAM Explorer, 28, 128
XDCAM video, 127

XDCAM Explorer, 128

Z

Zoom Edit Tool, 59
Zooming, 59
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